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PREFACE

Working through a solution to a research problem is a stimulating process. The
focus of this book is learning statistics while progressing through the steps of the
hypothesis-testing process from hypothesis to results. The hypothesis-testing
process is the most commonly used tool in science and entails following a logical
sequence of actions, judgments, decisions, and interpretations as statistics are
applied to research problems. Statistics emerged as a discipline with the purpose
of developing and applying mathematical theory and scientific operations to
enhance human understanding of phenomena experienced in life. For example,
William Gossett developed the t-statistic while working at the Guinness Brewery
in the late 1800s. He worked to explain the factors that contribute to Guinness
beer remaining suitable for drinking and what fertilizers produce the best yield
of barley used in brewing. Analysis of variance is the most widely used family of
statistics in the world, and Sir Ronald A. Fisher developed the procedure in 1921
while researching the factors contributing to better yields of wheat and potatoes.

The research problems used in the book reflect statistical applications related to
interesting and important topics. For example, research problems for students
to work through include findings on the efficacy of using cognitive-behavioral
therapy to treat depression among adolescents and evaluating if support partners
added to weight loss treatment can improve weight loss among persons who are
overweight. Itis hoped that students will find the problems that they work through
to be interesting and relevant to their field of study. The research problems pre-
sented are consistent with findings in the field.

The format for each chapter on a major statistic is to cover the research problem
by taking the student through identifying research questions and hypotheses;
identifying, classifying, and operationally defining the study variables; choosing



appropriate research designs; conducting power analysis; choosing an appropriate
statistic for the problem; using a data set; conducting data screening and analyses
(IBM SPSS); interpreting the statistics; and writing the results related to the
problem.

It is the intent of the authors to provide a user-friendly guide to students to
understand and apply procedural steps in completing quantitative studies. Stu-
dents will know how to plan research and conduct statistical analyses using
several common statistical and research designs after completion of the book. The
quantitative methodological tools learned by students can actually be applied to
their own research with less oversight by faculty.

Students will develop competencies in using IBM SPSS for statistical analyses.
Computer-generated statistical analysis is the primary method used by quantitative
researchers. Students will have the opportunity to also calculate statistics by hand
for a fuller understanding of mathematics used in computations.

Moreover, the curriculum includes having students analyze research articles
in psychology using a research analysis and interpretation guide. These learning
experiences allow students to enhance their understanding of consuming research
using the information they have learned about statistical and research methods.
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Chapter 1

INTRODUCTION
AND OVERVIEW

LEARNING OBJECTIVES
o Understand the purpose of the book and the structure of

the book.

o Review independent, dependent, and extraneous variables
and their scales of measurement.

o Review measures of central tendency and variability.

o Review visual representations of data, including the normal
distribution.

o Review descriptive and inferential statistical applications of
the normal distribution.




he purpose of this book is to provide a hands-on approach for

students to understand and apply procedural steps in completing

quantitative studies. The book emphasizes a step-by-step guide using
research examples for students to move through the hypothesis-testing process
for commonly used statistical procedures and research methods. Statistical
and research designs are integrated as they are applied to the examples.
The structure of each chapter covers the following nine quantitative research
procedural steps:

1. A description of a research problem, taking the student through identifying
research questions and hypotheses.

2. A method of identifying, classifying, and operationally defining the study

variables.

A discussion of appropriate research designs.

A procedure for conducting an a priori power analysis.

A discussion of choosing an appropriate statistic for the problem.

A statistical analysis of a data set.

N W

A process for conducting data screening and analyses (IBM SPSS) to test null
hypotheses.

*®

A discussion of interpretation of the statistics.

9. A method of writing the results related to the problem.

The underlying philosophy of the book is to view the quantitative research
process from a more holistic and sequential perspective. Concepts are discussed as
they are applied during the procedural steps. It is hoped that after completion of
the book readers will be better able to plan research and conduct statistical
analyses using several commonly used statistical and research designs. The
quantitative methodological tools learned by students can actually be applied to
their own research, hopefully with less oversight by faculty.

The use of statistical software is an essential tool of researchers. Psychological,
educational, social, and behavioral areas of research typically have multifactor
or multivariate explanations. Statistical software provides a researcher with
sophisticated techniques to analyze the effects and relationships among

2 ¢« CHAPTER 1



many independent variables (factors) and dependent variables (variates) in vari-
ous combinations all at once and instantly. We will use IBM SPSS statistical
software, which has been developed over many decades and is one of the most
widely used statistics programs in the world.

Statistical techniques may have more meaning, understandability, and rele-
vance when learned within the context of research. One needs to have an
understanding of statistical analyses to consume and construct professional
research competently. Knowledge of quantitative research methods is especially
important today because of the emphasis on evidence-based practice in psy-
chology (EBPP) to improve clinical work with clients. EBPP refers to using the
best available research with clinical expertise in the context of patient char-
acteristics, culture, and preferences (American Psychological Association, 2000).

Ideally, the goal is to help a student achieve self-efficacy in understanding,
planning, and conducting actual independent research. Information and skills
grow, leading to advanced understanding. We next present a review of founda-
tional information related to research and statistics that will be useful to review
prior to completing the chapters that follow.

REVIEW OF FOUNDATIONAL RESEARCH CONCEPTS

A review of foundational concepts related to research and statistics is presented
next. Quantitative research involves the interplay among variables after they have
been operationalized, allowing a researcher to measure study outcomes. Essential
statistical methods used to assess scores of variables include central tendency,
variability, and the characteristics of the normal distribution.

Independent, Dependent, and Extraneous Variables

At the core of quantitative research is studying and measuring how variables
change. Kerlinger and Pedhazur (1973) stated, “It can be asserted that all the
scientist has to work with is variance. If variables do not vary, if they do not have
variance, the scientist cannot do his work” (p. 3). Even the father of modern
statistics, Sir Ronald Fisher (1973), said, “Yet, from the modern point of view,
the study of the causes of variation of any variable phenomenon, from the yield of
wheat to the intellect of man, should be begun by the examination and mea-
surement of the variation which presents itself” (p. 3).
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An independent variable (IV) in a study is the presumed cause variable. In
experimental research, the IV is designed and employed to influence some other
variable. It is an antecedent condition to an observed resultant behavior. Changes
in the independent variable produce changes in the dependent variable.

All variables need to be able to vary. Kerlinger and Lee (2000) identified two
types of independent variables: active and attribute. An active independent variable
is one that is manipulated by the researcher. For example, a researcher designs a
study with an IV that has a researcher-specified treatment condition compared to
a no-treatment control condition. Other terms used for an active [V are stimulus
variable, treatment variable, experimental variable, intervention variable, and
X variable.

A second type of IV is called an attribute independent variable, which is not
manipulated but is ready-made or has preexisting values such as gender, age, or
ethnocultural grouping. Other terms used are organismic or personological variables.

The terms classification variable and categorical variable are often used as an IV
label. They can be used as either active or attribute types. For example, a
manipulated IV that has a treatment condition and a control condition could be
called a classification variable. Also, an attribute variable such as gender (male or
female) may be referred to as a classification or categorical variable.

A dependent variable (DV) is the presumed resulting outcome in research. It is
usually observed and measured in response to an IV. We look for changes ina DV
caused by an IV. A DV is also referred to as a response variable or a Y'variable.

An extraneous variable (EV) is an unwanted and contaminating variable. An
EV acts on a dependent variable like an independent variable does but in a
confounding way that confuses an understanding of how the IV is changing the
DV. An extraneous variable is undesired noise in a research study. A researcher
wants to control an extraneous variable to neutralize its effects.

Variables need to be assigned meaning by specifying activities or operations
necessary to measure the variable, which is known as an operational definition
(OD). A comprehensive operational definition entails all of the activities and
operations that define the variable. For example, an active IV psychotherapy
approach might have two conditions (Gestalt therapy and control condition). We
can say there are two operational definitions for the IV psychotherapy approach
for the sake of brevity. However, each condition has a detailed, comprehensive
operational definition that is clearly and fully specified. A brief operational def-
inition of a dependent variable of depressive symptomatology may be scores on

4 ¢« CHAPTER 1



the Beck Depression Inventory (BDI). However, the comprehensive OD would
detail key psychometric research used in validating the BDI.

In correlations research, an independent variable is often called a predictor
variable (PV), and a dependent variable is called a criterion variable (CV).

Scales of Measurement of Variables

Variables can be assigned scales of measurement. A variable does not have an
absolute scale of measurement. The scale of measurement of a variable can change
depending on how the variable is being used in different studies and even within
the same study. Therefore, there is a research contextual consideration that
helps determine the scale of measurement of a variable. The process of thinking
through the connection between scales of measurement and variables helps
the researcher more clearly see how variables can be measured in a study. Also, the
scales of measurement assigned to a variable can be useful in selecting appropriate
statistics to use in research.

There are two general classifications of scales of measurement, each having
two subcategories; they are discrete scale (nominal and ordinal) and conzinuous
scale (interval and ratio).

A variable using a discrete-nominal scale of measurement has mutually
exclusive categories. For example, gender has mutually exclusive categories of
male or female, and political affiliation has categories of Republicans, Democrats,
or independents. A discrete-ordinal scale of measurement variable has ordering
along some continuum. It is rank scaled. For example, the order (first, second,
third, etc.) in which runners complete a race reflects an ordinal scale.

A continuous-interval scale of measurement variable has numerical distances
on a scale that are considered approximately equal numerical distances of the
attribute being measured. There is no true zero point on the scale; it is considered
arbitrary. For example, scores on the Wechsler I1Q test are considered interval
scaled, and there is an arbitrary zero, but the test does not measure a total absence
(true zero) of intelligence. A continuous-ratio scale of measurement variable has a
true zero point, and the numerical distances on the scale are equal to the attribute
being measured. Weight is an example of a ratio-scaled variable. A zero number of
pounds is meaningful, and 100 pounds is one-third as heavy as 300 pounds.
Other examples of ratio-scaled variables include height, length, and time.

There are times when ordinal-scaled variables such as Likert-type scales are
statistically analyzed as a continuous-interval variable (Tabachnick & Fidell,
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2007). Howell (2010) states, “We do our best to ensure that our measures relate
as closely as possible to what we want to measure, but our results are ultimately
only the numbers we obtain and our faith in the relationship between those
numbers and the underlying objects or events” (p. 8). A more important gauge of
understanding the meaning of scores on dependent variables in a study has to do
with their distributions. Measures of central tendency and variability of scores of
distributions are discussed next.

REVIEW OF FOUNDATIONAL STATISTICAL
INFORMATION

One of the most important tasks of quantitative researchers is to understand the
data they are working with. Researchers need to assess their data for issues
including dishonest data, cases with atypical scores, and noncompliance with
appropriate use of statistical requirements. Also, it is important for researchers to
understand the uniqueness of their data sets by examining typical scores, vari-
ability among scores, and characteristics and shapes of distributions of scores
related to variables in a data set.

Measures of Central Tendency

Measures of central tendency are values that represent typical scores in a distri-
bution or set of scores. We will be using the data in Table 1.1 to demonstrate
how to calculate the three most common measures of central tendency: mode,
median, and mean.

TABLE 1.1 Values Used to lllustrate Measures of Central
Tendency and Variability

X(N = 6) X2 X -X) (X —X)?

48 2,304 48 — 49 =—1 1

43 1,849 43-49=-6 36

52 2,704 52-49=3 9

50 2,500 50— 49=1 1

48 2,304 48 — 49 =1 1

53 2,809 53-49=4 16

X =294 »X?2=14,470 (X -X)=0 (X -X)2 =64

(EX)? = (294)? = 86,436
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Mode (M,)

The mode (M,) is the score that occurs most often in a set of scores. The mode is
the highest point on a graph such as a frequency distribution or a histogram and
is referred to as unimodal. If there are two scores in a sample that are equally the
most frequently occurring, then the distribution is called bimodal. The column
headed by X (individual score) and N =6 represents six individual scores in the
distribution of scores example. The only score that is represented more than once

is 48. Thus, the M, =48 and it is a unimodal distribution.

Median (Mgn)

The median (My,) is a value in the set of which 50 percent of cases fall below and
50 percent above. If the number of a set of ordered scores from low to high is
odd, then the score that has half of the other scores below it and half above
it is the median. For example, in the set of numbers 4, 5, 7, 8, and 9, the number
7 is the median.

In the set in Table 1.1, the number of scores is even. The six scores ordered
are 43, 48, 48, 50, 52, 53. To obtain the median requires calculating the average
value between the score at V/2 and the score at (/V/2) + 1. So, NI2=06/2=3
(i.e., the third score) and (V/2) +1 =3 + 1 =4 (i.e., the fourth score). The third
score in the set is 48 and the fourth score is 50. The average of 48 and 50 is
(48 +50)/2 =98/2 =49. So, the median of the data set in Table 1.1 is 49.

Mean (X or M)

The mean (X or M) is the sum of individual scores (XX) in a data set divided by
the number of scores (V). The mean is typically a more precise measure of central
tendency than the mode or the median, because the specific value of each score is
used to calculate the mean. Also, the mean has the properties of being contin-
uously scaled as an interval or a ratio. The mean is more stable than the mode or
median when it is used as a sample measure of central tendency drawn from a
population. On the downside, when a sample has extreme scores (skewed), the
mean is drawn way from the clustered scores toward the extreme scores. In these
situations, the mean may not be the most typical score in a data set. For example,
an analysis of salaries of company employees that includes the high salaries of
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executives can produce a company employee mean salary that the vast majority of
employees are well below. The median might be a better indication of the typical
employee salary in the company. Presented next is the calculation of the mean of
our sample data in Table 1.1.

where

Y X=sum of the individual scores

N =number of scores

Measures of Variability (Dispersion) of Scores

Foundational to quantitative research is the study of the measures of variability
(dispersion) of scores in a sample data set. Here we review common measures of
range, mean deviation scores, sum of squares, variance, and standard deviation
using the data set from Table 1.1.

The range of scores in a data set is simply the difference between the highest
and lowest scores (scorepighese — SCOI€lowese)- In the example data in Table 1.1, the
highest score is 53 and the lowest score is 43; 53 — 43 = 10, which is the range.

A measure of variability that is used as a component in many statistical
formulas that are used in fundamental statistics is called the zozal sum of squares,
which is the sum of squared differences of all scores in the data set from their

overall mean, (X — X)7.

Variance of the Sample (s2)

The variance of the sample (%) is the total sum of squares divided by the number of
S(X

-X)? . .
scores, T) The symbol of the variance of the population is sigma squared
(6%). If all the cases are the same value, the variance will equal zero. The larger the
variance value, the more the values are spread out in the distribution.
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We will be using NV — 1 as the denominator rather than /N since the primary
focus of this book is to use samples to estimate populations. The use of N— 1 is a
more accurate estimate (unbiased estimate) of a population parameter. We do not
know what the population mean is, so the sample values have less variability.
We use the sample mean instead and with N—1 as a compensation for not
knowing the population mean. This use of N — 1 also is referred to as degrees of
[freedom (df), a practice used in most statistical analyses. As Hays (1963) states,
“Thus we say that there are NV— 1 degrees of freedom for a sample variance,
reflecting the fact that only NV — 1 deviations are ‘free’ to be any number, but that
given these free values, the last deviation is completely determined” (p. 311). If the
goal of studying a sample is to describe the sample and not to estimate a popu-
lation, then N may be used and not NV — 1. The variance is calculated next using
the data from Table 1.1.

3:2W—XV
N —1
64
5
2 =12.80

Standard Deviation of the Sample (s)

The standard deviation of the sample (s) is the square root of the variance. The
symbol for the standard deviation of the population is 0. The standard deviation
is a more useful explanatory measure of variability when compared to the variance
because it is in the same units as the original data. For example, when presenting
the mean and the standard deviation together, they are both in the same metric.

 Bx-X)
S VA
_Jos
-\
= 1/12.80
s = 3.58
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Coefficient of Variation (C)

The coefficient of variation (C) is a ratio of the standard deviation divided by the
mean. The coefficient of variation can be used to compare the variability of
different variables as well as the means of the variables. Using the s=3.58 and
X = 49 from the data in Table 1.1, the coefficient of variation is calculated here
as a ratio and as a percentage:

C==
X
3.58
49
C =073

C X100 = 7.30%

The coefficient of variation for the DV is 0.073, and converted to a percentage it is
7.30 percent. The standard deviation is approximately 7.30 percent of the mean.

Visual Representations of a Data Set

There are many charts available to assist researchers in more fully understanding their
data. Illustrations of a bar chart, histogram, and normal Q-Q plot are presented.

A data set of scores on a dependent variable of depressive symptoms is pre-
sented in a frequency distribution in Table 1.2. There are scores from 145 par-
ticipants and there are no missing data. Hence, the data set has complete scores
and the values in the Percent and Valid Percent columns are the same. The values
in the first column are the scores representing depressive symptoms. For example,
the score of 17 has a frequency of nine scores (9/145 = 6.2%) in the data set. The
value 17 represents a cumulative percentage of 49.7 percent, which is the closest
value to the 50th percentile rank of the distribution of scores.

This data can be shown as a bar chart (see Figure 1.1). The horizontal line of
the bar chart is called the abscissa or x-axis, and in this example each number
represents a value for depressive symptoms in the data set. The vertical line, also
called the ordinate or y-axis, represents the frequency of scores by participants at
each value for depressive symptoms in the data set. For example, you can see the
most frequently scored value (16) and the least frequently scored values (5, 7, 9,
35) by participants in the sample.
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TABLE 1.2 Frequency Distribution of Scores of Depressive Symptoms

Statistics
DV
N Valid 145
Missing (0]

DV

Frequency Percent Valid Percent Cumulative Percent

Valid 5 1 0.7 0.7 0.7
7 1 0.7 0.7 1.4
8 4 2.8 2.8 4.1
S 1 0.7 0.7 4.8

10 7 4.8 4.8 9.7
1 5 3.4 3.4 13.1
12 1 7.6 7.6 20.7
13 6 4.1 4.1 24.8
14 7 4.8 4.8 29.7
15 5 3.4 3.4 33.1
16 15 10.3 10.3 43.4
17 9 6.2 6.2 49.7
18 13 9.0 9.0 58.6
19 2 1.4 1.4 60.0
20 7 4.8 4.8 64.8
21 6 4.1 4.1 69.0
22 4 2.8 2.8 71.7
23 6 4.1 4.1 75.8)
24 3 2.1 2.1 77.9
25 4 2.8 2.8 80.7
26 4 2.8 2.8 83.4
27 4 2.8 2.8 86.2
28 3 2.1 2.1 88.3
29 5 3.4 3.4 91.7
30 2 1.4 1.4 93.1
32 7 4.8 4.8 97.9
55 2 1.4 1.4 99.3
35 1 0.7 0.7 100.0

Total 145 100.0 100.0
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FIGURE 1.1 Bar Chart of Scores of Depressive Symptoms
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A histogram of the data set is presented in Figure 1.2. In a histogram the x-axis
depicts intervals of scores and the y-axis still represents frequencies of scores.
However, the scores on the x-axis are reported as falling within intervals. In this
graph, the intervals are 10-point intervals, so all scores in the data set between 0
and 9 are represented by bars in this interval. Using Table 1.1 for assistance,
the scores by frequencies in the data set interval 0—9 are score 5 (frequency =1
score), score 7 (frequency =1 score), score 8 (frequency =4 scores), and score 9
(frequency = 1 score). Therefore, a total of seven scores in the data set are within
the range of 0—9. The total numbers of scores within the intervals are interval
0—9 (seven scores), interval 10—19 (80 scores), interval 20—29 (46 scores), and
interval 30—39 (12 scores).

A histogram of a data set provides the researcher with a quick visual
inspection of the shape of the distribution of scores. For example, we can see
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FIGURE 1.2 Histogram of Scores of Depressive Symptoms
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that scores cluster around the mean and there is reasonable symmezry (balance) of
scores on either side of the mean. Also, there appear to be no extreme scores to
the negative side (left) or the positive side (right) of the distribution.

The same histogram of the data set is presented in Figure 1.3 with a normal
curve superimposed on the graph. This provides additional information about
how well the sample distribution of scores fits a normal curve. If the data set
scores were a perfect fit to the normal curve, then the bars would fit fully within
the superimposed normal curve.

An example of a useful plot to assess normality of a data set is called a Q-Q
(quantile-quantile) plot (see Figure 1.4). The Q-Q plot is derived by first sub-

tracting each observed score from the group mean. Then, these residuals
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FIGURE 1.3 Normal Curve Superimposed on Histogram of Scores of
Depressive Symptoms
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(differences) are plotted against the expected observed scores if the data are from a
normal distribution (Norusis, 2003). Normality exists in the sample distribution of
scores if the points on the Q-Q plot fall on or near the straight line. In this example,
it appears that the data set shows reasonable normality among the scores.

THE NORMAL DISTRIBUTION

The normal distribution (bell curve) is the most studied and widely used curve in the
field of probability (Tabak, 2005). Many measurements of human activities have
been shown to be normally distributed. A great deal has been discovered about the
normal curve over the past 300 years since Abraham de Moivre formulated a
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FIGURE 1.4 Q-Q Plot of Scores of Depressive Symptoms
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mathematical proof of the normal distribution. The normal distribution has useful
properties. If two random variables have a normal distribution, their sum has a
normal distribution. In general, all kinds of sums and differences of normal variables
have normal distributions. So, many statistics derived from normal variates are
themselves normally “distributed” (Salsburg, 2001). The normal distribution has
two parameters (constants): the population mean (p) and the population standard
deviation (o). There are many different normal curves that are based on these two
parameters (Snedecor & Cochran, 1967).

Characteristics of the Normal Distribution

The normal distribution has a peak (highest point on the curve), zails (the extreme
left and right points of the curve) and shoulders (the left and right sections of
the curve between the peak and the tails) (see Figure 1.5). The right side of the
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FIGURE 1.5 The Normal Distribution and Standardized Scores
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curve is also called the positive side of the curve, and the left side is referred to as
the negative side.

The base of the curve is called the abscissa (horizontal axis, x-axis) and sec-
tions off measurements in standard deviation units of constant percentages such
as percentile ranks, z-scores, and 7-scores. The height of the normal curve is
called the ordinate (vertical axis, y-axis), which represents the percentage of cases
under portions of the normal curve.

The area within the normal curve is referred to as a density of 100 percent or
a unit of 1.0 for using probability. While the tails on both sides of the normal
curve extend to infinity (00) and never touch the abscissa, 99+ percent of
the curve falls within *3 standard deviations of the curve. Most of the area is
in the middle of the curve at the highest point where 68.26 percent is between
*+1 standard deviation of the normal curve. The percentage of the area under the
curve decreases as the shape of the curve moves toward the tails.

The normal distribution is symmetrical, and each half of the curve is exactly
50 percent density. The mean, median, and mode of the normal curve are the
same, as represented by 0 at the midpoint of the curve. Illustrations of using
the normal curve in descriptive statistical analyses are discussed next.

Descriptive Statistical Applications of the Normal Distribution

We will assess an individual’s measured 1Q score compared to the IQ scores of
others who are part of a normative sample of individuals whose scores reflect a
normal curve. Bob has a measured IQ score on a standardized IQ test that is 80.
The population mean of the normative sample is =100, and the standard
deviation is 0 = 15.

A z-score can be used with this information to compare Bob’s score with the
normative sample. A z-score is a standard score that shows the relative standing of
a raw score in a normal distribution. The formula for a z-score is z= X — p/o, where
Xis an individual score, | is the population mean, and o is the population standard
deviation. The z-score of Bob’s individual IQ score is z=80 — 100/15 = —1.33.
One can visualize where z= —1.33 is placed on the normal curve in Figure 1.5.

Next we will find the percentile rank of Bob’s z-score = —1.33 (raw score of
80). A percentile rank is the score that indicates what percentage of persons being
measured fall equal to or below the particular score. The exact percentages in the
normal curve associated with z-scores are found using an online statistics calculator.
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1. Go to www.danielsoper.com, where there are several free statistics calculators.

2. On the home website > click on Statistics Calculator > scroll down and click
on the Normal Distribution button > click on the Cumulative Area Under the
Normal Curve Calculator.

3. Type in Bob’s z-score of —1.33>click on the Calculate button > the
Cumulative area: is .09175914.

If you take .09175914 times 100 or move the decimal two places to the right,
you obtain 9.175914, which is approximately 9.18%. So a zscore = —1.33
indicates that equal to or less than 9.18 percent of the norm group obtain an IQ
score of 80, when the mean is 100 and the standard deviation is 15. Bob’s
percentile rank is 9.18.

In another example, Jean scored 105 on the same IQ test. Jean’s z-score =
105 — 100/15 = +.33. A z-score = +.33 is to the right of the center point mean.

1. Go to www.danielsoper.com, where there are several free statistics calculators.

2. On the home website > click on Statistics Calculator > scroll down and click
on the Normal Distribution button > click on the Cumulative Area Under the
Normal Curve Calculator.

3. Type in Jean’s z-score of .33 > click on the Calculate button > the Cumu-
lative area: is .62930002.

If you take .62930002 times 100 or move the decimal place two places to
the right, you obtain 62.930002, which is approximately 62.93 percent. So a
z-score = .33 indicates that equal to or less than 62.93 percent of the norm group
obtain an IQ score of 105, when the mean is 100 and the standard deviation
is 15. Jean’s 1Q score of 105 represents a percentile rank of 62.93.

Inferential Statistical Applications of the Normal Distribution

We just showed how the normal curve can be used in a descriptive statistical
analysis. The normal curve also plays a key role in inferential statistics, which
involves inferring information about samples to generalize to populations.
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Inferential probability statements made about populations’ characteristics
(parameters) from analysis of sample characteristics (statistics) is statistical
inference. Parameters are any measurable characteristic of a population, and
statistics are any measurable characteristic of a sample. Inferential statistics
are estimators in the sense that they estimate parameters. When a random
sample is selected from a population with the purpose to understand the
population, there is likely to be a difference between the population mean ()
and the sample mean (X). The difference between a population parameter and
a sample statistic is sampling error. If you were able to select an infinite number
of sample means from a population, the mean of the sample means would
equal the population mean. The infinite number of sample means forms a
sampling distribution of the mean that is distributed as a normal curve. This is
the foundation of one of the most important theorems in statistics. The central
limit theorem says that “whatever the shape of the frequency distribution of the
original population of X’s, the frequency distribution of X in repeated random
samples of size 7 tends to become normal as 7 increases” (Snedecor & Cochran,
1967, p. 51). Thus, all that is known about the normal distribution can be
applied to the sampling distribution of the mean, including the probability of
obtaining a mean by chance and testing hypotheses. The z-test is used to test
hypotheses when the parameters (i and o) are known. A sample mean can be
compared to these parameters to see if it belongs to that population. One use of
a z-test is in situations using test norms where 0 and p are identified in the
standardization process.

For example, a researcher wants to determine if a sample of adults who have a
learning disability in math would have an average full-scale (FS) IQ score that is
different from the normative sample of the Wechsler Adult Intelligence Scale—IV
(WAIS-IV). The WAIS-IV norms are: mean = 100 and standard deviation = 15.
Since the researcher is not indicating a direction as to whether the average FS 1Q
score will be higher or lower than the normative sample, it is referred to as
nondirectional and we can designate the alternative hypothesis as H,: p # 100. The
null hypothesis is tested, and it is written as Hy: p = 100. The population mean
symbol () is used because we are using the sample mean as an estimator of the
population mean in the hypothesis.

A random sample of 50 adults who have a learning disability in math have a

mean FS IQ score of 86 on the WAIS-IV. We want to test the null hypothesis
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that 50 adults with a learning disability in math are a random sample from
a population of adults represented by the standardized norm sample of the
WAIS-IV.

A criterion (critical value) is identified to compare to a calculated z-test sta-
tistic before calculating the z-statistic. We will use a commonly used alpha level of
o=.05. This is a two-tailed test since there is no specification that the outcome
will show that the sample mean is higher or lower than the norm mean. We will
therefore be using both the left (negative) and right (positive) sides of the normal
curve to find significance. In this case, if the z-statistic produces a negative value,
then we would look in the negative side of the distribution; and if a positive value
is found, then we would look in the positive side. Since we are using o= .05 and
the alternative hypothesis is nondirectional, creating a two-tailed test, we need to
distribute half of the alpha (.025) in each tail of the normal curve. We are going
to find a z critical value that is located on the abscissa (horizontal axis) of the
normal curve where .025 of the curve density falls beyond at either end of
the normal curve. We are going to use an online calculator to find the z critical
value at .025 in the left tail and right tail of the normal curve using the following
directions.

Go to www.danielsoper.com > click on Swtistics Caleulators > scroll down
and click on Normal Distribution > click on Standard Normal Disribution
z-score Calculator > beside Cumulative probability level: type 0.025 >
click the Caleulate! button and the answer is z-score: —1.95996398.

Rounded, the z-value is —1.96, corresponding to the o =.025 on the neg-
ative or left side of the curve. The other half of the av=.05 is on the positive or
right side of the normal curve since it is a two-tailed test. So, if you followed the
same online calculator directions but typed in .975 (1 —.025), you would get a
rounded +1.96 that is a positive value. Thus, the critical value that we will use to
compare to the calculated zstatistic is z., = =1.96 (a=.05, two-tailed). The
formula and calculations of the z-statistic are presented next. The numerator of
the formula o /\/7 is the standard error of the mean that is the index reflecting the
sampling distribution of the mean.
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X —p
o/\/n
86 — 100
15/1/50
—14
15/7.07
—14
15/7.07
et
2.12
z-statistic = —6.60

Z-statistic =

The z-statistic = —6.60 is greater than z., = —1.96, so there is a significant
difference in FS IQ between the sample mean (86) of adults who have a learning
disability and the mean (100) of the normative sample. The 50 adults with a
learning disability in math are not a random sample from a population of adults

represented by the standardized norm sample of the WAIS-IV.

One-Sample t-Test (Student’s t-Test)

The z-statistic is not often used since we rarely know the population parameters.
A more commonly used statistic that evolved from the z-statistic is used more
often and is known as the one-sample t-test (Student’s t-test). The originator of
the #-test was William Gossett, who worked for the Guinness Brewing Company.
He used the pseudonym Student when he wrote the seminal scientific article titled
“The Probable Error of the Mean,” published in the 1908 issue of Biometrika
(Student, 1908). Gossett had to use the pseudonym Student since, to protect
proprietary interests, it was against company policy for employees to publish
studies about Guinness.

Gossett developed a new probability distribution called the #distribution that
he assumed had an initial normal distribution. In large samples the #distribution is
nearly normal, but it is less so when the sample is less than 30. The #distribution
works well with all sample sizes as long as statistical assumptions are present. Not

INTRODUCTION AND OVERVIEW e 21



only is the ¢ distribution useful for small samples, but the sample standard
deviation and mean can also be used to estimated population parameters.

The one sample #statistic is very similar to the z-test except that the sample
standard deviation (s) is substituted for the known o and the #distribution is used
to identify probability estimates to compare to obtained statistical values.

For example, a school district wants to assess whether third graders in a
particular school perform in reading similarly to all third graders in the school
district. The average score on a reading achievement test of third graders in the
school district is 105. The sample of 25 third graders from the particular school
had an average score of X = 124 and standard deviation of s=13. The one-
sample #test is used next to test the null hypothesis that Hy: =105 at «=.01.
The alternative hypothesis is nondirectional, H,: p # 105. First, we will obtain a
critical value using an online calculator to compare to the calculated one-sample 7
test. The degrees of freedom N —1 (24) and alpha (ov=.01) are needed to
identify the critical value.

Go to www.danielsoper.com > click on Swtistics Calculators > scroll down
and click on #Distribution > click on Student t-Value Calculator> type
in 24 beside Degrees of freedom: > click 0.01 next to Probability level: >
click on Calculate! and the answer is t-value (two-tailed): £2.79693951.

Rounding the 7 critical value for the two-tailed test is 2.797. Next, the one-
sample #-test is calculated.
X
= S/—\/N
 124— 105
- 13/V25

19
T 13/5

19
T 26
t=7.31

t

The obtained #-value =7.31 is larger than the critical value =2.797, so we
reject the null hypothesis (p <.01). We conclude that 25 third graders from a
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particular school had a significantly higher average score on reading achievement
when compared to the average reading achievement score of all school district
third-grade students.

The #distribution also is used for two commonly used statistics to compare two
means for differences, which are the dependent t-test and the independent t-test.

Dependent t-Test

A comparison is made between two sets of dependent scores when a dependent
t-test (paired-sample #test) is used. The pairs of scores between the two sets are
linked together. A dependent #test is used in the following four situations.

1. A comparison of the pretest and posttest scores of the same participants.

2. A comparison of the scores of one group of participants with another group
of participants who are matched on one or more extraneous variables.

3. A comparison of the scores of the same group of participants under two
different conditions.

4. A comparison of the scores of naturally occurring correlated pairs, like twins.

We will illustrate the use of the dependent rtest related to research that
compares pretest scores with posttest scores on self-compassion from the same
16 participants who received a mindfulness treatment program. Self-compassion
is measured by the Self-Compassion Scale (SCS; Neff, 2003), and high scores
reflect higher self-compassion. The alternative hypothesis is H,: ppescs 7
Hposiscs and the null hypothesis to be tested is Ho: prescs = Kposescs-

We start by obtaining a # critical value to compare to an obtained #value
using the online calculator.

Go to www.danielsoper.com > click on Statistics Calculators > scroll down
and click on #-Distribution > click on Student t-Value Calculator > type in
15 beside Degrees of freedom: > click 0.05 next to Probability level: > click
on Calculate! and the answer is t-value (two-tailed): =2.13144955.

The rounded value is 7oy = +2.131 using an = .05 with 15 df (N,4irs — 1,
16 —1=15). The scores and difference measures used for the analysis are in

Table 1.3.
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TABLE 1.3 Scores and Difference Measures for Dependent ¢ Analysis

ID Number Pretest Posttest Difference (D) D?

1 65 14 —49 2,401
2 106 120 —14 196
3 45 74 -29 841
4 e 129 -13 169
5 75 105 -30 900
6 46 97 -51 2,601
7 54 95 —41 1,681
8 79 103 —24 576
9 55 109 —54 2,916
10 99 101 -2 4
n 52 94 —42 1,764
12 73 76 -3 9
13 51 77 —26 676
14 88 98 -10 100
15 76 86 -10 100
16 68 88 -20 400

Xoe = 7175 Ko = 97.88 »D=-418 »D?=15,334
D =71.75-97.88
D =-26.13

Dependent #-test = D .
Y2 (25)
\ N 1)
2613
2
15,334 — =508
\ T 16(16- 1)
B ~26.13
15,334 — 10,920
240
2613
- V1839
~-26.13
429
t= —06.09
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The calculated dependent = —6.09 is greater than the 7cy £ 2.131, so the
null hypothesis is rejected and we conclude that there is a significant difference

between the pretest and posttest self-compassion scores. The pretest X, pre = 71.75

and the posttest X o, = 97.88. Since a high score represents higher self-compassion,
we conclude that there was a significant gain in self-compassion following the
mindfulness treatment.

Independent t-Test

The independent #test is used to test if two sample means are significantly dif-
ferent from each other from two independent samples. This is a between group
analysis. We are testing whether the two means from independent samples
are from different populations. The sample means as estimators of the popula-
tion parameters based upon the sampling distribution of differences between
means.

An independent #test analysis will be demonstrated comparing a randomly
assigned group of 16 participants who received a psychotherapy intervention on
their changes in thought suppression to a control group (7= 16) who received
the treatment later. Thought suppression is measured using the White Bear
Suppression Inventory (WBSI) (Wegner & Zanakos, 1994), and high scores
represent higher perceived thought suppression. The alternative hypothesis is H,;:
Mpschotherapy 7& Meontrol and the null hYPOtheSis is Ho: Mpsychotherapy = Mcontrol-
The mean and variance of WBSI scores and group sizes for the psychotherapy
group of participants were X = 39.75, ¥ =95.67, n=16, and for the control
group X = 53.06, s>=130.73, n=16.

First, we obtain a # critical value.

Go to www.danielsoper.com > click on Sttistics Calculators > scroll down
and click on #-Distribution > click on Student t-Value Calculator > type in
30 beside Degrees of freedom: > click 0.01 next to Probability level: > click
on Calculate! and the answer is t-value (two-tailed): +2.74999566.

The rounded value is 7oy = £2.750 using an o = .01 with 30 df ([#; — 1] +
[n, — 1], [16 — 1] + [16 — 1] = 30).
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X, —X
Independent #-test = S
2 2
ST, %
— _|_ _<
71 7
39.75 — 53.06
95.67 130.73
_|_
16 16

—13.31
V598 +8.17
_ —13.31

3.76
t=—3.54

The calculated independent #= —3.54 is greater than the 7oy = +2.750, so
we reject the null hypothesis of no differences. The treatment group showed
significantly lower thought suppression scores than control group participants
who did not receive the treatment (p <.01).

We used equal-sized groups in this example of an independent #z-test.
Slz(ﬂl — 1) + S%(ﬂz — 1)
ny -+ ny — 2

A pooled variance, S; = , is used if the sizes of groups are

X, =X,

2 L L
()

unequal and the independent 7 formula becomes r =

SUMMARY

This chapter has presented the purpose of the book and information related to
the foundations of research and statistics. Several commonly used statistics are
covered in the book that are linked to the normal distribution, including: (1) one-
way analysis of variance, (2) repeated-measures analysis of variance, (3) factorial
analysis of variance, (4) analysis of covariance, and (5) correlation coefficient and
multiple regression analysis. Nonparametric statistics are covered later in the book
that have less distribution requirements and are referred to as distribution-free
statistics. The nonparametric statistics that are covered are Kruskal-Wallis one-
way analysis of variance, Mann-Whitney U statistic, Friedman’s rank test for /4
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correlated samples, and the Wilcoxon’s matched-pairs signed-ranks test. Each
statistic is demonstrated using the hypothesis-testing process that is the subject of
the next chapter.

PROBLEM ASSIGNMENT

Review information was presented in this chapter related to measures of central
tendency, variability, visual representations of data, and the normal distribution.
Moreover, applications of descriptive and inferential statistics of the normal
distribution were illustrated. Review problems are presented on the companion
website for you to practice on. Use the examples presented in this chapter to
guide you as you complete the assignment. Your instructor will evaluate your
completed worksheet when it is finished.

KEY TERMS

abscissa critical value
active independent variable degrees of freedom (df)
alpha level dependent t-test

alternative hypothesis dependent variable (DV)

attribute independent variable discrete scale

bar chart

bimodal

categorical variable
central limit theorem
classification variable
coefficient of variation (C)
continuous scale
continuous-interval scale
continuous-ratio scale

criterion variable (CV)

discrete-nominal scale
discrete-ordinal scale
extraneous variable (EV)
frequency distribution
histogram

independent t-test
independent variable (1V)
inferential statistics
mean (X)

mean deviation scores
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measures of central tendency

measures of variability (dispersion)
of scores

median (My,)

mode (M)

negative side
nondirectional

normal distribution

null hypothesis

one-sample t-test (Student’s t-test)
operational definition (OD)
ordinate

parameters

peak

percentile rank

positive side

predictor variable (PV)

Q-Q (quantile-quantile) plot

range

residuals

sampling distribution
of the mean

sampling error
shoulders

standard deviation of the
sample (s)

standard error of the mean
Statistics

sum of squares

symmetry

tails

two-tailed test

unbiased estimate
unimodal

variance of the sample (s°)
X-axis

y-axis

Z-SCcore
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Chapter 2

LOGICAL STEPS
OF CONDUCTING

QUANTITATIVE RESEARCH:

HYPOTHESIS-TESTING
PROCESS

LEARNING OBJECTIVES
o Understand the logic and purpose of the hypothesis-testing
process in scientific research.

o Identify the components and application of alternative and
null hypotheses.

o Examine the meaning of alpha level and commonly used
criterion levels of alpha (o) used in research.

o Explore the elements used to choose an appropriate sta-
tistic for use to test a null hypothesis.




o Understand decision rules associated with rejecting and
failing to reject a null hypothesis.

o Realize the importance of including effect size and confi-
dence interval information to further clarify making a
decision concerning the null hypothesis.

he hypothesis-testing process is a logical sequence of steps to
conduct the statistical analyses in a quantitative research study. Indeed,
hypothesis testing is the most widely used statistical tool in scientific
research (Salsburg, 2001, p. 114). However, we must remember that no method,
including obtaining statistical results from hypothesis testing, is the absolute final
answer to a research problem. As Snedecor and Cochran (1967) stated, “But
the basic ideas in statistics assist us in thinking clearly about the problem, provide
some guidance about the conditions that must be satisfied if sound inferences are
to be made, and enable us to detect many inferences that have not good logical

foundation” (p. 3).

HYPOTHESIS-TESTING PROCESS

There are six steps of the hypothesis-testing process that provide the procedure for
conducting the statistical analyses used in this book. Descriptions and key con-
cepts are discussed for each hypothesis step.

1. Establish the alternative (research) hypothesis (H,).

An alternative (research) hypothesis (H,) is a speculative statement about
the relations between two or more variables used in a quantitative research
study (Kerlinger & Lee, 2000). A researcher initially develops one or more
research hypotheses about the direction and expected results of a study. In
experimental and quasi-experimental research, the variables stated in an
alternative hypothesis reflect the changes in an outcome (dependent variable)
that can be attributed to a cause (independent variable) (Martin & Bridgmon,
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2009). Researchers focusing on the predictive relationships among variables
often use the terms predictor variable (independent) and criterion variable
(dependent).

An alternative hypothesis can be conceptualized as either a nondirectional
hypothesis or a directional hypothesis. A researcher does not have a clear
expectation about what direction the results of study will likely take when a
nondirectional hypothesis is used. Typically, there is little or no previous
evidence to inform the researcher as to what the results have been in the past
represented by similar studies when a nondirectional alternative hypothesis is
used. For example, if a researcher is studying the effects of cognitive-
behavioral therapy (CBT) and interpersonal therapy (IPT) on weight gain
among women with bulimia, a researcher might state a narrative nondirec-
tional alternative hypothesis () as:

H,: There will be significant differences in weight gain among women
with bulimia when comparing the effects of cognitive-behavioral therapy
to the effects of interpersonal therapy.

This nondirectional alternative hypothesis does not declare a direction as to
whether the one therapy condition will produce more effects than the other
therapy condition. We can also write this nondirectional hypothesis in the
following symbolic format:

Hy: ey 7 B2 (18T)

The symbol f¢ (mu) represents a population mean that we estimate using a
sample mean (X) when conducting inferential statistics to assess mean dif-
ferences. In this case, we are hypothesizing that the population mean of
weight gain resulting from CBT will be different from (not less than or
greater than) the population mean of weight gain produced by IPT. We
analyze sample means as estimates of the population means and might choose
to use an independent #test in this example.

A directional alternative hypothesis does state an expectation for the
outcome of the study. Researchers usually design their studies using previous
research to guide them. Since a major purpose of research is to integrate study
results with related previous and ongoing studies and theory, directional
hypotheses are commonly used by researchers.
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The following directional alternative hypothesis could be written based on
previous research studies showing cognitive-behavioral therapy to be more
effective than interpersonal therapy in reducing weight gain among women with
bulimia.

H, Cognitive-behavioral therapy will produce significantly higher
weight gain among women with bulimia when compared to the effects
of weight gain produced by interpersonal therapy.

This directional alternative hypothesis is a declaration that cognitive-behavioral
therapy will produce more weight gain than interpersonal therapy among
women with bulimia. Symbolically, the directional alternative hypothesis can
be written as:

Hy: Py (caT) = M2 (18T)

This symbolic alternative hypothesis states that the population mean of
weight gain resulting from CBT will be larger (greater) than the effects of IPT

on the population mean of weight gain.

2. Establish the null hypothesis (Hp). This is the hypothesis that is tested
statistically.

The null hypothesis (Hy) can be viewed as: (1) the hypothesis whose
nullification, statistically, would be taken as evidence in support of a specified
alternative hypothesis, or (2) the hypothesis that there is “no difference
between two sets of data with respect to some parameter, usually their means,
or of no effect of an experimental manipulation on the dependent variable of
interest” (Nickerson, 2000, p. 242); the latter is most commonly used in
psychological research. The “no difference” approach is often referred to as a
nil null hypothesis or a nil hypothesis.

We will be combining both approaches in the statistical nullification of
the null hypothesis in support of a specified alternative hypothesis. Also, we
will be testing no difference nulls and suspending judgment when we fail to
reject nulls. A null hypothesis related to our previous alternative hypothesis
example can be stated as:

Hy: There will be no difference in weight gain among women with
bulimia when comparing the effects of cognitive-behavioral therapy to
the effects of interpersonal therapy.
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A “no difference in effects” approach is taken in testing the null hypothesis.
Also, a statistical nullification of the null would provide evidence in support
of the specified alternative hypothesis. The null can be stated symbolically as:

Ho: Py (car) = M2 (1BT)

The null hypothesis states that the population means of weight gain resulting
from CBT and IPT will be equal. There will be no difference between the
means resulting from either treatment condition.

When the null hypothesis is rejected, a significant difference is found
between the sample means of weight gain (estimating the population means)
produced by the treatment conditions. Moreover, we will conclude that this
nullification provides evidence in support of the alternative hypothesis. If the
sample means are not significantly different from each other, we have an
inconclusive decision when we fail to reject the null hypothesis. We cannot
say that there is absolutely no difference between the two means in this case.
We instead suspend judgment as to the relation between the two means that
are not significantly different from each other.

Decide on the risk that one is willing to take for being wrong if one
rejects a true Hy, thus making a Type I (alpha [at]) error. Also, make a
decision about the risk one is willing to take for being wrong if one fails
to reject a false Hy, thus making a Type II (beta [3] error).

A researcher chooses (sets) an alpha level (o) prior to data analysis.
Common alpha levels used in research are .001, .01, .05, and .10, with the
two most common being o« = .05 and o = .01. One of the founders of
statistics, Sir Ronald A. Fisher, suggested using oo = .05 in the early 1900s
(Fisher, 1925). His practice evolved into the four most used alpha levels
ranging from .001 to .10. As Nickerson (2000) states, “If cv is set at .05, say,
and a significance test yields a value of p equal to or less than .05, the null
hypothesis is rejected and the result is said to be statistically significant at that
level” (p. 243).

We also need to consider the chances associated with making a beza error
(Type II error) when we select an alpha level for a particular study. We do this
by conducting an a priori power analysis, which tells us the probability in a
proposed study of correctly rejecting the false null hypothesis in favor of an
alternative hypothesis. The power analysis is conducted before a study begins
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using an estimated alpha level, sample size, and effect size. Power analysis is
g p p y

discussed further in Chapter 3.

4. Decide on the appropriate statistic to be used to test the H, and the
associated sampling distribution to be used (e.g., 2, t, F, , R, x?) on
the assumption that H is true.

The next step in the hypothesis-testing process is to identify the appro-
priate statistic and associated sampling distribution to use to test the null
hypothesis. The sampling distribution is a theoretical probability distribution
that provides the foundation for testing hypotheses statistically.

Several issues are examined to determine whether a certain statistic is
appropriate to use for a particular analysis (testing of an H,) in a study.
The choice of a statistic is based on elements related to: (1) the focus of the
interplay among variables (e.g., relationships or differences), (2) the number
of independent and dependent variables used in an analysis, (3) the scales of
measurements of the dependent variables, (4) the number and relationships
(dependent vs. independent) of participant groups being compared, and
(5) the extent that underlying assumptions of the statistic are met. A statistical
design process integrating these elements is presented in Chapter 4.

5. Draw a sample of size /V; screen the data for accuracy, missing values,
and outliers; and assess whether the underlying assumptions of the
statistic being used are met.

It may be necessary to change a decision about the statistic chosen or to
modify the data set based on your data screening results. Compute the sample
statistic and compare the result to the critical value (CV) (e.g., 2,95, £.99, F999)
of the sampling distribution. More commonly, a comparison is made
between the exact probability value obtained from the computer-generated
statistical result and the chosen alpha level to determine significance.

Initially in the data screening process, it is important to conduct data
cleaning once the data is collected. Study data may be entered into a com-
puterized statistical program by hand or imported or downloaded from
another source. All methods of data compilation have the potential for
varying degrees of imprecision. It is therefore important to use various
methods to check the accuracy of data before conducting statistical analyses.

The extent and pattern of missing data are another focus of data
screening. Missing data can occur from data handling error, from study

34 ¢« CHAPTER 2



participants failing to respond to items, or from participants discontinuing
their involvement in a study. Missing data can make it difficult to interpret
and generalize the results of statistical analyses to the population from which
the study sample was drawn.

Data diagnostic procedures are undertaken after the data are determined
to be accurate. Many statistical procedures, known as parametric statistics,
require that certain underlying assumptions are met in order to use a
given statistic with a data set. A parametric statistical process is undertaken
when sample characteristics are used to estimate population parameters
such as those from the known normal distribution, #distribution, and
F-distribution. For example, a one-way analysis of variance requires that the
scores of the dependent variable approximate a normal distribution,
their variances across groups are homogeneous or constant, and there is
independence of observations. If the underlying assumptions are not found to
be met, then a researcher may need to use a nonparametric statistic
that does not require the same strict underlying assumptions. Another
common alternative is to transform the data to minimize the effects of
outliers, nonnormal distributions, heterogeneous variances, and dependence
of observations.

Once the data are readied from data screening and diagnostics, the
testing of the null hypothesis can be conducted using the statistical analysis.
The statistical analysis significance probability (generated from the proba-
bilities of the sampling distribution used) is compared to the selected
alpha level. The researcher makes a decision to reject or fail to reject the null
hypothesis.

Make a decision regarding the Hy; either reject the Hy in favor of the H,
or fail to reject Hy. Additionally, provide effects sizes and confidence
intervals.

If the statistical significance probability is equal to or less than the alpha
level, the null hypothesis is rejected. The decision of failing to reject the Hj is
made if the statistical significance probability is greater than o For example,
in rejecting the null hypothesis when oo = .05, we will make a Type I error
no more than five times in 100. There is only a 5 percent or less chance that
we reject a true /. This statistical decision making can be illustrated using
the null hypothesis stated earlier.
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(Narrative Null)

Hy: There will be no difference in weight gain among women with
bulimia when comparing the effects of cognitive-behavioral therapy to
the effects of interpersonal therapy.

(Symbolic Null)
Hy: py (CBT) = M2 (1BT)

We will say that we found a statistical significance probability of
» = .003 and the alpha level of significance is &« = .05. The p = .003 is less
than the alpha criterion of av = .05 so the rule is to reject the Hy. We can
conclude that there was a significant difference in weight gain resulting from a
comparison of the CBT and IBT conditions. There is a less than 5 percent
chance that we reject a true Hy (p < .05). We expect that fewer than five
times in 100 would there be no difference between the two means. There is
another way to state this statistical decision of rejecting the null hypothesis by
linking to sampling distribution theory. It could be said that if one repeatedly
took two random samples from the same population and tested the differ-
ences between their means, one would expect to get a difference that was
significant at the .05 level about five times in 100 (Nickerson, 2000).

Now, let’s say that that we found a statistical significance probability
of p = .11 and the alpha level of significance is still a = .05. The obtained
p = .11 is greater than the alpha criterion of o = .05, so the rule is to fail to
reject the Hy (p > .05). We can conclude that it is inconclusive that CBT
and IPT have a differing effect on weight gain among participants. When we
fail to reject the null hypothesis, we cannot conclude that there is an absolute
noneffect or no difference. We would not say that CBT and IPT were equal
in their effects on weight gain. A nonsignificant result is an inconclusive result
or indefinite decision.

Making a decision about the null hypothesis is not enough. Additional
information is needed to help draw accurate conclusions about one’s study
data. Cohen (1994) provided three recommendations to improve the null
hypothesis significance testing (NHST) process. First, understand that there
is no magic alternative to NHST. Second, before generalizing from your data,
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understand and improve the data using “detective work” methods such as
data screening or exploratory data analysis (EDA). Third, routinely report
effect sizes and report data in the form of confidence limits. Jones and Tukey
(2000) proposed using confidence intervals when they are available and rec-
ognizing the limitations with traditional NHST.

Jones and Tukey (2000) also proposed another conclusion-making
process, emphasizing that a researcher should assess the sample data and
entertain one of three conclusions: “(a) act as if pa — pg > 0; (b) act as if
ta — pp < 0; or (c) act as if the sign of py — pp is indefinite, that is, is not
(yet) determined” (p. 412). Again, using our previous example, the first
possible conclusion following statistical analysis is that pcgr — ppr > 0,
which reflects that CBT produces a higher weight gain than the IPT con-
dition. The second possible conclusion is that pcgr — ppr < 0 resulted in
CBT producing less weight gain than the IPT condition. The final possible
conclusion is that pcpt — ppr is indefinite—that is, inconclusive.

It is important to remember that replication studies provide the tenability
of scientific findings. Scientific conclusions result from a stream of well-
designed studies in which data are compared across studies to formulate
theory. There is no final scientific truth, but, instead, there is evolving
scientific theory.

SUMMARY

The six steps of the hypothesis-testing process were discussed in this chapter. The

hypothesis-testing process is the model or template that is used to learn

the statistical analyses covered in the book. The hypothesis-testing process is the

most widely used tool in science; however, there are limitations to be aware of.

PROBLEM ASSIGNMENT

The components of the hypothesis-testing process were presented in this chapter,

including a rationale for decision making regarding the rejecting or failing to

reject the null hypothesis. Examples are available on the companion website for

you to practice your understanding of the hypothesis-testing process.
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KEY TERMS

alpha level () nil null hypothesis

alternative (research) hypothesis (H;)  nondirectional hypothesis

a priori power analysis null hypothesis (Ho)
beta error (Type Il error) nullification
confidence intervals parametric statistics
criterion variable predictor variable
data screening process replication studies
dependent variable sampling distribution
directional hypothesis suspending judgment
effect sizes w (mu)

independent variable
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Chapter 3

MAXIMIZING HYPOTHESIS
DECISIONS USING
POWER ANALYSIS

LEARNING OBJECTIVES
Understand the balancing considerations to avoid making
Typeland Type Il errors in choosing an alphalevel fora study.

Explore illustrations of study examples to avoid making
Type I and Type II errors.

Understand the difference between a priori power analysis
and post hoc power analysis.

Examine the three elements used in conducting an a priori
power analysis: alpha level, estimated effect size, and sample
size.

Understand the three classes of effect sizes.

Conduct and interpret an a priori power analysis using
G*Power.




aking a correct decision about rejecting or failing to reject a null

hypothesis relates to probability, not certainty. The null hypothesis

statistical testing process balances between avoiding making either
a Type I or Type II error. An a priori power analysis can be conducted to help a
researcher maximize correctly rejecting a false null hypothesis in favor of the
alternative hypothesis in a study.

The third step in the hypothesis testing process focuses on identifying an alpha
level as a criterion for making a decision about rejecting or failing to reject a null
hypothesis in a study. Choosing an alpha level involves considering avoiding making
both a Type I error (alpha [o] error) and a Type II error (beta [[3] error) when making a
decision to either reject or fail to reject a null hypothesis (). The correctness of
rejecting or failing to reject an Hj relates to a balance between avoiding making a
Type I error and avoiding making a Type II error. Refer to Table 3.1 as we discuss
this statistical decision process of rejecting or failing to reject a null hypothesis,
balancing the avoidance of making a Type I or Type II error.

The heading called Possible Study Decision in Table 3.1 refers to the deci-
sions facing a researcher to reject or fail to reject a null hypothesis related to a
particular study. Foundational to the statistical hypothesis testing process is an
understanding that when we reject or fail to reject a null hypothesis we never
know absolutely if our decision was correct, because we are using probability as
the basis of our decision. We want to make a tenable decision based on a high
degree of probability that our decision is correct. We can conceptualize the
correctness of our decision by comparing the possible study decisions about
the null to the hypothetical actual truth (theoretical) about the null in our study.

We will use the previous example null of Hy: 11 (cp1) = H2ap) With @ = .05
to illustrate the possible statistical decisions using Table 3.1. We can conceptualize a
true H, using our study example as meaning that there is no significant difference
between means and a false Hj as there is a significant difference between means.

TABLE 3.1 Decision Balance between Type | and Type Il Errors

Actual Truth about Hg

Possible Study Decision Ho True Ho False

Reject Ho Type | (o) error Correct decision
p=1-03 = Power

Fail to reject Ho Correct decision Type Il error
p=0

40 ¢« CHAPTER 3



If we reject the Hy (p < .05), we decided that there is a significant difference
in weight gain of women with bulimia who received cognitive-behavioral therapy
(CBT) compared to those who were provided the interpersonal therapy (IPT)
condition. However, if in actual truth (theoretical) the null hypothesis is true—
that is, there is no difference in weight gain comparing the mean of the CBT
group to the mean of the IPT group of participants—then we made a Type I (o)
error by rejecting a null hypothesis when we thought there was a difference in
weight gain between the groups but in actuality there was no difference.

We make a correct decision if we reject the Hj and in actuality the Hj is false.
The decision that there is a difference in mean weight gain between the groups is
correct because in actual truth the H, is false.

We make a Type II (beta) error if we fail to reject the Hj and in actual truth
the null hypothesis is false. We declare there is no significant difference between
group means when in actuality there is a significant difference in weight gain
produced by the two conditions of CBT and IPT.

If we fail to reject the Hj in our study and in actual truth the null hypothesis
is true, we make a correct decision. We decided that there is no significant
difference in weight gain produced by the CBT compared to the IPT conditions
and in actuality there is no difference in weight gain between the two condition
groups. As we discussed in Chapter 2, it is better to say that we suspend judg-
ment on a difference when we fail to reject a null hypothesis.

BALANCE BETWEEN AVOIDING
TYPE | AND TYPE Il ERRORS

There is a give-and-take relationship between avoiding making either a Type I
error or a Type II error when trying to make a correct decision about rejecting or
failing to reject a null hypothesis. The alpha, beta, and the a priori power levels
chosen by a researcher can influence the correctness of a significance decision
about the null hypothesis. The influence of alpha related to making Type I and II

errors is illustrated first.

lllustration of Avoiding Making a Type | (Alpha) Error

Suppose that administrators of a large school district have learned about a new
curriculum that has demonstrated effectiveness in improving reading scores in

MAXIMIZING HYPOTHESIS DECISIONS USING POWER ANALYSIS e 41



elementary schools in two other large school districts in their state. The
administrators have not concluded that they have a problem in their district, but
the other districts have shown an increase in student reading achievement when
they adopted the new curriculum. The school district administrators have esti-
mated that to implement the new reading curriculum it would cost the district
$900,000 in new materials and teacher training. The administrators plan a
study to assess the effectiveness of the new reading curriculum compared to the
old curriculum before making a decision. The school district research and
development director creates and implements a randomized design comparing
two treatments (old curriculum, new curriculum) on standardized reading
achievement scores. We present the null and alternative hypotheses for this
hypothetical study and go through possible decisions in Table 3.1 to discuss the
reciprocal relationship between Type I and II errors in possible decisions about
the null hypothesis.

H 0- OLD CURRICULUM — M'NEW CURRICULUM

Ha: Mold curriculum < Moew curriculum

Would it be of more concern for the researcher to avoid making a Type I error
or a Type Il error in this example? If a Type I error is made, the Hj is rejected when
in the true state of the world Hj is true. The decision is made that there is sig-
nificantly higher reading achievement scores of students who received the new
curriculum versus the old curriculum; however, there really is no significant dif-
ference between the two curricula to improve reading achievement scores.

A Type II error would suggest that the researcher failed to reject the H, when
the actual truth is that the H, is false. The researcher declared that there is no
significant difference in reading achievement between the two curricula when in
fact the new curriculum is more effective than the old curriculum.

It is always a balancing act between avoiding either a Type I or a Type II
error, so there is no one absolutely true answer to the question posed earlier. The
situational factors related to the research study contribute to the importance of
avoiding Type I and II errors.

It could be argued in this situation that the researcher might be most con-
cerned about avoiding making a Type I error, deciding there is a difference in the
effect of the new curriculum compared to the old curriculum when in truth there
is no difference. In making this error the school district might spend $900,000
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and put forth a great deal of effort in training teachers to use the new curriculum
when the new curriculum is no better than the old curriculum in increasing
reading scores.

Selected alpha levels can affect the balance to avoid making either a Type I or
a Type II error. You recall that the four most common alpha levels used in
research as the criterion for rejecting or failing to reject an H are:

More Stringent Less Stringent

Alpha levels .001 .01 .05 10

More stringent signifies that is more difficult to reject the null hypothesis and
less stringent means that it is less difficult to reject the null hypothesis. The choice
of a more stringent alpha level (.001 or .01) reduces the chances of making a
Type I error. For example, if the Hj is rejected at the o« = .01 level, then there is
a less than 1 percent chance that a true A, was rejected. In contrast, choosing an
o = .10 would result in a 10 percent chance of rejecting a true Hy. Choosing a
more stringent alpha level in this example would reduce the probability of making
a Type I error, which would increase the researcher’s confidence that there is a
real difference between the two curriculums on improving reading achievement.
However, making the alpha level more stringent increases the chances of making
a Type II error of failing to reject the A, when there may be an important dif-
ference between the two curricula on reading achievement but at a less stringent

alpha level.

lllustration of Avoiding Making a Type Il (Alpha) Error

Officials at a state department of public transportation want to determine from
a series of studies how blood alcohol intake affects driving skills. The officials
want to obtain evidence to consider whether driving under the influence (DUI)
laws should be changed relative to blood alcohol concentration (BAC) levels.
In one study, a sample of participants are randomly assigned to one of four
alcohol consumption conditions that produce BAC levels of either .03, .06,
.08, or .10. The participants are asked to drive automobiles through a driv-
ing skills course after reaching their designated BAC levels. The mean driving
skill levels are compared across the BAC condition groups. A lower mean
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score reflects lower-skill performance during driving. The null and alternative
hypotheses are stated as:

Hy: HBac.03 = MBac.os — MBac.os — MBAC.10
Ho: pgac.os = Pac.os = HBac.os = KBAC.10

Would it be of more concern for the researcher to avoid making a Type I error or
a Type 1I error in this example? There may be more reason in this example to
emphasize the avoidance of making a Type II error. If the researcher fails to reject
the H, that there is no difference in driving skills across the BAC levels when in the
truth there is a difference, making this Type II error could result in decisions
by the department of public transportation to allow more unsafe drivers on the
road. The researcher may want to choose a less stringent alpha level (.05 or .10) to
improve the chances of finding a difference if it exists. This decision, though, would
increase the chances of making a Type I error. The researcher may declare differences
in driving skills when in fact differences in BAC levels have no effect on driving skills.

A Priori Power Analysis

We have shown that the selection of alpha levels can influence the balance between
making either a Type I or a Type II error. Another important ingredient to
consider in the balancing process is @ priori power (see Table 3.1). While beta (3) is
incorrectly retaining a false H, (Type II error), power is the probability of correctly
rejecting a false null hypothesis in favor of the stated alternative hypothesis. Just as a
researcher develops a rationale for selection of an alpha level before (a priori) the
study begins, the researcher also wants to conduct an a priori power analysis.
A researcher also analyzes post hoc (observed) power after the study is conducted.

An a priori power probability is calculated before the study begins; its value
ranges from 0 to 1.0, and we want it to be as large as possible. A priori power is an
estimate of the probability of correctly rejecting a false null hypothesis in favor of
an alternative hypothesis when important elements in a study are combined. The
three important elements that comprise power are the (1) selected alpha level,
(2) planned study sample size, and (3) estimated a priori effect size.

A researcher chooses an alpha level for a study following a process as illus-
trated in the earlier discussion. The researcher plans a study sample size based on
practical issues such as availability and cost and also increasing the power of the
study. Moreover, larger sample sizes are important in being able to generalize
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study findings to a target population and maximize the likelihood of finding a
treatment effect if it exists in a study.

An effect size (ES) is used as either an a priori estimator in power analysis or a
post hoc (after the study) measure of the magnitude of an effect or relationship.
An effect size provides information about practical importance of a null
hypothesis statistical finding,

There are several types of effect sizes that are organized into three classes: (1)
standardized differences effect sizes, (2) variance-accounted-for effect sizes, and
(3) corrected effect sizes (Vacha-Haase & Thompson, 2004). The standardized
differences effect sizes are standardized scores (z-scores). A commonly used
standardized difference ES is Coben’s d statistic as defined by d = X Treaument —
X ontrol /SDpooled- The X Treqement is the sample mean of the treatment group on a
dependent variable, and the Xconrol is the mean of the control group. The
SDpeoled is the pooled (weighted average) standard deviation of the standard
deviations of both groups combined. Let’s say that an antidepressant medication is
compared to a placebo condition to improve mood symptoms as measured by a
standardized test of mood where high scores reflect better mood. The sample means
of mood scores and the pooled standard deviation are X AntidepressantMedication = 49,
Xplacebo = 27, and the SDpyoreq = 8. Then, d = (45 — 27)/8 = 18/8 = 2.25.
We can say that the study results show that the mean score of mood was 2%
standard deviations higher for the participants receiving antidepressant medication
than for the participants who were in the placebo condition. Cohen (1988) also
developed guidelines for identifying whether an effect size is small, medium, or
large (see Table 3.2).

A d = 2.25 is well beyond the cutoff criterion (>.80) for being a large effect size.
Effect sizes are best interpreted in the context of the variables being studied and in
relation to findings from similar previous studies (Vacha-Haase & Thompson, 2004).
Cohen’s strength of effect size guidelines can be used for approximate general inter-
pretations. These guidelines for & are most useful with the results of an independent

TABLE 3.2 Cohen’s Strength of d Effect Sizes

Effect Size d
Small .20
Medium .50
Large .80

MAXIMIZING HYPOTHESIS DECISIONS USING POWER ANALYSIS e 45



t-test. Cohen has also developed guidelines for other statistics (see Cohen, 2008).
Glasss A (delta) statistic is another example of a standardized difference effect size. It is
similar to the 4 statistic except that the denominator is the standard deviation of the
control condition, s0 A = X Treatment — X Control/ SDControlGroup-

A second class is variance-accounted-for effect sizes. These effect sizes are
interpreted differently than standardized differences effect sizes. Variance-
accounted-for effect size values range from 0 to +1.0, whereas the standardized
differences effect sizes are based on standard deviation units and can be plus or
minus and be well over =1.0.

Eta-squared (n°) is a commonly used variance-accounted-for effect size. It is
defined as SStiearment/ (SSTreatment T SSEror) When using analysis of variance.
Sum of squares treatment (also called SSp.ween) is a calculated value that reflects
systematic variation due to the treatment effect. Sum of squares error (also called
SSwWithin) is a value reflecting deviations of individual scores from its group mean
that are difficult to explain. When dividing SStveacment by itself and another value
SSEiror it is clear that the resulting value will be less than 1.0. So, if a study
comparing two relaxation techniques and a no-treatment control condition on
reducing stress produces a SSTiearmen: = 356.633, and a SSg,,., = 1,672.350,
then n* = 356.633/(356.633 + 1,672.350) = .176.

Cohen’s guidelines for strength of n” effect sizes are presented in Table 3.3. An
n” = .176 would fall beyond the minimum level (>.14) for being a large effect.

An effect size for a Pearson product-moment bivariate correlation coefficient
() or a multiple correlation coefficient (R) is achieved by squaring the correlation
coefficients, resulting in 7 and R* respectively. If a correlation coefficient
between the amount of marijuana use and the number of hours watching tele-
vision is 7 = .44, the #* = (.44)* = .194. The * = .194 would fall between a
small and a medium effect size according to Table 3.4.

The last class of effect sizes is corrected effect sizes. The effect size of sample
has its own uniqueness (sampling error variance) that may not easily generalize to
the population it was sampled from. Additionally, the unique aspects of a sample

TABLE 3.3 Cohen’s Strength of n? Effect Sizes

Effect Size n?
Small .01-.06
Medium >.06-.14
Large >14
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TABLE 3.4 Cohen’s Strength of r Effect Sizes

Effect Size r
Small .10
Medium .30
Large .50

may not be readily replicated in other samples. Therefore, some effect sizes have
corrections or adjustments to better estimate population parameters and enhance
reliability across replication studies.

Omega squared (w?) is an effect size used in analysis of variance that is a
more conservative estimate of effect size. This is evident using the same data
from the previous 1 calculation, where K (number of groups) = 3, SStreatment =
356.633, SSgpor = 1,672.350, and SStow = (SStrearment = 356.633 + SSgpor =
1,672.350) = 2,028.983, and MSg,,, = 29.339.

2 _ SSTreatment - (K - 1)1\/ISError
SSTotaI + MSError

356.633 — (2)29.339
~2,028.983 + 29.339
~297.955
~2,058.322

w? = .145

A comparison of m” = .176 and w® = .145 demonstrates the conservative
strength of a corrected effect size.

An adjusted #* is another common corrected effect size that is also a more
conservative estimate. The 7> = .194 we used to illustrate a variance-accounted-
for effect size might result in an adjusted 7 = .167.

The interpretations associated with standardized differences and variance-
accounted-for effect sizes are quite different. It is important for a researcher to
connect an effect size with the correct interpretation and be careful about cross-
interpretation from one effect size to another.

An effect size used in an a priori power analysis is an estimate of what is likely
to be the treatment effect of the planned study. Ways to estimate an effect size
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used for a study include using prior research, deciding on what size effect is
important, and choosing a value based on professional judgment (for a further
discussion see Howell, 2010). It is preferred to select an estimated effect size that
resulted from a similar previous study or series of such studies.

The three ingredients necessary to conduct an a priori power analysis are o,
sample size, and a priori effect size. A priori power analysis occurs prior
to conducting a study for the purpose of assessing whether the study is worth
conducting with the given planned alpha level, sample size, and estimated effect
size. The researcher wants to know, when given these elements, the likelihood of
finding a treatment effect if it exists. In other words, the researcher wants to
identify the probability of correctly rejecting a false null hypothesis (power) in
favor of the alternative hypothesis. The researcher would like to be assured with a
1.0 power (100 percent chance); however, that can be difficult to achieve and
may not be necessary. A commonly used power value criterion to aim for in power
analysis is power = .80, reflecting an 80 percent chance of correctly rejecting a
false null hypothesis in favor of the stated alternative hypothesis. A researcher
combines and analyzes the three a priori power elements and hopes that the
resulting value is equal to or greater than the power criterion of .80.

For example, a researcher of a pharmaceutical company wants to study the
effects of a new pain medication in reducing headache pain when compared to a
placebo (inactive) medication (Hy: PipainMedication = HPlacebo)- 1 he average effect size
from three similar previous studies was a 4 = .65, and it will be used as the esti-
mated effect size in the a priori power analysis. The researchers in the previous study
used an o = .01 because they were more concerned with avoiding making a Type I
error. There are similar drugs that are effective for reducing headaches, and it will be
expensive to mass-produce and market the new drug. If the new medication has a
similar effect to other similar drugs then there may be no reason to develop it.
The researcher is planning to use 60 participants (/V; = 30, N, = 30) for the
study. A useful online power analysis program called G*Power 3.1 (Faul, Erdfelder,
Lang, & Buchner, 2007) is used for this example and other examples in the book.

Power Analysis Using G*Power 3.1.2

Conduct the following steps.
1. Create a folder on your desktop called gpower.
2. Google G*Power.
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5.
6.

Click on G*Power3 is now available.

Then, click on Download and register and click on the download and save
to your folder.

Double click on a created folder called GPower3.
Then, double click on a box or icon called GPower 3.1.2.

The first page you see is found in Figure 3.1. Follow these nine steps to conduct a

power analysis for the example.

1.

Under Test family > t tests should be selected. The analysis will compare
two means, so a #-test is appropriate.

Under Statistical test > select Means: Difference between two indepen-
dent means (two groups). This is an independent #test because two
independent groups of participants are being compared on pain reduction.

Under Type of power analysis > select A priori: Compute required
sample size—given o, power, and effect size.

Beside Tail(s), One should be selected. We expect that the group of participants
receiving the pain medication will experience a significantly reduced headache
pain when compared to the placebo group (H,: |1 painMedication < H2Placebo)-

Type in beside Effect size d the example estimated effect size = 0.65, which
is an average effect size from three similar previous studies.

Type next to o err prob the selected example alpha = 0.01.
Type next to Power (1—3 err prob) the selected power criterion = 0.80.

The number 1 should be typed next to Allocation ratio N2/N1. For the
example, there are 60 participants with 30 participants in each group, so
the allocation ratio would be 30/30 = 1.

Click Calculate at the bottom right of the page.

The results of the a priori power analysis are shown in Figure 3.2. The

example elements were entered into G*Power: o = .01, estimated effect

size = .65, and power criterion = .80 for a one-tailed test using an equal number
of 30 participants in each of two groups for a total sample of N = 60. The results
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FIGURE 3.1 G*Power First Page

ii# G*Power 3.1.2
File Edit View Tests Calculator Help

Central and noncentral distributions | Protocol of power analyses

Test family Statistical test

|ttests VI lCorreIation: Point biserial model v|

Type of power analysis

IA priori: Compute required sample size - given o, power, and effect size vl

Input Parameters Output Parameters

Tail(s) | One v Noncentrality parameter & ?

Effect size |p| 0.3 Critical t ?
o err prob 0.05 Df ?

Power {1-p err prob) 0.95 Total sample size ?

Actual power ?

@ Chapter 3 Maximiz... =} ZipCentral - C:\Doc... T) SR-9-11-11-Chapt... it

show that to reach an actual power of .8010789 using the planned o and esti-
mated effect size, a total sample size of NV = 98 with 49 participants in each of the
two groups is required. Therefore, it would be advisable for the researcher to plan
on increasing the total sample size to =98 participants before conducting the
study to reach a power of .80.

Lowering the alpha level would reduce the sample size of participants needed
to reach an a priori power = .80. However, that is not the reason to select an
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FIGURE 3.2 A Priori Power Analysis for the Example

i, G*Power 3.1.2

File Edit View Tests Calculator Help
Central and noncentral distributions \ Protocol of power analvsesl
critical t =2.36582
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Test family Statistical test
It tests vl IMeans: Difference between two independent means (two groups) v|
Type of power analysis
|A priori: Compute required sample size - given o, power, and effect size v|
Input Parameters Output Parameters
Tail{s) | One v Noncentrality parameter & 3.2173359
Effect size d 0.65 Critical t 2.3658207
o err prob 0.01 Df 96
Power {1-p err prob) 0.80 Sample size group 1 49
Allocation ratio N2 /N1 1 Sample size group 2 49
Total sample size 98
Actual power 0.8010789

X-Y plotfor a range of values | I Calculate I

alpha level. The alpha was selected to choose the right balance between avoiding
either a Type I or a Type II error related to the particular context of the study.
Increasing the estimated effect size would also increase the a priori power. The
estimated effect size was based on previous studies’ findings, and one cannot
change the results of previous studies. Increasing sample size is a legitimate way to
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increase a priori power, and it should be done in this example to maximize
finding a significant difference, if it exists, between the effects of a new medi-
cation compared to a placebo in reducing headache pain.

SUMMARY

The correctness of rejecting or failing to reject an Hj is a balance between avoiding
making either a Type I or Type II error. There is no absolutely correct decision
that can be made. However, a researcher can conceptualize the level of alpha most
relevant to the context of the study. Moreover, the magnitude of treatment effects
from previous research can be used to help estimate the likely outcomes of a study.
Finally, itis important to select a sample size that will be conducive to finding an effect
in a study. Alpha level, an a priori effect size, and sample size can be combined to
estimate the probability of finding a real effect in a study. An a priori power analysis is
used before a study is implemented to identify a probability of finding a real effect.

PROBLEM ASSIGNMENT

Additional examples of conducting power analysis are on the companion website
for you to complete. Use the problem presented in this chapter to guide you as
you complete the assignment. Your instructor will evaluate your completed
worksheet when it is finished.

KEY TERMS
a priori effect size power analysis
a priori power re
Cohen’s d statistic R?
corrected effect sizes standardized differences

effect size (ES) effect sizes

eta-squared (772) Type | error (alpha [a] error)

Glass’s A (delta) statistic Type Il error (beta [(] error)

> variance-accounted-for effect sizes
omega squared (w*<)

post hoc (observed) power
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Chapter 4
RESEARCH AND
STATISTICAL DESIGNS

LEARNING OBJECTIVES

Understand the importance of carefully formulating
experimental conditions and procedures, reducing the
imprecision in measurement, and controlling extraneous
experimental influences.

Explore methods to control for extraneous variables.

Understand the threats to internal validity of experimental
and quasi-experimental designs.

Examine commonly used experimental and quasi-experi-
mental designs and examples of statistical methods that can
be used in the designs.

Understand basic models used in correlation methods.

Understand issues to consider in choosing statistics to use
in different research problems.




he purpose of this chapter is to identify important components of
establishing experimental and quasi-experimental research by examining
various designs. Correlational research models are also discussed.

Statistical designs are essentially linked to research designs. Research designs
provide the blueprint for researchers to find answers to research questions. The
choice and interpretation of statistics used in a particular study is dependent
upon the research design selected by a researcher. A class of research designs
called experimental designs has the purpose to assess outcomes of cause and effect
among variables. Generally, the purpose of experimental research is to manage
and understand the change among variables by maximizing experimental variance,
minimizing error variance, and control[ing extraneous variance (MaxMinCon)
(Kerlinger & Lee, 2000).

A researcher maximizes experimental variance by carefully formulating
experimental conditions and procedures. A researcher minimizes error variance
by strategically reducing the imprecision in measurement and random error
fluctuations. Controlling extraneous variance is dealt with by identifying and
reducing the effects of unwanted variables through the identification of well-
suited design, experimental procedures, and statistics (Martin & Bridgmon,
2009). A researcher considers several issues when choosing statistics to use for
varying research problems.

FORMULATING EXPERIMENTAL CONDITIONS

Experimental research is initiated based on well-developed research questions,
with alternative and null hypotheses usually connected to theory and previous
research. Independent (cause) variables and dependent (outcome) variables are
operationally defined. Operation definitions entail describing the variables in
detail, especially as to how they function and are measured.

For example, suppose a treatment method for seasonal affect disorder (SAD)
is an independent variable in a study and there are three treatment conditions
(light therapy, cognitive-behavioral therapy (CBT), and a minimal contact-
delayed treatment control condition). The dependent variable is the intensity of
symptoms of a current SAD episode.

The independent variable is assessed as to whether it was implemented as
planned, which is known as treatment integrity (treatment fidelity). A researcher
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operationally defines every aspect of the experimental conditions to ensure an
accurate and consistent implementation of the independent variable (treazment
delivery). Equally important is defining how to assess whether the participants
received (treatment receipt) and followed through with (zreatment adherence) the
intended treatment (Shadish, Cook, & Campbell, 2002).

The dependent variable of intensity of symptoms of the current SAD episode
also needs to be operationally defined to know what the variable is and how it will
be measured. The dependent variable might be operationally defined as the scores
on a psychometrically validated instrument such as the Structured Interview
Guide for the Hamilton Rating Scale of Depression and SAD subscale (SIGH-
SAD). The researcher comprehensively identifies research that substantiates the
validity and reliability of the SIGH-SAD.

Operationalism is vital to understanding research and maintaining objectivity.
Moreover, clearly defined experimental procedures and measurements make it easier
for researchers to replicate studies to confirm or repudiate important findings.

REDUCING THE IMPRECISION IN MEASUREMENT

All research includes fluctuations between an observed quantity and its true
quantity. These fluctuations or differences are referred to as errors that represent
imprecision in measurement. Two important sources of error are sampling error
and error of measurement.

Sampling Error

A sample selected for study is intended to represent a population. Inferences
about sample statistics such as a mean and standard deviation are used to estimate
population parameters. It is highly unlikely that sample statistics will be exactly
the same as population parameters. The difference between a sample mean and a
population mean is referred to as sampling error. Indexes representing sampling
error are available to help researchers understand the differences between sample
statistics and population parameters. All parametric statistical procedures have
sampling error terms to account for sampling error. For example, the sampling
error index for the difference between a sample and a population mean (one-
sample #test) is called the standard error of the mean. The standard error
terms associated with some other statistics include independent #test (standard

RESEARCH AND STATISTICAL DESIGNS e 55



error of difference), analysis of variance F-test (mean square error), correlation
coefficient-7 (standard error of estimate), and multiple regression (standard error
of regression coefficient).

The use of random sampling is the best way to reduce sampling error. Random
sampling involves taking a random sample from a larger population by selecting
cases by chance to represent the population. This probabilistic approach will
result in the most representative sample if it is done correctly. For example, the
first step for a researcher who wants to study third graders in a school district is to
obtain a complete list of all third graders. The researcher would choose a desired
sample size and then use a random number generator to select the number for
the sample from the complete list of third graders (population).

Ideally, the two-step process of first randomly selecting a sample of participants
and then randomly assigning them to a treatment condition is used in research for
generalized causal inference. However, it is uncommon for participants to be
randomly selected to participate in experimental studies (Shadish, Cook, &
Campbell, 2002). Random assignment of participants to treatment conditions is
required for a study to be considered experimental. The distinguishing charac-
teristic of quasi-experimental research is that random assignment is not used.

Shadish et al. articulate an alternative selection method to random selection
used by experimental researchers known as purposive sampling. Purposive sam-
pling is a deliberate process by a researcher to identify population characteristics,
including participants, treatments, outcomes, and settings, and then select a
sample that embodies the desired population characteristics.

Error of Measurement

A second source of error is error of measurement. When using measures from
participants to assess the dependent variables in a study, there are differences
between the participants’ observed scores and their true scores. An observed score is
the actual measured score of a participant, and a #rue score is the actual score
(theoretical) on the measure. Conceptually, an observed score is similar to a
sample characteristic, and a true score is similar to a population parameter.

Error of measurement can be attributed to both random error and systematic
error. Random error includes fluctuations is the characteristics of individuals, such
as the motivation levels of participants changing randomly from one assessment
to the next.
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A novice examiner may depart from standardized assessment procedures in
scoring or use an unreliable test in a study; these are examples of sources of
random error. Measurement reliability is especially affected by random error.

Systematic error is represented by a decrease or an increase of scores on a
dependent measure in a predictable way. This type of systematic error often
relates to procedural irregularities in the research process. A weight scale cali-
brated incorrectly and consistently measuring three pounds heavier than it
should represents systematic error. Systematic error most adversely affects mea-
surement validity.

Measurement error exists in all studies. We cannot eliminate errors in mea-
surement, but we can minimize their effects.

CONTROLLING EXTRANEOUS
EXPERIMENTAL INFLUENCES

Experimental research strives to accurately and consistently measure whether
changes in a dependent variable can be attributed to a specified independent
variable. Extraneous variables (nuisance variables) confuse the assessment of the
real effects of the independent variable on the dependent variable. Extraneous
variables are first identified and then efforts are made to control their con-
founding effects.

For example, a researcher wants to compare the effects of a hypnosis treat-
ment program to a nicotine gum therapy among smokers to see which program is
more effective in producing smoking abstinence. It is discovered that the group of
participants receiving the hypnosis treatment have a significantly lower average
number of years smoking compared to the nicotine gum therapy participants.
Prior number of years smoking is an extraneous variable that is salient in its
potential impact on the dependent variable of smoking abstinence. This extra-
neous variable needs to be accounted for and controlled to accurately understand
the cause-and-effect relationship between treatment and outcome.

Methods of Controlling Extraneous Variables

There are several general ways to control for extraneous variables. One way is to
eliminate an extraneous variable. For example, a researcher is concerned about the
extraneous effects of below-average and above-average IQ scores among

RESEARCH AND STATISTICAL DESIGNS e 57



individuals on correct responses in completing a task based on three methods of
instruction. So the researcher decides to select participants with IQ scores
between * one standard deviation from the mean.

Another way to account for extraneous variance is to build the extraneous
variable into the design. Prior evidence suggests that gender may confound the
results of interventions on math achievement. Gender can be included as an
independent variable in a design where its main and interaction effects can be
assessed with the primary independent variable of interest.

The effects of extraneous variance also can be statistically controlled using
techniques such as analysis of covariance and multiple regression. The extraneous
variable needs to be measured and then the dependent variable is adjusted to
account for its influence.

Matching participants across condition groups based on one or more extra-
neous variables can be used to rule out or hold constant their confounding effects.
A researcher might match participants in a treatment and control condition based
on gender, height, and age. A woman 5’ 0” to 5’ 2" in height who is between the
ages of 20 and 25 years is matched to participant with similar characteristics in
the other group. All participants would be matched on homogeneous char-
acteristics. Sophisticated propensity score matching methods have been refined in
recent years, which have enhanced the rigor of quasi-experimental designs (see
Cook & Steiner, 2010).

The most important way to control extraneous variance is using random
assignment. Bach participant is assigned to experimental and control group con-
ditions totally by chance. Tables of random numbers or computerized random
number generators are used to accomplish random assignment. Random
assignment makes groups randomly similar to each other. It is less likely that one
group of participants will have more or less extraneous variance than another
group when groups are randomly assigned from the same sample. Shadish, Cook,
and Campbell (2002) reported the benefits of random assignment to generalized
causal inference as: “equating groups before treatment begins, by making alter-
native explanations implausible, by creating error terms that are uncorrelated with
treatment variables, and by allowing valid estimates of error terms” (p. 252).

Another method of controlling extraneous variables is to use blinded proce-
dures. Participants are not informed about the nature or purpose of a study in a
single-blind procedure to minimize participants behaving in reaction to the pur-
pose of the study. In a double-blind procedure neither the participants nor the
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researchers are informed of the treatment conditions that the participants receive.
This procedure helps minimize experimenter expectancy effects and participant
reaction (demand) effects. This procedure usually requires that other people select
groups, administer treatment, and record results. In a triple-blind procedure nei-
ther the participants nor the persons administering the treatment nor those
evaluating the response to treatment know which participants are receiving a
given treatment. A partial-blind procedure is used when the researcher finds out
which treatment conditions are administered just before administering the
treatment conditions.

Deception can be used to shift the participants’ attention away from the actual
purpose of a study so they do not react to the perceived purpose in a certain way.
The use of deception requires careful consideration of ethical standards and
approval from an Institutional Review Board (IRB). There are several other
procedures to control for extraneous variables (see Kirk, 1995; Shadish, Cook, &
Campbell, 2002).

INTERNAL VALIDITY AND EXPERIMENTAL DESIGNS

For over 50 years, Campbell (1957); Campbell and Stanley (1963); Cook and
Campbell (1979); Shadish, Cook, and Campbell (2002); Shadish and Cook
(2009); and Cook and Steiner (2010) have developed sophisticated methods in
experimental and quasi-experimental research. Two of many experimental
methodological areas that have evolved are internal validity and research designs.

Internal Validity

Determining internal validity is assessing whether the A (cause) — B (outcome)
relationship is indeed causal based on the manipulations and measures of the
variables used in a study. This assessment process includes knowing which var-
iable is the cause and which is the effect, which is referred to as ambiguous
temporal precedence (Shadish, Cook, and Campbell, 2002).

An important part of assessing for internal validity is ruling out threats to
internal validity. Thirteen threats to internal validity are presented in Table 4.1.
The first eight threats (7HIS MESS) can be assessed and ruled out through the
use of experimental designs, and the last five threats (DREAD) are corrected using
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TABLE 4.1 Threats to Internal Validity: THIS MESS DREAD

Testing effect

History

Instrumentation

Selection (differential)

Maturation

Experimental mortality
(attrition)

Statistical regression

Selection-maturation
Interaction

Diffusion of experimental
effect

Rivalry (compensatory)

The treatment effect may be confounded when changes
in posttest scores of participants are influenced by their
experience from taking a pretest.

An external but concurrent event to the experiment (e.g.,
a hurricane) may affect scores on a dependent measure
that are unrelated to the treatment.

Pretest and posttest scores may change because of a
faulty measurement instrument, irrespective of the
treatment.

Differences in characteristics of participants assigned
(usually not random) to treatment conditions may
confound attributing the changes in the dependent
variable to the treatment.

Psychological and physical changes within participants
may occur in an experiment, especially over time. These
participant maturational changes may have an
extraneous effect on the dependent measure.

The loss of participants to treatment or measurement of
the dependent variable can produce unbalanced
attribution of the effects of the treatment on the
dependent variable.

This is the phenomenon that extremely high or low group
scores on a variable tend to regress to the mean (get
lower or higher) on a second measurement of the
variable, confounding the treatment effect.

This is a combination of two threats to internal validity.
For example, some participants in one assigned
treatment condition group may have matured in math
self-efficacy more than participants in another treatment
condition group, and the purpose of the study is to
increase math achievement. Additionally, other
combinations of threats could interact to confound the
treatment effect.

The treatment may diffuse to the control group over
time because the control group may seek access to the
more desirable treatment.

The control group participants may perform beyond
their usual level because they perceive that they are in
competition with the experimental group.
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Equalization of treatments A treatment group may receive experimental rewards

(compensatory) that appear more desirable than those received by the
control group participants. Efforts are made by
individuals outside of the experiment to compensate the
control group participants with similar desirable goods.
This would obscure the results of the treatment.

Ambiguous temporal A lack of clarity is provided by the researchers as
precedence to which variable occurred first, leading to a question of
which variable is the cause and which is the effect.

Demoralization Lower performance of control group participants on the
(resentfulness) dependent measures may result from their belief that
the treatment group is receiving a desirable treatment.

Source: Reprinted by permission from W. E. Martin Jr. & K. D. Bridgmon. (2009). Essential ele-
ments of experimental and quasi-experimental research. In S. Lapan & M. Quartaroli (Eds.),
Research essentials: An introduction to designs and practices (pp. 35—58). San Francisco, CA:
Jossey-Bass.

experimental procedures. Next, we will discuss how experimental designs are used
to rule out threats to internal validity.

Experimental Designs

There are many experimental designs, quasi-experimental designs, and correlation
designs available for use by researchers to execute their studies. Two fundamental
and commonly used experimental designs are discussed first. Explanations are
provided as to how the designs reduce the effects of THIS MESS. Examples of
statistical designs that can be used with the designs are identified. The other five
threats to internal validity (DREAD) are also discussed.

A few rules and symbols are used to describe experimental designs. Each row
represents a group of participants receiving a different experimental condition. An
R designates that the participants were randomly assigned to an experimental
condition (treatment or control). All O’s (observations) represent assessments of
one or more dependent variables. An O before an experimental condition is a pre-
experimental condition assessment, and an O after the experimental condition is a
postexperimental condition assessment. An X stands for a treatment condition
and C symbolizes a control condition.
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Randomized Multiple Treatments and Control with
Posttest-Only Design

R X 0
R X, 0
R C 0

This design is used in the one-way analysis of variance (ANOVA) example in
Chapter 7. The purpose of the study is to compare the effects of psychothera-
peutic treatment (independent variable) on changes in depressive symptoms
(dependent variable). Psychotherapeutic treatment has three experimental con-
ditions: (1) cognitive-behavioral therapy (CBT), (2) interpersonal therapy (IPT),
and (3) control group. Each line in the diagram represents one of the three
groups. The R symbolizes random assignment to each group condition, which
represents a study sample of participants being randomly assigned equally to each
condition. The conditions by groups are represented by X; (CBT), X, (IPT), and
C (Control). The O (observation) is the posttest following eight weeks of treat-
ment implementation using the Center for Epidemiological Studies Depression
Scale (CES-D) to measure differential change in depressive symptoms resulting
from the different treatment conditions.

This randomized multiple treatments and control with posttest-only design
strongly benefits from the essential elements of experimental research: (1) random
assignment, (2) control groups, and (3) a manipulated independent variable. The
design does reduce the threats of THIS MES but a concern arises with the last S
(interaction of two threats). For example, more participants may be lost (attrition)
from one or more randomly assigned groups (selection) during the course of an
experiment. This affects the expected outcome of random assignment to make
groups randomly similar to each other at the onset of the study. If there were a
pretest in the design, information could be derived to help explain how the
participants dropping out of the experiment affected changes in the dependent
variable. The interaction effect of attrition and selection would not be an issue if
there were no loss of participants using this design. Without a pretest, it is
impossible to know the causal effects of the independent variable on the
dependent variable because of the disproportionate loss of participants from one
condition compared to the other condition.
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A one-way ANOVA can be used in this design to compare the means of
CES-D scores across the three psychotherapeutic conditions for significant dif-
ferences. A post hoc analysis can be used to assess the differences between the
three pairs of means.

Randomized Multiple Treatments and Control with
Pretest and Posttest Design

R O X 0
R 0 X5 @)
R ) C @)

The randomized multiple treatments and controlwith pretest and posttest design adds
a pretest to the previous design. So, the participants could be measured on their
depressive symptoms using an equivalent form of the CES-D before administering
the experimental conditions. This reduces the concern about understanding the
effects of interaction between attrition and selection. The pretest scores on depressive
symptoms of people lost during the research process can be used to assist in con-
trolling differences in participants by group on the posttest scores. The design helps
control for all of the threats associated with THIS MESS.

A statistical design that could be used with this design is a 3 X 2 repeated-
measures ANOVA. The 3 represents the independent variable (factor) of psy-
chotherapeutic treatment with three conditions of CBT, IPT, and control. The 2
represents a second independent variable of #me with two conditions (pretest and
posttest). This statistical design allows for a comparison of the differences among
the means of CES-D scores across the three experimental conditions. A post hoc
analysis can be used to assess the differences between the three pairs of means.

Also, differences between the means at pretest and posttest can be analyzed.
Finally, the interaction effects of psychotherapeutic treatment and time can be
compared to see if the CES-D average scores differ at conditions of psycho-
therapeutic treatment when compared to pretest and posttest conditions. The
interaction effect analysis could be followed by a simple effects analysis to
determine which levels of the first independent variable interact with which levels
of the second independent variable to produce significant effects on the depen-
dent variable.
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Experimental Research Procedures

Effective experimental designs are used to reduce the threats to internal validity of
THIS MESS. Seven recommended experimental research procedures that aid to
reduce the threats of DREAD (see Table 4.1) are identified next.

1. Use different persons to implement each treatment condition.

2. Arrange treatment conditions so that contact between experimental and
control group participants is minimized.

3. Use single-blind, double-blind, or triple-blind procedures to remove partic-
ipant or experimenter bias.

4. Debrief participants using interviews to assess their experiences and expec-
tations of the treatment conditions.

5. Consider not using experimental rewards.
6. Clearly define treatment conditions.

7. Use past research and theory to guide the evidence of an A (independent
variable) — B (dependent variable) causal relationship.

Quasi-Experimental Designs

The purpose of using quasi-experimental designs is to discover causal relation-
ships similar to using experimental designs. However, quasi-experimental designs
are considered compromise designs because random assignment is not used. It is
important for researchers using quasi-experimental designs to provide carefully
detailed, logical arguments in ruling out alternative explanations (rival hypotheses)
to account for their findings of a causal relationship.

Quasi-experimental designs are improved by (1) adding control or compar-
ison groups, (2) adding pretests and posttests, (3) removing and reinstituting
treatments, (4) adding replications, (5) reversing treatment, and (6) case matching
(Shadish, Cook, & Campbell, 2002). Various statistical procedures also have
been developed that have improved quasi-experimental designs. Propensity scores
are used in case matching to equate individual cases from different populations to
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reduce selection bias. Propensity scores are a weighted composite of measured
covariates that correlate with treatment (Cook & Steiner, 2010; Rosenbaum &
Rubin, 1983). Regression discontinuity designs use cutoff scores to assign partici-
pants to conditions. The cutoff score is a measure obtained before treatment is
undertaken. Then, posttest scores are analyzed with ordinary least squares
regression using the cutoff scores (Shadish, Cook, & Campbell, 2002). Two
commonly used quasi-experimental designs are presented next.

Repeated-Treatment Design with One Group

OBaseline Xl Ol XZRemoved 02 X3 03 X4 04

The focus of the research example of repeated-treatment design with one group is to
assess whether the use of friends (support partners) in behavioral weight control
treatment (BWCT) can improve the weight loss outcomes of persons who are over-
weight (this example is used in Chapter 8). A randomly selected group of participants
who are overweight are weighed at baseline before treatment (Op,geline)- Then, each
participant’s weight loss is measured and recorded after three months of treatment
with partner support (X; O at 3 months), after three months when partner support is
removed (Xoremoved O2 at 6 months), after three months when partner support is
added back to treatment (X5 O at 9 months), and after the treatment with partner
support is continued for three months (X; Oy at 12 months).

The most important result of this design to demonstrate some degree of
causal relationship is measuring the change of weight loss when the treatment is
removed and reinstated. External events (history) and physical/psychological
changes affecting participants may confound the understanding of weight loss as
it relates to the treatment. It would be difficult to tease out confounding without
using a control group and random assignment. Moreover, participants’ awareness
of the cycle of treatment, treatment removal, and observations might behave
uncharacteristically in reaction to the study cycle. Since the same participants are
measured repeatedly over time under various conditions, a repeated-measures
ANOVA would be an appropriate statistic to use in this study. The changes in
mean weight and covariances at baseline, three months, six months, and 12
months would be assessed for differences.
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Nonequivalent No-Treatment Control Group Time-Series Design

NR O, 0, 05 X 0, 05 O
NR Ol 02 03 C 04 OS 06

There is a control group in the nonequivalent no-treatment control group time-
series design and no removal of treatment. The NR stands for nonrandom
assignment. This design controls for most of the threats to internal validity, THIS
MES. However, an interaction (S) between selection and history may be a
concern. It is possible that one group of participants is affected differently by
external events (history) that influence their scores more on a dependent variable
than the other group. The control group and multiple pretests and posttests in
this design provide valuable information to rule out threats to internal validity.
Visual analyses of graphs are useful for understanding the results. Other statistics
that can be used include repeated-measures ANOVA, randomization tests, and
bootstrapping methods.

Correlational Research Methods

Correlations methods are used in experimental and quasi-experimental designs,
but the primary purpose of correlation research is to explore bivariate relation-
ships, multiple relationships, and predictions among variables. Variables in corre-
lational research are often referred to as X'and Y variables. The X variable is called
either an independent or a predictor variable, and the Y variable is identified
as either a dependent or a criterion variable. A bivariate correlation (r) assesses
the relationship between two variables, and a multiple correlation (R) assesses the
relationships among more than two variables. A simple linear regression uses a
bivariate correlation to predict the dependent variable (¥) from the independent
variable (X). A multiple linear regression uses a multiple correlation to predict a
dependent variable (Y) from two or more independent variables (Xs).

In Chapter 12, an example is presented about a researcher who assessed
whether lower interest in scientific activities is a better predictor of higher dis-
sertation stress reported by counseling and clinical psychology doctoral students
when compared to their interests in practitioner activities.

The first independent variable in the study is doctoral students’ interest in
scientific activities as measured by the Scientist Scale of the Scientist Practitioner
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Inventory (SPI). The Scientist Scale measures student interests in activities related
to research, statistics and design, teaching/guiding/editing, and academic ideas.

The second independent variable used in the study is students” interest in
practitioner activities measured using the Practitioner Scale of the SPI. The
Practitioner Scale assesses interests in activities involving therapy, clinical exper-
tise and consultation, and testing and interpretation. Higher scores on the
Practitioner Scale reflect higher interests.

First, we consider only one independent variable (scientific activities) and its
prediction of dissertation stress. An analysis of the extent that students’ interest in
participating in scientific activities (X) relates and predicts dissertation stress (")
could be answered using a bivariate correlation and simple linear regression
model. The model could be written symbolically as Y /(X), where Y (dissertation
stress) is a function of X (scientific interests). A prediction model can be written
as Y' = A + B, Xj, where Y’ is the predicted value on the dependent variable
(dissertation stress), A is the intercept, the value of ¥ when all the X values are
zero, B is the unstandardized regression coefficient assigned to each X value, and X
is the measured value of the independent variable (scientific interests).

A multiple correlation and multiple regression analysis can be used to ana-
lyze the two independent variables with the dependent variable. It can be
written symbolically as ¥ £ (X;, X;). The prediction model would be Y = A +
BX, + BoXo.

CHOOSING A STATISTIC TO USE FOR AN ANALYSIS

The consideration of five issues can be useful in deciding on a statistic to use in a
particular analysis: (1) the focus of the interplay among variables (e.g., relation-
ships or differences), (2) the number of independent and dependent variables
used in an analysis, (3) the scales of measurements of the dependent variables,
(4) the number and relationships (dependent vs. independent) of participant
groups being compared, and (5) the extent that underlying assumptions of the
statistic are met. These issues are illustrated in relation to statistics covered in this

book (also see Figure 4.1).

One-Way Analysis of Variance

1. Focus of analysis. The purpose of a one-way ANOVA is to compare mean
differences of a dependent variable among groups.
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FIGURE 4.1 Issues in Choosing a Statistic to Use for an Analysis

1. Focus of analysis Differences Relationships
b f | |
2 :Lélr:peer:oloent One Independent More Than One
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variables
| |
3. Scale of | | | |
measurement Nominal Ordinal Interval Ratio
of dependent
variable | |
4. Rela_tl(_)nshlp’ of Not Related Related Both
participants (Independent) (Dependent)
scores across

groups being
compared

5. Underlying Met Not Met
assumptions of
statistic used | |

[ 1
One-Way Simple Multifactor One-Way Kruskal- Mann-Whitney Friedman Wilcoxon Bivariate MRA
ANOVA RM-ANOVA ANOVA ANCOVA Wallis Correlation

2. Number of independent variables. The descriptor one-way indicates that there
is one independent variable.

3. Scale of measurement of dependent variable. A continuously scaled (interval or
ratio) dependent variable is used in a one-way ANOVA.

4. Relationship of participants’ scores across groups being compared. There are
different participants in the groups being compared and their scores are not
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related (independent) in a one-way ANOVA. This is also referred to as a
between-group design.

Underlying assumptions of the statistic being used. The underlying assumptions
of normality, homogeneity of variance, and independence of scores related to
the dependent variable must be met. This applies to original dependent
variables or dependent variables that have been successfully transformed.

Simple Repeated Measures Analysis of Variance

1.

Focus of analysis. The purpose of simple RM-ANOVA is to compare mean

differences across groups, conditions, or testing times (i.e., pretest-posttest).

Number of independent variables. There is one independent variable used in a

simple RM-ANOVA.

Scale of measurement of dependent variable. A continuously scaled (interval or
ratio) dependent variable is used in a simple one-way ANOVA.

Relationship of participants’ scores across groups being compared. Scores are
related to (dependent on) each other. Scores on the same or matched par-
ticipants are obtained two or more times. This is also called a within-group

design.

Underlying assumptions of the statistic being used. The underlying assumpt-
ions of normality, homogeneity of variance and covariance related to
the dependent variable must be met. These assumptions apply to original
dependent variables or dependent variables that have been successfully
transformed.

Multifactor Analysis of Variance

1.

Focus of analysis. The purpose of factorial ANOVA is to assess mean differ-

ences across main effects, interaction effects, and simple effects.

Number of independent variables. Factor is another word used for independent
variables, so multifactor denotes that more than one independent variable is
used in the analysis.

Scale of measurement of dependent variable. A continuously scaled (interval or
ratio) dependent variable is used in a multifactor ANOVA.
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4.

Relationship of participants’ scores across groups being compared. A multifactor
ANOVA can include both scores that are not related (between groups) and
scores that are related (within groups).

Underlying assumptions of the statistic being used. Normality, homogeneity of
variance-covariance, and independence of scores related to the dependent
variable must be met. This applies to original dependent variables or
dependent variables that have been successfully transformed.

One-Way Analysis of Covariance

1.

Focus of analysis. The purpose of a one-way ANCOVA is to compare mean
differences among groups when the dependent variable has been adjusted for
by one or more covariates.

Number of independent variables. The descriptor one-way indicates that there
is one independent variable used in a one-way analysis of covariance.

Scale of measurement of dependent variable. A continuously scaled (interval or
ratio) dependent variable is used in a one-way ANCOVA.

Relationship of participants’ scores across groups being compared. There are
different participants in the groups being compared, and their dependent
variable scores are not related (independent). This is also referred to as a
between-group design. If a covariate used is a pretest-posttest score, then
there are elements of both between-group and within-group designs.

Underlying assumptions of the statistic being used. The underlying assumptions
of normality, homogeneity of variance, and independence of scores related to
the dependent variable must be met. This applies to original dependent
variables or dependent variables that have been successfully transformed.

Kruskal-Wallis One-Way Analysis of Variance

1.

Focus of analysis. The purpose of the Kruskal-Wallis (K-W) test is to compare
mean rank differences among two or more groups. The K-W test is a
nonparametric alternative to the one-way ANOVA.

Number of independent variables. There is one independent variable used in a
K-W analysis.
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3.

Scale of measurement of dependent variable. A discrete-ordinal dependent
variable is used in a K-W analysis. Continuous dependent variables can be
used; however, the observed continuous scores are converted to ranks in the

K-W analysis.

Relationship of participants’ scores across groups being compared. There are
different participants in the groups being compared, and their scores are not
related (are independent) in a K-W analysis. This is also referred to as a
between-group design.

Underlying assumptions of the statistic being used. The K-W test is a non-
parametric statistical test and is considered distribution-free; therefore, the
assumptions of normality and homogeneity of variance are not necessary.
However, it is important that observations are independent from each other
and there is some degree of continuity of the variable used.

Mann-Whitney U Test

1.

Focus of analysis. The purpose of the Mann-Whitney U (MWU) test is to
compare mean rank differences between two groups. The MWU test is the
nonparametric alternative to the independent #test.

Number of independent variables. There is one independent variable used in a
MWU analysis.

Scale of measurement of dependent variable. A discrete-ordinal dependent
variable is used in a MWU analysis. Continuous dependent variables can be
used, and the observed continuous scores are converted to ranks in the

MWU analysis.

Relationship of participants’ scores across groups being compared. There are
different participants in the groups being compared, and their scores are not
related (are independent). This is also referred to as a between-group design.

Underlying assumptions of the statistic being used. The MWU test is a non-
parametric statistical test and is considered distribution-free; therefore, the
assumptions of normality and homogeneity of variance are not necessary.
However, it is important that observations are independent from each other
and there is some degree of continuity of the variable used.
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Friedman Repeated Measures Analysis of Variance

1.

Focus of analysis. The purpose of the Friedman RM-ANOVA is to compare
mean rank differences among two or more groups with related scores.
The Friedman RM-ANOVA is the nonparametric alternative to the
RM-ANOVA.

Number of independent variables. There is one independent variable used in
the Friedman RM-ANOVA analysis.

Scale of measurement of dependent variable. A discrete-ordinal dependent
variable is used in a Friedman analysis. Continuous dependent variables can
be used, but the observed continuous scores are converted to ranks in the

Friedman RM-ANOVA analysis.

Relationship of participants’scores across groups being compared. Scores are related
to (dependent on) each other. Scores on the same or matched participants
are obtained two or more times. This is also referred to as a within-group
statistical design.

Underlying assumptions of the statistic being used. The Friedman RM-ANOVA
test is a nonparametric statistical test and is considered distribution-free;
therefore, the assumptions of normality and homogeneity of variance are not
necessary. However, it is important that observations are independent from
each other and there is some degree of continuity of the variable used.

Wilcoxon Matched-Pairs Signed-Ranks Test

1.

Focus of analysis. The purpose of the Wilcoxon test is to compare mean rank
differences between two groups with related scores. The Wilcoxon test is the
nonparametric alternative to the dependent #test.

Number of independent variables. There is one independent variable used in
the Wilcoxon test analysis.

Scale of measurement of dependent variable. A discrete-ordinal dependent
variable is used in a Friedman analysis. Continuous dependent variables can
be used, but the observed continuous scores are converted to ranks in the
Wilcoxon test analysis.

Relationship of participants’ scores across groups being compared. Scores are
related to (dependent on) each other. Scores on the same or matched
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participants are obtained two times. This is also referred to as a within-group
statistical design.

Underlying assumptions of the statistic being used. The Wilcoxon test is a
nonparametric statistical test and is considered distribution-free; therefore,
the assumptions of normality and homogeneity of variance are not necessary.
However, it is important that observations are independent from each other
and there is some degree of continuity of the variable used.

Pearson’s Product Moment Coefficient of Correlation (7)

1.

Focus of analysis. The purpose of the Pearson correlation coefficient is to
analyze the relationship between two variables.

Number of independent variables. There are two variables used in the analy-
sis. It is not necessary, but one variable may be called an independent variable
(X) or predictor variable and the other variable may be called a dependent
variable (Y") or criterion variable.

Scale of measurement of dependent variable. The two variables used in
the Pearson correlation coefficient analysis are continuously scaled (interval
or ratio).

Relationship of participants’ scores across groups being compared. Scores on the
two variables are paired on the same participants, and therefore the scores are
related to (dependent on) each other.

Underlying assumptions of the statistic being used. The Pearson correlation
coefficient requires meeting normality and homogeneity in arrays that are the
residual variance of a Y conditional to a specific X.

Multiple Regression Analysis

1.

Focus of analysis. The purpose of a multiple regression analysis (MRA) is to
analyze the extent that two or more independent variables relate to a dependent
variable.

Number of independent variables. There are two or more continuously scaled
independent (predictor) variables used in the analysis.
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3. Scale of measurement of dependent variable. The dependent variable is also
continuously scaled (interval or ratio) in an MRA analysis.

4. Relationship of participants’ scores across groups being compared. Participants
have scores on all of the variables used in the MRA, and therefore the scores
are related to (dependent on) each other.

5. Underlying assumptions of the statistic being used. The underlying assumptions
and other issues of an MRA to assess include normality, homoscedasticity,
linearity, independence of errors, and multicollinearity.

SUMMARY

Research and statistical designs can be conceptualized as having the purpose to
maximize treatment variance, minimize error variance, and control extraneous
variance. The basic components of experimental, quasi-experimental, and cor-
relational research designs were discussed in this chapter. Statistical methods used
with various research designs were covered. Threats to internal validity were
identified with examples of experimental and quasi-experimental designs. Finally,
issues to consider in choosing statistics for research problems were presented.

PROBLEM ASSIGNMENT

Go to the companion website for additional examples of formulating experi-
mental conditions and procedures, reducing imprecision in measurement, and
controlling extraneous experimental influences. Use the information presented in
this chapter to guide you as you complete the assignment.

KEY TERMS
ambiguous temporal precedence controlling extraneous variance
bivariate relationships correlation designs
blinded procedures criterion variable
build the extraneous variable into deception

the design

74 « CHAPTER 4



dependent (outcome) variables
double-blind procedure

DREAD

eliminate an extraneous variable
error of measurement

errors

experimental designs
experimental research procedures

extraneous variables (nuisance
variables)

independent (cause) variables
internal validity

matching participants

maximizing experimental variance
MaxMinCon

minimizing error variance
multiple linear regression

multiple relationships

nonequivalent no-treatment control
group time-series design

observed score

operationally defined
partial-blind procedure
predictor variable
propensity scores
psychotherapeutic treatment
purposive sampling

quasi-experimental

quasi-experimental designs
random assignment
random error

random sampling

randomized multiple treatments and
control with posttest-only design

randomized multiple treatments
and control with pretest and
posttest design

randomly assigning
regression discontinuity designs

repeated-treatment design with one
group

rival hypotheses

sampling error

simple linear regression
single-blind procedure
standard error of the mean
statistically controlled
systematic error

THIS MESS

time

treatment adherence
treatment delivery
treatment integrity (treatment fidelity)
treatment receipt
triple-blind procedure

true score
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Chapter 5
INTRODUCTION TO

IBM SPSS 20

LEARNING OBJECTIVES
o Become familiar with the start-up procedures of IBM
SPSS 20.
o Learn navigational skills in the IBM SPSS 20 program.
o Learn to name and define variables.

o Practice entering data.

o Execute basic computational procedures using IBM SPSS 20.




he focus of this chapter is to introduce you to the basic steps of setting

‘ up and manipulating daza in IBM SPSS 20. It is important to follow the

steps and take your time in setting up your data. It takes more time to set

up your data than it does to run the analyses. The accuracy of the results is highly
dependent upon the exactness of the data entered.

Data analysis commands used in this book are for use in IBM SPSS 20 for
Windows. Most SPSS analysis commands have remained consistent across SPSS
versions; however, students using older versions of SPSS may need to make
modifications to the commands. IBM SPSS 20 can be operated both through pull-
down menus and by syntax commands. Syntax commands are based on SPSS
language that is written commands made by a user to generate statistical results.
The pull-down menu is similar to many Windows applications; therefore, it is user
friendly. If you select a particular option and then determine it is not what you
were looking for, you can use the cancel feature. Basic applications for IBM SPSS
20 are described in this chapter, but you will learn more advanced applications as
they are applied to statistics presented in the following chapters of the book.

When entering data or manipulating existing data sets in IBM SPSS 20, make
sure to save often and use titles for the data that make sense for the data set. For
example, you may wish to date the data set and include descriptive comments that
will allow you to know what each data set is for future use. IBM SPSS 20 includes
a Help feature that will assist users to obtain more information about commands
and output. Next, we will go step-by-step in naming and defining variables in a
data set (Variable View), enter data (Data View), and conduct some basic analyses.

Start-Up Procedures in IBM SPSS

1. Clickon the Start button (bottom left of your screen) > click on Programs > click
on IBM SPSS 20 or the version you are using. This start-up procedure may vary
with computers based on how the program manager configured the program files.

2. When opening the IBM SPSS 20 program, the initial screen will provide
several options (see Figure 5.1). The Type in data feature is the icon used to
enter data for the first time. (After data has been saved, the default option of
Open an existing data source is used to retrieve data. Also, you can click
twice on a saved data set and open it.) Click on Type in data > click OK.
This produces a spreadsheer (Data View) with the title at the top left, Unti-
tled1 [DataSet0] - IBM SPSS Statistics Data Editor (see Figure 5.2). The
Data View spreadsheet is where you will enter data.
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FIGURE 5.1 IBM SPSS 20 Initial Screen

IBM SPSS Statistics

What would you like to do?

© Open an existing data source
© Run the tutorial

More Files
: . @
- 3 o h
© Open another type of file © Run an existing query

More Files
. © creste new guery
using Database Wizard
[7] Don't show this dialog in the future @@

FIGURE 5.2 Data View Screen of IBM SPSS 20

& Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor

1]

IBM SPSS Statistics Processor is ready
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THE IBM SPSS 20 DATA VIEW SCREEN

The Data View screen has various options. The first line on the toolbar is the
name of your data set. This is what the data set is named when the Save As
feature is used. The next line is called the menu bar. This menu bar offers several
options that offer a pull-down feature. This menu bar is primarily used for
making pull-down command analyses, but also includes the Help tool. The third
line is the toolbar and includes icons. Once the mouse curser is placed over an
icon, the function of the tool is briefly described to the user. The majority of the
screen is the spreadsheet for entering data. Scroll bars are available vertically and
horizontally to maneuver around the screen.

Along the left side of the screen spreadsheet are the row (case) numbers. The
rows usually represent the participants or cases in a study. It is important
to remember that these numbers are not numbers that stay with participants but
are row numbers. A separate variable labeled ID can be created to consistently
identify participants; that avoids confusion with the row or case number.

At the top of the screen spreadsheet are the columns with the abbreviation
var that stands for variable. Typically, the study variables are represented as
columns in a data set.

At the bottom left-hand corner of the Data View screen are two tabs. One
tab is titled Data View where the data is entered. The other tab is called Variable
View and is used to name and define variables. Click on the Variable View tab
and we will name and define variables before entering data (see Figure 5.3).

NAMING AND DEFINING VARIABLES IN VARIABLE VIEW

Naming and defining variables is important for entering data, analyzing data, and
interpreting output after conducting an analysis. We will first name and define
the variables used in this chapter. There are 10 variables that you will be naming

and defining.

Entering Variables

Variable ID

1. In the Variable View screen, click on Row 1 of the Name column. The box

will be highlighted once it is clicked.

2. In the cell under Name in Row 1, type in the variable’s name, /D.
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FIGURE 5.3 Variable View Screen of IBM SPSS 20

10] - IBM SPSS Statistics Data Editor
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3. Press the 74b key. This is the Type column. Now there are three blue dots in
this cell. The pull-down menu for TYPE can be used by clicking on the three
dots to specify the type of variable. For this variable (ID numbers of parti-
cipants), use the default (Numeric). You see that there are several options for
Variable Type. If you click on the Help button, the Variable Types will be
explained. We use primarily Numeric and String (variable values that are not
numeric) Variable Types in this book. However, the Variable Type Date will
be used in this introduction to IBM SPSS 20 chapter.

4. Press the 7ab key again. This is the Width column. IBM SPSS 20 defaults to 8;
however, in the cell, arrows are provided to increase or decrease the width of the
variable’s name. The desired width can also be entered by keying in the number.
Obviously, the default width of 8 is sufficient for the two-letter name /D.

5. Press the 7ab key. This is the Decimals column. SPSS 20 defaults to
2 decimal places. Again, this can be changed with the arrows or keying in
the desired number of decimal places. If working with data that do not
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include decimal places, decrease the Decimals cell to zero, as this will
eliminate unneeded zeros in the decimal places. Change this to zero since
the /D number does not need zeros.

6. Press the 74b key. This is the Label column that shows the identity of the
variable in data output. Keep labels short but understandable so you can
recognize a variable in the output. We will not use a label for the /D variable.

7. Press the 7ab key. This is the Values column. Some variables will be cat-
egorized for analyses. For example, if Gender is used as a variable, this is the
place when male and female would be labeled. Leave this blank since we are
not categorizing the variable /D.

8. Press the 7ab key. This is the Missing Values column that allows a user to enter
values or ranges of values defined as missing data. IBM SPSS 20 defaults at none.
By selecting none for this column, it allows missing data to be identified when
conducting analyses. Leave the Missing Values cell blank for the /D variable.

9. Press the 74b key. This is the Columns column. IBM SPSS 20 defaults at
an 8 character width for each column. This may be changed by using

the arrow keys or keying in the desired column size. Leave the width at the
default of the /D variable.

10. Press the 7ab key. This is the Align column. IBM SPSS 20 will default to
right. However, left, right, or center are all options. Leave the default
of right for this variable.

11. Press the 7ab key. This is the Measure column. The scale of measurement
for each variable is selected here. The options of Scale (default), Ordinal, or
Nominal are available. The Scale option is used for continuous-scaled
variables, including either ratio- or interval-scaled variables such as time
(ratio) or standardized achievement test score (interval). The Ordinal scale
option is used for ranked variables such as a Likert scale. The Nominal
scale is for data used as counts in mutually exclusive categories such as
religious affiliation. Leave this variable as the default of Scale.

12. Press the 7ab key. This is the Role column. IBM SPSS 20 defaults at Input.
An Input variable is usually used as an independent or predictor variable.
A Target variable is used as a dependent or criterion variable. The Both option
means it may be used as either an Input or a Target variable in analyses.
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13.

Partition means that the variable will be used to partition data into separate
samples for training, testing, and validation. Role assignment is used only when
analyses support the role assignment and otherwise does not affect analyses.
We will not need to use role assignments for the analyses in this book. However,
it is recommended that you use the role assignment of Input for independent
or predictor variables and Target for dependent or criterion variables. Use Input
for all other variables. Leave the default of Input for the variable /D.

Press the 7ab key. The curser is now back at NAME and is ready for the
next variable.

Variable returndate

1.
2.

3.

In the cell under Name in row 2, type in returndate (not in italics).

Click on Type; choose Date on the left, and to the right click on mm/dd/yy
and click OK. Remember you must enter the data dates in the same format

as mm/ddlyy.

Use the default definitions in the rest of the row.

Variable status

1.
2.
3.

In the cell under Name in row 3, type in status.
Type is Numeric, Width should be 8, and Decimals should be 0.

Under the column Label in row 3, type in counseling students and counseling
professionals.

Click on the cell under the column Values. You are going to type in the
categories for the variable status that will tell the SPSS program what values
represent. Beside Value type in 1, and beside Label type in student; then click
on the Add button. Then, click on Value again; type in 2 and beside Label
type in professionals and click on the Add button and then the OK button.

Leave as is (the default values) for Missing, Columns, and Align.

In the Measure column, choose nominal. Nominal-scaled variables have
categories that have no intrinsic order.

In the Role column, select Input since szatus will be used as an independent
variable in some analyses.
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Variable gender

1.
2.
3.

In the cell under Name in row 4, type in gender.
Type is Numeric, Width should be 8, and Decimals is 0.
In the Label column, label the variable as sex.

In the Values column, assign the following values for gender in the blue
box: Value = 1; Label = Male > Click Add. Repeat for Female gender with
Value = 2; Label = Female > Click Add > Click OK.

Missing is None, Columns = 8, and Align = Right.

In the Measure column, change the level of measurement to Nominal, and
the Role column is Input.

Variable age

1.
2.
3.

In the cell under Name in row 5, type in age.
Leave Type = Numeric, Width = 8, and change the Decimals cell to zero.

Keep all other columns to default except for Measure (change to Scale).

Variable ethn

1.
2.
3.

In the cell under Name in row 6, type in ethn.
Width = 8 and change the Decimals column to zero.
In the Label column, label the variable as ethnicizy.

In the Values column, assign the following values for Ethnicity: Value = 1;
Label = af amer > Click Add. Value=2; Label =as amer > Click Add.
Value = 3; Label = eur amer > Click Add. Value =4; Label = hisp amer >
Click Add. Value =5; Label = nat amer > Click Add. Value = 6; Label =
Other > Click Add > Click OK.

Missing = None, Columns =8, Align = Right, Measure = Nominal, and
Role = Input.

Variable ethnicother

1.

The variable ethnicother in row 7 has responses that are words, so select String

under Type.
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Since the responses are words, there is a need to expand the characters for this
variable, so type in 25 in the cell under the column Width.

For Decimals the cell should be zero, and under Label type in other ethnicity
description.

The other columns should be: Values = None, Missing = None, Columns =
8, Align = Left, Measure = Nominal, and Role = Input.

Variable counconfid

1.
2.

In the cell under Name in row 8, type in counconfid.

The cell under Type=Numeric, Width=38, and change the Decimals

column to zero.
In the Label column, label the variable as confidence as a counselor.

In the Values column, assign the following values for counseling confidence.
Value =1; Label =Strongly Disagree > Click Add. Value =2; Label =
Disagree > Click Add. Value =3; Label = Somewhat Agree > Click Add.
Value = 4; Label = Agree > Click Add. Value = 5; Label = Strongly Agree >
Click Add > Click OK.

The other columns should be: Missing= None, Columns=38, Align =
Right, Measure = Ordinal, and Role = Target. Target is used because the

variable (counconfid) is a dependent variable in the analyses.

Variable micskill

1.

Type in the name micskill in the cell in row 9 under the column Name. This

is a subscale called Micro Counseling Skills of the Counseling Self-Estimate
Inventory (COSE).

The columns Type = Numeric, Width = 8, Decimal = 0, and under Label
type in COSE Confidence in Executing Microskills.

The other columns should be: Values = None, Missing = None, Columns =
8, Align = Right, Measure = Scale, and Role = Target.

Variable dealdiff

1.

Type in the name dealdiff in the cell in row 10 under the column Name.
This is a subscale called Dealing with Difficult Clients of the Counseling
Self-Estimate Inventory (COSE).
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FIGURE 5.4 Variables Named and Defined in Variable View
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2. The columns Type = Numeric, Width = 8, Decimal = 0, and under Label

type in COSE Dealing with Difficult Client Bebaviors.

3. The other columns should be: Values = None, Missing = None, Columns = 8,
Right, Measure = Scale, and Role = Target.

Align =

4. Check the accuracy of the variables entered. Also check your work with

Figure 5.4.

Once variables have been correctly named and defined in Variable View,
click on the Data View tab at the bottom left of the Variable View screen. You
will see the variable names that you created at the top of the columns in
the Data View screen. You will now be able to enter data for the variables
created using the data in Figure 5.5. Consider these recommendations when

entering data.

ENTERING DATA
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FIGURE 5.5 Example Data in Data View
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1. The return key moves the curser down the spreadsheet. The tab key moves
the curser across the spreadsheet.

2. If you make an error, click on the cell, delete, and retype the correct value.

3. Check your entered data for correctness and Save As Chapter5Data.

EXAMPLES OF BASIC ANALYSES

Commands are provided next using the pull-down menus for basic statistical
analyses with output produced.

1. Frequency Analysis (good for ungrouped data).

® Go to the top of the window and click on Analyze> Descriptive
Statistics > Frequencies.
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TABLE 5.1 Frequencies Table of Ethnicity

Frequencies

Statistics
ethnicity

N Valid 20
Missing (0]

ethnicity

Frequency Percent Valid Percent Cumulative Percent

af amer 1 5.0 5.0 5.0
as amer 2 10.0 10.0 15.0
eur amer 1l 55.0 55.0 70.0

Valid hisp amer 2 10.0 10.0 80.0
other 4 20.0 20.0 100.0
Total 20 100.0 100.0

® In the box on the left, click on and highlight e#hnicity [ethn] and then, using
the arrow to the right, click it over to the space under Variable(s). (If you want
to stretch the Frequencies screen out, you can place your cursor to the left side
of the box, left click, and move the end of the box left. This will allow you to
see the fuller description of the variables. Another way is to place your cursor
on the variable and it will show the full name of the variable.)

® Now click on the button called Charts. Select Bar charts as the type of
chart and Percentages as the chart value > Continue > OK. This will

produce a frequency table and bar chart for the variable (see Table 5.1 and
Figure 5.6).

2. Explore Analysis (useful for grouped data and univariate data screening).

® Go to the top of the window and click on Analyze> Descriptive
Statistics > Explore.

o Click over the Confidence in Executing Microskills [micskill] into the
Dependent List.

o Click over Counseling Students and Counseling Professionals [status] to the
Factor List.
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FIGURE 5.6 Bar Chart of Ethnicity
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® Under Display keep the default at Both.

® To the upper right of the window are three buttons called Statistics,
Plots, and Options. Click on Plots and choose Stem-and-leaf and
Histogram under Descriptive. Also, choose Normality plots with tests,
click Continue, and then click OK. This produces valuable output that is
used for univariate data screening. The output provides results by
grouping since we used szazus as a grouping variable. There are several plots
and a table of information in the Explore output. The descriptive statistics
table only is presented in Table 5.2.

3. Independent t-test. An analysis will be conducted to see if there is a significant
difference (v =01) in the means of dealing with difficult client behaviors
between the counseling students and counseling professionals. A high score
on the dependent variable dealdiff means more confidence in dealing with
difficult client behaviors.
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TABLE 5.2 Descriptive Statistics of Status

Descriptives

counseling students and counseling professionals Statistic Std. Error
Mean 55.27 2.435
95% Confidence Interval for Mean Lower Bound 49.85
Upper Bound 60.70
5% Trimmed Mean 55.58
Median 57.00
Variance 65.218
student Std. Deviation 8.076
Minimum 40
Maximum 65
Range 25
Interquartile Range 13
Skewness =.7/5% .661
Kurtosis —.311 1.279
COSE Confidence in Mean 61.33 2.369
Executing Microskills 95% Confidence Interval for Mean Lower Bound 55.87
Upper Bound 66.80
5% Trimmed Mean 61.76
Median 61.00
Variance 50.500
professional Std. Deviation 7.106
Minimum 46
Maximum 69
Range 23
Interquartile Range <
Skewness =11e)5 717
Kurtosis 2.053 1.400




® Go to the top of the window and click on Analyze > Compare Means >
Independent-Samples T Test.

o Click over counseling students and counseling professions [status] under
Grouping Variable (independent variable). Click on button called Define
Groups. Type the number 1 (which represents counseling students)
beside Group 1, and type the number 2 (which represents counseling
professionals) beside Group 2; click Continue.

® Then dick over COSE Dealing with Difficult Client Behaviors |dealdiff]
under Test Variables(s) (dependent variables). Click OK and the output
is produced.

(It is also possible to click over several variables under Test Variable(s)
and it will run a separate independent #test on each dependent variable.)

The output (Table 5.3) shows that #= —4.406 with a significant prob-
ability (Sig. [2-tailed]) equal to p =.000. Since p =.000 is less than the alpha
criterion of .01, the rule is to reject the null hypothesis of no difference, so
there is a significant difference. The mean of dealing with difficult client
behaviors X = 24.64 is for students and X = 34.78 for professionals. Thus,
the counseling professionals showed more confidence in dealing with difficult
client behaviors than did the counseling students.

. Bivariate correlational matrix. Next we look at creating a matrix of correlation
coefficients among three continuously scaled variables: age, confidence in
executing counseling microskills, and confidence in dealing with difficult
client behaviors. We want to determine if age is significantly correlated
(ov=.05) to the other two variables.

¢ (Click Analyze > Correlate > Bivariate.
o Click over age, micskill, and dealdiff to Variables.
e (Click on Pearson and click OK.

You can see that the correlation and significance between age and
COSE Confidence in Executing Microskills is r = 420, p = .065, and age and COSE
Dealing with Difficult Client Behaviorsis r = .663, p = .001 (see Table 5.4). Age
is significantly correlated to COSE Dealing with Difficult Client Behaviors since
the p=.001 is less than the ov=.05 and the rule is to reject the null of no
relationship when the computed probability is less than the chosen « criterion.
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TABLE 5.3 An Independent t-Test Analysis

Group Statistics

counseling students and Std. Error
counseling professionals N Mean Std. Deviation Mean
COSE Dealing with Difficult Client Behaviors student n 24.64 5.334 1.608
professional 9 34.78 4.842 1.614

Independent Samples Test

Levene’s
Test for
Equality of t-test for Equality
Variances of Means
95%
Confidence
Interval of the
Difference
Sig. Mean Std. Error
F Sig. t df (2-tailed) Difference Difference Lower Upper
COSE Dealing with  Equal variances .025 .877 —4.406 18 .000 —10.141 2.302 —-14.977 —5.305
Difficult Client assumed
Behaviors Equal variances —4.451 17.764 .000 —10.141 2.279 —-14.933 —5.350

not assumed




TABLE 5.4 Correlation Matrix of Age, COSE Confidence in Executing
Microskills, and COSE Dealing with Difficult Client Behaviors

Correlations

COSE COSE Dealing
Confidence with Difficult

in Executing Client
age Microskills Behaviors
age Pearson Correlation 1 .420 .663*
Sig. (2-tailed) .065 .001
N 20 20 20
COSE Confidence  Pearson Correlation 420 1 419
in Executing Sig. (2-tailed) .065 .066
Microskills N 20 20 20
COSE Dealing Pearson Correlation .663** .419 1
with Difficult Sig. (2-tailed) .001 .066
Client Behaviors N 20 20 20

*Correlation is significant at the 0.01 level (2-tailed).

5. Simple scatter plot. We now look at a scatter plor showing graphically the
relationship between age and COSE Dealing with Difficult Client Behaviors
(see Figure 5.7).

® Click Graphs > Legacy Dialogs > Scatter/Dot.

® Click on the chart to the left of Simple Scatter and click on the Define
button.

e Click over age to the Y Axis and COSE Dealing with Difficult Client
Behaviors to the X Axis and click OK.

The scatter points are forming somewhat of an oval around a straight line
that can be visualized starting at the bottom left corner of the rectangle and
extending to the upper right corner of the rectangle.

Creating a Composite Summed Variable of Two Variables

1. Often researchers combine variables by summing them into a composite

variable. We are going to add together the scores of COSE Confidence in
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FIGURE 5.7 Scatter Plot of Age and COSE Dealing with Difficult Client
Behaviors
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COSE Dealing with Difficult Client Behaviors

Executing Microskills and COSE Dealing with Difficult Client Behaviors and

create a combined variable (composite) from the two variables.

® Click Transform > Compute Variable > under Target Variable type
COSEComposite.

® Click over the variable COSE Confidence in Executing Microskills under
Numeric Expression and click on the button that is a plus sign (+).

o Click over the variable COSE Dealing with Difficult Client Behaviors under

Numeric Expression.

e Click the OK button and click out of the output created; look at the end
of the columns on Data View and you will see a new column created
called COSEComposite. This column represents the sum of the two vari-
ables (see Figure 5.8).
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FIGURE 5.8 COSE Composite Sum Variable
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IBM SPSS Statistics Processor is ready ‘

Creating a Composite Mean Variable of Two Variables

1.

Sometimes it is useful to create a composite variable of the averages (means)
of several variables. We will create the composite mean of the scores of COSE
Confidence in Executing Microskills and COSE Dealing with Difficult Client
Behaviors.

Click Transform > Compute Variable > under Target Variable type
COSECompositeMean. (If you information on the page from the previous
analysis, press the Reset button.)

Under Function group:, click on All >, then under Functions and Special
Variables, scroll down until you find Mean and click on it.

Using the arrow pointing up, click Mean to the Numeric Expression box.
Under Numeric Expression, you will see MEAN(Z,?).

Click over COSE Confidence in Executing Microskills under Numeric
Expression > click to the right of the comma (that has to be in the expression)
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FIGURE 5.9 COSE Composite Mean Variable
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and delete the question mark > then click over the variable COSE Dealing with
Difficult Client Behaviors to Numeric Expression.

6. Click the OK button and click out of the output created; look at the end of
the columns on Data View and you will see a new column created called
COSECompositeMean. This column represents the mean of the scores of two
variables (see Figure 5.9).

EXAMPLES OF MODIFYING DATA PROCEDURES

1. Insertinga new variable into Data View. (This can also be done in Variable View.)

® In Data View, right click on the column where you want to insert the new
variable to its left.

e (lick Insert Variable.

® The new variable will be located to the left of the column you right clicked on.
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Inserting a case in Data View.

Click on Data View.
Right click on the row you want a new row (case) to be above.
Click Insert Cases.

The new case will be above the highlighted row.

Sorting cases in ascending or descending order by a variable.

Click Data > Sort Cases > Click over the variable to wish to sort and
click on Ascending > click OK.

To return the rows in the original order, click Data> Sort Cases >
Deselect the variable you sorted and click over /D under Sort By and click
on Ascending; click OK.

Another option to sort data is to right click on the variable column in
Data View, and click on either Sort Ascending or Sort Descending. To
return the data set to its original order, sort the /D back to Ascending.

Square-root transformation of a variable.

Click Transform > Compute Variable. Under the Target Variable, type
the variable’s name preceded by sg in the title for easy identification in
your data set that you wish to transform, such as sqcounconfid.

Go to Function group: and select Arithmetic.

Under Functions and Special Variables:, click Sqrt under Numeric
Expression and will look like SQRT(?) > click over variable counconfid;
click OK. The new variable sqconfidence will show up on Data View as the
last column.

SUMMARY

Data in IBM SPSS 20 can be entered and manipulated in various ways. Following
the procedural steps outlined in this chapter provides a starting point for you to
familiarize yourself with the program. You will be enhancing your knowledge and
use of IBM SPSS 20 as you learn about various statistical procedures presented in
this book through problem applications.
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PROBLEM ASSIGNMENT

Go to the companion website for review questions on using IBM SPSS 20. Use
the information presented in this chapter to guide you as you complete the

assignment.

KEY TERMS
ascending IBM SPSS 20
bivariate correlational matrix independent t-test
chart nominal
data ordinal
descending scale
descriptive statistics scatter plot
Explore Analysis spreadsheet
Frequency Analysis variables
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Chapter 6

DIAGNOSING STUDY DATA
FOR INACCURACIES
AND ASSUMPTIONS

LEARNING OBJECTIVES

o Understand the reasons for diagnosing a data set for accuracy
of data, missing data, univariate outliers, and underlying
assumptions related to parametric statistics.

o Examine the methods used to diagnose study data for
inaccuracies and assumptions.

o Execute procedures using IBM SPSS to conduct an
assessment of data accuracy, missing data, univariate
outliers, and underlying assumptions.

o Conduct procedures to modify a data set using data
diagnostic results, and interpret the outcomes.




he purpose of this chapter is to explore and implement methods for

data screening a data set before conducting the main analyses related to

the research hypotheses. Data diagnosis concepts, methods, and proce-
dures are implemented to prepare a data set for analyses.

The purpose of data diagnostics (also called exploratory data analysis, data
screening, or data preparation) is to protect the integrity of inferential statistical
tests (Tabachnick & Fidell, 2007). Researchers want their data to be accurate,
complete, and in compliance with the underlying assumptions of the statistics
being used. This screening procedure is part of step 5 of the hypothesis-testing
process and involves preparing one’s data for statistical analyses to accurately
answer questions about the research questions and hypotheses. Data diagnostics
methods will be examined by analyzing data related to a hypothetical research
example. The data to be entered into IBM SPSS are at the end of this chapter.

RESEARCH EXAMPLE

A researcher wants to implement a new and unique mindfulness training program
to see if it is more effective in increasing mindfulness attention awareness when
compared to a traditional mindfulness training program. The dependent variable
mindfulness attention awareness is defined as the presence or absence of attention
to and awareness of what is occurring in the present (Brown & Ryan, 2003). The
dependent variable is measured using the Mindfulness Attention and Awareness
Scale (MAAS). The norm group mean and standard deviation on the MAAS is
X = 64, and SD =9.9. Forty participants are randomly assigned equally to each
of the two conditions. Participant information related to various potential
extraneous variables was obtained prior to assignment to a condition. The par-
ticipants were compared by group on this information to verify that randomi-
zation did produce similar groups on key extraneous variables. All participants
received six weeks of training and were compared between groups at the end of
treatment using the MAAS scores following the development of a randomized
posttest-only control group design.

Detecting Erroneous Data Entries

Obviously, the integrity of your data analyses can be significantly compromised
by entering wrong data. It is most desirable to enter and check your own data by
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comparing the original data to the data in the computer program spreadsheet.
Having a trusted colleague replicate your data entry and checking procedures
is ideal.

When someone else is entering your data, you need to train and trust them as
well as monitor their data entry. If you cannot check all of their data entry, then,
at the minimum, check one or more random subsets of the data set.

Data that are downloaded, imported, or mined from another data source also
need to be reviewed carefully compared to the original source of data. It is not
uncommon to have data accuracy problems arise from different formats used by
various software programs or even computer platforms.

After the data have been inputted or imported, one can conduct some
screening analyses to assess whether scores on variables are in the expected ranges.
Additionally, a determination can be made as to whether the frequencies, means,
and standard deviations seem plausible.

Go to the Data View in the example data set you created and follow the these
three commands:

1. At the top of the screen, choose Analyze > Descriptive Statistics >
Frequencies.

2. Click over TotalMAAS and Condition to under Variable(s):

3. C(lick on the Statistics button > click on Mean and Std.deviation > click
on Continue and click OK.

A review of the output table called Statistics (Table 6.1) shows there is an
unusually high standard deviation of 72.26442 (the group norm standard

TABLE 6.1 Mean and Standard Deviation of
MAAS Scores

Statistics
TotalMAAS
N Valid 39
Missing 1
Mean 64.4359
Std. Deviation 72.26442
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TABLE 6.2 Frequencies of MAAS Scores

TotalMAAS

Frequency Percent Valid Percent Cumulative Percent

Valid 37.00 1 25 2.6 2.6
38.00 1 2.5 2.6 5.1
40.00 1 25 2.6 7.7
43.00 2 5.0 5.1 12.8
44.00 1 2.5 2.6 15.4
46.00 4 10.0 10.3 25.6
47.00 2 5.0 5.1 30.8
48.00 1 2.5 2.6 353
50.00 1 2.5 2.6 5.9
51.00 2 5.0 5.1 41.0
52.00 5 12.5 12.8 53.8
53.00 1 2.5 2.6 56.4
54.00 2 5.0 5.1 61.5
56.00 2 50 5.1 66.7
57.00 5 12.5 12.8 79.5
58.00 1 2.5 2.6 82.1
59.00 1 2.5 2.6 84.6
60.00 1 2.5 2.6 87.2
61.00 1 2.5 2.6 89.7
63.00 1 2.5 2.6 92.3
85.00 1 25 2.6 94.9
86.00 1 2.5 2.6 97.4
500.00 1 2.5 2.6 100.0
Total 39 97.5 100.0
Missing System 1 2.5
Total 40 100.0

deviation is 9.9). Also, it is unusual to have a standard deviation value higher than
the mean.

Looking at the Frequency Table (Table 6.2) also in the output, we see there is
a number listed that is 500, which is considerably higher than the next-highest
number of 86. Suppose that a review of the original data set shows that the 500
was inputted inaccurately and should be 50. The incorrect number of 500 also
inflated the standard deviation out of the realm of plausibility.

Click out of the frequency table output (don’t save the output unless you
want to). Go to Data View and correct the incorrect value accordingly; save the
corrected data set as anew data file, called Data after data correction.
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ID # Incorrect Value New Corrected Value

500 50

Identifying and Dealing with Missing Data

Missing data is a rather common and annoying phenomenon. When data is
missing from a data set, there is a potential bias in your data that statistical
analyses may ignore because of hidden causes of the missing data. For example, if
persons aged 60 to 65 consistently refused to provide their age in a community
survey, the results could be biased.

Reasons missing values exist in a data set include participants who don’t
respond to some items or sections of items, participants who discontinue their
participation in a study (attrition), and data management mistakes. A researcher
does not want any missing data, but the best type of the bad to have is missing
completely at random (MCAR). The MCAR missing data is unpredictable with no
systematic pattern. The worst type of missing data to have in a data set is missing
not at random (MINAR). There is a systematic cause for MNAR missing data, such
as patterns of not answered questions for a reason (e.g., purposeful avoidance
of embarrassing questions) or a consistent error in data collection or recording
methods. MNAR missing data creates hidden rival explanations in interpreting a
dara set.

One way to determine the impact of missing data is to create dummy vari-
ables. For example, a dummy variable might be created for variable A by applying
the code 0 to represent each case with no missing data on variable A and using the
code 1 to represent all cases with missing data on variable A. This dummy var-
iable has two groups of cases: (1) those cases with no missing data, and (2) those
cases with missing data. This variable can be used as an independent variable on
variable B to see if there is a significant difference on variable B comparing the no
missing data group to the missing data group using an independent #-test or one-
way ANOVA and assessing the effect size of T]z. Other variables (C, D, E, etc.)
could also be analyzed for significant differences using the dummy variable as the
independent variable. Significant differences on the variables between the no
missing data group and the missing data group would suggest there is a systematic
effect of the missing data. A software program called IBM SPSS Missing Values
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diagnoses the missing values in a data set and estimates new values to replace the
missing values. Another program, IBM SPSS AMOS (Analysis of Moment
Structures), computes maximum likelihood statistics in the presence of random
missing data.

There are several ways of handling missing data. Stevens (1996) states,
“Probably the ‘best’ solution is to make every attempt to minimize the problem
before and during the study” (p. 33).

Deleting cases that have a large number of missing data is one option. Hair,
Black, Babin, Anderson, and Tatham (2000) offer the guideline that “missing data
under 10% for an individual case or observation can generally be ignored, except
when the missing data occurs in a specific nonrandom fashion” (p. 55). The
deletion of cases may be more attractive when only a small subsample of random
cases of a large sample of cases has missing data (Tabachnick & Fidell, 2007).

Deleting variables with substantial missing data is another option. Again,
deletion of variables is more appealing if the missing data are random and the
variables being deleted are not critical to the analysis.

Deletion of cases or variables is not the ideal solution. Deleting cases means
smaller samples and potentially a less representative sample of the population they
were drawn from. Deleting variables eliminates important information from a
study that a researcher planned to examine.

More acceptable options for improving a data set with missing data include
using various approaches to estimate (impute) the missing data. A popular
approach has been replacing missing values with a mean of the available data on a
target set of scores, such as a column that often represents a variable. For example,
the mean may be from the variable of completed scores where the missing value(s)
reside(s). Mean substitution is attractive because it is a conservative estimate since
the mean of the scores on the variable does not change. However, the variance
of the variable is reduced compared to another score that may have been the
missing value, because one is replacing the missing value with its distribution
mean. Correlations with other variables are also lowered because of the reduced
variance. Mean substitution is less frequently used because other more accurate
methods of imputation have been developed.

Another method is using regression analysis. Regression analysis takes com-
pleted case values from a data set and generates a regression equation to predict the
missing values. This approach may be more sophisticated than mean substitutions,
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but it has limitations. If the variables used to predict the missing values are not
good predictors of the missing values, then the outcome is not optimal.

A sophisticated imputation method called expectation maximization (EM)
involves creating a distribution of partially missing data and making inferences
about missing data under the likelihood of that created distribution (see Little &
Rubin, 2002). As mentioned earlier, specialized statistical software programs have
been developed to handle missing data, such as IBM SPSS Missing Values.

Repeating analyses with and without (imputed) missing data is highly
recommended following any of the methods of handling missing data. You will
be comparing the results for similarities and differences. If the results of the
two analyses are similar, then this provides the researcher with self-assurance as to
interpretation of the results. Further data investigation is needed if the results are
different. It is good practice to report results from both a missing data set and an
imputed missing data set.

We now look at an illustration of assessing and imputing a missing data point
in the example data. We use an imputation technique available in IBM SPSS
known as linear trend at point, which replaces missing values with a linear trend
for that point. There is a regression on the existing series on an index variable
scaled from 1 to 7 This linear trend point estimates the missing values.

Initiate Analyze > Descriptive Statistics > Frequencies. If there are any
variables still under the Variable(s) column, click on the Reset button at the
bottom of the screen.

1. Click over TotalMAAS under Variable(s): and click OK.
The output in the TotalMAAS Statistics Table (Table 6.3) shows that

there are 39 cases and 1 case with a missing value. The ID for the missing case
is #11 as seen on the DataView. There is a blank cell for ID #11 in the
column for the dependent variable TotalMAAS.

We will impute the missing value using a linear trend at point analysis.

2. To replace the missing value for /D #11 on the variable 70zalMAAS, initiate
Transform > Replace Missing Values > first beside Method: choose Linear
trend at point > then click over 70/MAAS under New Variable(s): > click
OK > click out of the output produced and go to the DataView, where a new
column is produced called 7ozalMAAS_1. Save a new data file named Data
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TABLE 6.3 Missing Case for TotalMAAS

Statistics
TotalMAAS
N Valid 39
Missing 1

after imputed value & data correction so you know that it contains an
imputed value added to the corrected value completed previously.

You will notice that all of the values in the new column are the same except
for the value that was imputed, and it is 53.76, which is the estimated value for
the missing data. We will be using this changed data file (corrected value and
imputed value) for several other analyses.

Identifying and Assessing Univariate Outliers

Next, we examine how to screen for wnivariate outliers and the underlying
assumptions of the statistic used. We will also modify the data based on our
findings. We are preparing our data to answer one simple question based on
our study problem: Will there be a significant difference in mindfulness attention
awareness resulting from a new and unique mindfulness training program com-
pared to a traditional mindfulness training program? We will be testing the null
hypothesis that there will be no difference in mindfulness attention awareness
between the new and traditional mindfulness training programs (Ho: pinew =
Mo Traditional). We will eventually run a one-way ANOVA (F-test) to see if there are
significant differences (we could also run an independent #-test). We screened and
corrected the data set for data entry problems and missing data. We will continue
the data screening process to prepare our data for analysis to protect the integrity
of the inferential statistical test (F-test).

Identifying and Assessing Univariate Outliers

Many statistical methods are sensitive to the impact of scores that are outliers, so
it is important to identify and make decisions about what to do with them. The
reason is, according to Stevens (1996): “Because we want the results of our
statistical analysis to reflect most of the data, and not to be highly influenced by

106 ¢« CHAPTER 6



just 1 or 2 errant data points” (p. 13). The results of a data set with outliers do not
generalize well to other samples unless they also have similar outliers.

Outliers can be univariate or multivariate. Univariate outliers are extreme
scores by cases on one variable. Multivariate outliers are extreme score combi-
nations by cases on two or more variables. There are many possible reasons for the
existence of outliers (Tabachnick & Fidell, 2007). Outliers can be caused by
errors in data entry and mismanagement of a data file. The participant with an
outlying score on a dependent variable may not be a member of the population
that you intended to sample. For example, you may be studying persons with
obsessive-compulsive disorders (OCDs); a participant got into the sample who
does not have an OCD disorder, and this person’s score on a dependent variable
is extreme compared to the OCD participants’ scores. It is also possible that
participants have outlying scores and they do represent the population you
wanted to sample. The population may have more extreme scores than is
expected in a normal curve.

Tabachnick and Fidell (2007) identified a guideline for determining if a
participant’s score on a continuously scaled dependent variable is a univariate
outlier. If any z-score is in excess of z=%3.29 (p <.001, two-tailed test),
then it is declared to be a univariate outlier. This guideline is two-tailed,
meaning it applies to extreme negative (left tail) scores and extreme positive
(right tail) scores.

The raw scores on dependent variables are transformed to z-scores. If any z-score
is greater than *3.29, it is considered a univariate outlier. Such a score would clearly
be an extreme score using the £3.29 on the normal curve to make the determi-
nation. Next, we compute z-scores for the dependent variable (70IMAAS_1) raw
scores using the changed data file (corrected value and imputed value).

1. Select Analyze > Descriptive Statistics > Descriptives.

2. Click over TotalMAAS_1 (the longer variable name is TREND(TotalMAAS)
[TotalMAAS_1]) under Variable(s): > click on the box at the bottom of the
screen that says Save standardized values as variables and then click OK.

3. Click out of the Descriptives output and see the new variable at the end of
the DataView spreadsheet called Z70zalMAAS_1. These are the z-scores for
each raw score. Save this file as a new data set called Data after z-score,
imputed value, & entry correction.
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Odur task is to identify any value that is greater than *=3.29 in each cell under
ZTotalMAAS_1. The value of z=3.37707 for participant ID #32 in the control
group is greater than +3.29, so the raw score of 86 is an outlier. The z-score =
3.27498 (ID #8) in the treatment condition group is close to being an outlier
using our criterion of 3.29 but it does not reach the criterion level. However, it’s
near outlying (using our criterion) effects will be detected in additional analyses
that will be conducted.

There are various approaches for minimizing the effects of outliers. Less desirable
methods are to delete the case or variable with the outlier(s) based on an assessment
of whether the case is representative of the population that the sample was drawn
from. Another approach is using #immed means by discarding 5 percent of the largest
scores and doing the same for 5 percent of the smallest scores.

Conducting a data transformation of the original raw scores also is used to
reduce the influence of extreme scores by bringing the oudliers closer to the
majority of scores in the distribution. The procedure to transform data is very
common in the use of statistics. Data transformations are used when raw scores
are converted to z-scores or 7-scores. Several advanced statistics have natural
logarithms in their formulas, including logistic regression and log-linear analysis.

Obtaining additional data screening information will be useful to assess
before making a decision on how to handle the univariate outlier that we dis-
covered in the data set. We will next screen the data to establish whether the data
meet the underlying univariate assumptions of the one-way ANOVA statistic.

Screening and Making Decisions about Univariate Assumptions

Many statistical analyses “require that all groups come from normal populations
with the same variance” (Norusis, 1994, p. 89). Statistics like the one-way
ANOVA use sampling distributions to test whether a statistic is significant. The
central limit theorem tells us that regardless of the shape of the population distri-
bution, the sampling distribution of means, drawn from a population with variance
o> and mean i, will approach a normal distribution with 6/ as sample size N
increases. So, we want our sample distribution on the dependent variable to reflect
normality and the sample variances to be approximately equal (same population) so
that we can test whether two sample means come from the same populations or
different populations. As such, we will assess whether all the group variances are
equal and that samples come from normal populations. If these assumptions
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are violated then we will identify strategies to rectify the violations. More specif-
ically, for normality we will assess histograms, normal Q-Q plots, skewness,
kurtosis, and the Shapiro-Wilk statistic. We will examine the variance ratio (£,,,,)
and the Levene’s test to make a decision about the assumption of homogeneity of
variance. Evidence is combined from all of the sources of information to make
decisions about whether the dependent variable is normal and reflecting homo-
geneity of variance across the two conditions. The decisions made are based on the
preponderance of evidence.

We begin by analyzing the dependent variable, mindfulness attention
awareness, for normality using the modified variable 70ta/MAAS_1. We have
discovered in the screening for unvariate outliers screening that dependent vari-
able had one univariate outlier. We have postponed a decision on what to do with
the univariate outlier until after our screening for normality and homogeneity of
variance. Univariate outliers do have detrimental effects on both normality and
homogeneity of variance. Conduct the following data analysis on 7TolIMAAS_1.

1. Analyze > Descriptive Statistics > Explore

2. Click over dependent variable TREND(TotalMAAS)[70talMAAS_1]) to the
Dependent List.

3. Click over independent variable (Condition) to Factor List.
4. Do not change Display choices; leave on Both.

5. In the upper right corner of the screen there are three buttons. Click on
Plots. Then select Histogram and Normality plots with tests.

6. Click on Continue.

7. Click on OK.

Skewness and Kurtosis

Much of the data from the output provides information about the skewness and
kurtosis of the sample distribution of scores. A distribution where scores are not
balanced (asymmetrical) with extreme scores in either tail of the distribution is
skewed. Outliers produce skewed distributions. If most of the scores are on the
left but there are extreme scores on the right side of the curve, it is posizively
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skewed. When the extreme scores are on the left side of the curve and most of the
scores are on the right side, it is negatively skewed.

Kurtosis is the relative concentration of scores in the center, the upper and
lower ends (tails), and the shoulders (between the center and the tails) of a dis-
tribution (Norusis, 1994). Mesokurtic refers to a curve as being more symmetrical
and normal (bell) shaped. A curve that is more narrow and peaked is leptokurtic.
Platykurtic reflects a shape of a curve that has scores more widely dispersed and flat.

Histograms

Histograms provide a general visual description of the distribution of data values.
The inspection of histograms is a good place to start in understanding your study
data distribution, but they are often difficult to interpret. Histograms show the
extent that a distribution of values is symmetrical (mesokurtic) and whether cases
cluster around a central value. You can see if the shape of the distribution is more
peaked or narrow (high in the middle—leptokurtic) or more flat (dispersed—
platykurtic). You can also tell if there are values far removed from the other values,
such as values far to the right of the distribution (positive skew) or values far to the
left of the distribution (negative skew).

Refer to the computer output and scroll down until you find the histograms
of the mindfulness attention awareness (7o0ta/MAAS 1) scores for both the
treatment and control groups. The abscissa of the histograms represents the scores
and the ordinate represents the frequency that participants generated the scores.

The treatment group scores appear somewhat symmetrical in Figure 6.1, but
the score distribution is positively skewed with an extreme score on the right side
of the curve. This is the near-outlying score for participant ID #8. The peak of the
curve seems to be higher than we might expect (leptokurtic) compared to the peak of a
normal curve, but we won’t find out for sure until we have conducted more analyses.

The histogram of mindfulness awareness scores for the control group (Figure 6.2)
is positively skewed with a univariate outlier discovered earlier, score 86, participant
ID #32. The curve is somewhat symmetrical and possibly leptokurtic.

Skewness Screening

A more accurate way to assess whether the distribution of scores on the dependent
variable in each group is significantly skewed is done by creating z-scores. The
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FIGURE 6.1 Histogram of Mindfulness Attention Awareness Scores for
the Treatment Group
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output table called Descriptives contains the information that we will be using
for our analyses (see Table 6.4). We will examine skewness values and calculate
skewness z-scores. The signs (+ or —) of skewness values and z-scores indicate
the direction of the skew but not whether it is a significant skew. A positive
skewness value and z-score indicate that the score distribution is in the direction
of the right side of the curve, and a negative skewness value and z-score indicate
the direction in the left size of the curve. A skewness value and z-score at or near
0 indicate there is no skewness.

The skewness value for the treatment condition group is 2.071 (positive skew
direction), and the standard error value next to it is .512 (see Table 6.4). When
the skewness value is divided by its standard error the result is a z-score.
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FIGURE 6.2 Histogram of Mindfulness Attention Awareness Scores for
the Control Group
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So, 2.071/.512 equals a zgc,, =4.045. This value can be compared to the cri-
terion that we used for univariate outliers, z= *=3.29 (p <.001, two-tailed test).
The zg)e,, = 4.045 is greater than z= *3.29, so we conclude that the distribution
of scores of the treatment condition group is significantly positively skewed
(»<.001) and departs from being a normal distribution.

The skewness value (1.995, positive skew direction) and its standard error
(.512) for the control group score distribution generate a zgje,, = 1.995/.512 =
3.896. Again, the control group distribution of scores is not normally distributed
because it is significantly positively skewed since the zgy,, = 3.896 is greater than
our criterion of z= *3.29.

112 ¢« CHAPTER 6



TABLE 6.4 Skewness and Kurtosis Values with Standard Errors of the
Dependent Variable for Both Conditions

Descriptives

Condition Statistic Std. Error
TREND Treatment Mean 55.288 1.9418
(TotalMAAS) 95% Confidence Lower Bound 51.224
Interval for Mean Upper Bound 59.352
5% Trimmed Mean 54.320
Median 53.881
Variance 75.414
Std. Deviation 8.6841
Minimum 43.0
Maximum 85.0
Range 42.0
Interquartile Range 6.5
Skewness 2.071 512
Kurtosis 6.915 992
Control Mean 50.550 2.3424

95% Confidence Lower Bound 45.647
Interval for Mean Upper Bound 55.453

5% Trimmed Mean 49.333

Median 50.000

Variance 109.734

Std. Deviation 10.4754

Minimum 37.0

Maximum 86.0

Range 49.0

Interquartile Range 1.0

Skewness 1.995 512
Kurtosis 6.457 992

Kurtosis Screening

We conduct the same process obtaining kurtosis z-scores and compare them to the
criterion of *£3.29. A positive kurtosis value and z-score indicate that the distri-
bution of scores is in the direction of a leptokurtic (more peaked) distribution, and a
negative kurtosis value or z-score designates the direction of a platykurtic (more
flat) distribution. A kurtosis value or z-score close to 0 signifies a mesokurtic
(normal and symmetrical) distribution.
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The kurtosis value for the treatment group is 6.915, the standard error is .992,
and the ziyrosis = 6.915/.992 =6.971 (see Table 6.4). The zkyrwosis = 6.971 is
greater than +3.29, so it reflects a significant leptokurtic distribution of scores,
which is not a normal distribution.

The control group has a kurtosis value = 6.457 and standard error = .992, so the
ZKurtosis = 0.457/.992 = 6.509 > £3.29, p < .001. The control group has a signif-

icant leptokurtic distribution of scores, thus departing from a normal distribution.

Shapiro-Wilk Statistic
The Shapiro-Wilk (5-W) test and the Kolmogorov-Smirnov test with Lilliefors

correction are statistical tests that assess the hypothesis that the data are from a
normal distribution. It is important to remember that whenever the sample size is
large, almost any goodness-of-fit test will result in rejection of the null hypothesis
since it is almost impossible to find data that are exactly normally distributed. For
most statistical tests, it is sufficient that the data are approximately normally
distributed (Norusis, 1994).

We will obtain additional evidence about the normality of the distributions of
dependent variable scores in the two groups by testing the null hypothesis, Hy:
sample distribution of scores = normal. If we fail to reject (retain) the Hj in this
analysis, this finding provides support for the sample scores being normally
distributed. If we reject the Hy, then the finding suggests that sample scores are
not normally distributed. Therefore, we are hoping to retain the null when using
the Shapiro-Wilk (S-W) statistic. We will use an alpha (o) level of .05.

The significance probability of the S-W statistic for the treatment group is
p=.002 (see Table 6.5). The rule for rejecting an H is: if the significance
probability of the statistic is equal to or less than the alpha level, then the Hj is
rejected. The null is rejected for the treatment group since p=.002 < a=.05.
This suggests that the sample distribution of scores for the treatment group is not
normally distributed. The control group also had a significance probability of
p=.002, which is less than a=.05, so the null hypothesis is rejected. The
control group distribution of scores is not normally distributed.

Assessing Normal Q-Q Plots for Normality

Each observed value in a distribution of scores is paired with its expected value from

the normal distribution in a normal probability plot (Q-Q plot). The expected values
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TABLE 6.5 Shapiro-Wilk Statistic Results to Assess Normality

Tests of Normality

Kolmogorov-Smirnov? Shapiro-Wilk

Condition Statistic df Sig.  Statistic df Sig.

TREND(TotalMAAS)  Treatment 177 20 .099 .820 20 .002
Control 169 20 136 .827 20 .002

2 Lilliefors significance correction.

from the normal distribution are based on the number of cases in the sample and
the rank order of the case in the sample. If the sample is from a normal distribution,
we expect that the points will fall more or less on a straight line.

The Q-Q plots of distributions of scores for both conditions are in
Figures 6.3 and 6.4. For the most part, the points are on or near the line.
However, there is one point in each graph that is substantially off the line. Each
point in the first and second Q-Q plots represents the extreme score in the
treatment and control condition groups that we have identified earlier.

Summary of Our Screening Results for the Underlying
Assumption of Normality

A significant univariate outlier was identified in the control group and an extreme
score was also found in the treatment group but it was not significant. All the
skewness and kurtosis z-scores and Shapiro-Wilk statistics were significant,
indicating that the score distributions in both groups departed from normality.
Finally, the Q-Q plots reflected outliers in the distributions of scores. The pre-
ponderance of evidence strongly suggests that the sample data do not meet the
underlying assumptions of normality. Next, we assess whether the underlying
assumption of homogeneity of variance is met.

Screening for Homogeneity of Variance

The variance ratio (#,,,,) and Levene’s test will be used to assess homogeneity
of variance. A variance ratio analysis can be obtained by dividing the highest group
variance by the lowest variance of a group in an analysis. Norusis (2005) provided
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FIGURE 6.3 Q-Q Plot to Assess Normality of Treatment Condition Scores
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a guideline that the homogeneity is acceptable if the ratio of the largest variance to
the smallest variance is less than 4:1. Tabachnick and Fidell (2007) suggested that
if the group or cell sizes (participants per cell) are relatively equal, such as 4 to 1
for largest to smallest participants per cell, then a variance ratio as high as 10 is
acceptable. However, if the largest to smallest number of participants per group
(or cell) are as large as 9 to 1, then, a variance ratio (F,,,) as low as 3 can be
associated with inflated Type I error.

The participants per group are equal in size (7, = 20 and 7, = 20). The variances
of the two groups are found in Table 6.4. The control group had the highest variance of
SEommel = 109.734 and st =75.414. The variance ratio is Fp, = 109.734/
75.414 = 1.455. The variance of the control group is 1.455 larger than the variance of
the treatment group. This ratio is lower than the criterion of 4 times larger or 10 times
larger. There appears to be homogeneity of variance across the two groups according
to the variance ratio. We will verify this finding with the Levene’s test.
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FIGURE 6.4 Q-Q Plot to Assess Normality of Control Condition Scores

Normal Q-Q Plot of TREND(TotalMAAS)
for Condition = Control
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Levene’s Test

The Levene’s test is a test of homogeneity of variance that is less dependent on the
assumption of normality than most tests and thus is particularly useful with analysis
of variance. It is obtained by computing, for each case, the absolute differences from
its cell mean and performing a one-way analysis of variance on these differences.
If the Levene’s test statistic is significant, then the groups are not homogeneous and
we may need to consider transforming the original data or using a nonparametric
statistic (Norusis, 1994). The Levene’s test results are provided with the one-way
ANOVA results, allowing us to review both results at the same time.

1. Analyze > General Linear Model > Univariate.

2. Click over dependent variable TREND(TotalMAAS)[70talMAAS_I] to
Dependent Variable:.

3. Click over independent variable (Condition) to Fixed Factor(s).
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4. Click on the Options button, then select Descriptive statistics, Estimates
of effect size, Observed power, and Homogeneity tests in the Display box.

5. Click on Continue.

6. Click on OK.

The output results of the Levene’s test are found in the table titled Levene’s Test of
Equality of Error Variances (Table 6.6). We are testing the null hypothesis that the
variances and error variances of the dependent variable are equal across the two

" g2 — o2 : —
condition groups, Hy: O Eron = Omror(Control) - W e are usingan o= .05 to test

Treatment)
the null hypothesis. The significance probability of the Levene’s test resultis p = .578,
which is greater than oo =.05 so we fail to reject the H,. We can conclude from the
Levene’s test that the variances and error variance are equal across the conditions, and
we met the underlying assumption of homogeneity of variance. Both the Levene’s test
and the variance ratio support the presence of homogeneity of variance across the two
sample distributions of scores. Next, we discuss the results of the one-way ANOVA
that are also on the output following the Levene’s test information.

One-Way Analysis of Variance Results

We did meet the underlying assumption of homogeneity of variance, but we did
not meet the assumption requirement that dependent variable scores are normally
distributed. We are therefore going to correct for the violation of normality by
transforming the dependent variable to minimize the influence of the outlying
scores that are causing the distribution of scores to be positively skewed and
leptokurtic rather than normal. Both the nontransformed and transformed
analyses are conducted and presented following good practice.

TABLE 6.6 Results of Levene’s Test of
Homogeneity of Variance

Levene’s Test of Equality of Error Variances?
Dependent Variable: TREND(TotalMAAS)

B dfl df2 Sig.

315 1 38 .578

Tests the null hypothesis that the error variance of the dependent
variable is equal across groups.
@ Design: Intercept + Condition
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Nontransformed One-Way ANOVA Results

The output results of the one-way ANOVA are in the table called Tests of
Between-Subjects Effects (see Table 6.7). The research problem is a comparison
between the effects a new and unique mindfulness training program and a tra-
ditional mindfulness training program on increasing mindfulness attention
awareness. The null to be tested is Hoy: |11 Treatment = I1Control Using o= .05. The
results on the row labeled Condition under Source show that the significance
probability is p =.128. The p =.128 is greater than the alpha criterion of .05, so
we retain the null hypothesis that there are no mean differences between the two
conditions on mindfulness attention awareness, (1, 38) =2.425, p >.05. We
will see if the results are similar after we transform the dependent variable.

Transformed Screening and One-Way ANOVA Results

Especially if cases with extreme scores are considered part of the population you
sampled, then a way to reduce the influence of a univariate outlier is to transform the
variable to change the shape of the distribution to be more normal. Tabachnick and
Fidell (2007) and Stevens (1996) provide guides on what type of transformation to use
depending on the shape of the distribution you are planning to transform. For
example, a square root or a log10 transformation can be used for positively skewed
distributions to try to normalize them. For negatively skewed distributions,
reflecting the negative distribution (reversing it to positive) and then using a square
root or a log transformation may normalize the distribution. All transformations,
changes of scores, and deletions should be reported in the findings of a study. Since
we have a substantial positively skewed dependent variable, we are going to employ
a log10 transformation. Please run the following analysis after clicking out of the
output we have been using.

1. Select Transform > Compute.

2. Under Target Variable type L7otalMAAS_1. This command will create a
new column of transformed scores on the DataView, so the L (for Loga-
rithm) is used for clarity of what each column of scores represents.

3. Under Functions group: click on All > then under Functions and Special
Variables: scroll down until you find LG10, then click on it and click on the
arrow button to the left point up. This places LG10 under Numeric Expression:.
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TABLE 6.7 One-Way ANOVA Results before Log10 Data Transformation

Tests of Between-Subjects Effects
Dependent Variable: TREND(TotalMAAS)

Type Il Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power®
Corrected model 224.499° 1 224.499 2.425 128 .060 2.425 .329
Intercept 112,017.093 1 172,017.093 1,210.025 .000 .970 1,210.025 1.000
Condition 224.499 1 224.499 2.425 128 .060 2.425 329
Error 3,517.821 38 92.574
Total 115,759.413 40
Corrected total 3,742.319 39

? R-squared =.060 (adjusted R-squared =.035)
® Computed using alpha=.05



4. Next go to variables under Type and Label and click on TREND(Total-
MAAS)[TotalMAAS_1] and then click on the arrow to the right of the box of
variables. It will show up in the place under Numeric Expression where the 2

was. So, the Numeric Expression should look like LG10(TotalMAAS _1).

5. Then, click OK and the logl0 transformed variable will be on your Data-
View spreadsheet.

Now, we will see if the log10 transformation was successful in normalizing the
distribution of the dependent variable. We will repeat the exploration commands to
assess the measures of normality on the transformed dependent variable.

1. Analyze > Descriptive Statistics > Explore.

2. Click on Reset and then click over the transformed dependent variable

(LTotalMAAS_I) to Dependent List.
Click over independent variable (Condition) to Factor List.
4. Do not change Display choices—leave on Both.

5. To the upper right there are three buttons. Click on Plots. Then, select
Histogram and Normality plots with tests.

6. C(lick on Continue.

7. Click on OK.

The output of the histograms (Figures 6.5a and 6.5b) after Log10 transfor-
mation shows that the extreme scores have moved closer to the other scores in
the distributions. However, they still are apart for the majority of scores in the
distributions.

The output skewness and kurtosis values of the transformed data are in
the Descriptives table (Table 6.8). The zsiewTreatment = 1.310/.512=2.559
and the zsiewControl = 1.064/.512 =2.078. The zg).,, scores for both groups are
below *3.29; thus the sample distribution scores are no longer significantly
positively skewed. The logl0 transformation was successful on skewness.

The zZkurosisTreatment = 4.061/.992 =4.094 and the 2z rosisControl = 3-006/
992 =3.030. The 2k rosisTreatrment = 4.094 > £3.29, so it remains significantly
leptokurtic; but the ziyrosisControl = 3-030 < £3.29, so it is no longer signifi-
cantly leptokurtic.
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FIGURE 6.5A AND B Histograms of the Dependent Variable by Condition
Groups after Log10 Data Transformation
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TABLE 6.8 Skewness and Kurtosis Values after Log10 Transformation

Descriptives

Condition Statistic Std. Error

LTotalMAAS_1 Treatment Mean 1.7382 .01384
95% Confidence Lower Bound 1.7092
Interval for Mean Upper Bound 1.7672

5% Trimmed Mean 1.7334

Median 1.7314

Variance .004

Std. Deviation .06189

Minimum 1.63

Maximum 1.93

Range .30

Interquartile Range .05

Skewness 1.310 512

Kurtosis 4.061 992
Control Mean 1.6961 .01806

95% Confidence Lower Bound 1.6583
Interval for Mean Upper Bound 1.7339

5% Trimmed Mean 1.6900

Median 1.6990
Variance .007

Std. Deviation .08074
Minimum 1.57

Maximum 1.93

Range 37
Interquartile Range .10

Skewness 1.064 512
Kurtosis 3.006 992

The Shapiro-Wilk statistics in the Tests of Normality output table (Table 6.9)
show that the treatment group score distribution is still significant since the p = .040 is
less than ov = .05, but the control group is no longer significant, p = .094 > o = .05.

The output of the normal Q-Q plots (Table 6.10) shows that the logl0
transformation was successful in bringing the points closer to the line, including
the extreme scores (see Figures 6.6a and 6.6b). This reflects more congruence
between observed and estimated normal scores.
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TABLE 6.9 Shapiro-Wilk Statistics after Log10 Transformation

Tests of Normality

Kolmogorov-Smirnov? Shapiro-Wilk

Condition Statistic df Sig. Statistic df Sig.

LTotalMAAS_1 Treatment 142 20 .200* .900 20 .040
Control 130 20 .200* 919 20 .094

2 Lilliefors significance correction.
*This is a lower bound of the true significance.

TABLE 6.10 Levene’s Test of Homogeneity of Variance after Log10
Transformation

Levene’s Test of Equality of Error Variances?
Dependent Variable: LTotalMAAS_1

F dafl ar2 Sig.

917 1 38 344

Tests the null hypothesis that the error variance of the dependent variable is equal across groups.
@Design: Intercept + Condition

The preponderance of the evidence of the logl0 transformed data suggests
that the transformed dependent variable scores of both condition groups more
closely approximate normal distributions. We will conduct a one-way ANOVA
on the transformed data to see if there is a significant difference in mindfulness
attention awareness between the new and tradition mindfulness training pro-
grams, Hp: P Trearment = H1Control using o= .05.

1. Analyze > General Linear Model > Univariate.

2. Click over the logl0 transformed dependent variable (Z70zalMAAS_1I) to
Dependent Variable.

3. Click over independent variable (Condition) to Fixed Factor(s).
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FIGURE 6.6A AND B Normal Q-Q Plots after Log10 Data Transformation
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4. Click on the Options button, then select Descriptive statistics, Estimates
of effect size, Observed power, and Homogeneity tests in the Display box.

5. Click on Continue.

6. Click on OK.

The Levene’s test results are under the output table called Levene’s Test of
Equality of Error Variances (Table 6.10). The Levene’s test significance probability is
p=.344> a=.05. There is homogeneity of variance as before the transformation.

The one-way ANOVA results of the log10 transformed data are in the output
table named Tests of Between-Subjects Effects (Table 6.11). The significance
probability is p=.072 and is greater than oo =.05, so we fail to reject the null
hypothesis, (1, 38) =3.419, p > .05. This is a similar to our finding using the
nontransformed data. This result reinforces the original conclusion that there
appears to be no significant difference in mindfulness attention awareness
between the new and tradition mindfulness training programs that were imple-
mented with this study sample.

The data we used for all of the previous analyses is in Table 6.12.

TABLE 6.11 One-Way ANOVA Results for the Log10 Transformed Data

Tests of Between-Subjects Effects
Dependent Variable: LTotalMAAS_1

Type llI Partial

Sum of Mean Eta Noncent. Observed
Source Squares df Square F Sig. Squared Parameter Power®
Corrected .018° 1 .018 3.419 .072 .083 3.419 437
model
Intercept 117.945 1 117.945 22,791.796 .000 .998 22,791.796 1.000
Condition .018 1 .018 3.419 .072 .083 3.419 437
Error 197 38 .005
Total 18.160 40
Corrected 214 39
total

@ R-squared =.083 (adjusted R-squared =.058)
P Computed using alpha=.05
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TABLE 6.12 Data Diagnostics Study Example

ID# TotalMAAS Condition
1 52 Treatment**
2 43 Treatment
3 57 Treatment
4 46 Treatment
5 52 Treatment
6 47 Treatment
7 53 Treatment
8 85 Treatment
9 52 Treatment
10 54 Treatment
1* Treatment
12 51 Treatment
13 48 Treatment
14 56 Treatment
15 57 Treatment
16 58 Treatment
17 57 Treatment
18 63 Treatment
19 60 Treatment
20 61 Treatment
21 46 Control

22 500 Control

23 40 Control

24 50 Control

25 37 Control

26 58 Control

27 44 Control

28 51 Control

29 46 Control

30 56 Control

31 54 Control

32 86 Control

33 46 Control

34 57 Control

35 52 Control

36 57 Control

37 47 Control

38 38 Control

39 43 Control
40 52 Control

**Designed missing data cell for data screening.
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SUMMARY

Assessing the integrity of data used in statistical analyses is essential to enhance

the validity of study findings. Data diagnostics are used to screen for data

accuracy, data representativeness, and data meeting the underlying assumptions

of the statistics being used.

PROBLEM ASSIGNMENT

Go to the companion website for additional examples of diagnosing study data

for inaccuracies and assumptions. Use the information presented in this chapter

to guide you as you complete the assignment.

KEY TERMS

asymmetrical

central limit theorem

data diagnostics

data transformation

dummy variable

expectation maximization (EM)
histograms

impute

kurtosis

leptokurtic

Levene’s test

linear trend at point

logT10 transformation
mesokurtic

missing completely at random (MCAR)
missing data

missing not at random (MNAR)

negatively skewed

normal probability plot (Q-Q plot)
normality

platykurtic

positively skewed

repeating analyses

replacing missing values with a mean

sample variances to be approximately
equal

Shapiro-Wilk (S-W) test

Skewness

transforming the dependent variable
trimmed means

univariate assumptions

univariate outliers

variance ratio analysis
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Chapter 7
RANDOMIZED DESIGN
COMPARING TWO
TREATMENTS AND A
CONTROL USING A ONE-WAY
ANALYSIS OF VARIANCE

LEARNING OBJECTIVES

o Demonstrate how to develop research questions and
hypotheses as they relate to a research problem incorpo-
rating independent and dependent variables.

o Identify the components and application of a randomized
posttest-only control group design.

o Examine Type I and II error considerations and a priori
power analysis in establishing alpha (o).




o Conduct data diagnostics to assess for normality, homo-
geneity of variance, and independence of observations.

o Execute a one-way analysis of variance (ANOVA) and
Tukey honestly significant difference (HSD) using IBM
SPSS and formulas.

o Interpret post hoc analyses using eta-squared (%), omega-
squared (w?), and confidence intervals.

o Understand the study findings combining the various
analyses.

one-way analysis of variance (ANOVA) is used to evaluate the effects

of treatment programs to reduce depression among adolescents. A

research question and hypotheses are developed postulating that cognitive-
behavioral therapy and interpersonal therapy will produce significantly lower
depressive symptoms among adolescents when compared to a no-treatment control.
A randomized experimental research design comparing two treatments and a
control is used. A data set is presented that is used for both IBM SPSS software
and formula analyses.

An a priori power analysis is conducted to determine if the sample size,
estimated effect size, and alpha level are adequate to proceed with the study.
A one-way analysis of variance (ANOVA) is applied to test the overall (omnibus)
null hypothesis. The magnitudes of treatment effects are assessed using both eta-
squared and omega-squared effect size measures. A post hoc analysis is conducted
using the Tukey honestly significant difference (HSD) statistic. The .95 confi-
dence intervals are interpreted for the mean differences between group means.
Finally, the overall results are presented.

RESEARCH PROBLEM

The purpose of this research is to determine how effective treatment programs are
in reducing symptoms associated with depression among adolescents. Previous
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research has demonstrated the effectiveness of cognitive-behavioral therapy
(CBT) and interpersonal therapy (IPT) for both treatment (Weisz et al., 2009;
Rossello, Bernal, & Rivera-Medina, 2008) and prevention (Horowitz, Garber,
Ciesla, Young, & Mufson, 2007).

Initially, 160 eighth and ninth grade participants comprised the sample. Prior to
random assignment to condition, 10 participants were identified as not eligible for
the study because they met exclusion criteria related to having a co-occurring
medical or physical condition, receiving psychological treatment, or using medica-
tion for a behavioral or neurological disorder. The remaining 150 participants in the
sample were randomly assigned to receive one of three treatment conditions: (1)
cognitive-behavioral therapy (CBT), (2) interpersonal therapy (IPT), or (3) no-
treatment control (Control). Following assignment to condition, two persons in the
CBT condition and three persons in the IPT chose to discontinue before the study
began. This resulted in 145 participants distributed in the treatment condition
groups: CBT (n; = 48), IPT (n, = 47), and Control (73 = 50). The participants’
average age was M = 14.55 (SD = .68) in this simulated example. Females and
males were approximately equal in number in the sample, 75 (52 percent) females
and 70 (48 percent) males. The adolescents lived in suburban, middle-class
communities.

Depressive symptoms were measured using a self-report measure called the
Center for Epidemiological Studies Depression Scale (CES-D). Higher scores on
the CES-D reflect more depressive symptoms. The CES-D was administered to
all participants in the study prior to treatment and following treatment. We will
be analyzing the posttreatment scores only.

STUDY VARIABLES

The independent variable, depression treatment program, and how it was oper-
ationally defined in this study are described next. In addition, the dependent
variable and its operational definition are identified.

Independent Variable

The independent variable (IV) designed to have an effect on the dependent
variable (DV') (symptoms of depression) in this study is depression treatment
program. Depression treatment program is operationally defined (OD) as having
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three conditions in this study: (1) cognitive-behavioral therapy (CBT),
(2) interpersonal therapy (IPT), and (3) no-treatment control (Control). These
three conditions will likely, based on previous research, show variability in their
effects on symptoms of depression. Researchers of a different study might use
more, fewer, or other conditions to operationally define the IV—depression
treatment program. More specific operational definition information about the
three conditions of the IV—depression treatment program is presented next.

The cognitive-behavioral therapy condition was developed from a specific
psycho-educational program used for depression among adolescents. The pro-
gram teaches adolescents how to (1) monitor daily moods, (2) identify causes of
their moods, (3) discover and change personal negative beliefs, and (4) under-
stand how negative beliefs affect mood and behavior. The manualized CBT will
be delivered to the randomly assigned group of 48 adolescents in 90-minute
sessions once a week over eight weeks.

The second treatment condition, interpersonal therapy, will be administered to a
different group of 47 adolescents using the same session and time line format
as used for the CBT condition. IPT prevents depression by teaching
communication and social skills to maintain positive relations. IPT focuses
on interpersonal improvement related to life changes, interpersonal conflicts,
and interpersonal skill deficits.

The 50 adolescents participating in the no-treatment, waiting-list control
condition will receive the treatment (CBT or IPT) that demonstrates more
effectiveness when the study is completed. Additionally, the control group par-
ticipants will be monitored weekly as to their functioning and will have imme-
diate access to psychological assistance on their request.

The IV-depression treatment program is an active IV since it can be actively
manipulated by the research. The scale of measurement of the IV is discrete-
nominal (or categorical) as the conditions are designed to be mutually exclusive
from each other with no intended order.

Dependent Variable

The dependent variable (DV) is represented by symptoms of depression and is
expected to change as a result of the impact of the IV—depression treatment
program. The DV, symptoms of depression, in this study is operationally defined
as scores on the Center for Epidemiological Studies Depression Scale (CES-D).
The CES-D is a self-report measure comprised of 20 items. Each item measures a
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depressive symptom on a 4-point frequency scale over the prior week. For
example, an item is “I felt lonely” and the response format ranges from “Rarely or
none of the time (<1 day)” through “Most or all of the time (5—7 days).” Higher
scores on the CES-D represent higher depressive symptoms.

The CES-D scaled items are added together to form a composite scale that is
treated as a continuous-interval scale. The CES-D was administered to all par-
ticipants in the study prior to treatment and following treatment; however, we
will be analyzing the posttreatment scores only.

RESEARCH DESIGN

The research design used for this research example is a randomized posttest-only
control group design (Campbell & Stanley, 1963), also known as a randomized
design comparing two treatments and a control (Shadish, Cook, & Campbell,
2002), comparing the dependent variable results of two groups of adolescents
receiving different treatments and one group getting a no-treatment control
condition. This is an experimental group design involving random assignment of
participants to conditions, a manipulated independent variable, and use of a
no-treatment, waiting-list control condition. The design can be diagrammed as
follows:

R Xi O
R X5 0
R C @)

Each line in the diagram represents a group (three groups), and the R sym-
bolizes random assignment to each group condition. The conditions by groups
are represented by X; (CBT), X, (IPT), and C (Control). The observation (O) is
the posttest following eight weeks of treatment implementation using the CES-D

to measure differential change in depressive symptoms resulting from the dif-
ferent treatment conditions.

Statistical Analysis: One-Way Analysis of Variance (ANOVA)
A one-way ANOVA (also called a simple ANOVA) tests for significant differ-

ences between two or more means. Theoretically, one-way ANOVA assesses
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mean differences among groups (samples) drawn from different populations, one
population, or several identical populations. The one-way ANOVA is a mathe-
matical extension of the independent #test, and any number of means can
be tested for differences. In a one-way ANOVA there is one independent
variable (with two or more levels or conditions) and one dependent variable.
The dependent variable used in a one-way ANOVA must be continuously scaled
at the levels of interval or ratio. The following three underlying assumptions need
to be met in order to use the one-way ANOVA.

1. Normality. The scores on the dependent variable for each condition are
normally distributed around their mean.

2. Homogeneity of variance. The variances of the scores of the dependent variable
across the conditions should be constant.

3. Independence of observations. The observations are independent from one
another and not correlated with each other.

The one-way ANOVA is the basic statistic in the ANOVA family of statistics
that is the most used group of statistics in research. The term F-test is used to
denote the statistic in the ANOVA family. The symbol F was designated for
ANOVA statistics by Snedecor (1934) in honor of the founder of the ANOVA,
Sir Ronald Fisher.

There are several commonly used ANOVA family statistics. The multifactor
ANOVA (factorial ANOVA) analyzes the effects of two or more independent
variables on one dependent variable. The ANOVA statistic is referred to as a two-
way ANOVA if there are two independent variables used in the analysis and a
three-way ANOVA when there are three independent variables.

A repeated-measures ANOVA (RM-ANOVA) is used when there are
two or more measures obtained on the same participants or matched particip-
ants. A RM-ANOVA can have one or more independent and dependent
variables.

A multivariate ANOVA has one or more independent variables but more than
one dependent variable. Analysis of covariance (ANCOVA) is used to assess mean
differences using a covariate to control for an extraneous variable.
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PROGRESS REVIEW

1. The research problem that is focused on in this chapter
relates to comparing the effects of depression treatment
program (independent variable) operationally defined as
cognitive-behavioral therapy, interpersonal therapy, and a
waiting-list control condition on reducing depressive symp-
toms (dependent variable) among adolescents.

2. The 145 adolescent participants are randomly assigned to the
three treatment conditions using a randomized posttest-only
control group design.

3. The changes in depressive symptoms as operationally
defined as scores on the Center for Epidemiological Studies
Depression Scale (CES-D) will be assessed across the three
conditions (CBT, IPT, and Control) using a one-way analysis of
variance statistic.

4. Next, the research question is stated and we begin complet-
ing the steps of the hypothesis-testing process.

STATING THE OMNIBUS (COMPREHENSIVE)
RESEARCH QUESTION

The research question is typically stated before developing the alternative
(research) and null hypotheses. A research question needs to be succinct and
clearly stated so that people reading the research know what is being studied.
Moreover, the variables used in a research study should be identified in the
research question and suggest that they can be operational defined for the pur-
poses of measurement and analysis. The steps of the hypothesis-testing process
related to this research problem will be presented following the statement of the
research question.
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Omnibus Research Question (RQ)

Will there be significant mean differences in depressive symptoms (CES-D
scores) across the depression treatment programs (CBT, IPT, Control) following
treatment implementation?

HYPOTHESIS TESTING STEP 1: ESTABLISH THE
ALTERNATIVE (RESEARCH) HYPOTHESIS (H,)

The omnibus (comprehensive) alternative hypothesis for our research problem is
stated next in both narrative and symbolic formats. We also will be addressing
subquestions and subhypotheses following the overall analysis.

Omnibus Narrative Alternative Hypothesis (H,)

There will be significant lower mean depressive symptoms (CES-D scores)
between the depression treatment programs of CBT and IPT when compared to
the control condition following treatment implementation.

Symbolic H,

Hy: (g # 1p) <y

where  |; = population mean of depressive symptoms (CES-D) of partici-
pants in the CBT condition being estimated by the sample mean

Hy = population mean of depressive symptoms (CES-D) of partici-
pants in the /PT condition being estimated by the sample mean

i3 = population mean of depressive symptoms (CES-D) of partici-
pants in the Control condition being estimated by the sample mean

This is a directional alternative hypothesis because it is expected that both the
CBT and IPT treatments will significantly reduce depressive symptoms when
compared to the no-treatment control condition. However, there is no direction
hypothesized as to whether CBT or IPT will be more effective when compared to
each other in reducing depressive symptoms. In this study, we are taking the
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position that there is nonconclusive previous evidence to hypothesize that either
CBT or IPT will be superior to the other in reducing depressive symptoms.
However, there is evidence from the literature allowing us to state a direction
regarding the effectiveness of both CBT and IPT in reducing depressive symp-
toms compared to the control condition.

An alternative process to reach conclusions in analyzing one’s sample data is
following the recommendations of Jones and Tukey (2000). Act as if: (1) (u; —
H2) >0, (b1 — p3) >0, (2 — p3) > 05 (2) (11 — pa) <0, (b — p3) <0,
(Lo — p3) < 05 or (3) the sign (< 0 or > 0) of (11 — pa), (11 — P3), (o — p3) is
indefinite. Using this approach, we will be making conclusions about whether
omnibus and paired-mean differences are greater than zero or less than zero, or
that the findings are inconclusive about the whether one mean is greater or less
than zero. In this study, we are expecting that the CBT and IPT conditions will
produce lower scores on depressive symptoms compared to the control condition,
so we expect these conclusions to be that (u; — p3) < 0 and (uy — p3) < 0.
We do not have enough previous evidence to hypothesize whether CBT and IPT
will produce lower depressive symptoms when compared to each other, so we will
state that (ju; — o) is indefinite.

HYPOTHESIS TESTING STEP 2:
ESTABLISH THE NULL HYPOTHESIS (Hy)

The omnibus null hypothesis is stated in narrative and symbolic formats in the
second step of the hypothesis-testing process.

Omnibus Narrative Null Hypothesis (H,)

Hy: There will be no significant mean differences in depressive symptoms
(CES-D scores) across the depression treatment programs (CBT, IPT,
Control) following treatment implementation.

Symbolic H,

Hy:py = py = i3
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HYPOTHESIS TESTING STEP 3: DECIDE ON A RISK LEVEL
(ALPHA) OF REJECTING THE TRUE Ho CONSIDERING
TYPE | AND Il ERRORS AND POWER

During this step of the hypothesis-testing process, we choose an alpha criterion (o)
that we will use to make a decision about whether to reject a true null hypothesis
(Hp). In choosing cv, we will consider Type I (alpha) error, which is the probability of
rejecting Hy (mean differences) when in fact (theoretically) it is true (no mean
differences). To balance making a Type I error, we need to also consider the making
a Type II (beta) error, which is the probability of failing to reject Hy (no mean
differences) when it is in fact (theoretically) false (mean differences).

Then, we will use our chosen « level and combine it with anticipated sample
size and an estimated (a priori) effect size and determine if we have enough power
to conduct the study. Power is the probability of correctly rejecting a false null
hypothesis.

Selecting Alpha («) Considering Type | and Type Il Errors

One decision we need to make before collecting and analyzing data to test the
omnibus null hypothesis () is to choose a risk level we are willing to take in
rejecting an H, (identifying a difference in means) when the H, is true (there is
no difference in means). This decision is referred to as setting the alpha level (o).
This decision is also called establishing a level of significance or setting the alpha
criterion.

We will choose a level for o from .001, .01, .05, or .10, following common
practice. The closer the chosen alpha is to .000, the stricter it is because the Hj is
more difficult to reject. Thus, an alpha of .001 (1 time in a thousand) is very strict,
and o« = .01 (1 time in 100) can be viewed as strict. In contrast, an o = .05
(5 times in 100) is somewhat strict and o = .10 is less strict as risk levels in
rejecting the null hypothesis.

There have been a few previous studies (see Horowitz & Garber, 2006)
showing that CBT and IPT are effective in reducing depressive symptoms among
adolescents when compared to a no-treatment control, but neither treatment has
demonstrated superior effectiveness over the other.

A somewhat strict alpha of .05 will be used in this study to test the Hy, since
there have been a limited number of previous studies conducted demonstrating
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the effectiveness of CBT and IPT on depressive symptoms in adolescents. There
is not enough evidence yet concerning the pattern of mean differences in studies
comparing CBT and IPT to each other and to a control condition. Thus, we will
not use a stricter (.001 or .01) alpha level since we do not want, at this point, a
criterion level that more closely differentiates a decision about the degree of
differences between conditions on depressive symptoms.

An alpha of .05 provides a reasonable balance between avoiding rejecting the
Hjy when there really is no significant difference in the means (Type I [alpha]
error) and not rejecting the A, when there really is a significant difference in
means (Type II [beta] error).

A Priori Power Analysis

It is important to assess if key elements are in place to find a significant difference
in means on the dependent variable across the conditions if it exists before we
conduct the study (a priori) or data analysis. Therefore, we will conduct an «
priori power analysis that is the probability associated with correctly rejecting
a false null hypothesis (see Figure 3.1 from previous Chapter 3). Initially, the a
priori power analysis is conducted before participants are selected and assigned to
conditions so that decisions can be made about study modifications such as
increasing sample size before the study actually begins. If the selected number of
participants is lower than the number of participants planned prior to selection,
then power analysis is conducted again to see if it is acceptable. In our example,
we are going to conduct an a priori power analysis after participant selection and
assignment to condition before the data are analyzed.

The three key elements used to conduct an a priori power analysis are alpha,
sample size, and estimated (a priori) effect size. We can combine these three
elements together mathematically and determine if our planned alpha, sample
size, and estimated effect size for our proposed study converge into an acceptable
probability (power) necessary to find a significant difference in means if it exists.
It is not in a researcher’s best interest to go ahead and conduct the study if
these three elements combined do not create a probability that maximizes the
emergence of treatment effects in a study if they exist. This could result in making
a Type II error, which is the probability of not finding a significant difference
when there really is a difference—in other words, failing to reject the Hy when it
is false.
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We have decided to use an alpha of .05 and we are planning on using a
sample size of 145. Now we need to estimate an effect size and then we can
combine the three elements to identify the probability of correctly rejecting a false
null hypothesis (power). An effective method for estimating an effect size for the a
priori power analysis is to use effect sizes resulting from previous studies that use
variables and designs similar to the ones we will use in our study.

We are going to use findings obtained from four previous studies that focused
on assessing the effects of either CBT or a combination of CBT and IPT on
depression improvement among adolescents. The four studies produced the
following post hoc effects sizes using ezm-squared m?): 1° = .11 (N =21),
N’ = .13 (N = 94), 0* = .32 (N = 41), and 1* = .61 (N = 59). We can get
an accurate measure of central tendency (mean) of the four effects sizes by
weighting them by their sample sizes (i.e., weighted by sample size).

Weighted by Sample Size Average nz

Next, we will calculate a weighted average m” that we will combine with our
sample size and alpha for use in calculating power.

, 21(.11) + 94(.13) + 41(.32) + 59(.61)

215
2,310 + 12.220 + 13.120 + 35.990
215
_ 63.640
215

M = .296 (This is the weighted by sample average 1’

from four previous studies.)

Conversion to Cohen’s Effect Size (f)

So, we now have an estimated effect size (T]2 = .296). We will next convert the
average 1 to another effect size fusing the formula identified by Cohen (1988).
This conversion will allow us to use several procedures developed by Cohen for
analysis and interpretation.
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f= V-7
_ /2961 = 29
_ 296/ 704
— /420

f = .648

*In our problem, 1’ is the average 1° of four previous studies.
P g P

Power Analysis Using G*Power 3.1.2

A useful method to conduct a power analysis is to use a computer program called
G*Power 3.1.2, developed by Erdfelder, Faul, & Buchner (2010). Conduct the
following steps (see Figure 7.1).

1.

Y © N oW

10.
11.
12.
13.
14.

Create a folder on your desktop called gpower.

2. Google G*Power.
3.
4

. Then, click on Download and register; click on the download and save to

Click on G*Power3 is now available.

your folder.

Double click on a created folder called GPower3.

Double click GPOWER 3.1.2 link.

Under Test family > select F tests.

Under Statistical test > select ANOVA: Fixed effects, omnibus, one-way.

Under Type of Power Analysis > select A priori: Compute required
sample size—given o, power, and effect size.

Type in beside Effect size f 0.648.

Type next to o err prob 0.05.

Type next to Power (1—3 err prob) 0.80.
Type next to Number of groups 3.

Click on the Calculate button and you will see that we need a total sample
size = 27 to reach an actual power of 0.8145419.
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FIGURE 7.1 A Priori Power Analysis of ANOVA Problem

File Edit View Tests Calculator Help
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Type of power analysis
IA priori: Compute required sample size - given o, power, and effect size vl
Input Parameters Output Parameters

Effect size f 0.648 Noncentrality parameter A 11.3374080
o err prob 0.05 Critical F 3.4028261

Power {1-p err prob) 0.80 Numerator df 2

Number of groups 3 Denominator df 24

Total sample size 27

Actual power 0.8145419

[ X-Y plot for a range of values ] I Calculate ]

Our total sample of 145 far exceeds a needed sample size of 27. Considering the
combined elements in our study of total sample size of 145, f = .648,and o = .05,
a power greater than .80 should be achieved. Therefore, we should be confident in
correctly rejecting a false Hj in our study and thus avoid making a Type II error.
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PROGRESS REVIEW

1. We stated the research question for the study problem.

2. We completed the first two steps of the hypothesis-testing
process by stating the alternative and null hypotheses in
narrative and symbolic formats.

3. Next, we decided on the risk we are willing to take when
rejecting a true null hypothesis by choosing alpha (o).
We chose a = .05, which we believed was a reasonable cri-
terion in our study to avoid making a Type | or Type |l error.

4. We conducted a power analysis to make sure that our prob-
ability of correctly rejecting a false null hypothesis in favor
of an alternative hypothesis was adequate (power =.80)
before moving ahead with the study. We found that we had
adequate a priori power using an online power analysis pro-
gram (G*Power). This provided information necessary to
continue on with the study.

HYPOTHESIS TESTING STEP 4: CHOOSE
APPROPRIATE STATISTIC AND ITS
SAMPLING DISTRIBUTION TO TEST THE Hy
ASSUMING Ho IS TRUE

We will be using a one-way ANOVA to test the null hypothesis: Hy: p; =
My = ps. We are going to compare the means of depressive symptoms across
the conditions (CBT, IPT, and Control) for significant differences using the
F-distribution. The one-way ANOVA is appropriate to use because: (1) there is
one independent variable, (2) there are different participants in each independent
condition group, (3) there is one dependent variable, and (4) the dependent
variable is continuously scaled.
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HYPOTHESIS TESTING STEP 5: SELECT SAMPLE, COLLECT
DATA, SCREEN DATA, COMPUTE STATISTIC, AND
DETERMINE PROBABILITY ESTIMATES

Data are collected from a sample of participants during Step 5 of the hypothesis-
testing process. The data are assessed for data accuracy, missing values, and uni-
variate outliers, and to determine if the underlying assumptions of the statistic are
met. If needed, data modifications are made. Then the omnibus null hypothesis is
tested using statistical analyses.

Sample Selection and Assignment

The sample in this study is selected using purposive sampling of typical instances
(Shadish, Cook, & Campbell, 2002). In purposive sampling of typical instances,
we define the characteristics that reflect the persons, settings, times, independent
variables, and dependent variables we intend to generalize in our findings.
We then select participants who match the targeted characteristics. We can also
use inclusion criteria and exclusion criteria to assist in the matching process for
congruence to the targeted characteristics. Moreover, the use of exclusion criteria
can help us assess whether the participants are appropriate and safe as they engage
in the study conditions.

Adolescents with symptoms of mild depression in eighth and ninth grades
living in suburban, middle-class communities in the Southwest United States
during the 2012 fall semester were targeted for this study. Following necessary
Institutional Review Board (IRB) approvals, school district professionals referred
students for participation in the study.

The students were interviewed and assessed prior to being selected for the
study. They needed to meet the inclusion criteria of: (1) being an eighth or ninth
grade student in the school district, (2) having mild symptoms of depression as
measured by having a score between 14 and 19 on the Beck Depression Inventory
IT (BDI-II), (3) assenting or agreeing to participate in the study, and (4) having
parental consent to participate.

Students were excluded from participating in the study if they: (1) had a
co-occurring medical or physical condition, (2) were currently receiving psy-
chological treatment, (3) were currently using medication for a behavioral
or neurological disorder, (4) had current thoughts or past history of suicide
ideation, or (5) were currently involved in substance abuse. The school district

144 o« CHAPTER 7



professionals referred 160 eighth and ninth grade students for participation in the
study. Before random assignment to condition, 10 participants were determined
to be not eligible for the study because they met exclusion criteria related to
having a co-occurring medical or physical condition, receiving psychological
treatment, or using medication for a behavioral or neurological disorder. The
remaining 150 participants in the sample were randomly assigned to three groups
using a table of random numbers to receive one of three treatment conditions.
Following assignment to condition, two persons in the CBT condition and three
persons in the IPT chose to discontinue before the study began, leaving a sample
of 145. This resulted in the following number of participants in each treatment

condition group: CBT (n; = 48), IPT (n, = 47), and Control (73 = 50).

Study Data Diagnostics

Diagnostic assessments are conducted on the sample data after it has been col-
lected but before the primary study hypothesis is tested. The purposes of daza
diagnostics (also called exploratory data analysis, data screening, or data prepara-
tion for analysis) are to: (1) check accuracy of data entries, (2) identify and deal
with missing data (missing data analysis), (3) detect and make decisions about
univariate (one dependent variable) outliers, and (4) screen and make decisions
about univariate parametric assumptions. The underlying assumptions of a one-
way ANOVA are that the dependent variable is normally distributed (normal
enough), the group variances and error variances of the dependent variable are
equal (not exactly equal but equal enough), and all observations are independent
from each other. There are several measures to assess normality, homogeneity of
variance, and independence. Screening measures have limitations as to their
usefulness given various conditions of a study. We will therefore look at several
screening measures to assess underlying assumptions and use a preponderance of
evidence to make a decision about whether the underlying assumptions were met.

Accuracy of Data Entry

The original data were compared to the entered data by two members of the
research team. The accuracy of the data was corroborated by the two researchers.
Moreover, the variable scores were in the expected range, and the means and
standard deviations appeared plausible.
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Missing Data Analysis

There were no missing data in the original data set.

Means, Standard Deviations, Variances, and Assessing for Univariate
Outliers IBM SPSS Commands

Enter the data from the One-Way Analysis of Variance Data table at the end of
this chapter into IBM SPSS. Enter the data into three columns just as it appears
in the table.

1. Click on Data > Split File > click on circle beside Organize output by
groups > click on Condition and click the arrow so that Condition is under
Groups Based on > click on OK and don’t save command output. You
have told the program to provide output by the three groups (Condition).
You will need to change this command back later.

2. Click on Analyze > Descriptive Statistics > Descriptives > click over
DepSymptoms to Variable(s) > click on Save standardized values as vari-
ables > click on Options and check Minimum, Maximum, Mean, Std.
deviation, and Variance > click on OK > save the output as ANOVA
Descriptives.

The Descriptive Statistics table (Table 7.1) lists the sample size of each
group followed by the lowest (minimum) and highest (maximum) scores in
each group. Valid V refers to the number of participant scores that do not having
missing data. The average scores (means) by groups on the CES-D following
treatment are provided. Measures of variability designate how the scores in each
group distribution deviate from their group mean. The standard deviation is an
average measure of score deviations from the mean, whereas the square of s is the
variance (s°) or general spread of scores from the mean. Higher scores reflect more
deviation of scores from the mean for both s and s°. As you can see, there is a
higher deviation of scores from the mean for the control group followed by the
CBT and IPT groups.

The standard values (z-scores) requested for the analysis to assess for uni-
variate outliers are produced in a new column on the Data View spreadsheet and
named ZDepSymptoms. These values represent the z-scores corresponding to the
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TABLE 7.1 Descriptive Statistics of Depressive Symptoms by Condition
Group

Condition = CBT

Descriptive Statistics®

N  Minimum Maximum Mean Std. Deviation Variance
DepSymptoms 48 7.00 33.00 17.3333 6.22737 38.780
Valid N (listwise) 48

Condition = IPT

Descriptive Statistics®

N Minimum Maximum Mean Std. Deviation Variance
DepSymptoms 47 5.00 32.00 17.0213 5.99452 35.934
Valid N (listwise) 47

Condition = Control

Descriptive Statistics®

N  Minimum Maximum Mean Std. Deviation Variance
DepSymptoms 50 10.00 35.00 21.6800 7.14697 51.079
Valid N (listwise) 50

2 Condition = CBT
P Condition = IPT
€ Condition = Control

TABLE 7.2 Highest +z-Scores by Condition Group

Condition Highest +z Outlier? > £3.29 Highest —z Outlier? > £3.29

CBT 2.516* No —1.659 No
IPT 2.499 No —2.005 No
Control 1.864 No -1.634 No

* This number is rounded to three decimals.

raw scores in each group : CBT (rows 1—48), IPT(rows 49—95), and Control
(rows 96—145). The three highest positive and negative z-scores for each group
are reported in Table 7.2. For example, the highest +z score for CBT is 2.516
(rounded up to three decimal places) and is obtained by subtracting the raw score
(33) from the CBT group mean (17.333) and dividing by the CBT group
standard deviation (6.227).
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33 —17.333 +15.667
Z = = = 42.516
6.227 6.227 25

We are going to use as a criterion =3.29 (<.001, two-tailed) to compare our
z-scores, following a recommendation by Tabachnick and Fidell (2007). On the
normal curve, only .001 (1 one-thousandth) of the curve remains beyond a z-score
of *£3.29, and for a two-tailed test, only .0005 remains in either tail. So, any
z-score representing a raw score from a group on the dependent variable of
depressive symptoms greater than *3.29 is indeed an extreme score (univariate
outlier). Since the highest positive and negative z-scores for each group are less than
*+3.29, there are no univariate outliers within any of the three groups using the
p < .001, two-tailed test criterion. No individual score within a group is too far
removed from the rest of the group’s scores, given the criterion that we have selected.

At this point, remove the Split File filter. Data > Split File > click on the
Reset button and then click OK; click out of the output and don’t save it.

Assessing for Underlying Assumptions

Certain underlying assumptions must be present in order to apply various statistical
analyses to data sets. Two important underlying assumptions for many parametric
statistics are that the dependent variable is normally distributed and that there are
equal variances and error variances across groups. We are going to use several
measures to assess both normality and homogeneity of variance and evaluate the
preponderance of evidence to determine if we have met these underlying assump-
tions. First, we will evaluate the dependent variable (depressive symptoms) for
normality by assessing histograms, skewness, kurtosis, the Shapiro-Wilk statistic,

and normal Q-Q plots.

Normality IBM SPSS Commands
1. Analyze > Descriptive Statistics > Explore.

2. Click over dependent variable DepSymptoms to Dependent List.

3. Click over independent variable (Condition) to Factor List. Factor is
another term for independent variable.

4. Do not change Display choices—leave on Both.
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5. To the upper right of Display are three buttons. Click on Plots. Then,
select Normality plots with tests.

Under Spread vs. Level with Levene Test click on Untransformed.
Click on Continue.

Click on OK.

Y © N

Save the output as assumptionscreen.

First, look at the information under Descriptives on the output (see
Table 7.3), you will notice that there are several descriptive statistics provided
relative to depressive symptoms for each of the three condition groups. For
example, means, standard deviations, and variances are provided for each group,
and these match the values that you identified in a previous analysis.

You also see values for skewness and “Std. Error” for each group. When you
divide the skewness statistic value by its standard error value, the resulting value is
a z-score. The skewness and standard error and their resulting skewness z-scores
are presented in Table 7.4.

A positively skewed (right-skewed) curve has most of the scores at the lower
values of the horizontal axis, and the curve tails off toward the higher end. Thus,
more extreme scores relative to most of the scores in the distribution are in the
positive (right) end of the distribution.

A negatively skewed (lefi-skewed) distribution has most of the scores at the
higher values, and the curve tails off toward the lower end of the horizontal axis.
Thus, more extreme scores relative to most of the scores in the distribution are in
the negative (left) end of the distribution.

If a skewness z-score value is at or near 0, the distribution is symmetrical and
considered normal or near normal. When the skewness z-score value is positive, there
is some degree of skew in the positive (right) side of the curve but not necessarily a
significant skew. A negative skewness z-score value suggests some degree of skew in
the negative (left) side of the curve but again not necessarily a significant skew.

The skewness z-scores are compared to the same criterion that we used to
determine univariate outliers, =3.29 (p < .001, two-tailed test). The distribu-
tion of raw scores on the dependent variable (depressive symptoms) for each
condition group (CBT, IPT, and Control) does not significantly depart from
normality using our criterion, as is evident when you compare the calculated
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TABLE 7.3 Skewness, Kurtosis, and Standard Error Values by Group

Descriptives

Condition Statistic Std. Error
DV CogBehav Mean 17.3333 .89884

95% Confidence Lower Bound  15.5251

Interval for Mean  Upper Bound 19.1416

5% Trimmed Mean 17.0648

Median 16.5000

Variance 38.780

Std. Deviation 6.22737

Minimum 7.00

Maximum 33.00

Range 26.00

Interquartile Range 9.50

Skewness 613 343

Kurtosis —.022 674
IPI-AST Mean 17.0213 .87439

95% Confidence Lower Bound  15.2612

Interval for Mean  Upper Bound 18.7813

5% Trimmed Mean 16.8570

Median 16.0000

Variance 35.934

Std. Deviation 5.99452

Minimum 5.00

Maximum 32.00

Range 27.00

Interquartile Range 8.00

Skewness .524 347

Kurtosis .014 .681
Control Mean 21.6800 1.01073

95% Confidence Lower Bound  19.6489

Interval for Mean  Upper Bound 23.7111

5% Trimmed Mean 21.6556

Median 21.0000

Variance 51.079

Std. Deviation 7.14697

Minimum 10.00

Maximum 35.00

Range 25.00

Interquartile Range 12.25

Skewness .093 337

Kurtosis —1.143 .662
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TABLE 7.4 Skewness z-Scores by Condition Group

Skewness z (Stat./ Skewness Sig. Departure?
Condition Std. Error = 2) Direction (> +£3.29)
CBT .613/.343 = 1.787 Positive No
IPT .524/.347 = 1.510 Positive No
Control .093/.337 = 276 Positive No

TABLE 7.5 Kurtosis z-Scores by Condition Group

Kurtosis z (Stat./ Kurtosis Sig. Departure?
Condition Std. Error = 2) Direction (> £3.29)
CBT —.022/.674 = —.033 Platykurtic No
IPT .014/.681 = .021 Leptokurtic No
Control —1.143/.662 = —1.727 Platykurtic No

skewness z-score values from Table 7.4 to the criterion of =3.29. For example,
we found the highest skewness z-score to be +1.787, which is considerable lower
than our criterion of +3.29.

Below the skewness and standard error values in output reported in Table 7.3
are the “Kurtosis” and “Std. Error” values. We will divide the kurtosis statistic by
its standard error and compare the z-score resultant to a =3.29 to see if any group
distribution significantly departs from normality. (See Table 7.5.)

Kurtosis is the clustering of scores in the center, the upper and lower ends
(tails), and the shoulders (between the center and the tails) of a distribution
(Norusis, 1994). A distribution that is symmetrical and normal is mesokurtic and
will have a z-score around 0. A positive z-score indicates that the distribution is
more /eptokurtic with a shape that is more narrow and peaked. However, just having
a positive z-score does not mean that the distribution is significantly departing from
normality. A platykurtic shape generates a negative z-score and the distribution is
more broad and flat, but it is not necessarily significantly departing from normality.
None of the three condition group distributions have kurtosis z-scores that are
greater than *£3.29, so they do not depart significantly from normality.

The Shapiro-Wilk (S-W) statistic is another source of evidence to use to
determine if the distribution of the group conditions are normally distributed.

RANDOMIZED DESIGN USING ONE-WAY ANOVA e 151



TABLE 7.6 Shapiro-Wilk Statistics by Condition Group

Tests of Normality

Kolmogorov-Smirnov?® Shapiro-Wilk
Condition Statistic df Sig. Statistic df Sig.
DV CogBehav 145 48 .013 .961 48 107
IPI 159 47 .005 967 47 196
Control .092 50 .200* 952 50 .043

2 Lilliefors significance correction.
* This is a lower bound of the true significance.

The S-W statistic is found in the output under 7ests of Normality (see Table 7.6).
First, we are going to state a null hypothesis to test using the S-W with an

alpha of .05.

Hj : The Sample Distribution = Normal

More often than not, when we test a null hypothesis we want to reject it to
demonstrate a significant difference or relationship. Interpreting the results of the
S-W statistic is an example of when we want to retain the null hypothesis, which
says that the sample distribution that we are testing is not deviating significantly
from being normal.

In the output table called 7ests of Normality, you see values associated with
the Shapiro-Wilk statistic, 4f; and “Sig.” We fail to reject the null hypotheses for
the condition group distributions of the CBT and IPT groups since the signif-
icant probability levels (“Sig.”) of the Shapiro-Wilk statistic are .107 and .196,
which are greater than o = .05. The rule is to reject a null hypothesis if the
probability level of the calculated statistic is less than our stated alpha level and we
fail to reject the null if our significance probability is greater than our alpha. Thus,
we conclude that these two group distributions are not deviating significantly
from being normal. However, the significant probability value of .043 for the
Control group is lower than o = .05; therefore, the null is rejected, suggesting
that the distribution is not normally distributed.

The final evidence of normality that we will interpret is the normal Q-Q plot
for each distribution. A plot for each group is located in the output under the
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FIGURE 7.2 Normal Q-Q Plot of Depressive Symptoms for CBT Group

Normal Q-Q Plot of DepSymptoms
for Condition = CBT
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heading Normal Q-Q Plots. An observed value in the distribution is paired with
its expected value from the normal distribution to form the normal Q-Q ploss.
The number of cases in the sample and the rank order of the cases in the sample
are used to generate the expected values for the normal distribution. If the
sample is from a normal distribution, we expect that the points will fall more or
less on a straight line (see Figures 7.2, 7.3, and 7.4).

The vast majority of points on the Q-Q plots in all three condition group
distributions fall on or near the straight line, providing further evidence that each
group is normally distributed.

Summary of the Normality Evidence

There were no univariate outliers identified within the distributions of the three
condition groups. The skewness z-scores, kurtosis z-scores, and Q-Q plots pro-
vided support that the three distributions are not deviating significantly from
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FIGURE 7.3 Normal Q-Q Plot of Depressive Symptoms for IPT Group

Normal Q-Q Plot of DepSymptoms
for Condition = IPT
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normality. The S-W statistic was satisfactory for the CBT and IPT distributions
but less than satisfactory for the Control group distribution. Despite the S-W
statistic finding for the Control group, the preponderance of evidence suggests
that the three distributions are normal enough to clearly meet the underlying
assumption of normality.

Homogeneity of Variance

In this study we are expecting that the independent variable (depression treat-
ment program) will affect the means of the dependent variable (symptoms of
depression) but not the variances of the groups. We want the variances of the
three groups (CBT, IPT, and Control) on the dependent variable to be relatively
constant. We are going to look at two methods to assess whether the variances are
equal enough across the condition groups. The first method is called the variance
ratio (Fnay), which is the ratio of the largest group variance to the smallest group
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FIGURE 7.4 Normal Q-Q Plot of Depressive Symptoms for Control Group

Normal Q-Q Plot of DepSymptoms
for Condition = Control
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variance within the three condition groups. This provides a simple descriptive
statistic for initial screening. If the ratio of group sizes is less than 4.0, then an
Fnax as high as 10.0 is acceptable. When the ratio of group sizes goes to 9.0, then
an F,, of 3.0 is acceptable (Tabachnick & Fidell, 2007).

The Control group had the largest number of participants at 50, and the
IBT had the smallest group size of 47 (see Table 7.1). The group size ratio is
50/47 = 1.064; this is well below a group size ratio of 4.0, so we can apply the
Frax = 10.0 guideline.

The Control group had the highest variance of 51.079, and the IPT group
showed the lowest variance of 35.934. The F,,,, = 51.079/35.934 = 1.421 and
is well below 10.0. The low variance ratio supports homogeneity of variance
across the groups. We will next corroborate this finding with another measure of
homogeneity of variance known as Levene’s test.

We will test the following null hypothesis of equality of the error variances
across the three groups when using Levene’s test of homogeneity of variance.
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TABLE 7.7 Levene’s Test of Homogeneity of Variance

Test of Homogeneity of Variance

Levene’s Statistic dfl drf2 Sig.

DepSymptoms Based on mean 2.034 2 142 135
Based on median 1.826 2 142 165
Based on median and 1.826 2 141.911 165
with adjusted df
Based on trimmed mean 2.060 2 142 131

We want to retain the null hypothesis concluding that the variances across the
three groups are equal enough using an alpha criterion of .05.

L2 2 2
Ho: 0, cpr = 0, 1p1 = 9 Control

The Levene’s statistic is found in the “assumptionscreen” output under the
heading Test of Homogeneity of Variance (see Table 7.7) on the line called “Based
on the Mean.”

We fail to reject the Hj that the error variances are equal since the probability
value of .135 is greater than the o = .05. The underlying assumption of
homogeneity of variance has been met using Levene’s statistic.

Summary of the Homogeneity of Variance Evidence

The evidence from both the variance ratio (#,.,) and Levene’s statistic provide
support that the variances and error variances are equal enough across the three
condition groups. There is no alarming disparity in group sizes among the groups,
so we will conclude that the underlying assumption of homogeneity of variance
has been met.

Independence

There are different participants in each of the three groups, and each participant’s
score was produced independent of the other scores. If dependent variable test
scores across condition groups are correlated with each other when the scores are
collected in the same order, the significance level of the ANOVA can be smaller
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than it should be (Norusis, 2003). We are going to assess the independence of

observations by graphing the responses of participants on the dependent variable

by group condition based on the same order in which measurements (observa-
tions) were obtained. The data in the SPSS Data View spreadsheet are in a similar
order by group based on when the data were collected. We will need to create

three columns of data to complete the matrix scatter plot analysis to assess

independence.

Matrix Scatter Plot IBM SPSS Commands

1.

First, close all output that you have been working on. Under the column
labeled DepSymptoms on the IBM SPSS Data View spreadsheet, left click and
hold on the first cell, which is 76, and drag down until you reach row 48,
which happens to be another /6 and the last participant score in the CBT
group (condition I). All of the numbers should be in bold.

At the top of the screen, click on Edit and then Copy. This will copy the

data for pasting to a new column.

Go to the first empty column (var), click on the first cell, and it will be

bolded.

At the top of the screen, click on Edit and then click on Paste and the data
from the CBT group will be copied to the new column.

At the bottom left of the spreadsheet, click on Variable View and then name
the new column as CBT and change the decimals to 0.

Click on the Data View button and create a new column for the 47
IPT DepSymptoms scores (Condition 2) and a new column for the 50
Control scores (Condition 3) in the same way. Once you have completed the
three new columns, File > Save.

At the top of the screen, click on Graphs > Legacy Dialogs > Scatter/
Dot > Matrix Scatter > Define.

Click over the three new columns (CB7, IPT, and Control) to the space
under Matrix Variables > OK.

The matrix scatter plot (Figure 7.5) shows the scores of each group compared

to the other groups. The scores are in the order they were obtained and are paired
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FIGURE 7.5 Matrix Scatterplot to Assess Independence
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as circles in each graph representing two groups being compared. If the scores
form a diagonal straight line when any two groups are compared, then the
scores are correlated and not independent. There appear to be no serious linear
trends between paired scores across the groups. The points scatter in many
directions. Therefore, we will conclude that we have met the assumption of
independence.

Summary of the Underlying Assumptions Findings

The preponderance of evidence assessed demonstrates that the distributions of
scores on the dependent variable in the three condition groups did not deviate
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from normality. Both measures of homogeneity of variance supported fulfill-
ment of the assumption of equality. Finally, the scatter plots suggest that
independence of dependent variable scores was met. This information provides
an endorsement to conduct the one-way analysis of variance statistic to test the
omnibus null hypothesis in this study.

PROGRESS REVIEW

1. Data were collected from the study participants on the
dependent variable (depressive symptoms) using the CES-D
after the eight-week treatment of the 145 participants who
were randomly assigned to one of the three condition groups
(CBT, IPT, Control).

2. Problems with data accuracy and missing data were ruled out
in the early steps of the data-screening process.

3. The distributions of CES-D scores of the condition groups
were assessed for compliance to meeting the underlying
assumptions of using the one-way ANOVA. The evidence
showed that CES-D distributions of scores on the condition
groups met normality, homogeneity of variance, and inde-
pendence assumptions. The positive results of this screening
assessment allow us to conduct the one-way ANOVA to
determine the effects of the treatment conditions (CBT, IPT,
Control) on depressive symptoms as measured by the CES-D.

One-Way Analysis of Variance of the Omnibus Hp

One-Way ANOVA IBM SPSS Commands

1. Click Analyze > click General Linear Model > click Univariate > click
over DepSymptroms under Dependent Variable and Condition under Fixed
Factor(s).
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2. Click on the Plots button > click Condition to Horizontal Axis > click the
Add button > click Continue.

3. Click on Post Hoc button > click over Condition to Post Hoc Tests
for > click on the box next to Tukey and then Continue.

4. Click on the Options button > click on the boxes for Descriptive statis-
tics, Estimates of effect size, and Observed power > the Significance level
should be .05 > click on Continue > click OK.

5. Save generated output as ANOVA Results.

The results of this analysis provide information to test the omnibus null
hypothesis of the study:

Hy: There will be no significant mean differences in depressive symptoms
(CES-D scores) across the depression treatment programs (CBT, IPT,

Control) following treatment implementation.
Hy: py = g = 1

The results of the one-way ANOVA are presented next. Additionally,
interpretations are provided for the magnitude of treatment effects (effect sizes),
post hoc power, post hoc multiple comparisons of means, and confidence
intervals for the mean differences.

One-Way ANOVA Results

In the ANOVA output labeled 7ests of Between-Subjects Effects you will see the
name of the independent variable (Condition) under the heading Source that
we created when the data were entered (see Table 7.8). We will be using the
information in this row to make a decision about rejecting the null hypothesis.

The one-way ANOVA statistic is in the F column (F = 7.909) and the
Fostatistic is significant at the p = .001 probability level from the Sig. column.
The criterion that we selected to make a decision about rejecting the null
hypothesis was o = .05. The significant statistic probability of .001 is less than
o = .05, so the decision is to reject the null hypothesis that the population’s
means that we are estimating with sample means are equal. There is a less than 5
percent chance that we rejected a true Hy (p < .05). Only five times in 100
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TABLE 7.8 One-Way Analysis Results

Tests of Between-Subjects Effects

Dependent Variable: DepSymptoms

Type Il

Sum of Mean Partial Eta Noncent. Observed
Source Squares df Square F Sig. Squared Parameter Power®
Corrected model 665.985° 2 332.992 7.909 .001 .100 15.818 .951
Intercept 50,553.552 1 50,553.552 1,200.732 .000 .894 1,200.732 1.000
Condition 665.985 2 332.992 7.909 .001 100 15.818 .951
Error 5,978.525 142 42.102
Total 57,518.000 145
Corrected total 6,644.510 144

2 R-squared = .100 (adjusted R-squared = .088)

P Computed using alpha = .05



would there be no difference between means. If one repeatedly took three ran-
dom samples from the same population and tested the differences between their
means, one would expect to get a difference that was significant at the .05 level
about five times in 100 (Nickerson, 2000).

Thus, there is a significant difference among the means of the three groups
(CBT, IPT, and Control) on depressive symptoms. We can write this finding of
the omnibus hypothesis as /(2, 142) = 7.909, p < .05. The value 2 represents
the degrees of freedom associated with the treatment (Condition) and the 142
reflects the degrees of freedom associated with error. The p symbol could also be
stated as p = .001 since an o = .05 was stated before the data were analyzed,
which allows for a comparison between the alpha criterion and the derived sta-

tistic probability.

HYPOTHESIS TESTING STEP 6: MAKE DECISION
REGARDING THE Ho AND INTERPRET POST HOC
EFFECT SIZES AND CONFIDENCE INTERVALS

We can conclude, at this point, that there are mean differences in depressive
symptoms somewhere across the condition groups. We will assess where the mean
differences are among the three possible paired means after interpreting the
magnitude of treatment effect and post hoc power.

Magnitude of Treatment Effect—Post Hoc Effect Size

Again refer to the Tests of Between-Subject Effects table of the ANOVA results
output (see Table 7.8). You see an eta-squared value (n2 = .100) on the Con-
dition line next to the Sig. value. Eta-squared is a measure of practical significance
and is referred to as a post hoc effect size or magnitude of treatment effect. Eta-
squared values range from 0 (small) to 1.0 (large).

It is a ratio of the variance explained by the independent variable in relation to
the total variance. The term partial eta-squared is most relevant when an ANOVA
design results in analyses of several independent variables and interactions
between the independent variables.

There are several different effect sizes, and nz is one that is commonly used.
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We can interpret the > = .100 by converting the fraction to a percentage by
moving the decimal two spaces to the right, and can report that approximately
10 percent of the change in the dependent variable (depressive symptoms) can be
attributed to the independent variable (depression treatment program). The
n* = .100 has a medium strength effect according to Cohen’s convention for 1>
where approximately 1 percent to 6 percent is small, >6 percent to 14 percent is
medium, and >14 percent is large. There is clearly a meaningful magnitude of
treatment effect of the depression treatment program on decreasing depressive

symptoms.

Post Hoc Power

You remember that we estimated the probability of correctly rejecting a false null
hypothesis prior to conducting the study resulting in a priori power results
conducive to conducting the study. The observed post hoc power after the study
was conducted is reported in the Between-Subjects Effects output under Observed
Power for Condition (see Table 7.8). The post hoc power is .951, indicating that
given a post hoc effect size of .100, an o of .05, and a sample size of 145, the
probability is approximately 95 times in 100 that we correctly rejected a false null
hypothesis. So, the a priori power analysis results were a good prediction and
quite congruent with our post hoc power = .951 in the probability of correctly
rejecting a false null hypothesis. The actual effect size (post hoc) generated in this
study of .100 is lower than the estimated (a priori) effect size of .296. However,
the a priori power was more than sufficient in this study.

Post Hoc Multiple Comparisons of Means

We have concluded that there is an overall significant difference among the group
means of depressive symptoms resulting from the depression treatment program
(CBT M = 17.333, IPT M = 17.021, Control M = 21.680). It also is useful to
find out specifically which pairs of group means are different from each other.
The results of a posthoc analysis of multiple mean comparisons are interpreted
next using the Tukey honestly significant difference (HSD) statistic. The Tukey
HSD is a commonly used post hoc analysis technique used for all pairwise
comparisons of means (Norusis, 2005).
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TABLE 7.9 HSD Post Hoc Analysis

Multiple Comparisons

DepSymptoms Tukey HSD

95% Confidence

Interval
Mean

O} J) Difference Std. Lower Upper
Condition Condition -J) Error Sig. Bound Bound
CBT IPT .31 1.332 .970 —-2.84 3.47

Control =4l 55" 1.31 .003 —7.45 —-1.24
IPT CBT =3 1.332 .970 —-3.47 2.84

Control —4.66* 1.318 .002 -7.78 -1.54
Control CBT 4.35* 1.311 .003 1.24 7.45

IPT 4.66* 1.318 .002 1.54 7.78

Based on observed means.
The error term is Mean Square(Error) = 42.102.
* The mean difference is significant at the .05 level.

You recall that the omnibus alternative hypothesis stated that there will be
significant lower mean depressive symptoms (CES-D scores) between the
depression treatment programs of CBT and IPT when compared to the Control
condition following treatment implementation, Hy4: (11 # pp) < ps. Thus, the
focus of the post hoc analysis is to assess whether the CBT and IPT depression
treatment programs significantly reduced depressive symptoms among the par-
ticipants when compared to the control group. The extent that CBT and IPT
produced a similar reduction in depressive symptoms also will be assessed.

The output called Multiple Comparisons shows the three possible multiple
mean comparisons of CBT versus IPT, CBT versus Control, and IPT versus
Control using the Tukey HSD statistic (see Table 7.9). The significance values are
corrected for multiple comparisons being analyzed. The statistic probability for the
mean difference between the CBT (M = 17.333) versus IPT (M = 17.021) is
.970, which is greater than the alpha criterion of av = .05, so we fail to reject the
null (p > .05). The mean comparison of CBT (M = 17.333) and Control
(M = 21.680) is significant (p < .05) since the statistic probability of .003
is less than o = .05. Finally, the mean comparison of IPT (M = 17.021) and
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Control (M = 21.680) is significant (p < .05) since the statistic probability of
.002 is less than o = .05.

The multiple mean comparisons support the directional alternative hypoth-
esis that both the CBT and IPT depression treatment programs significantly
reduce depressive symptoms among participants compared to a no-treatment
control condition. Neither the CBT nor the IPT showed superiority in reduc-
ing depressive symptoms when they are compared with each other; CBT
(M = 17.333) and IPT (M = 17.021), p > .05.

Applying Jones and Tukey’s (2000) approach, we can conclude that the
paired-means differences are (u; — p3) < 0 (p = .003) and (p, — p3) <0
(p = .002). The difference in depressive symptoms comparing the CBT to IPT

conditions (j1; — i) is indefinite.

Confidence Intervals of Mean Differences

A confidence interval (CI) provides information about the probability that a given
interval will encircle the true difference between the population means. The
probability used for the confidence interval is .95 since o = .05 in this study.

The .95 CI for each mean difference is provided in the output under the
Multiple Comparisons table (see Table 7.9). These confidence intervals are cor-
rected since we are making several (three) comparisons and have a wider range
than would be expected if we were not adjusting for multiple comparisons. The
interpretations of the mean difference confidence intervals for the two paired-
mean comparisons that are significant (ju; vs. 13 and i, vs. pi3) are presented next.
The .95 CI interval for the means difference in depressive symptoms for com-
paring the CBT and Control conditions is (—7.45) — (—1.24). The probability is
.95 that this interval will include the true mean differences between the popu-
lation means of depressive symptoms between the CBT and control conditions
for adolescents. The .95 confidence interval for the means difference in depressive
symptoms comparing IPT to Control is (—7.78) — (—1.54), and this interval will
include the true means difference between the population means of depressive
symptoms 95 times in 100. These mean differences are due to sampling from
populations where the mean of the control group is not equal to the means of
the CBT or IPT condition participants. It is important to note that the upper
limit of both .95 intervals is a negative value that reflects a reduction in depressive
symptoms.
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PROGRESS REVIEW

1. The omnibus Ho: p = po = pz was rejected (p < .05), indi-
cating the existence of significant mean differences.

2. The overall magnitude of treatment effect of the independent
variable (depression treatment method) on the dependent
variable (depressive symptoms) was a medium effect,
n}% = .100.

3. The post hoc power of .951 was considerably larger than the
criterion of .80, which is consistent with our a priori power
analysis results.

4. The post hoc paired-means comparisons using the Tukey HSD
showed that CBT and IPT both produced significant lower
(p < .05) depressive symptoms when compared to the Con-
trol condition. There was no significant difference between the
CBT and IPT groups on reducing depressive symptoms.

5. The .95 confidence intervals for the mean differences reflec-
ted decreases in depressive symptoms of CBT versus Control
and IPT versus Control.

FORMULA CALCULATIONS OF THE STUDY RESULTS

The formula calculations for the one-way ANOVA, Tukey HSD, post hoc effect
sizes, and confidence intervals are presented next.

One-Way ANOVA Formula Calculations

The specifications for constructing an ANOVA summary table are presented
first. The information in this table captures most of the important data needed to
conduct the ANOVA. Additionally, the information in Table 7.10 will be useful

for calculating the HSD, post hoc effect sizes, and confidence intervals. We will
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TABLE 7.10 ANOVA Summary Table Specifications

Source of Variation df Sum of Squares (SS) Mean Square (MS) F

Treatment (T) K—1 (dfr)(MST) Formula MSy
MSg

Error (E) Ntor — K (dfg)(MSE) Formula —

Total (TOT) Nror — 1 (dFD)(MST) + (dfe)(MSg) — —

dft = K — 1is the treatment degrees of freedom where K'is the number of treatments, groups, or
means.

dfe = Nrot — Kis the error degrees of freedom. The degrees of each group is (n — 1df ), which
is summed across all treatments or groups.

dfror = Ntot — listhe total degrees of freedom based on N scores with one score unable to vary.

complete the ANOVA summary table for this study after we calculate the nec-
essary formulas.

ANOVA Formulas

There are several formulas that can be used to compute the ANOVA. We are
using descriptive formulas to calculate mean square treatment (MS7) and mean
square error (MSE) terms. The means, group sizes, and variances that you will
need to use for the formulas can be found in Table 7.1.

(My — Mioe)” + m(My — Mi)” + n3(Ms — Myyy)” + -+
K -1

MS; =1

where
ny, 1y, n3 = number of participants in each condition group

M, M,, M; = means of each condition group

M, = grand mean

Grand Mean

All of the values to complete the formulas are in the Descriptive Statistics table
except for the grand mean (Mro7), which is calculated next using a weighted
process since the group sizes are unequal.
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_ m(M) + m(My) + n3(Ms)

Mo = N
_ 48(17.333) +47(17.021) + 50(21.680)
a 145
 831.984 +799.987 + 1084
- 145
2715971
145
M., =18.731

Mean Square Treatment

Now, with the grand mean we can solve for the mean square treatment term.

48(17.333—18.731)*+47(17.021—18.731)*+50(21.680— 18.731)?

MSt = >
| 48(—1.398)*+47(—1.710)* + 47(2.949)°
N 2
_ 48(1.954) +47(2.924) +50(8.697)
N 2
93.792+ 137.428 4 434.850
B 2
~666.07
2
MSt =333.035

Mean Square Error

Next, we will solve for the mean square error term.
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(m = 1P+ (m = 1) + (1 = 1)85 + -
(m—=1)+(m—1)+ (n3— 1)
(48 — 1)38.780 + (47 — 1)35.934 + (50 — 1)51.079
(48 — 1)+ (47 — 1)+ (50 — 1)
(47)38.780 + (46)35.934 + (49)51.079
47 + 46 + 49

1,822.660 + 1,652.964 + 2,502.871
142

MSg =

5,978.495
142

MSg = 42.102

ANOVA Summary Table

Refer to the specifications in Table 7.10 that were used to calculate MSt and
MSg values in the ANOVA summary table (Table 7.11).

Graphical Representation of Findings

Figure 7.6 shows a visual representation of the findings. A critical value (CV) is
obtained using an online calculator.

Go to www.danielsoper.com > select Statistics Calculators > select
F-Distribution > select Critical F-value Calculator > type in 2 next
to Degrees of freedom 1: > type 142 next to Degrees of freedom
2: > type 0.05 beside Probability level: > click on Calculate!

TABLE 7.11 ANOVA Summary Table

Source of Variation df Sum of Squares (SS) Mean Square (MS) F

Treatment (T) 2 666.070 333.035 333.035
42102
F =7.910

Error (E) 142 5,978.484 42102 -

Total (TOT) 144 6,644.554 - -
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FIGURE 7.6 Hypothesis Testing Graph—One-Way ANOVA

Area of Retention Area of Rejection

8 9 10 MM 12...

4 5 6 7

Fcrit. = 3.06 FObt. = 7.91

The F critical value is 3.05983069, rounded to 3.06. We place the F critical
value on the abscissa (base of the curve) of the F-distribution curve. Then, we
place the obtained omnibus ANOVA value of F = 7.91 on the curve. The area of
rejection begins on the abscissa at the CV, and any obtained F to the right of the
CV informs us to reject the null hypothesis. Our Fpined = 7.91 falls in the area
of rejection to the right of the CV = 3.06, so we reject the Hj, concluding that if
the null hypothesis is true we would have obtained results like these less than
5 percent of the time. There is a difference in depressive symptoms across the
three conditions at the .05 level of significance.

Tukey HSD Test for Multiple Comparisons

A calculation of the Tukey HSD is presented next. First, the HSD formulas for equal
and unequal sample sized groups are presented. Since we have unequal samples, we
will initially compute a weighted sample size value using the harmonic mean.

Tukey HSD with Equal Sample Sizes by Group

g.05\/ MSg/n
Tukey HSD with Unequal Sample Sizes by Group

4.0s\/ MSg /ny,
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where ¢ o5 is the Studentized range statistic that is a linear function of # where

q = +v/2 (Howell, 2007). Using the ¢ allows us to adjust the critical value (CV)
of ¢ for the number of means (three) involved in our post hoc analysis. To obtain
a ¢0s, go to the following online calculator.

Google VassarStats > click on VassarStats : Statistical Computation Web
Site > under Site Map click on Udtilities > click on Statistical Tables
Calculator > click on critical values of Q > under K type 3 and under
df type 142 > click on Calculate. This results in g5 = 3.35.

MSg =42.102,
: , K
np, (harmonic mean of unequal n’s) =
1/}’11 —|— 1/}’12—|— 1/713
- 3
©1/48 +1/47 +1/50
- 3
.021+.021 4.020
3
062
ny, = 48.39

Tukey HSD with Unequal-Sized Groups

HSD =3.35./42.102/48.39
=3.35V/.870
=3.35(.933)

HSD =3.126

The mean differences of the three pairs of means are presented in Table 7.12.
Any mean difference that is larger than our calculated HSD statistic of 3.126 is
significantly different. Depressive symptoms are significantly lower (p < .05)
following the CBT and IPT conditions when compared to the Control condition

(see Table 7.9).
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TABLE 7.12 Matrix of Mean Differences

Group Means' M; =17.333 M, =17.021 Mz = 21.680
CBT M; =17.333 = 312 —4.347*
IPT M, =17.021 = = —4.659*

Control M3 = 21.680 — — —

T Interpret these mean differences as absolute values ignoring the + or — signs.
* p < .05; these mean differences are greater than the HSD statistic = 3.126, so the differences
are significantly different.

Post Hoc Effect Sizes

We are going to calculate the post hoc effect sizes that relate directly to the
findings of the one-way ANOVA. The partial eta-squared is a descriptive measure
of the magnitude of treatment effects that was reported in the IBM SPSS output.
We will also calculate omega-squared (w?), which is a more conservative estimate
of the population effect size and is not provided in the IBM SPSS output.

Eta-Squared (%)

Eta-squared is a measure of practical significance and is referred to as an effect size
or magnitude of treatment effect. It is a ratio of the variance explained by the
independent variable in relation to the total variance. ANOVA designs may result
in analyses of several independent variables and interactions between the inde-
pendent variables, and eta-squared statistics are computed for each, producing
partial eta-squared values. Eta-squared values range from 0 (small) to 1.0 (large).
There are several different effect sizes, and ” is commonly used. The T]; =.100

from the ANOVA output and is defined as:

2 Treatment (Condition) sum of squares (SS)

"l Treatment SS + Error SS
B 666.070
666.070 + 5,978.484
~ 6066.070
6,644.554
n? =.100
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We can interpret the > = .100 by converting the fraction to a percentage by
moving the decimal two spaces to the right, and report that approximately 10
percent of the change in the dependent variable (depressive symptoms) can
be attributed to the independent variable (depression treatment program). The
n” = .100 has a medium strength effect according to Cohen’s convention where
approximately 1 percent to 6 percent is low, >6 percent to 14 percent is medium,
and >14 percent is large. There clearly is a meaningful magnitude of treatment

effect of the depression treatment program on decreasing depressive symptoms.
Omega-Squared (w?)

Omega-squared is another useful effect size that is more conservative (lower) because
it estimates effect size between the IV and the DV in the population (Tabachnick &
Fidell, 2007). Eta-squared provides more of a descriptive effect size of the impact of
the IV on the DV in a study. Omega-squared also ranges from 0 to 1.0.

2 SSTreatment - (K - 1) MSError
B SSTotal + MSError

where SSTreatment = condition sum of squares
K = number of condition groups
MSgror = error mean square

SStowl = total sum of squares

Omega-squared is not reported in the Tests of Between-Subjects Effects
output but it can be calculated using information from the table.

,  666.070 — (3 — 1)42.102
 6,644.554 + 42.102

666070 — 84.204
T 6,686.656

_ 581.866
 6,686.656

w? =.087
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The w® = .087 indicates that approximately 8.7 percent of the change in the
dependent variable (depressive symptoms) in the population can be attributed to
the independent variable (depression treatment program). The w® = .087 is
lower than the n* = .100 as expected. However, both effect sizes provide similar
perspectives of the magnitude of treatment effect.

Confidence Intervals (.95) for Mean Differences of Significant Pairs

The Cl g5 calculations for the mean differences within the three sets of paired
means (CBT vs. IPT, CBT vs. Control, and IPT vs. Control) are presented next.
The calculations closely approximate the confidence intervals displayed in Table
7.9 of the Multiple Comparisons table that were IBM SPSS generated. Minor

differences are related to rounding differences.

HSD ClLos = [g.05/V2][\/MSg(1/m; + 1/n;)]

CBT versus IPT

3.35/1.414][\/42.102(.021 + .021)]
[2.369][V/42.102(.042)]
2.369][1.330]

3.151

(CBT M) — (IPT M) = (17.333 — 17.021) = +.312
Clys Lower limit = +.312 — 3.151 = —2.839
Cl 95 Upper limit = +.312 4 3.151 = +3.463
ClLys = (—2.839)iffercnce (+3-463)

CBT versus Control

3.35/1.414][\/42.102(.021 + .020)]
[2.369][1/42.102(.041)]
2.369][1.314]

3.113
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(CBT M) — (Control M) = (17.333 — 21.680) = —4.347
Clys Lower limit = —4.347 — 3.113 = —7.460
Clos Upper limit = —4.347 + 3.113 = —1.234
Clos = (—=7.460)Mpifterence (—1.234)

IPT versus Control
[3.35/1.414][/42.102(.021 + .020)]
[2.369][/42-102(.041)]
2.369][1.314]
3.113
(IBT M) — (Control M) = (17.021 — 21.680) = —4.659
Cl 95 Lower limit = — 4.659 — 3.113 = —7.772
CIos Upper limit = — 4.659 + 3.113 = —1.546
Clos = (=7.772)pifference (—1.546)

ANOVA Study Results

It was hypothesized that two depression treatment programs, cognitive-behavioral
therapy (CBT) and interpersonal therapy (IPT), would significantly reduce
depressive symptoms among adolescents compared to a no-treatment control
group (Control). It was expected that there would be no differences in the effects
of cognitive-behavioral therapy versus interpersonal therapy on reducing
depressive symptoms. The Center for Epidemiological Studies Depression Scale
(CES-D) was used to measure depressive symptoms, and higher scores represent
more self-reported depressive symptoms.

The sample consisted of 145 eighth and ninth grade participants who lived in
suburban, middle-class communities. The average age of the participants was
M = 14.55 (8D = .68), and there was a reasonable balance between females (52
percent) and males (48 percent).

An a priori power analysis was conducted to assess the probability of correctly
rejecting a false null hypothesis. Using an alpha of .05, a sample size of 145, and
an estimated effect size of /= .65, we found that we had adequate power (>.80)
to correctly reject a false null hypothesis in favor of the alternative hypothesis.
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The data were screened prior to testing the null hypothesis. The accuracy of the
data set was checked and confirmed. The data set had no missing data or univariate
outliers. The normality of the dependent variable (depressive symptoms) was
assessed for each group. The distributions of depressive symptoms for the CBT and
IPT groups fully met the underlying assumption of normality. The Control group
did not meet the criteria of the Shapiro-Wilk normality statistic. However, the
Control group distribution did meet the normality criteria of the Q-Q normality
plots and the skewness and kurtosis standardized scores. Therefore, the decision was
made to proceed with the analyses without modifying the Control group distri-
bution since the preponderance of the evidence supported normality.

The underlying assumption of homogeneity of variance also was met across
the three relatively equal-sized groups. The variance ratio (1.064 < 10.0) and
Levene’s test (p > .05) both demonstrated homogeneity of variance.

The depressive symptoms mean, standard deviation, and sample size for each
condition in the study were: (1) CBT condition (M = 17.333, SD = 6.227,
n = 48), (2) IPT condition (M = 17.021, SD = 5.995, n = 47), and (3)
Control condition (M = 21.680, SD = 7.147, n = 50).

The adolescent participants across group conditions (CBT, IPT, Control)
were tested for significant differences in depressive symptoms with a one-way
ANOVA using an alpha criterion of o = .05. The omnibus ANOVA analysis
was significant, F(2, 142) = 7.909, p = .001 (or we can state this finding using
the alpha level of the study as p < .05). If the null hypothesis is true, we would
have obtained results like these less than 5 percent of the time. The > = .100
(W

(W> = 8.70%) of the variability in depressive symptoms can be explained by the

= .870) is a medium effect size, indicating that approximately 10 percent

depression treatment programs and control.

A post hoc analysis was conducted to compare all paired means using the
Tukey HSD statistic. Two significant paired mean differences on reduced
depressive symptoms were found between the CBT and the Control participants
(p < .05, or p = .003) and the IPT versus Control participants (p < .05 or
p = .002). The CBT and IPT conditions produced significantly lower depressive
symptoms, whereas the CBT versus IPT participants showed similar results
(p > .05 or p = .970). In other words, we can conclude that the paired-means
differences were (LcpT — Hconmol) < 0 (p = .003) and (upT — Heconto) < 0
(p = .002). The difference in depressive symptoms comparing the CBT to IPT
conditions (pcpT — ppr) is indefinite.
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The .95 CI for the means difference between the two significant paired means
were CBT versus Control (—7.45) — (—1.24) and IPT versus Control (—7.78) —
(—1.54). The probability is .95 that these intervals will include the true mean
differences between the population means of depressive symptoms between the
CBT versus Control and the IPT versus Control, respectively. Decreases in
depressive symptoms comprised the lower and upper limits of the .95 confidence
intervals of CBT versus Control and IPT versus Control conditions.

In conclusion, the cognitive-behavioral therapy and interpersonal therapy
depression treatment programs significantly reduced depressive symptoms among
adolescents when compared to a no-treatment control condition. CBT and IPT
were equally effective in reducing depressive symptoms.

SUMMARY

We have demonstrated how a randomized posttest-only control group design
using a one-way analysis of variance statistic is applied to a research problem
within the context of the hypothesis-testing process. Research questions and
hypotheses were developed that incorporated independent and dependent vari-
ables. We established a criterion alpha level considering Type I and II errors. An a
priori power analysis was conducted to assess the fidelity of the study.

Data were entered for computer analyses using the IBM SPSS statistical
program (see data in Table 7.13). We conducted data diagnostics to make sure that
data were accurate and that we met univariate underlying assumptions of nor-
mality, homogeneity of variance, and independence of scores. Confidence intervals
of mean differences and magnitude of treatment effects were discussed. The one-
way ANOVA, Tukey HSD, post hoc effect sizes, and confidence intervals also
were presented using formulas. Finally, we presented a summary of the results.

PROBLEM ASSIGNMENT
The steps involved in conducting a one-way ANOVA using both IBM SPSS and

formulas have been presented in this chapter. Now it is your turn to indepen-
dently work through the steps of the hypothesis-testing process related to a one-
way ANOVA using IBM SPSS. Go to the companion website and you will find a
new one-way ANOVA research problem and data set along with a worksheet to
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TABLE 7.13 One-Way Analysis of Variance Data

ID# DepSymptoms Condition*
1 16 1
2 26 1
3 24 1
4 25 1
5 22 1
6 21 1
7 20 1
8 19 1
© 18 1
10 17 1
n 23 1
12 27 1
13 n 1
14 12 1
15 14 1
16 15 1
17 14 1
18 8 1
19 10 1
20 12 1
21 7 1
22 14 1
23 9 1
24 17 1
25 16 1
26 16 1
27 18 1
28 25 1
29 23 1
30 32 1
31 29 1
32 24 1
33 33 1
34 18 1
35 18 1
36 18 1
37 16 1
38 16 1
39 10 1
40 13 1
41 12 1
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(Continued)
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TABLE 7.13 One-Way Analysis of Variance Data (Continued)

ID# DepSymptoms Condition*
84 17 2
85 16 2
86 16 2
87 16 2
88 16 2
89 16 2
90 16 2
91 18 2
92 15 2
93 18 2
94 18 2
95 18 2
96 29 3
97 30 3
98 33 3
99 35 3
100 26 3
101 27 3
102 28 3
103 23 3
104 30 3
105 28 3
106 21 3
107 32 3
108 29 5
109 27 3
1o 28 3
m 32 3
n2 32 3
13 32 5
n4 32 3
15 21 3
16 22 3
n7 22 3
18 26 3
19 21 3
120 16 3
121 18 3
122 12 3
123 13 3
124 20 3
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125 20 S
126 16 3
127 23 3
128 18 3
129 19 3
130 18 3
131 10 3
132 13 3
133 il 3
134 13 3
135 10 3
136 20 3
137 12 3
138 15 3
139 23 3
140 16 3
141 12 3
142 20 3
143 14 3
144 21 3
145 15 3

*1= CBT; 2 = IPT; 3 = Control

complete. Use the problem presented in this chapter to guide you as you com-
plete the assignment. Your instructor will evaluate your completed worksheet
when it is finished.

KEY TERMS
alpha criterion (o) data diagnostics
alternative hypothesis degrees of freedom
analysis of covariance (ANCOVA) dependent variable (DV)

ANOVA summary table specifications estimated (a priori) effect size

a priori eta-squared (772)

a priori power analysis exclusion criteria

confidence intervals for the mean grand mean (Msog)
differences
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homogeneity of variance
inclusion criteria
independence of observations
independent variable (IV)
kurtosis

leptokurtic

Levene’s statistic

maghnitude of treatment effects
(effect sizes)

mean square error (MSg)
mean square treatment (MS7)
mesokurtic

missing data analysis

multifactor ANOVA (factorial ANOVA)

multivariate ANOVA

negatively skewed (left-skewed)
distribution

normality

normal Q-Q plots
no-treatment control condition
null hypothesis

omega-squared (w2)

operationally defined (OD)
outliers
platykurtic

positively skewed (right-skewed)
curve

post hoc multiple comparisons of
means

post hoc power
power

purposive sampling of typical
instances

randomized posttest-only control
group design

randomly assigned

repeated-measures ANOVA
(RM-ANOVA)

Shapiro-Wilk (S-W) statistic

Tukey honestly significant difference

(HSD) statistic
Type | (alpha) error
Type Il (beta) error
univariate parametric assumptions

weighted by sample size
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Chapter 8
REPEATED-TREATMENT
DESIGN USING A
REPEATED-MEASURES
ANALYSIS OF VARIANCE

LEARNING OBJECTIVES

o Demonstrate how to develop research questions and
hypotheses as they relate to a research problem incorpo-
rating independent and dependent variables.

o Identify the components and application of a repeated-
treatment research design.

o Examine Type I and II error considerations and a priori
power analysis in establishing alpha (o).

o Conduct data diagnostics to assess for normality and

sphericity.




o Execute a repeated-measures analysis of variance (RM-
ANOVA), profile plots, and Fisher’s protected least sig-
nificant differences (PLSD) pairwise mean analysis using

SPSS and formulas.

o Interpret post hoc analyses using eta-squared (), trend
analysis, and confidence intervals.

o Understand the study findings combining the various
analyses.

repeated-measures analysis of variance (RM-ANOVA) is used to
A evaluate if support partners added to weight loss treatment can improve

weight loss among persons who are overweight. Research questions and
hypotheses are developed that anticipate that adding support partners to treat-
ment will improve the outcome of weight loss. A repeated-treatment design is
used with one group of persons who are overweight. A data set is presented that
is used for both IBM SPSS and formula analyses.

An a priori power analysis is conducted to determine if the sample size,
estimated effect size, and alpha level are adequate to proceed with the study.
An RM-ANOVA is applied to test the overall (omnibus) null hypothesis. The
magnitude of treatment effects is assessed using both eta-squared and omega-
squared effect size measures. Post hoc analyses are conducted using profile plots,
the Fisher’s protected least significant differences (PLSD) statistic, and trend
analysis. The .99 confidence intervals are interpreted for the mean differences
between condition group means. Finally, the overall results are presented.

RESEARCH PROBLEM

The focus of this simulated research problem is to assess whether the use of
friends (support partners) in behavioral weight control treatment (BWCT) can
improve the weight loss outcomes of persons who are overweight. Gorin et al.
(2005) found that support partners can improve the weight loss of individuals
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who are overweight if the support partners are also successfully losing weight
during the treatment program.

There are 35 participants who are overweight in this study who were randomly
selected from a large weight loss center in a metropolitan area in the United States.
The participants’ average age is 40 years old (SD = 3.20). Each participant has a
support partner (friend) who is also participating in the behavioral weight control
treatment, and the friends’ average age is 41 (SD = 5.23).

The participants’ weight is measured before the treatment begins. The
treatment program begins with a behavioral weight control treatment includ-
ing the support partners. After three months, the weight loss in pounds of the
participants is measured and recorded. Next, the behavioral weight control
treatment is continued for three months but without having the support partners
participate. Again, the weight loss is assessed. The support partners are reinsti-
tuted to the behavioral weight control treatment for another three months, fol-
lowed by a weight loss measurement. Finally, participants experience another
three months of BWCT with support partners and the last assessment is made.

STUDY VARIABLES

The independent variable, weight loss intervention, and how it was operationally
defined in this study are described next. Moreover, the dependent variable, weight
loss, and its operational definition are identified.

Independent Variable

The independent variable (IV) in this study problem is weight loss intervent-
ion. The IV is operationally defined as a behavioral weight control treatment
(BWCT) with the addition or removal of support partners. BWCT involves the
daily self-monitoring of calories, fat, and activity. Goals are established to
maintain 1,200 to 1,500 calories per day, 20 percent calories from fat, and 150
minutes of moderate activity each week. Individuals also participate in behavioral
modification activities.

Support partners have several important roles to provide support and share
the journey in the treatment of persons who are overweight. They establish
cooperative, mutual goals toward weight loss. Support partners are counted on to
reach the shared goals that work the best for both individuals. Support partners
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are available and willing to communicate consistently. Support partners must be
able to determine what unique kinds of encouragement work best with a given
individual. The format of the operationally defined conditions of the IV (weight
loss intervention) are: (1) BWCT and support partners (three months), (2) BWCT
with support partners removed (three months), (3) BWCT with support partners
reinstituted (three months), and (4) BWCT with support partners continued
(three months). The study extends over 12 months.

Dependent Variable

The dependent variable (DV) is weight loss in pounds from the baseline measured
weight of the participants over the 12 months of the study. The operational
definition of weight loss is the loss in pounds from their baseline weight before the
treatment began. Weight loss is measured, recorded, and compared at three
months, six months, nine months, and 12 months.

RESEARCH DESIGN

The research design used for this research example is a repeated-treatment design
(Shadish, Cook, & Campbell, 2002). Initially, a randomly selected group of
participants who are overweight are weighed at baseline before treatment. Then,
each participant’s weight loss is measured and recorded after three months of
treatment with partner support (at three months), after three months when
partner support is removed (at six months), after three months when partner
support is added back to treatment (at nine months), and after the treatment with
partner support is continued for three months (at 12 months). The repeated-
treatment design with one group is diagrammed and explained in Figure 8.1.

Statistical Analysis: Repeated-Measures Analysis of Variance

The one-way ANOVA that we used previously was a between-subjects statistical
design. Independent groups producing independent scores were compared for
mean differences. In this study, a repeated-measures ANOVA (RM-ANOVA) is
used, which is a within-subjects design in which participants experience more than
one treatment condition and are measured more than once on a dependent
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FIGURE 8.1 Repeated-Treatment Design with One Group for
Study Example

Ogaseline  Xiwith O1 Xoremove O2  X2add O3 Xacontinue O4
Ogaseline = Weight measurement of participants before treatment

Xiwith = Treatment with partner support for three months

O, = Weight loss measurement at three months

Xoremove = Treatment with removal of partner support for three months
O, = Weight loss measurement at six months

Xzadd = Treatment with added partner support for three months

Oz = Weight loss measurement at nine months

Xacontinue = Treatment with continued partner support for three months
O4 = Weight loss measurement at 12 months

FIGURE 8.2 Same Participants Measured Repeatedly over Time

Participants SameMeasT1 SameMeasT2 SameMeasT3 ...
Person 1 1st score 2nd score 3rd score
Person 2 1st score 2nd score 3rd score
Person 3 1st score 2nd score 3rd score
Person 4 1st score 2nd score 3rd score

variable. The RM-ANOVA generalizes from the dependent #-test and allows for
more than two measurements on the same individuals. In the next chapter, we
conduct a factorial ANOVA that integrates a within-subjects IV and a between-
subjects IV. However, a factorial ANOVA can also involve only between-subjects
IVs. If the statistical design has both between-subjects effects and within-
subjects effects, it is called a mixed-subject ANOVA statistical design.

Three common uses of repeated-measures ANOVA involve: (1) the same
participants measured repeatedly over time (see Figure 8.2), (2) the same parti-
cipants measured under different conditions (see Figure 8.3), and (3) matched
pairs of participants measured under different conditions (see Figure 8.4).

In this study, we are studying the same participants measured repeatedly over
time. The following three underlying assumptions need to be met in order to use

the RM-ANOVA.
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FIGURE 8.3 Same Participants Measured under Different Conditions

Participants Condition 1 Condition 2 Condition 3 ...
Person 1 1st score 2nd score 3rd score

Person 2 1st score 2nd score 3rd score

Person 3 1st score 2nd score 3rd score

Person 4 st score 2nd score 3rd score
FIGURE 8.4 Matched Pairs of Participants Measured under Different
Conditions

Participants Condition 1 Matched Participants Condition 2
Person 1 Score Person matched Score
Person 2 Score Person matched Score
Person 3 Score Person matched Score
Person 4 Score Person matched Score

1. The scores of participants are independent from the scores of all other par-

ticipants, known as independence of scores.

2. Variables are assumed to be normally distributed around zero within each

treatment.

3. The group variances and the covariances are assumed to be homogeneous

across treatments, which is known as sphericity.

PROGRESS REVIEW

1. The research problem focuses on whether adding support
partners to behavioral weight control treatment can increase
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weight loss among persons who are overweight. A repeated-
treatment research design is used.

2. The independent variable is weight loss intervention and
is operationally defined as BWCT with the addition or rem-
oval of support partners: (1) BWCT and support partners
(three months), (2) BWCT with support partners remo-
ved (three months), (3) BWCT with support partners
reinstituted (three months), and (4) BWCT with support
partners continued (three months). The dependent variable is
weight loss and is operationally defined as number of pounds
lost at three, six, nine, and 12 months.

3. Thirty-five persons who are overweight are randomly selected
from a large weight loss center, and the same participants
experience four treatment conditions and four weight loss
measures.

4. The changes in weight loss of the participants across the
conditions are assessed using the repeated-measures
ANOVA statistic.

5. Next, the research question is stated and we begin complet-
ing the steps of the hypothesis-testing process.

STATING THE OMNIBUS (COMPREHENSIVE)
RESEARCH QUESTION

The initial research question is stated. Then, the steps of the hypothesis-testing
process related to this research problem will be presented following the statement
of the research questions.

Omnibus Research Question (RQ)

Will there be significantly more weight loss (number of pounds) among persons
who are overweight when support partners are included in a behavioral weight
control treatment?
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HYPOTHESIS TESTING STEP 1: ESTABLISH THE
ALTERNATIVE (RESEARCH) HYPOTHESIS (H,)

The omnibus (comprehensive) alternative hypothesis is stated next in both nar-
rative and symbolic formats. Subquestions and subhypotheses follow the overall
analysis.

Omnibus Narrative Alternative Hypothesis (H,)

H,: There will be significantly more weight loss (number of pounds)
among persons who are overweight when support partners are included
with BWCT compared to BWCT alone using the following schedule
over 12 months: (1) BWCT and support partners (three months),
(2) BWCT with support partners removed (three months), (3) BWCT
with support partners reinstituted (three months), and (4) BWCT with
support partners continued (three months).

Symbolic H,
H,: My Withsupport > 5%} Removesupport < (Mf‘} Addsupport, Mg Continuesupport)

where 1 Withsuppore 18 the population mean of weight loss of participants in
the BWCT with support partners condition being estimated by the
sample mean.

HoRemovesuppore 1 the population mean of weight loss of participants in
the BWCT with support partners removed condition being estimated
by the sample mean.

H3Addsuppore 1S the population mean of weight loss of participants in the
BWCT with support partners added back condition being estimated

by the sample mean.

H4Continuesupport 1S the population mean of weight loss of participants in
the BWCT with support partners continued condition being esti-
mated by the sample mean.

This is a directional alternative hypothesis because it is expected that the three
conditions that have support partners included with BWCT will produce more
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weight loss than when support partners are removed. It also is expected that
the three conditions with support partners will not differ from each other in the
amount of resulting weight loss.

An alternative process to reach conclusions in analyzing one’s sample
data is following the recommendations of Jones and Tukey (2000). Act as

it: (1) (Liwithsuppore — M2Removesuppord = 05 (3Addsuppore — H2Removesuppord = 05
(WsContinuesuppore — H2Removesuppord = 05 0F (2) (1 Withsupport — H2Removesupport) <<
0, (13Addsuppore — M2Removesuppord < 05 (H4Continuesupport — Hé4Coninuesuppord < 05 OF
3) the Sign (< 0 or>0) of (MlWithsupport - MZRemovesupport): (M3Addsupport -

MZRemovesupport)’ (M4Continuesupport - LLZRemovcsupport) is indefinite. USiﬂg this
approach, we will be making conclusions about whether omnibus and paired-mean

differences are greater than zero or less than zero, or that the findings are incon-
clusive about whether one mean is greater or less than zero. In this study, we are
expecting that the three conditions that combine BWCT with support partners will
significantly increase weight loss when compared to the BWCT without support
partners. Thus, we expect to make the following conclusions: (Jt1withsuppore —
MZRemovesupport) >0, (M3Addsupport B MZRemovesupport) >0, (M4Continuesupport B
H2Removesupport) > O-

HYPOTHESIS TESTING STEP 2: ESTABLISH THE
NULL HYPOTHESIS (Ho)

The omnibus null hypothesis is stated in narrative and symbolic formats in the
second step of the hypothesis-testing process.

Omnibus Narrative Null Hypothesis (Hp)

There will be no significant weight loss (number of pounds) among persons who
are overweight when support partners are included with BWCT compared to
BWCT alone using the following schedule over 12 months: (1) BWCT and
support partners (three months), (2) BWCT with support partners removed
(three months), (3) BWCT with support partners reinstituted (three months),
and (4) BWCT with support partners continued (three months).

Symbolic H,

Hy: My Withsupport — Mo Removesupport M3Addsupport = Hy Continuesupport
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HYPOTHESIS TESTING STEP 3: DECIDE ON A RISK LEVEL
(ALPHA) OF REJECTING THE TRUE Ho CONSIDERING
TYPE | AND Il ERRORS AND POWER

We will be choosing an alpha criterion (o) that we will use to make a decision about
whether to reject a true null hypothesis (Hp) in this step of the hypothesis-testing
process. We consider the balancing act between Type I (alpha) and Type II (beta)
errors. Then, we will use our chosen « level and combine it with anticipated sample
size and an estimated (a priori) effect size and determine whether we have enough
power (a priori) to conduct the study. Power is the probability of correctly rejecting a
false null hypothesis in favor of an alternative hypothesis.

Selecting Alpha (o) Considering Type | and Type Il Errors

Previous studies have shown that including support partners with behavioral weight
control treatment increases weight loss when compared to BWCT alone. We will
use a stricter alpha criterion of o« = .01 for this study since we will be replicating
past studies. This increases the probability of not making a Type I error, which is
rejecting a true null (no mean differences). This will provide more confidence in our
decision if the support partner conditions with BWCT significantly increase weight
loss when compared to the BWCT condition alone (reject Hy). However, if we
don’t reject the null that there are differences, the o = .01 increases the probability
of making a Type Il error of failing to reject Hy when there are significant differences
in means (false H,).

A Priori Power Analysis

It is important to assess whether key elements are in place to find a significant dif-
ference in means on the dependent variable across the conditions if it exists before we
conduct the study (a priori) or analyze data. Therefore, we will conduct an a priori
power analysis that is the probability associated with correctly rejecting a false null
hypothesis (see Figure 3.1 from previous Chapter 3). Initially, the a priori power
analysis is conducted before participants are selected and assigned to conditions so
that decisions can be made about study modifications such as increasing sample size
before the study actually begins. If the selected number of participants is lower than
the number of participants planned prior to selection, then power analysis is
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conducted again to see if the number is acceptable. In our example, we are going
to conduct an a priori power analysis after participant selection and assignment to
condition before the data are analyzed.

The three key elements used to conduct an a priori power analysis are alpha,
sample size, and estimated effect size (a priori). For an RM-ANOVA, we also
need an a priori value for the correlation between the repeated measures. In the
previous study, average correlation across the repeated measures was #,yerage = -55.
We have decided to use an alpha of .01 and we are planning on using a sample
size of 35. Now we need to estimate an effect size and then we can combine the
three elements to identify the probability of correctly rejecting a false null
hypothesis (power). An effective method for estimating an effect size for the a
priori power analysis is to use effect sizes resulting from previous studies that use
similar variables and designs to those we will use in our study.

We are going to use findings obtained from a very similar previous study that
resulted in a partial eta-squared: nlz’ = .35. We now have the elements (o = .01,

nf) = .35, N = 35, Zayerage = -55) necessary to conduct a power analysis for the

RM-ANOVA. We will use G*Power 3.1 to determine if our key elements
combined result in an acceptable power =.80 (see Figure 8.5).

Power Analysis Using G*Power 3.1.2
1. Open up the G*Power 3.1.2 program.

2. Select F tests under Test family > under Statistical test, selecc ANOVA:
Repeated measures, within factors > under Type of power analysis, select
A priori: Compute required sample size - given o, power, and effect size.

3. Click on the button called Determine to the left of Effect size f > a new
window opens to the right > click on the Direct button > beside T]; type
in our partial eta-squared of .35 > click on the button that says Calculate
and transfer to main window > and click on Close.

4. In the main window is the f= .7337994 that was calculated using the
n; = .35 > beside o err prob, type .01 > beside Power (1-3 err prob), type
0.80 > beside Number of groups, type 1 > beside Number of measure-
ments, type 4 > beside Corr among rep measures, type 0.55 > leave the 1
next to Nonsphericity correction e > click on the Calculate button.
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FIGURE 8.5 Power Analysis for the RM-ANOVA Problem
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The power analysis results show that we would need only a total sample
size = 6 participants to reach a power =.80; in the analysis the power was .901
(rounded). Our total sample of 35 far exceeds a needed sample size of 6. Con-
sidering the combined elements in our study of total sample size of 35,
f=.7337994, and o = .01, and an average correlation of measures = .55, a
power greater than .80 should be achieved. We are therefore confident that we
will correctly reject a false Hy in our study and avoid making a Type II error.

194 ¢« CHAPTER 8



PROGRESS REVIEW

1. The research question for the study problem was stated.

2. The first two steps of the hypothesis-testing process were
completed by stating the alternative and null hypotheses in
narrative and symbolic formats.

3. We decided on the risk we are willing to take when rejecting a
true null hypothesis and chose a = .01, which was believed to
be a reasonable balance in our study to avoid making a Type |
or Type Il error.

4. We conducted a power analysis to make sure that our proba-
bility of correctly rejecting a false null hypothesis was adequate
(power = .80) before continuing with the study as planned.
A G*Power analysis confirmed that the a priori power was larger
than .80, allowing us to continue the study with confidence.

HYPOTHESIS TESTING STEP 4: CHOOSE APPROPRIATE
STATISTIC AND ITS SAMPLING DISTRIBUTION TO TEST THE
Ho ASSUMING Ho IS TRUE

The RM-ANOVA will be used to test the null hypothesis:
Hy: p‘lWithsupport ) Removesupport — M3Addsupport = My Continuesupport

We are comparing the means of weight loss across the four conditions for
significant differences using the F-distribution. The RM-ANOVA is appropriate
to use because: (1) the same participants are being measured more than two
times, (2) there is one dependent variable, and (3) the dependent variable is
continuously scaled.
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HYPOTHESIS TESTING STEP 5: SELECT SAMPLE,
COLLECT DATA, SCREEN DATA, COMPUTE STATISTIC,
AND DETERMINE PROBABILITY ESTIMATES

Data are collected from a sample of participants during Step 5 of the hypothesis-
testing process. The data are assessed for data accuracy, missing values, and
univariate outliers, and to determine whether the underlying assumptions of the
statistic are met. If needed, data modifications are made. Then the null hypothesis
is tested using statistical analyses.

Sample Selection and Assignment

Thirty-five participants were randomly selected from a client population of a large
weight loss center in a metropolitan area in the United States. The average age of
the participants is 40 years old (SD = 3.20). Each participant has a support
partner (friend) who is also participating in the behavioral weight control treat-

ment, and the friends’ average age is 41 (SD = 5.23).

Study Data Diagnostics

We will next screen the sample data after it has been collected but before the primary
study hypothesis is tested. We are screening to: (1) check accuracy of data entries,
(2) identify and deal with missing data, (3) detect and make decisions about uni-
variate (one dependent variable) outliers, and (4) screen and make decisions about
univariate parametric assumptions. The underlying assumptions of a repeated-
measures ANOVA are that the dependent variable is assumed to be normally
distributed around zero within each treatment, and the group variances and cov-
ariances are assumed to be homogeneous across treatments, which is known as
sphericity. Sphericity refers to the variances being constant and the covariances being
constant within the covariance matrix, which is also known as compound symmetry.

Accuracy of Data Entry

The original data were compared to the entered data by members of the research
team. The data were determined to be accurate. The check of frequencies in the
descriptive statistics analysis showed that the variable scores were in expected
range and the means and standard deviations appeared plausible.
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Missing Data Analysis

There were no missing data in the original data set.

Means, Standard Deviations, Variances, and Assessing for
Univariate Outliers SPSS Commands

Enter the data found at the end of the chapter into IBM SPSS. Enter the data into

five columns just as it appears in the table. There is one ID column and there are

four data columns.

1. Click on Analyze > Descriptive Statistics > Descriptives > click over
Withsupport, Removesupport, Addsupport, and Continuesupport to Variable(s):.

2. Click on Options button and check Mean, Std. deviation, and Variance

and click on Continue.

3. C(lick on the box Save standardized values as variables and click OK.

4. Save the output as RM-ANOVA Descriptives.

The Descriptive Statistics Table 8.1 lists the sample size (V) of each group
followed by the lowest (minimum) and highest (maximum) scores in each group.
Valid N refers to the number of participant scores that do not having missing
data. The average scores (means) of weight loss by conditions are provided.
Measures of variability designate how the scores in each group distribution
deviate from their group mean. The standard deviation is an average measure of
score deviation from the mean, whereas the square of s is the variance () or

TABLE 8.1 Descriptive Statistics of Weight Loss by Condition Group

Descriptive Statistics

N Minimum Maximum Mean

Std. Deviation Variance

Withsupport 35
Removesupport 35
Addsupport 35

Continuesupport 35
Valid N (listwise) 35

7.00
1.00
8.00
7.00

15.00

7.00
16.00
14.00

10.3143
41143

10.6000

10.2571

2.24619
1.67633
1.63059
1.82052

5.045
2.810
2.659
3.314
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TABLE 8.2 Highest +z-Scores by Condition Group

Highest Outlier? Highest Outlier?
Condition +z > +3.29 =z > +3.29
Withsupport 2.086* No —-1.476 No
Removesupport 1.721 No —1.858 No
Addsupport 3.312 Yes —1.595 No
Continuesupport 2.056 No —1.789 No

* This number is rounded to three decimals.

general spread of scores from the mean. Higher scores reflect more deviation of
scores from the mean for both s and s*. As you can see, there is a higher standard
deviation of scores from the mean for the Wishsupport condition, and the stan-
dard deviations associated with the other conditions are closer together.

The standard values (z-scores) requested for the analysis to assess for uni-
variate outliers are produced in a new column for each condition on the Data
View spreadsheet and named ZWithsupport, ZRemovesupport, ZAddsupport, and
ZContinuesupport. These values represent the z-scores corresponding to the raw
scores in each condition. The highest positive and negative z-scores associated
with the raw scores of weight loss for each condition are reported in Table 8.2.
The z-scores are obtained by subtracting each condition’s raw scores from that
condition mean and dividing by its standard deviation (z = [X; — M]/SD).

One participant (ID #24) has a weight loss of 16 pounds at the condition
Addsupport that is a univariate outlier (z = 3.312) using the criterion of *3.29
(<.001, two-tailed). No other weight loss scores are outliers in any of the four
condition groups.

The outlying raw score of 16 is higher than the other 34 participants at the
end of the Addsupport condition, with the condition group average weight loss
being M = 10.60 (SD = 1.631). Looking at the other weight loss scores for #24
when the treatment included both the BWCT and support partners, the pounds
lost are Withsupport (15 lbs.) and Continuesupport (14 lbs.) (see Data View to
view these numbers for participant #24). The group outlying score of 16 for
Addsupport is not an uncharacteristic score for participant #24 when compared to
that individual’s other scores.

Case study information relative to participant #24 is analyzed to determine if
there are any personal characteristics, events during the study, or unique treat-
ment or measurement conditions that would explain the outlying weight
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loss score at the nine-month weight measure for the Addsupport condition.
No explanations for the outlying score were identified. The decision is to keep the
outlying score and participant in the study since there is no reason to expect that
this individual is not representative of the population that we have sampled from.

Assessing for Underlying Assumptions

Initially, we will evaluate the dependent variable (weight loss) for normality by
assessing histograms, skewness, kurtosis, the Shapiro-Wilk statistic, and normal

Q-Q plots.

Normality SPSS Commands

1. Click on Data > Descriptive Statistics > Explore > click over Wizh-
support, Removesupport, Addsupport, and Continuesupport to Dependent List.

2. Both should be clicked on under Display. In the upper right section, click
on the Plots button and click on Histogram and Normality plots with tests
and click Continue and OK.

3. Save the output as RM-ANOVA-assumptionscreen.

First, look at the histograms of the weight loss in the four conditions (see
Figures 8.6a, 8.6b, 8.6¢, and 8.6d). Notice that they appear to approximate being
symmetrical. You will see the outlying score of 16 represented graphically by the
Addsupport histogram. It is difficult to confirm that a distribution is normal
enough for using a parametric statistic by viewing a histogram, so we will obtain
more definitive information.

Next, we will use the output information under Descriptives in the output
(see Table 8.3) to calculate skewness and kurtosis values.

We divide the skewness statistic value by its “Std. Error” value, and the
resulting value is a z-score that we compare to the criterion £3.29 (p < .001,
two-tailed test). The skewness and standard error and their resulting skewness
z-scores are presented in Table 8.4.

The distribution of raw scores on the dependent variable (weight loss) for each
condition group (Withsupport, Removesupport, Addsupport, and Continuesupport)
does not significantly depart from normality using our criterion, as is evident
when you compare the calculated skewness z-score values from Table 8.4 to the
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FIGURE 8.6A, B, C, AND D Histograms of Weight Loss by Weight Loss
Intervention
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FIGURE 8.6A, B, C, AND D (Continued)
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TABLE 8.3 Skewness, Kurtosis, and Standard Error Values by
Condition Group

Descriptives

Statistic Std. Error

Withsupport Mean 10.3143 .37968

95% Confidence Lower Bound 9.5427

Interval for Mean Upper Bound 11.0859

5% Trimmed Mean 10.2619

Median 11.0000

Variance 5.045

Std. Deviation 2.24619

Minimum 7.00

Maximum 15.00

Range 8.00

Interquartile Range 4.00

Skewness 160 .398

Kurtosis =SS .778
Removesupport Mean 41143 .28335

95% Confidence Lower Bound 3.5384

Interval for Mean Upper Bound 4.6901

5% Trimmed Mean 41270

Median 4.0000

Variance 2.810

Std. Deviation 1.67633

Minimum 1.00

Maximum 7.00

Range 6.00

Interquartile Range 2.00

Skewness —-.032 .398

Kurtosis —.748 778
Addsupport Mean 10.6000 27562

95% Confidence Lower Bound 10.0399

Interval for Mean Upper Bound 11.1601

5% Trimmed Mean 10.5159

Median 10.0000

Variance 2.659

Std. Deviation 1.63059

Minimum 8.00

Maximum 16.00

Range 8.00

Interquartile Range 2.00
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Skewness 912 .398

Kurtosis 2.231 .778
Continuesupport Mean 10.2571 30772

95% Confidence Lower Bound 9.6318

Interval for Mean Upper Bound 10.8825

5% Trimmed Mean 10.2302

Median 10.0000

Variance 3.314

Std. Deviation 1.82052

Minimum 7.00

Maximum 14.00

Range 7.00

Interquartile Range 3.00

Skewness 183 .398

Kurtosis —.531 778

TABLE 8.4 Skewness z-Scores by Condition Group

Skewness z Skewness Sig. Departure?
Condition (Stat./Std. Error = 2) Direction (> £3.29)
Withsupport 160/.398 = .402 Positive No
Removesupport —.032/.398 = —.080 Negative No
Addsupport .912/.398 = 2.291 Positive No
Continuesupport .183/.398 = .460 Positive No

criterion of +3.29. The degree of skewness is the highest in the positive direction
of the Addsupport distribution (Z = 2.291), which is the result of the univariate
outlier in the group. However, the outlier is not causing the group distribution to
depart from normality.

We follow the same procedures to assess kurtosis (see values in the output in Table
8.3), which is the clustering of scores in the center, the upper and lower ends (tails),
and the shoulders (between the center and the tails) of a distribution (Norusis, 1994).

None of the distribution kurtosis z-scores are considered problematic using
the +3.29 criterion (see Table 8.5). However, notice that the kurtosis of the
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TABLE 8.5 Kurtosis z-Scores by Condition Group

Kurtosis z Kurtosis Sig. Departure?
Condition (Stat./Std. Error = 2) Direction (> +£3.29)
Withsupport —.919/.778 = —1.181 Platykurtic No
Removesupport —.748/.778 = —.961 Platykurtic No
Addsupport 2.231/.778 = 2.868 Leptokurtic No
Continuesupport —.531/.778 = —.683 Platykurtic No

TABLE 8.6 Shapiro-Wilk Statistics by Condition Group

Tests of Normality

Kolmogorov-Smirnov?® Shapiro-Wilk
Statistic df Sig. Statistic df Sig.
Withsupport 134 35 112 947 35 .093
Removesupport 130 35 143 951 35 125
Addsupport 158 35 .027 919 35 .014
Continuesupport 128 35 162 .958 35 197

4Lilliefors significance correction

Addsupport condition group (z = 2.868) also is affected by the univariate outlier
but not significantly departing from being a mesokurtic distribution.

The Shapiro-Wilk (S-W) statistic is assessed as another source of evidence to
use to determine whether the distributions of the group conditions are normally
distributed. The S-W statistic is found in the output under Tests of Normality
(see Table 8.6). The null hypothesis to test the S-W with an alpha of .01 is

presented next. We want to retain these hypotheses.

Hj: The Sample Distribution = Normal

We fail to reject the null hypotheses (p > .01) for all of the condition group
distributions since the significant probability levels (Sig.) of the Shapiro-Wilk
statistic are larger than ov = .01. We conclude that the four group distributions
are not deviating significantly from being normal as indicated by the S-W sta-
tistic. As you can see, the Sig. of .014 of the Addsupport group is close to our
criterion of o = .01, but it is still above the criterion so we fail to reject the null
hypothesis that the sample distribution is normal. Again, the univariate outlier in
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the Addsupport group is causing the S-W statistic to be close to reflecting
nonnormality.

The final evidence of normality that we will interpret is the normal Q-Q plot
for each distribution. A plot for each group is located in the output under the
heading Normal Q-Q Plot of Withsupport, Removesupport, Addsupport, and
Continuesupport (see Figures 8.7a, 8.7b, 8.7¢c, and 8.7d). An observed value in
the distribution is paired with its expected value from the normal distribution to
form the normal Q-Q plots. The number of cases in the sample and the rank
order of the case in the sample are used to generate the expected values for the
normal distribution. If the sample is from a normal distribution, we expect that
the points will fall more or less on a straight line.

The Q-Q plots reflect acceptable normality, with the vast majority of points
on the Q-Q plots in all condition group distributions falling on or near the
straight line, providing further evidence that each group is normally distributed
(see Figures 8.7a, 8.7b, 8.7¢, and 8.7d). Again, you can see the univariate outlier
in the Addsupport Q-Q plot.

Summary of the Normality Evidence

There was one univariate outlier identified within the Addsupport distribution.
The effects of the univariate outlier were evident in all of the measures to assess
normality. This demonstrates how one case outlier can have a substantial effect
on the normal shape of a distribution. However, the skewness z-scores, kurtosis z-
scores, S-W statistics, and Q-Q plots were all in the acceptable range for us to
assume that the distributions were normal enough to conduct the RM-ANOVA.

Next, we assess the homogeneity of variances and covariances (sphericity)
assumption. We will need to run the actual RM-ANOVA analysis to get infor-
mation to assess this assumption.

Repeated-Measures Analysis of Variance of the Omnibus Ho

RM-ANOVA SPSS Commands

1. Click Analyze > click General Linear Model > click Repeated Mea-
sures > in the box that says factorl, type in conditions and in the box beside
Number of Levels: type in the number 4 and click on the Add button and
then click on the Define button.
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FIGURE 8.7A, B, C, AND D Normal Q-Q Plots of Weight Loss by Weight
Loss Intervention Conditions
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FIGURE 8.7A, B, C, AND D (Continued)
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2. In a new window, click each of the four variables (Withsupport, Remove-
support, Addsupport, and Continuesupport) to the section titled Within-
Subjects Variables (factor 1):.

3. C(lick on the Plots button, then click over conditions to box under Hori-
zontal Axis:, then click on the Add button and the Continue button.

4. Click on the Options button, click over (OVERALL) and conditions under
the box title Display means for:, click on Compare main effects and select
LSD (none) under Confidence interval adjustment:, click on Descriptive
statistics, Estimates of effect size, and Observed power.

5. In the box next to Significance level:, type in .01 and click on the Continue
button and click on OK.

6. Save the output as RM-ANOVAResulss.

Sphericity

The assumption of sphericity means that there is a constant pattern of variances
with each other and covariances with each other on the dependent variable weight
loss across the four conditions. Remember that variance is the mean of the sum of
the squared deviations from the mean score divided by the number of scores
(minus 1), $* = (X — M)*/N — 1. Covariance is conveys the extent that two
variables vary together, covyy = X(X — M)(Y — M)/N — 1.

Sphericity is similar to the assumption of homogeneity, but covariances are
added, resulting in variance-covariance matrices that are assessed. Since there are four
measures on the same dependent variable for each participant, the scores and means
are dependent (related) to each other, producing covariances that need to be con-
sistent with each other to accurately test the null hypothesis using RM-ANOVA.

We are using Mauchly’s test to assess whether the variance-covariance matrix
meets the assumption of sphericity by testing the following null hypothesis:

Hy: The variances are constant with each other, and covariances are
constant with each other.

We want to retain the null hypothesis. If we reject the Hp, then we will have
to make corrections to accurately interpret the F-test value produced from the

RM-ANOVA.
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TABLE 8.7 Mauchly’s Test of Sphericity

Mauchly’s Test of Sphericity?®

Measure: MEASURE_1

o Epsilon®
Within-
Subjects Mauchly’s  Approx. Greenhouse- Huynh- Lower
Effect " Chi-Square df Sig. Geisser Feldt Bound
Conditions .761 8.942 5 N2 .867 .945 BEF

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed
dependent variables is proportional to an identity matrix.

2 Design: Intercept within Subjects.

P May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected
tests are displayed in the Tests of Within-Subjects Effects table (Table 8.8).

Design: Conditions.

On the output, refer to the table tided Mauchly’s Test of Sphericity (see
Table 8.7).

The significance level associated with Mauchly’s W test is p = .112,
which is larger than our o = .01. We retain the H, that there is a constant
pattern of variances and covariances. We have met the sphericity assumption.
We will interpret the F-statistic results associated with the source Sphericity
Assumed.

If we had rejected the H, that the variances and covariances are not constant,
then we could use the df; and df. of the Greenhouse-Geisser or Huynh-Feldt to
obtain a critical value to evaluate the significance of F. The adjusted degrees of
freedom are obtained by taking the epsilons in the Mauchly table times the
degrees of freedom of the F-test in the tests of the Within-Subjects Effects Table.
The Greenhouse-Geisser is more conservative (especially with small samples) than
the Huynh-Feldt to correct for problems with sphericity.

Summary of Underlying Assumptions Findings

The assumption of normality of the four distributions of weight loss is met based
on the preponderance of evidence using several measures. The assumption of
sphericity is also met.
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PROGRESS REVIEW

1. The weight of participants was obtained at baseline. Then
data were collected on the dependent variable (weight loss)
in four three-month intervals over 12 months at the following
conditions: (1) with support partners in treatment, (2) remove
support partners in treatment, (3) add support partners in
treatment, and (4) continue support partners in treatment.

2. Problems with data accuracy and missing data were ruled out
in the early steps of the data-screening process.

3. The distributions of weight loss of the condition groups were
assessed for compliance in meeting the underlying assump-
tions of using the RM-ANOVA. One participant had a weight loss
score that was a univariate outlier. The decision was to keep the
outlying score and participant in the study since the participant
was found to be representative of the accessible population.

4. All other the measures of normality confirmed that the dis-
tributions met the underlying assumption of normality.

5. The underlying assumption of sphericity also was met.

6. The RM-ANOVA is conducted next.

RM-ANOVA Results

The following omnibus null hypothesis is tested next using the RM-ANOVA.

H: MIWithsupport = MIRemovesupport = MlAddsupport = MlContinuesupport

Refer to the RM-ANOVA Results output reproduced in Table 8.8 as the
table called 7ests of Within-Subjects Effects.

See conditions under the column titled Source. We used the term conditions to
reflect the independent variable in the study when we set up the data set. There are
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TABLE 8.8 RM-ANOVA Results for the Omnibus Null Hypothesis

Tests of Within-Subjects Effects

Measure: MEASURE_1

Type Il Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power®
Conditions Sphericity assumed 1,036.364 3 345.455 110.325 .000 .764 330.976 1.000
Greenhouse-Geisser 1,036.364 2.600 398.651 110.325 .000 .764 286.811 1.000
Huynh-Feldt 1,036.364 2.834 365.689 110.325 .000 .764 312.663 1.000
Lower bound 1,036.364 1.000 1,036.364 110.325 .000 764 110.325 1.000
Error Sphericity assumed 319.386 102 3.131
(conditions)  Greenhouse-Geisser 319.386 88.389 3.613
Huynh-Feldt 319.386 96.356 3.315
Lower bound 319.386 34.000 9.394

@ Computed using alpha = .01



four rows under conditions, and we are going to use the row called “Sphericity
assumed” since we previously found that are data met the underlying assumption of
sphericity. We see that the Sig. value is .000 and that is less than our o« = .01, so we
can reject the null hypothesis, £(3, 102) = 110.325,p < .01. There isasignificant
difference in means of weight loss pounds across the condition groups: (1) with
support partners in treatment (M = 10.314, SD = 2.246), (2) remove support
partners in treatment (M = 4.114, SD = 1.676), (3) add support partners
in treatment (M = 10.600, SD = 1.631), and (4) continue support partners in
treatment (M = 10.257, SD = 1.821).

We found that there are mean differences in weight loss among the
four condition groups. Specifically, we will assess which pairs of means are
significantly different from each other.

Post Hoc Multiple Comparisons of Pairs of Means

We rejected the omnibus null hypothesis, concluding that there was a significant
difference in weight loss among the four condition groups. We also want to
find which pairs of means are significantly different from each other. The Fisher’s
protected least significant differences (PLSD) statistic is used to make pairwise
comparisons.

The results of comparing the pairs of means are in a table called Pairwise
Comparisons in the RM-ANOVA results output (reproduced in Table 8.9).

The first column in Table 8.9 shows the mean pairs of condition group com-
parisons being made where 1 = with support partners in treatment (M = 10.314),
2 = remove support partners in treatment (M = 4.114), 3 = add support partners
in treatment (M = 10.600), and 4 = continue support partners in treatment
(M = 10.257).

The first row is comparing 1 (with support partners in treatment) (M = 10.314)
to 2 (remove support partners in treatment) (M = 4.114). The Sig. value of the
differences between the two means is .000, which reflects a significant difference
(p < .01). The participants had significantly more weight loss with support partners
in treatment than when the support partners were removed.

A review of the other rows shows that the mean weight loss of condition
group 2 (remove support partners in treatment) (M = 4.114) is significantly
lower than all of the other group means. And the other three groups are not

212 « CHAPTER 8



TABLE 8.9 Post Hoc Comparisons Using the Fisher’s Protected Least
Significant Differences (PLSD) Statistic

Pairwise Comparisons

Measure: MEASURE_1

99% Confidence Interval
for Difference?

Mean
) J) Difference  Std. Lower Upper
Conditions Conditions a-J9 Error Sig.? Bound Bound
1 2 6.200* 458 .000 4.950 7.450
3 —.286 435 .516 —1.472 901
4 .057 494 909 —-1.289 1.404
2 1 -6.200* .458  .000 —7.450 —4.950
3 —6.486* 379 .000 —7.519 —5.452
4 —6.143* 434 .000 —7.327 —4.958
3 1 .286 435 .516 —.901 1.472
2 6.486* .379 .000 5.452 7.519
4 343 315 .284 —.516 1.202
4 1 —-.057 494 .909 -1.404 1.289
2 6.143* 434  .000 4.958 7.327
3 —.343 S .284 -1.202 .516

* Based on estimated marginal means.

* The mean difference is significant at the .01 level.

@ Adjustment for multiple comparisons: least significant difference (equivalent to no
adjustments).

significantly different from each other. We can conclude that when the support
partners are included in the treatment of persons with weight problems, a sig-
nificantly higher weight loss is experienced by the participants.

Trend Analysis

Trend analysis is another post hoc approach that is useful when the groups are defined
by the independent variable ordered along a continuum (Howell, 2010). Trend
analysis allows us to continue the analysis from the overall RM-ANOVA to an
analysis of the characteristics of the shape of the relationship between the independent
variable and the dependent variable. For example, one can mathematically model the
form of the decline (or incline) of a dependent variable. Common shapes tested in
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FIGURE 8.8 Profile Plot of Means of Weight Loss by Condition Groups

Estimated Marginal Means of MEASURE_1
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Conditions

trend analysis are linear trend (straight line), quadratic trend (variation of a U
or V shape), cubic trend (variation of an S shape), and guartic trend (similarities to
previous shapes but including another bend in the shape).

In this study, we expect that the condition of removing the support partners from
treatment for three months would decrease the weight loss of participants. When the
support partners are added to treatment, there would be an increase in weight loss.

Looking at the profile plot of means of weight loss by condition groups from
the RM-ANOVA results (see Figure 8.8), a V shape (quadratic trend) is evident.

This graphical trend can be assessed for significance from information pre-
sented in the Tests of Within-Subjects Contrasts table in the RM-ANOVA output
(see Table 8.10). The null we will be testing is Hy: Quadratic trend = 0. The
row Conditions—Quadratic shows a Sig. value of .000, which is less than
o = .01 and therefore significant. There is a significant quadratic trend in the
means of weight loss across the condition groups, F(1, 34) = 114.583, p < .01.
The effect size of practical significance is substantial, nlzl =.771.
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TABLE 8.10 Trends of Weight Loss Means Across the Condition Groups
Tests of Within-Subjects Contrasts
Measure: MEASURE_]1
Type Ill Sum Mean Partial Noncent. Observed

Source Conditions of Squares df Square F Sig. Eta-Squared Parameter Power?
Conditions Linear 69.773 1 69.773 15.682 .000 .316 15.682 .883

Quadratic 300.179 1 300.179 114.583 .000 771 114.583 1.000

Cubic 666.413 1 666.413 286.676 .000 .894 286.676 1.000
Error Linear 151.277 34 4.449
(conditions) Quadratic 89.071 34 2.620

Cubic 79.037 34 2.325

@ Computed using alpha = .01



HYPOTHESIS TESTING STEP 6: MAKE DECISION
REGARDING THE Ho AND INTERPRET POST HOC EFFECT
SIZES AND CONFIDENCE INTERVALS

The results showed that there was an overall significant difference among the
weight loss means across the four conditions. The post hoc analyses showed
that when the partner support was removed, the resulting mean weight loss was
significantly lower from all of the other three conditions of Withsupport,
Addsupport, and Continuesupport. Moreover, we discovered a significant qua-
dratic trend in the condition means that showed the dramatic effect on weight
loss of removing the partner support (Removesupport). The magnitude of
treatment effect, post hoc power, and confidence intervals are presented next to
provide further clarification to the results.

Magnitude of Treatment Effect—Post Hoc Effect Size

Again refer to the Tests of Within-Subjects Effects table of the RM-ANOVA results
output (see Table 8.8). You see a partial eta-squared value (n; = .764) on the

“Conditions—Sphericity assumed” line next to the Sig. value. Eta-squared ranges
from 0 (small) to 1.0 (large).
We can interpret the T]; = .764 by converting the fraction to a percentage by

moving the decimal two spaces to the right, and report that approximately 76.40
percent of the change in the dependent variable (weight loss) can be attributed to
the independent variable (weight loss intervention). There is clearly a substantial
magnitude of treatment effect of the weight loss program on weight loss.

Post Hoc Power

The actual power after the study was conducted is reported in the Tests of
Within-Subjects Effects table of the RM-ANOVA results output (see Table 8.8).
You see the observed power value (1.000) on the “Conditions—Sphericity
assumed” line at the end of the row. We had a 100 percent chance of correctly
rejecting a false null hypothesis in favor of the alternative hypothesis with a post
hoc effect size of .764, a sample size of 35, and an alpha of .01. This post hoc

power is consistently large as was the a priori power value of .901.
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Confidence Intervals of Mean Differences

The .99 CI for each means difference is provided in the output under Multiple
Comparisons Table (see Table 8.9). The interpretations of the mean
difference confidence intervals for the three paired-mean comparisons that are sig-
nificant (MlWithsupport vs. M2Removesupport): (M3Addsupport vS. MZRemovesupport)’ and
(4 Continuesupport VS+ H2Removesuppore) are presented next. The .99 Cl interval for the
means difference in weight loss comparing 1 (with support partners in treatment) to 2
(remove support partners in treatment) is (4.950) — (7.450). The probability is .99
that this interval will include the true means difference between the population means
of weight loss between 1 (with support partners in treatment) and 2 (remove support
partners in treatment) and conditions for persons who are overweight. The .99
confidence interval for the means difference in weight loss comparing 3 (add support
partners in treatment) to 2 (remove support partners in treatment) is (5.452) —
(7.519), and this interval will include the true means difference between the popu-
lation means of weight loss 99 times in 100. The CI o9 for the difference between 4
(continue support partners in treatment) and 2 (remove support partners in treat-
ment) is (4.958) — (7.327). The lower and upper limits of all of the intervals are
positive, which shows the high probability associated with having an increase in
weight loss when support partners are involved in treatment.

PROGRESS REVIEW

1. After concluding that the group distributions met the sphericity
assumption, the omnibus null hypothesis was rejected (p < .01),
indicating the existence of significant mean differences.

2. The overall magnitude of treatment effect of the independent
variable (weight loss intervention) on the dependent variable
(weight loss) was substantial, n]% = .764.

3. The post hoc power value (observed power = 1.0) showed
that we had a 100 percent chance of correctly rejecting
a false null hypothesis with a post hoc effect size of .764, a
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sample size of 35, and an alpha of .01. This post hoc power is
consistent with the a priori power value of .901.

4, The pairwise mean comparisons using the PLSD statistic
showed that when the support partners are included in the
treatment of persons with weight problems, a significantly
higher weight loss is experienced by the participants.

5. The .99 confidence intervals for the mean differences show
the high probability associated with having an increase in
weight loss when support partners are involved in treatment.

6. The trend analysis demonstrated a significant quadratic
trend, providing further evidence for the increase in weight
loss when support partners are included in behavioral
weight control treatment.

FORMULA CALCULATIONS OF THE STUDY RESULTS
The RM-ANOVA summary table specifications are found in Table 8.11. The

column and row means by subject and condition that we will be using in
the formula calculations are found in Table 8.12.

TABLE 8.1 RM-ANOVA Summary Table Specifications MS;/MSg

Sum of Squares Mean Square

Source of Variation df (SS) (MS) F
Within subjects (S) N —1 TS (Ms — Mrot)? SSs/dfs —
Treatment (T) K—1 NS(My — MTOT)2 SS+/dfr MS+/MSg
Error (E) (K—=1DN —1) SStor — SSt — SSs  SSg/df: =

Total (TOT) Nror — 1 NE(Mat — Mror)2 — -

dfs = N — 1is the within-subjects degrees of freedom where N is the number of subjects.

dft = K — 1is the treatment degrees of freedom where K is the number of treatments.

dfe = (K — 1)(N — 1) is the error degrees of freedom: the number of treatments minus 1times the
number of subjects minus 1.

dfror = Ntot — 1is the total degrees of freedom based on N scores with one score unable to
vary. Ntot is calculated by [(K)(N) — 1].
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TABLE 8.12 Study Data with Column and Row Means by
Subject and Condition

With Remove Add Continue Subject

Subject support support support support Means
1 1 6 N 9 9.250
2 8 5 1 8 8.000
3 8 4 12 10 8.500
4 8 3 10 12 8.250
5 7 4 9 N 7.750
6 12 2 10 8 8.000
7 12 6 10 9 9.250
8 13 7 9 7 9.000
9 7 1 12 14 8.500
10 8 2 n 13 8.500
n n 4 n 12 9.500
12 13 4 10 n 9.500
13 14 5 10 10 9.750
14 9 4 n 9 8.250
15 9 6 9 8 8.000
16 8 3 8 8 6.750
17 n 2 10 < 8.000
18 n 4 10 7 8.000
19 12 5 13 12 10.500
20 10 4 n 12 9.250
21 10 3 10 n 8.500
22 7 5 12 9 8.250
23 7 6 9 10 8.000
24 15 7 16 14 13.000
25 14 2 8 10 8.500
26 12 1 13 10 9.000
27 il 4 il 12 9.500
28 N 4 12 n 9.500
29 10 5 10 10 8.250
30 9 3 9 9 7.500
31 12 5 8 12 9.250
32 n 5 10 n 9.250
33 9 6 12 10 9.250
34 8 7 1 12 9.500
55 13 2 12 < 9.000
Treatment 10.314 4114 10.600 10.257 8.821
means
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Calculation of Sums of Squares

The within, treatment, total, and error sum of squares are calculated with for-
mulas using the row means, column means, and grand mean (M1 = 8.821)
using the data from Table 8.12. The calculated results are then transferred to the
RM-ANOVA summary table, Table 8.13.

SSwithin = T (Ms — Meor)’
=435(9.250 —8.821)* + -+~ +(9.000 — 8.821)* = 150.730
SStreatment = NE(Mr — M)
—=35%(10.314 —8.821)° + (4.114—8.821)* 4 (10.600 — 8.821)°
+(10.257 - 8.821)
—35%(1.493)" + (—4.707)* + (1.779)” + (1.436)°
—=35%2.229+22.15643.165+2.062
=35(29.612)
—1036.42

SSToul = NE(Miscores — Mior)’
= 3(11 — 8.821)* 4 (8 — 8.821)* 4 --- + (12 — 8.821)*
+ (9 — 8.821)* = 1506.536
SSError = S8Total — SSTreatment — SSSubjects
= 1506.536 — 1036.42 — 150.730
SSkror = 319.386

TABLE 8.13 RM-ANOVA Summary Table Specifications

Source of Variation df Sum of Squares (SS) Mean Square (MS) F

Within Subjects (S) 34 150.73

Treatment (T) 3 1,036.42 345.473 110.3
Error (E) 102 319.386 3.131 —
Total (TOT) 139 1,506.536 — —
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FIGURE 8.9 Hypothesis Testing Graph RM-ANOVA
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Figure 8.9 shows a visual representation of the findings. A critical value (CV)
is obtained using an online calculator.

Go to www.danielsoper.com > select Statistics Calculators > select
F-Distribution > select Critical F-value Calculator > type in 3 next
to Degrees of freedom 1: > type 102 next to Degrees of freedom
2: > type 0.01 beside Probability level: > click on Calculate!

The F critical value is 3.97960580, rounded to 3.98. We place the F critical
value on the abscissa (base of the curve) of the F-distribution curve. Then, we
place the obtained omnibus ANOVA value of = 110.3 on the curve. The area
of rejection begins on the abscissa at the CV, and any obtained F to the right of
the CV informs us to reject the null hypothesis. Our Fypaineq = 110.3 falls in the
area of rejection to the right of the CV = 3.98, so we reject the Hj, concluding
that if the null hypothesis is true we would have obtained results like these less
than 1 percent of the time. There is a difference in weight loss across the four
conditions at the .01 level of significance.

Post Hoc Effect Size—Partial Eta-Squared

The n; is calculated next, resulting in n]% = .7064; this has a large strength effect

according to Cohen’s convention, where approximately 1 percent to 6 percent is
low, >0 percent to 14 percent is medium, and >14 percent is large. There clearly
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is a very large magnitude of treatment effect of the weight-loss intervention
program on increasing weight loss.

S§ WithinSubjects

n, =
SSWithinSubjects T SSError

B 1,036.42

~1,036.42 + 319.386

_1,036.42

~ 1,355.806

n}% = .764

Post Hoc Paired-Means Comparisons
Fisher’s Protected Least Significant Differences (PLSD)

Fisher’s protected least significant differences (PLSD) is a multiple comparison
procedure to assess for differences in pairs of means following a significant
omnibus F statistic. It is considered a liberal approach since more mean differ-
ences are found with this procedure than with most other procedures. The mean
square error term from the omnibus F analysis is used in the denominator of the
PLSD formula and helps protect against making a Type I error. In this problem
the MS, is 3.131, which can be found in Table 8.13.

We start by obtaining a ¢ critical value to compare to obtained #-values using
an online calculator.

Go to www.danielsoper.com > click on Statistics Calculators > scroll down
and click on t-Distribution > click on Student t-Value Calculator >
type in 34 beside Degrees of freedom: > click 0.01 next to Probability
level: > click on Calculate! and the answer is t-value (two-tailed):
+2.72839437.

The rounded value is fcy = *£2.728 using an o = .01 with 34 df (WVpairs
— 1, 35 — 1 = 34). The obtained PLSD values for mean pairs are calculated
next, and the obtained 7 values are then compared to the 7y = +2.728.
Obtained values greater than the #cy = +2.728 reflect significant differences
(p < .01) between pairs of means.
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Withsupport Mean versus Removesupport Mean
X1 —X,

I 1

MS,{ —+—

\ n 7
10.314 — 4.114
3.131 i + a
\ ' 35 35

B 6.200
\/3.131(.029 + .029)

IPLSD =

6.200
\/3.131(.058)

6.200

182

~6.200
427

tprsp = 14.520, P < .01

Withsupport Mean versus Addsupport Mean

X —X;

ms, (Ll
\ 71 )

10.314 — 10.600

3.131 i+i
\ ' 35 35

PLSD =
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—.286

\/3.131(.029 + .029)
— 286

\/3.131(.058)

—.286

v.182

—.286
427

tpLsp = —.670, P> .01

Withsupport Mean versus Continuesupport Mean

X, — X4

1 1
MS, | —+—
\ 71 ny

10.314 — 10.257

RN R
\' 35 35

057

pLSD —

\/3.131(.029 + .029)
.057

V/3131(058)

.057
V.182

_ 057
427

tprsp = 130, P > .01
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Removesupport Mean versus Addsupport Mean

X, — X3

ws (Ll
\ n 7>

4.114 — 10.600

3.131 L—Fi
' 35 35

B —6.486
\/3.131(.029 + .029)
—6.486

\/3.131(.058)

 —6.486
/182

_ —6.486
427

trrsp = —15.190, p < .01

IPLSD =

Removesupport Mean versus Continuesupport Mean

X, — X4

1 1
MS,[—+—
\ 1 7

4.114 — 10.257

3031 [ =+~
\' 35 35
B —6.143

\/3.131(.029 + .029)

IpPLSD =
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—6.143

V/3131(058)

6143
/182

6143
427

IPLSD = —14.386, y4 < .01

Addsupport Mean versus Continuesupport Mean

X3 — X4

MS, i—i-i
\ m ny

10.600 — 10.257

3.131 (i + i)
\ 35 ' 35
B 343
~\/3.131(.029 + .029)

343

V/3.131(.058)
343
IRVATS)
_ 34

427

tprsp = -803, P> .01

pLSD =

The three condition means of with support, add support, and continue
support are significantly different (p < .01) from the remove support mean;
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however, the three condition means are not significantly different from each
other. These results are the same as we found from the PLSD pairwise com-
parisons in the SPSS results (Table 8.9).

Study Results

The purpose of this study was to determine if support partners included in a behavioral
weight control treatment (BWCT) program for persons who are overweight would
increase their weight loss. A repeated-treatment design with a group of participants was
used in the study. After obtaining a baseline weight from participants, they received
three months of BWCT including support partners and their weight loss was mea-
sured. Then the BWCT continued, removing the support partners for three months,
and the participants’ weight loss was measured again. The support partners were added
back to the BWCT for three months and the participants’ weight loss was measured.
Finally, the BWCT and support partners were continued for three more months and
weight loss measurements were made one last time.

The sample consisted of 35 participants who were randomly selected from a
client population of a large weight loss center in a metropolitan area in the
United States. The average age of the participants was 40 years old (SD = 3.20).
Each participant has a support partner (friend) who was also participating in the
behavioral weight control treatment, and the friends’ average age was 41
(SD = 5.23).

An a priori power analysis was conducted using o = .01, NV = 35, a priori
effect size f'= .734, and average correlation of measures = .55. The analysis
showed a power =.80, so we were confident that we would correctly reject a false
Hj in our study and avoid making a Type II error.

The data were screened prior to testing the null hypothesis. The accuracy of the
data set was checked and confirmed. The data set had no missing data. One parti-
cipant’s weight loss score was a univariate outlier (z = 3.312 > 3.29) but was
determined to be representative of the target population. Additional measures were
used to assess the normality of the data set, including skewness and kurtosis z-scores,
Shapiro-Wilk statistics, and Q-Q plots. All normality measures reflected acceptable
normality. Sphericity was assessed, and the variance and covariances of weight loss
across the conditions were constant. The means and standard deviations of the
sample at each condition were: (1) with support partners in treatment (M = 10.314,
SD = 2.246), (2) remove support partners in treatment (M = 4.114,
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SD = 1.676), (3) add support partners in treatment (M = 10.600, SD = 1.631),
and (4) continue support partners in treatment (M = 10.257, SD = 1.821).

A significant difference in the four means was found using a RM-ANOVA,
F(3, 102) = 110.325, p < .01. The magnitude of treatment effect was very
large, n; = .764. The PLSD statistic was used to assess the pairs of means for

significance. The mean of weight loss after removing support partners from
BWCT was significantly lower (p < .01) than the means of all of the other
conditions that included support partners with BWCT. No other pairs were
significantly different among the three conditions that included support partners.

The Cl 99 intervals for the mean difference of significant pairs were 1 (with
support partners in treatment) vs. 2 (remove support partners in treatment)
(4.950) — (7.450), 3 (add support partners in treatment) vs. 2 (remove support
partners in treatment) (5.452) — (7.519), 4 (continue support partners in
treatment) vs. 2 (remove support partners in treatment) (4.958) — (7.327). The
lower and upper limits of all of the intervals were positive, which shows the high
probability associated with having an increase in weight loss when support
partners are involved in treatment. A trend analysis resulted in a significant
quadratic trend (p < .01) reinforcing an increase in weight loss when support
partners are included in behavioral weight control treatment.

In conclusion, the results of this study demonstrate that when support
partners are included in behavioral weight control treatment for persons who are
overweight, weight loss increases significantly when compared to BWCT without
the use of support partners.

SUMMARY

We used an RM-ANOVA within a repeated-treatment design applied to a research
problem within the context of the hypothesis-testing process. Research questions and
hypotheses were developed that incorporated independent and dependent variables.
We established a criterion alpha level considering Type I and II errors. An a priori
power analysis using G*Power was conducted to assess the fidelity of the study.
Data were entered for computer analyses using the IBM SPSS statistical
program (see Table 8.14). Data diagnostics were conducted to make sure that
data were accurate and that we met univariate underlying assumptions of nor-
mality, sphericity, and independence of scores. Interpretations were discussed of
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TABLE 8.14 Repeated-Measures Analysis of Variance Data

ID With support Remove support Add support Continue support
1 il 6 1 9
2 8 5 1l 8
3 8 4 12 10
4 8 3 10 12
5 7 4 9 il
6 12 2 10 8
7 12 6 10 9
8 13 7 9 7
9 7 1 12 14
10 8 2 1 13
n il 4 1 12
12 13 4 10 il
13 14 5 10 10
14 9 4 N e
15 9 6 9 8
16 8 3 8 8
17 n 2 10 9
18 il 4 10 7
19 12 5 13 12
20 10 4 N 12
21 10 3 10 n
22 7 5 12 9
23 7 6 9 10
24 15 7 16 14
25 14 2 8 10
26 12 1 13 10
27 il 4 1 12
28 il 4 12 il
29 10 3 10 10
30 9 5 9 9
31 12 5 8 12
32 n 5 10 n
33 9 6 12 10
34 8 7 1 12
35 13 2 12 9

the omnibus RM-ANOVA results, pairwise mean comparisons, trend analysis,
effect size, post hoc power, and confidence intervals. Formula calculations were
conducted for the RM-ANOVA and pairwise mean comparisons. Finally, a
summary of the results was presented.
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PROBLEM ASSIGNMENT

Another RM-ANOVA problem with data set is found on the companion website.
Use the worksheet that is provided along with the steps used in this chapter to
complete the assignment.

KEY TERMS
average correlation quadratic trend
compound symmetry quartic trend
covariances repeated-measures ANOVA
(RM-ANOVA)

cubic trend

Greenhouse-Geisser repeated-treatment design

Huynh-Feldt sphericity

linear trend Sphericity Assumed

Mauchly’s Test of Spericity Tests of Within-Subjects Effects

mixed-subject ANOVA trend analysis

statistical design within-subjects design

protected least significant
differences (PLSD)
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Chapter 9

RANDOMIZED FACTORIAL
EXPERIMENTAL DESIGN
USING A FACTORIAL ANOVA

LEARNING OBJECTIVES

o Demonstrate how to develop research questions and hypoth-
eses as they relate to a research problem incorporating the effects
of two independent variables on one dependent variable.

o Identify the components and application of a randomized
factorial experimental design.

o Examine prestudy considerations, conduct data diagnostics,

and execute a two-way analysis of variance (ANOVA) using
IBM SPSS and formulas.

o Perform post hoc analyses and understand the study findings
by combining the various analyses.




study example is presented assessing methods to retain cocaine abu-
sers in treatment. A partially randomized factorial design using a two-
way ANOVA is used to evaluate if a standard care plus contingency
management intervention can improve the treatment completion rate of cocaine
abusers. Also assessed is whether the number of prior treatment attempts has an
effect on treatment retention.
An a priori power analysis is conducted prior to the factorial ANOVA. Spe-
cifically, a2 X 2 ANOVA is executed resulting in F-tests for two main effects, one
interaction, and simple effects. The results of the several analyses are presented.

RESEARCH PROBLEM

People with substance abuse disorders typically try several treatment attempts over
the life course of their disorders. In fact, Dennis, Scott, Funk, and Foss (2005)
reported that substance abusers attempt treatment three to four times over a median
of nine years before reaching a minimum of one year of sustained abstinence. The
purpose of this study is to assess whether a behavioral intervention known as
contingency management (CM) can improve treatment retention compared across
prior treatment attempts by cocaine abusers. This simulated example approximates
findings of a study by Rash, Alessi, and Petry (2008).

A sample size of 125 participants was obtained. Two individuals met exclusion
criteria and three persons dropped out of the study before it began, resulting in a
study sample of 120 cocaine abusers who sought treatment. Fifty-four percent
(n=065) of the participants were males, while females comprised 46 percent
(n=155) of the sample. The average age of participants was 35, and on average they
had abused cocaine for over 10 years (M = 10.50 years, SD =7.23).

STUDY VARIABLES
The independent and dependent variables are identified next. Additionally, the
operational definitions of the variables are described.
Independent Variables

Treatment condition is one independent variable (IVya), and #reatment status is a
second independent variable (IVg). Independent variables are also referred to as
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factors, and we will be using both terms synonymously in our discussion.
Treatment retention is the dependent variable.

Treatment condition is operationally defined with two levels: (1) standard care
(SC) of substance abuse outpatient treatment and (2) standard care + contingency
management (CM). The SC level for participants with cocaine use disorders
involved group therapy, psycho-education, skills-based instruction, 12-step treat-
ment, and screening of breath and urine samples over 12 weeks. The participants in
the SC + CM level condition received standard care as just described, with the
added benefit of being given a financial reinforcement for verified abstinence and
goal-related activity completion over the same time period. Participants’ abstinence
from cocaine during treatment was measured with 21 sets of breath and
urine samples over the 12 weeks. Each time the participants gave a clean breath
and urine sample they received a financial reinforcement. Moreover, each time the
participants completed a goal-related activity they received money as a reinforcement.
The scale of measurement of the IV is discrete-nominal (categorical) since the con-
ditions are designed to be mutually exclusive from each other with no intended order.

Treatment status is the second independent variable (IVp) and is used in this
study to determine if the number of previous attempts by participants to treat
their cocaine disorder affects treatment retention. Treatment status in the study
example is operationally defined as (1) 0—1 prior treatment attempts and (2) =2
prior treatment attempts. The scale of measurement of the IVy also is discrete-
nominal (categorical).

Dependent Variable

The dependent variable (DV) is treatment retention, operationally defined as the
number of successful weeks in treatment. Since there are 12 weeks of treatment,
the possible range of scores for the dependent variable is 0—12 weeks. The DV is
continuously scaled (ratio) variable with equal distances between number points
and a true zero reference.

RESEARCH DESIGN

The research design used for this research example is a factorial design (Shadish,
Cook, & Campbell, 2002) to assess the effects of two independent variables,
treatment condition (Xy) and treatment status (Xp), on one dependent variable
(treatment retention).
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TABLE 9.1 2 X 2 Factorial Design Matrix

Xg Treatment Status
O—1 Prior treatment =2 Prior treatment
attempts (1) attempts (2)
Xa Treatment SC (M Cell Xa1g1 Cell Xa1g2
Condition SC+CM (2) Cell XA251 Cell XA252

This is a 2 X 2 factorial design that is represented as a matrix in Table 9.1. It is
a partially randomized design in which participants were randomly assigned to the
standard condition and the standard condition + contingency management
condition. However, the independent variable of Treatment Status is an attribute
IV since participants bring with them prior treatment attempts, resulting in being
classified as either 0—1 prior treatment attempts or =2 prior treatment attempts.

The two levels, SC (1) and SC+ CM (2), of the independent variable X,
Treatment Condition are two rows in the matrix. The two levels, 0—1 Prior
Treatment Attempts (1) and =2 Prior Treatment Attempts (2), of the second
independent variable Xy 7reatment Status are columns in the matrix. This 2 X 2
factorial design creates four cells. In this study, we are using a between 2 X 2
randomized factorial design in which the cells are independent or orthogonal from
each other. There are different participants in each cell receiving a unique
combination of one level of each independent variable. For example, participants
in Cell Xa;p; will receive the SC treatment level condition and they will be
individuals who have had 0-1 prior treatment attempts. A different group of
participants who are in Cell Xy,p, will receive the SC + CM treatment level
condition and they will have =2 prior treatment attempts.

The 2 X 2 factorial design can be diagrammed as follows:

R Xp81 O
R Xp182 O
R Xpop1 O
R Xpopy O
Each line in the diagram represents an independent group (four groups

[cells]), and the R symbolizes random assignment to each group condition. The
combination of one level of each independent variable represents the unique
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treatment condition and treatment status of the participants in each independent
group: (1) Xa1p1 ([SC] and [0-1 prior treatment attempts]), (2) Xa1p2 ([SC] and
[=2 prior treatment attempts]), (3) Xaop; ([SC + CM] and [0-1 prior treatment
attempts]), and (4) Xaopo ([SC + CM] and [=2 prior treatment attempts]). The
observation (O) is the post measure following 12 weeks of treatment imple-
mentation reflecting the number of weeks completed successfully in treatment,
which is the dependent variable, treatment retention.

Statistical Analysis: Factorial Analysis of Variance

A factorial ANOVA is used to test the effects of two (or more) independent variables
(main effects) on the same dependent variable and also examine how the independent
variables influence each other on the dependent variable (interaction effects). The
term factor is synonymous with independent variable, and a factorial ANOVA also is
referred to as a multifactor ANOVA, reflecting the fact that there is more than one
independent variable used in the statistical design. We can also use the descriptor
two-way ANOVA since there are two independent variables in this study.

In our example, a 2 X2 ANOVA means that there are two independent
variables (factors) with two levels to each independent variable (factor). The
initial analyses test the null hypotheses associated with the effects of each inde-
pendent variable (factor) on the dependent variable (two main effects), and a
combination of effects on the dependent variable from certain levels of the first
independent variable (factor) with certain levels of the second independent var-
iable (factor) (one interaction effect). If the interaction effect is significant, we will
conduct a simple effects analysis to determine which levels of the first independent
variable with which levels of the second independent variable interact to produce
significant effects on the dependent variable.

Any ANOVA can be classified as being a between-subjects, within-subjects,
or mixed-subjects ANOVA design. A between-subjects ANOVA design compares
participant scores across groups that are not dependent on each other. A within-
subjects ANOVA design compares repeated-measured scores across participants. A
mixed-subjects ANOVA design combines both analyses between scores of inde-
pendent groups and within analyses of repeated measured scores of participants.
In this study, the 2 X 2 factorial ANOVA is a between-subjects ANOVA design.
We will be analyzing scores across independent groups, and there are no repeated
measurements on participants.
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Factorial ANOVA models can get more complex (higher orders) such as a
2 X 3 X 2 ANOVA, which means the analysis would involved three independent
variables, the first IV with two levels, the second IV with three levels, and a third
IV with two levels. We can visualize this analysis with a three-dimensional cube
(having 12 cells) where we are analyzing rows (first IV with levels), columns
(second IV with levels), and layers (third IV with levels) and then the interactions
between rows and columns, rows and layers, columns and layers, and rows,
columns, and layers. So, in the first analysis there would be seven null hypotheses
tested. Then the many possible post hoc and simple effects analyses would be
conducted.

The following underlying assumptions need to be met in order to use a
factorial ANOVA. Data screening will be conducted to assess whether the data set
meets these three assumptions:

1. Normality. The scores on the dependent variable for each condition are
normally distributed around their mean.

2. Homogeneity of variance. The variances of the scores of the dependent variable
across the conditions should be constant.

3. Independence of observations. The observations are independent from one
another and not correlated with each other.

PROGRESS REVIEW

1. Theresearch problem was presented that focuses on whether
a contingency management approach added to standard
care for cocaine abusers can increase their completion rate
in treatment. The independent variables are Treatment
Condition (SC vs. SC + CM) and Treatment Status (O-1 prior
treatment attempts vs. =2 prior treatment attempts), and their
effects on the dependent variable (Treatment Retention) will
be assessed.
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2. The 120 participants are randomly assigned to the four treat-
ment conditions using a 2 X 2 randomized factorial design.

3. The changes in the dependent variable, Treatment Retention,
are operationally defined as successful weeks in treatment
and will be assessed across the conditions using a two-way
analysis of variance statistic.

4. Next, the research questions are stated and we begin com-
pleting the steps of the hypothesis-testing process.

STATING THE OMNIBUS (COMPREHENSIVE)
RESEARCH QUESTIONS

The statistical results of a two-way ANOVA automatically generate three find-
ings, which are two main effects and one interaction effect. Additional statistical
findings can be created from these basic three analyses. We are going to start by
identifying the three omnibus research questions that relate the basic analysis of
the 2 X2 ANOVA used in this problem. The steps of the hypothesis-testing
process related to this research problem will be presented following the statement
of the three research questions.

Omnibus Research Questions (RQs)

RQ; (Main Effect of Treatment Condition): To what extent will the standard
care + contingency management condition produce significantly higher treat-
ment retention (successful weeks in treatment) among participants when com-
pared to the standard care condition?

RQ, (Main Effect of Treatment Status): To what extent will the =2 prior
treatment attempts level result in higher treatment retention (successful weeks in
treatment) among participants when compared to the 0-1 prior treatment
attempts level?

RQ; (Interaction Effect of Treatment Condition & Treatment Status): To
what extent will there be significant mean differences in treatment retention
(successful weeks in treatment) across levels of treatment condition and treatment
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status? (Or it could be stated: To what extent will there be a significant inter-
action effect between treatment condition and treatment status on treatment
retention as measured by successful weeks in treatment?)

HYPOTHESIS TESTING STEP 1: ESTABLISH THE
ALTERNATIVE (RESEARCH) HYPOTHESIS (H,)

The three omnibus alternative hypotheses for our research problem are stated
next in both narrative and symbolic formats. We also will be addressing sub-
questions and subhypotheses following the overall analysis.

Omnibus Narrative Alternative Hypotheses (H,)

H,, (Main Effect of Treatment Condition): The standard care +
contingency management condition will produce significantly higher
treatment retention (successful weeks in treatment) among participants
when compared to the standard care condition without the contingency
management (CM) condition.

H, (Main Effect of Treatment Status): The =2 prior treatment
attempts level will result in higher treatment retention (successful weeks
in treatment) among participants when compared to the 0-1 prior
treatment attempts level.

H,3 (Interaction Effect of Treatment Condition & Treatment Status):
There will be significant mean differences in treatment retention (suc-
cessful weeks in treatment) across levels of treatment condition and
treatment status.

Symbolic Alternative Hypotheses (H,)

H,;: (Main Effect of Treatment Condition): p; < p,

where ;= population mean of treatment retention (successful weeks in
treatment) of participants in the SC level of the #reatment condition
being estimated by the sample mean
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where

where

o = population mean of treatment retention (successful weeks in
treatment) of participants in the SC + CM level of the mreatment con-
dition being estimated by the sample mean

H,>: (Main Effect of Treatment Status): p; < p,

{; = population mean of treatment retention (successful weeks in
treatment) of participants in the 0-1 prior treatment attempts level of
the treatment status being estimated by the sample mean

o = population mean of treatment retention (successful weeks in
treatment) of participants in the =2 prior treatment attempts level of
the treatment status being estimated by the sample mean

: (Interaction Effect of Treatment Condition & Treatment Status)
Py X =0

i, = population means of treatment retention (successful weeks in
treatment) of participants in both levels of the treatment condition (SC
and SC + CM) estimated by the sample means

W, = population means of treatment retention (successful weeks in treat-
ment) of participants in both levels of mreatment status (0-1 prior attempts
and =2 prior treatment attempts) estimated by the sample means

The alternative hypotheses for the main effects are directional. The SC + CM
level of treatment condition is expected to produce better treatment retention (suc-

cessful weeks in treatment) when compared to the SC level. The =2 prior treatment

attempts level of treatment status is expected to generate higher treatment retention

when compared to 0-1 prior treatment attempts. The interaction alternative

hypothesis is stated in a nondirectional format. The specific differences in treatment

retention across levels of treatment condition and treatment status are not specified.

Jones and Tukey (2000) Recommended Process to Reach
Conclusions

We have three possible decisions that can be made for each of the three

hypotheses following the recommendations by Jones and Tukey (2000). For the
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first two main effects, there are three possible conclusions for each main effect:
(1) the mean number of treatment completed weeks resulting from the SC ()
condition is higher than for the SC + CM condition (j1,), (2) the mean number
of treatment completed weeks resulting from the SC (j11) condition is lower than
for the SC + CM condition (j1,), or (3) the conclusions are indefinite. The two
possible conclusions for the interaction effect are that there is an interaction effect
or that the presence of an interaction effect is indefinite.
(Main Effect of Treatment Condition). Act as if:

1. (1 —p2) >0, (2) (b — o) <0, or (3) the sign (<0 or >0) of (u; — py) is
indefinite.

(Main Effect of Treatment Status). Act as if:

2. (1 —p2) >0, (2) (1 — po) <0, or (3) the sign (<0 or >0) of (u; — pp) is
indefinite.

(Interaction Effect of Treatment Condition & Treatment Status). Act as if:

3. (g X pp) >0 or (2) the sign (>0) of (ju; X py) is indefinite.

HYPOTHESIS TESTING STEP 2: ESTABLISH THE NULL
HYPOTHESIS (Ho)

The omnibus null hypotheses are stated in narrative and symbolic formats in the
second step of the hypothesis-testing process.

Omnibus Narrative Null Hypotheses (Hop)

Hy; (Main Effect of Treatment Condition): There will be no significant mean
difference in treatment retention (successful weeks in treatment) when comparing
the effects of the standard care (SC) condition to the standard care + contingency
management (CM) condition.

Hpy, (Main Effect of Treatment Status): There will be no significant mean
difference in treatment retention (successful weeks in treatment) when comparing
the effects of 0—1 prior treatment attempts to =2 prior treatment attempts.
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Hy; (Interaction Effect of Treatment Condition & Treatment Status): There
will be no significant mean differences in treatment retention (successful weeks in
treatment) across levels of treatment condition and treatment status.

Symbolic Null Hypotheses (H))
Hy: (Main Effect of Treatment Condition): ju; = i,

Hy,: (Main Effect of Treatment Status): j1; =1,

Hys: (Interaction Effect of Treatment Condition & Treatment Status):
1 X pp =0

HYPOTHESIS TESTING STEP 3: DECIDE ON A RISK LEVEL
(ALPHA) OF REJECTING THE TRUE Ho CONSIDERING
TYPE | AND Il ERRORS AND POWER

We will choose an alpha criterion () that we will use to make a decision about
whether to reject a true null hypothesis (H)) in this step of the hypothesis-testing
process. During this step of the hypothesis-testing process, we choose an alpha
criterion (o) that we will use to make a decision about whether to reject a true
null hypothesis (Hy). We consider the balancing act between Type I (alpha) and
Type II (beta) errors. Then, we will use our chosen o level and combine it with
anticipated sample size and an estimated (a priori) effect size and determine if we
have enough power (a priori) to conduct the study. Power is the probability of
correctly rejecting a false null hypothesis.

Selecting Alpha (o) Considering Type | and Type Il Errors

As is customary, we will choose an « level of either .001, .01, .05, or .10. Several
previous studies have shown that adding contingency management to standard
care practices is effective in keeping cocaine abusers in treatment. Moreover,
previous research has shown that persons with =2 prior treatment attempts have
higher treatment retention than individuals with 0—1 prior attempts. This study
has a goal to replicate findings from past studies. Therefore, a stricter alpha cri-
terion of o =.01 will be used in this study. This increases the probability of not
making a Type I error, which is rejecting a true null. This will provide more
confidence in our decision if the SC+ CM condition and =2 prior treatment
attempts level produces significantly higher treatment retention when compared
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to the SC condition and 0-1 prior attempts level (reject Hy). However, if we
don’t reject the null that there are differences, the av=.01 increases the proba-
bility of making a Type II error of failing to reject H, when there are significant
differences in means (false H,).

A Priori Power Analysis

Next, we will conduct an a priori power analysis to determine the probability of
correctly rejecting the false null hypotheses in our study. We have a sample size
(N=120) and alpha (av=.01) but need estimated effect sizes for the two main
effects and the interaction effect to conduct the power analysis. One might use
different power analysis criteria for various effects. For example, previous litera-
ture may show that the estimated effect size of one main effect is lower than the
other main effect. In that case, we would use different estimated effect sizes when
conducting the power analyses for each main effect.

We are going to use the following a priori effect sizes based on average eta-
squared effect sizes from several related studies: (1) Treatment Condition,
1 = .24; (2) Treatment Status, 1)> = .19; (3) Treatment Condition X Treatment
Status Interaction, 1° =.22. We are going to use G*Power 3.2.1 to compute the
power analyses.

Power Analysis Using G*Power 3.1

We also will conduct the power analysis using G*Power 3.1.2 for the two main
effects and the interaction effect. The o = .01, desired power of .80, and an estimated
effect sizes of Treatment Condition (n* = .24), Treatment Status (1> =.19), and
Treatment Condition X Treatment Status Interaction, n* = .22 are used.

Treatment Condition

1. Open up the G*Power 3.1.2 program.

2. Select F tests under Test family > under Statistical test, select ANOVA:
Fixed effects, special, main effects and interactions > under Type of
power analysis, sclect A priori: Compute required sample size - given o,
power, and effect size.

3. To the left of Effect size f, click on the Determine button and a new
attached window opens up that requests additional information. Click on the
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Direct circle and beside partial > type in the first 1°>=.24 (Treatment
Condition) and click on the Calculate and transfer to the main window
button and click on the Close button.

4. You will notice that next to Effect size f is the number 0.5619515. Next,
beside o err prob type 0.01 > beside Power (13 err prob), type 0.80 >
beside Numerator df, type 1 > beside Number of groups, type 2 > click on
Calculate button.

The analysis for Treatment Condition produced a required total sample size
of 41 participants to reach a power of .8073356 using an a=.01 and an esti-
mated effect size of T]z = .24. (See Figure 9.1.) Our study sample size of N= 120
exceeds the requirement.

Treatment Status Follow the same procedures to conduct the power analysis for
Treatment Status now using an T]2 =.19. (See Figure 9.2.) Click on the Direct circle
and beside partial 1> type in the n°=.19 (Treatment Status) and click on the
Calculate and transfer to the main window button and click on the Close button.
This produces in the main window an effect size /= 0.4843221. Next, beside o err
prob type 0.01 > beside Power (1-3 err prob), type 0.80 > beside Numerator df,
type 1 > beside Number of groups, type 2 > click on Calculate button.

The analysis for Treatment Status produced a required total sample size of 54
participants to reach a power of .8075639 using an o =.01 and an estimated effect
size of ° = .19. Our study sample size of N= 120 exceeds the requirement.

Treatment Condition X Treatment Status Interaction Follow the same
procedures to conduct the power analysis for Treatment Condition X Treatment
Status Interaction now using nowan > = .22. (See Figure 9.3.) Click on the Direct
circle and beside partial n* type in the m*=.22 (Treatment Condition X
Treatment Status) and click on the Calculate and transfer to the main window
button and click on the Close button. This produces in the main window an effect
size f=0.5310850. Next, beside o err prob type 0.01 > beside Power (1-3 err
prob), type 0.80 > beside Numerator df, type 1 > beside Number of groups,
type 4 (there are four groups or cells being compared) > click on Calculate button.

The analysis for Treatment Status produced a required total sample size of 46
participants to reach a power of .8113268 using an o« =.01 and an estimated effect
size of 1> = .22. Our study sample size of N = 120 exceeds the requirement.
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FIGURE 9.1 Power Analysis for Treatment Condition of the Factorial
ANOVA Problem

iift, G*Power 3.1.2 E] [ZJ

File Edit Yiew Tests Calculator Help

i Central and noncentral distributions ’ Protocol of power analyses
critical F =7.27956
0.5 -
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Test family Statistical test
\F tests VI |ANOVA: Fixed effects, special, main effects and interactions VI

Type of power analysis

’A priori: Compute required sample size - given o, power, and effect size VI
Input Parameters Output Parameters
Effect size f 0.5310850 Noncentrality parameter A 12.9743588
o err prob 0.01 Critical F 7.2795611
Power {1-p err prob) 0.80 Denominator df 42
Numerator df 1 Total sample size 46
Number of groups 4 Actual power 0.8113268
[ X-Y plotfor a range of values ] [ Calculate ]
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FIGURE 9.2 Power Analysis for Treatment Status of the Factorial ANOVA
Problem

ii#, G*Power 3.1.2
File Edit VYiew Tests Calculator Help

Central and noncentral distributions l Protocol of power analyses
critical F = 7.14885
0.5 4
0.4 1
0.3 4
0.2 4
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Test family Statistical test
’F tests v‘ lANOVA: Fixed effects, special, main effects and interactions v|

Type of power analysis

’A priori: Compute required sample size - given o, power, and effect size v|
Input Parameters Qutput Parameters
Effect size f 0.4843221 Noncentrality parameter A 12.6666664
o err prob 0.01 Critical F 7.1488515
Power {1-p err prob) 0.80 Denominator df 52
Numerator df 1 Total sample size 54
Number of groups 2 Actual power 0.8075639
[ X-Y plotfor a range of values ] l Calculate ]
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FIGURE 9.3 Power Analysis for Treatment Condition X Treatment Status
Interaction of the Factorial ANOVA Problem

iift, G*Power 3.1.2
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o err prob 0.01 Critical F 7.3327938
Power {1-p err prob) 0.80 Denominator df 39
Numerator df 1 Total sample size 41
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PROGRESS REVIEW

1. We stated the research questions for the study problem.

2. We completed the first two steps of the hypothesis-testing
process by stating the alternative and null hypotheses in
narrative and symbolic formats.

3. Next, we decided on the risk we are willing to take when
rejecting a true null hypothesis by choosing alpha (o). We
chose a=.01, which we believed was a reasonable criterion in
our study to avoid making a Type | or Type Il error.

4. We conducted a power analysis to make sure that our
probability of correctly rejecting a false null hypothesis was
adequate (power =.80) before moving ahead with the study.
Using G*Power 3.1.2, we found that we met the a priori power
expectation of .80.

HYPOTHESIS TESTING STEP 4: CHOOSE APPROPRIATE
STATISTIC AND ITS SAMPLING DISTRIBUTION TO TEST
THE Ho ASSUMING Ho IS TRUE

We are using a two-way ANOVA to test the three null hypotheses in this study.
We are going to compare the means of 7reatment Retention (DV) for each main
eftect of Treatment Condition (IV,) and Treatment Status (IV,) and their
interaction effect for significant differences using the F distribution. The two-
way ANOVA is appropriate to use because: (1) there are two independent
variables, (2) there are different participants in each of the four groups,
(3) there is one dependent variable, and (4) the dependent variable is contin-
uously scaled.
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HYPOTHESIS TESTING STEP 5: SELECT SAMPLE, COLLECT
DATA, SCREEN DATA, COMPUTE STATISTIC, AND
DETERMINE PROBABILITY ESTIMATES

In Step 5 of the hypothesis-testing process, data are collected from a sample of
participants. The data are assessed for data accuracy, missing values, and uni-
variate outliers, and to determine if the underlying assumptions of the statistic are
met. Data modifications are made if warranted by the data screening results.
Then the null hypotheses are tested using the two-way ANOVA.

Sample Selection and Assignment

The sample of this study consisted of cocaine abusers seeking treatment in a
substance use disorder clinic. Participants were included in the study if they were
18 years of age or older and had abused cocaine within the past year or longer.
Also, they had to meet the Diagnostic and Statistical Manual of Mental Disorders
criteria for dependency.

Potential participants were excluded if they had a psychosis diagnosis, suicidal
ideation, or chronic gambling history. They also were excluded if they were
unable to comprehend and follow the study procedures.

The independent variable of Treatment Status is an attribute IV where the
participants either have 0—1 prior treatment attempts or equal to or greater than two
(=2) prior treatment attempts. Therefore, it was necessary to select a sample with
an equal number of participants in the two categories of prior treatment attempts.
The initial sample was 125 individuals; however, two individuals met exclusion
criteria and three persons dropped out of the study before it began. The final study
sample was 120 cocaine abusers who sought treatment. The participants encompass
characteristics that reflect the persons, settings, times, independent variables, and
dependent variables we intend to use to generalize our findings.

The 120 participants were assigned randomly to four groups as follows:
(1) Xa1p1 ([SC] and [0-1 prior treatment attempts]), (2) Xa1p2 ([SC] and [=2
prior treatment attempts]), (3) Xaop; ([SC+ CM] and [0-1 prior treatment
atctempts]), and (4) Xaopy ([SC+ CM] and [=2 prior treatment attempts]).
Whether a participant had either 0-1 prior treatment attempts or =2 prior
treatment attempts was an attribute that participants brought with them to the
study, so random assignment could not be used across the two conditions.
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However, random assignment was used to group participants by Treatment
Status into the two groups used for each condition.

Study Data Diagnostics

We are next going to conduct data diagnostics to assess for accuracy of data
entries, missing data, univariate outliers, and compliance to the underlying
assumptions of the two-way ANOVA. This is done after the data are collected
and before the null hypotheses are tested.

Accuracy of Data Entry

The individual scores on the dependent variable were in expected range and the
means and standard deviations were credible when compared to descriptive sta-
tistics from previous studies. All of the original data were compared and cor-
roborated to the entered data by two members of the research team.

Missing Data Analysis

There were no missing data in the original data set.

Means, Standard Deviations, Variances, and Assessing for Univariate Outliers
IBM SPSS Commands

Enter the data from the Two-Way Analysis of Variance Data table at the end of
the chapter into IBM SPSS. Enter the participant ID numbers and three columns
of data just as they appear in the table.

1. Click on Data > Split File > click on circles beside Compare groups and
Sort the file by grouping variables > click on 7reatmentStatus and Trear-
mentCondition and click the arrow so that TreatmentStatus and Treatment-
Condition are under Groups Based on>click on OK and don’t save
command output. You have instructed the program to generate output by
the four groups (7reatmentStatus X TreatmentCondition). You will need to
change back this split file command later.
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2. Click on Analyze > Descriptive Statistics > Descriptives > click over
TreatmentRetention to Variable(s) > click on Save standardized values as
variables > click on Options and check Mean, Std. deviation, and Vari-
ance > click on OK > save the output as TwowayANOVA Descriptives.

The Descriptive Statistics Table 9.2 lists the sample size of each group followed
by the lowest (minimum) and highest (maximum) scores in each group. Valid N
refers to the number of participant scores that do not having missing data. The
average scores (means) by groups on the Treatment Retention (number of treatment
weeks successfully completed) are provided. Measures of variability designate the
extent that the scores in each group distribution deviate from their group mean. The
standard deviation is an average measure of score deviation from the mean, whereas
the square of s is the variance %) or general spread of scores from the mean. Higher
scores reflect more deviation of scores from the mean for both s and 5*. As you can
see, the standard deviations and variances do not deviate highly from one another,
which suggests we may have homogeneity of variance.

The standard values (z-scores) requested for the analysis to assess for univariate
outliers are produced in a new column on the Data View IBM SPSS spreadsheetand
named Z7reatmentRetention. These values represent the z-scores corresponding to
the raw scores in each group. Since we used the “Split File” command, the z-scores
for participant scores are produced separately for each of the four groups. The first
group, ([SC] and [0-1 prior treatment attempts]), is represented by ID #s 1-30,
group 2 ([SC] and [=2 prior treatment attempts]) =ID #s 31-60, group 3
([SC+ CM] and [0-1 prior treatment attempts]) = ID #s 61-90, and group 4
([SC+ CM] and [= 2 prior treatment attempts]) = ID #s 91-120. The highest
positive and negative z-scores for each group are reported in Table 9.3.

None of the z-scores exceed the criterion of =3.29 (<.001, two-tailed), so we
conclude that the raw scores of each group are not far removed from the rest of
the scores in each group.

At this point, remove the Split File filter. Data > Split File > click on the
Reset button and then click OK; click out of the output and don’t save it.

Assessing for Underlying Assumptions

Initially, we will assess the dependent variable (treatment retention) by each
group for normality by assessing histograms, skewness, kurtosis, the Shapiro-Wilk
statistic, and normal Q-Q plots.
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TABLE 9.2 Descriptive Statistics of Treatment Retention by Treatment Condition X Treatment Status Groups

TreatmentCondition

N Minimum Maximum Mean

Std.

Deviation Variance

Standard Care

Standard Care +
Contingency
Management

TreatmentStatus
O—1 Prior treatment TreatmentRetention
attempts Valid N (listwise)
=2 Prior treatment TreatmentRetention
attempts Valid N (listwise)
O—1 Prior treatment TreatmentRetention
attempts Valid N (listwise)
=2 Prior TreatmentRetention
treatment Valid N (listwise)

attempts

30
30

30
30
30
30

30
30

3.00

2.00

2.00

5.00

9.00

7.00

8.00

11.00

5.5667 150134

4.8000 1.42393

5.7000 157896

7.5333 1.35782

2.254

2.028

2.493

1.844




TABLE 9.3 Highest +=z-Scores by Group

Conditions Highest Outlier? Highest Outlier?
Group +z >+3.29 4 >+3.29
SC/0-1 2.287* No -1.710 No
SC/=2 1.545 No —1.966 No
SC + CM/0-1 1.457 No —2.343 No
SC + CM/ 2 2.553 No —1.866 No

*These numbers are rounded to three decimals.

Normality IBM SPSS Commands

1.
2.

Analyze > Descriptive Statistics > Explore.
Click over dependent variable 7reatmentRetention to Dependent List.

Click over independent variables (7reatmentCondition & TreatmentStatus)
to Factor List. Remember factor is another term for independent variable.

Do not change Display choices—leave on Both.

To the upper right of Display are three buttons. Click on Plots. Then,
select Histograms, Normality plots with tests.

Under Spread vs. Level with Levene Test click on Untransformed. (If we
wanted a .99 CI of the Mean, we would change at Statistics button.)

Click on Continue.
Click on OK.

Save the output as TwowayANOVAassumptionscreen.

First, look at the information under Descriptives on the output (see Table 9.4).

There are two SPSS tables of descriptives. The first table shows means of the
dependent variable (Treatment Retention) based on Treatment Condition and is
followed by several other statistical tables of information that we will use. The second
table of descriptives based on Treatment Status is in the second half of the SPSS
output followed by several tables. Please note that these four means are row and

column means that combined cell means of each of the two rows and two columns.

The four means in Table 9.4 are the cell means that are used to compute the row and
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TABLE 9.4 Skewness, Kurtosis, and Standard Error Values by Group

Descriptives

TreatmentCondition Statistic  Std. Error
TreatmentRetention Standard Care Mean 5.1833 19382
95% Confidence Lower Bound 4.7955
Interval for Mean Upper Bound 5.5712
5% Trimmed Mean 5.1667
Median 5.0000
Variance 2.254
Std. Deviation 1.50132
Minimum 2.00
Maximum 9.00
Range 7.00
Interquartile Range 2.00
Skewness .049 .309
Kurtosis —.215 .608
Standard Care Mean 6.6167 .22309
+ Contingency Management
95% Confidence Lower Bound 6.1703
Interval for Mean Upper Bound 7.0631
5% Trimmed Mean 6.6481
Median 7.0000
Variance 2.986
Std. Deviation 1.72805
Minimum 2.00
Maximum 11.00
Range 9.00
Interquartile Range 2.75
Skewness —.255 .309
Kurtosis 371 .608

(Continued)



TABLE 9.4 Skewness, Kurtosis, and Standard Error Values by Group (Continued)

Descriptives

TreatmentStatus Statistic  Std. Error
TreatmentRetention O-1 Prior treatment attempts Mean 5.6333 19739
95% Confidence Lower Bound 5.2383
Interval for Mean Upper Bound 6.0283
5% Trimmed Mean 5.6481
Median 6.0000
Variance 2.338
Std. Deviation 1.52900
Minimum 2.00
Maximum 9.00
Range 7.00
Interquartile Range 2.00
Skewness —.144 .309
Kurtosis —.348 .608
=2 Prior treatment attempts Mean 6.1667 25174
95% Confidence Lower Bound 5.6629
Interval for Mean Upper Bound 6.6704
5% Trimmed Mean 6.1667
Median 6.0000
Variance 3.802
Std. Deviation 1.94994
Minimum 2.00
Maximum 11.00
Range 9.00
Interquartile Range 2.75
Skewness —-.029 .309
Kurtosis —.271 .608




column means. Later, we will combine the cell, row, and column means into one table
to clarify the interpretation of the two-way ANOVA.

Skewness

Look at the values for skewness and “Std. Error” for each group in Table 9.4.
Divide the skewness statistic value by its Std. Error value to obtain z-scores. The
skewness and standard error and their resulting skewness z-scores are presented in
Table 9.5.

There are no extreme scores relative to most of the scores in the distributions
in the positive (right) end or negative (left) end of the distributions. The skewness
z-scores are not even close to the criterion of £3.29 (p <.001, two-tailed test).

Below the skewness and standard error values in Table 9.4 are the “Kurtosis”
and “Std. Error” values. We will divide the kurtosis statistic by its standard error
and compare the resultant z-score to =3.29 to see if any group distribution
significantly departs from normality (see Table 9.6).

None of the four condition group distributions have kurtosis z-scores that are
greater than £3.29, so they do not depart significantly form normality.

TABLE 9.5 Skewness z-Scores by Condition Group

Skewness z Skewness Sig. Departure?
Condition (Stat./Std. Error=2) Direction  +3.29)
SC .049/.309 =.159 Positive No
SC+CM —.255/.309 = —.825 Negative No
O-1 Prior visits —144/.309 = —.466 Negative No
=2 Prior visits —.029/.309=-094 Negative No

TABLE 9.6 Kurtosis z-Scores by Condition Group

Kurtosis z Kurtosis Sig. Departure?
Condition (Stat./Std. Error=2) Direction (> £3.29)
SC —.215/.608 = —.354 Platykurtic No
SC+CM .371/.608 =.610 Leptokurtic No
O-1 Prior visits —.348/.608=—.572 Platykurtic No
=2 Prior visits —.271/.608 = —.446 Platykurtic No
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Shapiro-Wilk (S-W) Statistic

The S-W statistic provides corroborating evidence to use to determine if the
distribution of the group conditions are normally distributed. The S-W statistics
are found in the output under 7ests of Normality (see Table 9.7). The null
hypothesis that we are testing (o =.01) for each group with the S-W is:

Hjy: The Sample Distribution = Normal

We want to retain the null hypothesis, which says that the sample distribu-
tion that we are testing is not deviating significantly from being normally
distributed.

The significant probability levels (Sig.) of the Shapiro-Wilk statistic are .051
(SC), .075 (SC + CM), .042 (01 prior attempts), and .208 (=2 prior attempts);
all of these levels are greater than o =.01. Our rule is to reject a null hypothesis if
the probability level of the calculated statistic is less than our stated alpha level,
and we fail to reject the null if our significance probability is greater than our
alpha. Therefore, we conclude that these four group distributions are not devi-
ating significantly from being normally distributed.

Normal Q-Q Plots

The final evidence of normality that we will interpret is the normal Q-Q
plot for each distribution. A plot for each group is located in the output under
the heading Normal Q-Q Plots. If the sample is from a normal distribution, we
expect that the points will fall more or less on a straight line, reflecting con-
gruence between observed values in the distribution paired with their expected
values from the normal distribution (see Figures 9.4a, 9.4b, 9.4c, and 9.4d).

The points fall on or near the straight line of the Q-Q plots for all four
groups, adding to the evidence that each group is normally distributed.

Summary of the Normality Evidence

No individual 77eatment Retention scores were univariate outliers within the
four groups represented by combinations of the two levels of the two

256 ¢« CHAPTER 9



TABLE 9.7 Shapiro-Wilk Statistics by Condition Group

Tests of Normality

Kolmogorov-Smirnova

Shapiro-Wilk

TreatmentCondition Statistic df Sig. Statistic df Sig.
TreatmentRetention Standard Care 140 60 .005 .961 60 .051
Standard Care + 154 60 .001 .964 60 .075
Contingency Management
Tests of Normality
Kolmogorov-Smirnovb Shapiro-Wilk

TreatmentStatus Statistic df Sig. Statistic df Sig.
TreatmentRetention O-1 Prior treatment attempts 145 60 .003 .959 60 .042
= =2 Prior treatment attempts 132 60 0N 973 60 .208

ab| jlliefors significance correction.



FIGURE 9.4A, B, C, AND D Normal @-Q Plot by Condition Groups
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FIGURE 9.4A, B, C, AND D (Continued)
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independent variables. The skewness z-scores, kurtosis z-scores, S-W statistics,
and Q-Q plots demonstrated that the four distributions were not deviating sig-
nificantly from normality. The consistency of the evidence supports that the
Treatment Retention is normally distributed within the distributions of the
groups, meeting the assumption of normality.

Homogeneity of Variance

We want the variability of the scores across groups to be constant. First we will
calculate the variance ratio of the highest variance by the lowest variance of the
four groups (see Table 9.4). The highest variance is 3.802 for the ==2 Prior
Treatment Attempts group, and the lowest variance is 2.254 for the Standard
Care group. The variance ratio (Fj,,,) is 3.802/2.254 = 1.687. Since the groups
are equal in size, we can use the criterion of an F,,,, <10 being acceptable.
Clearly, our F,,,, of 1.687 is less than 10.

Next, we will see if Levene’s test of homogeneity of variances also supports
meeting the underlying assumption. We are testing the null hypothesis of
equality of the error variances across the four groups. We want to retain the null
hypothesis concluding that the variances across the three groups are equal enough
using an alpha criterion of .01.

L2 2 _ 2 )
Hy: %sc = %sc+cM = O;‘OflPriorAttempts_ UeZZPriorAttempts

The Levene’s statistic is found in the “assumptionscreen” output under the
heading Test of Homogeneity of Variance (see Tables 9.8 and 9.9) on the line called
“Based on mean.”

We fail to reject the Hj that the error variances are equal in both comparisons
since the probability value of .365 (SC vs. SC + CM) and .068 (0-1 vs. =2) are
greater than the o =.01. The underlying assumption of homogeneity of variance
has been met using the Levene’s statistic.

Summary of the Homogeneity of Variance Evidence

The evidence from both the variance ratio (F,,,) and the Levene’s statistic
support that the variances and error variances of the dependent variable are equal
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TABLE 9.8 Levene’s Test Comparing Variances of the Treatment
Condition Groups (SC vs. SC+ CM)

Test of Homogeneity of Variance

Levene’s
Statistic dfl df2 Sig.

TreatmentRetention Based on mean .828 1 18 .365
Based on median 477 1 N8 491
Based on median 477 1 112202 .491
and with adjusted df
Based on trimmed .800 1 N8 373
mean

TABLE 9.9 Levene’s Test Comparing Variances of the Treatment Status
Groups (0-1vs. =2)

Test of Homogeneity of Variance

Levene’s
Statistic dfl df2 Sig.

TreatmentRetention Based on mean 3.400 1 118 .068
Based on median 3.440 1T 18 .066
Based on median 3.440 1 NM5.785 .066
and with adjusted df
Based on trimmed 3.423 1 18 .067
mean

across the two groups of each independent variable. These findings paired with
the group sizes being equal allow us to conclude that the underlying assumption
of homogeneity of variance has been met.

Independence

There are different participants in each of the four groups, and each participant’s
score was produced independent of the other scores. However, if dependent
variable test scores across condition groups are correlated with each other when
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the scores are collected in the same order, the significance level of the ANOVA
can be smaller than it should be (Norusis, 2003). We are going to assess
the independence of observations by graphing the responses of participants

on the dependent variable by group condition based on the same order in which

measurements (observations) were obtained. The data in the SPSS Data View

spreadsheet are in a similar order by group based on when the data were collected.

We will need to create four columns of data to complete the analysis of matrix

scatter plots to assess independence.

Matrix Scatter Plot SPSS Commands

1.

First, close all output that you have been working on. Under the column
labeled 7reatmentRetention on the IBM SPSS Data View spreadsheet, left
click and hold on the first cell, which is 6, and drag down until you reach
ID# 30, which is the value 5 and the last participant score in the Treatment
Condition SC+ Treatment Status 0—1 group. All of the numbers should be
in bold.

At the top of the screen, click on Edit and then Copy. This will copy the
data for pasting to a new column.

Go to the first empty column in the Data View and click on the first cell,
and it will be bolded.

At the top of the screen, click on Edit and then click on Paste; the data from
the SC+ 0-—1 group will be copied to the new column.

At the bottom left of the spreadsheet, click on Variable View and name the
new column as sc0I and change the decimals to 0.

Click on Data View button and create a new column for the other three
groups of 30 participants in the same way; call them sc2, scem01, and scem?2.
Once you have completed the four new columns, File > Save.

At the top of the screen, click on Graphs > Legacy Dialogs > Scatter/
Dot > Matrix Scatter > Define.

Click over the four new columns you created to the space under Matrix

Variables > OK.
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FIGURE 9.5 Matrix Scatter Plot to Assess Independence on Treatment
Retention Across the Condition Groups
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The matrix scatter plot (Figure 9.5) shows the scores of each group compared to
the other groups. The scores are in the order they were obtained and are paired as
circles in each graph representing two groups being compared. If the scores form a
diagonal straight line when any two groups are compared, then the scores are
correlated and not independent. There appear to be no clear linear trends between
paired scores across the groups. The points scatter in many directions. We therefore
conclude that we have met the assumption of independence.

Summary of Underlying Assumptions Findings

The majority of evidence obtained shows that the distributions of scores on the
dependent variable in the four groups did not deviate from normality. Both
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measures of homogeneity of variance supported fulfillment of the assumption of
constancy of variance across the groups. Finally, the scatter plots suggest that
independence of dependent variable scores was met. This information provides
support for conducting the 2 X 2 ANOVA to test the omnibus null hypotheses in
this study.

PROGRESS REVIEW

1. The reported data were collected from the sample partici-
pants on the dependent variable treatment retention as
measured by the number of successful weeks in treatment.

2. Four groups were formed based on combinations of the
independent variable treatment condition (SC and SCCM)
and treatment status (O-1 and =2).

3. Data were screened and met the criteria for missing data and
underlying assumptions.

Two-Way Analysis of Variance of the Omnibus Hy’s

Two-Way ANOVA SPSS Commands

1. Click Analyze > click General Linear Model > click Univariate > click
over TreatmentRetention under Dependent Variable and 77eatmentCondi-
tion and TreatmentStatus under Fixed Factor(s).

2. Click on the Plots button > click TreatmentCondition to Horizontal Axis
and TreatmentStatus to Separate Lines > click the Add button > click
Continue.

3. Click on the Options button > click on the boxes for Descriptive statistics,
Estimates of effect size, Observed power, and Homogeneity tests > the
Significance level should be .01 > click on Continue > click OK.

4. Save generated output as Two-WayANOVA Results.
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The results of this analysis provide information to test the three omnibus null
hypotheses of the study:

Hy; (Main Effect of Treatment Condition): There will be no significant mean
difference in treatment retention (successful weeks in treatment) when
comparing the effects of the standard care (SC) condition to the standard
care + contingency management (CM) condition (Hy;: py = ).

Hpy, (Main Effect of Treatment Status): There will be no significant mean
difference in treatment retention (successful weeks in treatment) when
comparing the effects of 0-1 prior treatment attempts to =2 prior
treatment attempts (Hpy: [y = [1o).

Hys (Interaction Effect of Treatment Condition & Treatment Status): There
will be no significant mean differences in treatment retention (successful
weeks in treatment) across levels of treatment condition and treatment
status (Hys: pq X pp =0).

The results of the two-way ANOVA are presented next. Additionally, inter-
pretations are provided for the magnitude of treatment effects (effect sizes), post
hoc power, post hoc multiple comparisons of means, and confidence intervals for
the mean differences.

Two-Way ANOVA Computer Analysis Results

Descriptive statistics are provided in the two-way ANOVA output (see Table 9.10)
showing means, standard deviations, and sample sizes by combinations of conditions.

Previously, we assessed for homogeneity of variance of the treatment reten-
tion across the two groups for each condition and found there was constancy of
variance. Table 9.11 shows the results of assessing the variances of all four groups
together, and it shows that the significance is .822, which is greater than the
a=.01. Thus, we fail to reject the null that the variances are equal, and this
result supports the previous finding of constancy of variance.

In the two-way ANOVA output (see Table 9.12) labeled Tests of Between-
Subjects Effects you will see the name of the independent variables (7reatment-
Condition, TreatmentStatus, and TreatmentCondition X TreatmentStatus) under
the heading Source that we created when the data were entered. We will be using

RANDOMIZED FACTORIAL EXPERIMENTAL DESIGN USING A FACTORIAL ANOVA e 265



TABLE 9.10 Descriptive Statistics by Conditions

Descriptive Statistics

Dependent Variable: TreatmentRetention

TreatmentCondition TreatmentStatus Mean Std. Deviation N
SC 0O-1 5.567 1.501 30
+2 4.800 1.424 30
Total 5.183 1.501 60
SC+CM 0-1 5.700 1.579 30
+2 7.533 1.358 30
Total 6.617 1.728 60
Total 0-1 5.633 1.529 60
+2 6.167 1.950 60
Total 5.900 1.765 120

TABLE 9.11 Levene’s Test of Equality of Error Variancesa

Dependent Variable:TreatmentRetention

B dfl df2 Sig.

.305 3 116 .822

Tests the null hypothesis that the error variance of the dependent variable
is equal across groups.

?Design: Intercept + TreatmentCondition + TreatmentStatus + Treatment-
Condition X TreatmentStatus

the information in these rows to make decisions about rejecting or failing to reject
the three null hypotheses.

The results of testing all three null hypotheses are in Table 9.12. The results of
the first main effect of Treatment Condition (SC vs. SC + CM) on the dependent
variable 7reatment Retention (successful weeks in treatment) are under the column
called Source across the row TreatmentCondition. The test of significance of the first
main effect is in the #column (#= 28.605) and is significant at the p = .000, which
is less than our o =.01 and thus is significant, /(1, 116) = 28.605, p < .01. There
was a significant difference between the row means (see Table 9.10) of the SC level
(M=5.183, SD=1.501) versus the SC + CM level (M =6.617, SD=1.728).
The standard condition + contingency management level increased significantly

266 « CHAPTER 9



TABLE 9.12 Two-Way Analysis of Variance Results

Tests of Between-Subjects Effects

Dependent Variable: TreatmentRetention

Type Il
Sum Mean Partial Noncent. Observed

Source of Squares df Square F Sig. Eta-Squared Parameter Power?®
Corrected model 120.867° 3 40.289 18.699 .000 .326 56.097 1.000
Intercept 4,177.200 1 4,177.200 1,938.738 .000 .944 1,938.738 1.000
TreatmentCondition 61.633 1 61.633 28.605 .000 198 28.605 .996
TreatmentStatus 8.533 1 8.533 3.961 .049 .033 3.961 .270
TreatmentCondition X 50.700 1 50.700 23.531 .000 169 23.531 .986
TreatmentStatus
Error 249.933 116 2.155
Total 4,548.000 120
Corrected total 370.800 19

2Computed using alpha=.01.
PR-squared =.326 (adjusted R-squared =.309).



(p <.01) the number of successful weeks in treatment (7reatment Retention) of the
participants with cocaine disorders when compared to the standard condition level.

The second null hypothesis related to the main effect of 7reatment Status on
Treatment Retention (successful weeks in treatment) generated a significant
probability of p =.049, which is larger than the criterion av=.01 so the effect is
not significant, (1, 116) =3.961, p > .01. There was not a significant difference
(p>.01) between the column means of successful weeks in treatment of the 0—1
prior treatment attempts level (M =5.633, SD=1.529) versus the =2 prior
treatment attempts level (M= 6.167, SD=1.950).

The third null hypothesis related to the interaction effect was significant,
F(1,116) =23.531, p < .01. There were significant mean differences in treatment
retention (successful weeks in treatment) across levels of treatment condition and
treatment status.

The significant interaction is demonstrated in Figure 9.6 in relation to means
on treatment retention (weeks successful treatment completed) produced by the
independent variables. The two means of the 7reatmentCondition (horizontal
axis) are compared to the two means of the 7reatmentStatus level. (These cell
means are found in Table 9.10.) Parallel lines indicate no interaction, and
nonparallel lines reflect interaction. The lines in Figure 9.6 cross each other,
reflecting interaction (nonparallel lines) between the two independent variables
on the dependent variable. The two means across the levels of the treatment
condition for the treatment status level of 0—1 prior treatment attempts are
similar (SC [M=5.567] vs. SC+ CM =[M=5.700]. In contrast, the two
means across the levels of the treatment condition for the treatment status level
=2 prior treatment attempts are quite different. The SC + CM mean on #rear-
ment retention (M = 7.533) is considerably higher than the mean produced by the
SC condition level (M =4.800). These cell means being graphically compared
can be statistically tested, which is called a simple effects analysis.

Simple Effects Analysis

A simple effect is the effect of one factor (IV) on the DV at one level of the other
factor. We are going to conduct this because we have a significant interaction
effect. We are going to use IBM SPSS syntax commands to obtain these results.
Syntax commands are the instructions that you write to the program to initiate an
action.

268 ¢« CHAPTER 9



FIGURE 9.6 Estimated Marginal Means of Treatment Retention

Estimated Marginal Means of TreatmentRetention

3 - TreatmentStatus
—— 0O-1 Prior Treatment Attempts

—— =2 Prior Treatment Attempts

Estimated Marginal Means

T T
Standard Care Standard Care + Contingency
Management

TreatmentCondition

1. Go to File > New > Syntax > and type exactly the syntax for treatment
condition at each treatment status level below.

2. When complete save as syrax].

3. Select Run > click on All > and the results will be produced as an output;
save as outputl.

Syntax for Treatment Condition at Each Treatment Status Level Results
MANOVA

TreatmentRetention BY TreatmentCondition(1 2) TreatmentStatus(1 2)

/METHOD=UNIQUE
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/ERROR WITHIN

/DESIGN=TreatmentCondition WITHIN TreatmentStatus(1) Treat-
mentCondition WITHIN TreatmentStatus(2).

After clicking out of the first syntax you wrote, follow the same commands as
previously to produce the results of syntax for treatment status at each level of
treatment condition and save as syntax2 and outpur2.

Syntax for Obtaining Treatment Status at Each Level of Treatment
Condition Results

MANOVA

TreatmentRetention BY TreatmentCondition(1 2) TreatmentStatus(1 2)
/METHOD=UNIQUE

/ERROR WITHIN

/DESIGN=TreatmentStatus WITHIN TreatmentCondition(1) Treat-
mentStatus WITHIN TreatmentCondition(2).

Table 9.13 shows the results of two comparisons for 7reatment Condition (SC
and SC + CM) at each Treatment Statuslevel (0—1 and =2). The first comparison is
between the cell means of Treatment Condition (Msc=5.567) compared to
(Msc+cm = 5.700) at the treatment status level of 01 prior treatment attempts
(see Table 9.10). There is no significant difference since the Sig. of Fvalue is .726
(p>.01). The second comparison is between the cell means of Treatment Con-
dition (Msc =4.800) compared to (Msc+cm = 7.533) at the treatment status level

TABLE 9.13 Treatment Condition at Each Treatment Status Level Results

Tests of Significance for TreatmentRetention using UNIQUE sums of squares

Source of Variation SS DF MS F Sig. of F
WITHIN Cells 249.93 116 2.15
TreatmentCondition 27 1 27 12 726

WITHIN TreatmentStatus(1)

TreatmentCondition 12.07 1 112.07 52.01 .000
WITHIN TreatmentStatus
)
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TABLE 9.14 Treatment Status at Each Level of Treatment Condition
Results

Tests of Significance for TreatmentRetention using UNIQUE sums of squares

Source of Variation SS DF MS F Sig of F
WITHIN Cells 249.93 16 2.15

TreatmentStatus WITHIN 8.82 1 8.82 4.09 .045
TreatmentCondition(1)

TreatmentStatus WITHIN 50.42 1 50.42 23.40 .000

TreatmentCondition(2)

of =2 prior treatment attempts (see Table 9.10). Participants with =2 prior
treatment attempts and who received the Standard Care + Contingency Man-
agement treatment showed a significantly higher number of successful weeks in
treatment than those with =2 prior treatment attempts who received the standard
care treatment, F(1, 116) =52.01, p <.01.

In Table 9.14, the results of two comparisons for 7reatment Status (0—1 and
=2) at each Treatment Condition level (SC and SC + CM) are shown. The first
analysis compares the means of (My_; =5.567) compared to (M=, =4.800) at
SC, resulting in no significant difference (p > .01). Next, there was a significant
difference between the means of the #reatment status level 0—1 prior treatment
attempts (M =5.70) compared to the =2 prior treatment attempts level
(M=7.533) at the treatment condition level of SC + CM, F(1, 116) = 23.40,
p <.01. Participants receiving SC + CM showed a significantly higher number of
successful weeks in treatment if they had =2 prior treatment attempts when
compared to those with 0-1 weeks of prior treatment. Overall, the group of
participants who showed the most success had =2 prior treatment attempts and
received the standard care plus contingency management treatment.

HYPOTHESIS TESTING STEP 6: MAKE DECISION
REGARDING THE Ho AND INTERPRET POST HOC
EFFECT SIZES AND CONFIDENCE INTERVALS

The decisions regarding rejecting or failing to reject the omnibus null hypotheses
of the main effects and interaction effect are presented in Table 9.15. Since we
rejected the interaction effect, the decisions and conclusions regarding the simple
effects analysis are in Table 9.16.

RANDOMIZED FACTORIAL EXPERIMENTAL DESIGN USING A FACTORIAL ANOVA e 271



TABLE 9.15 Decisions and Conclusions Regarding Null Hypotheses
of Main Effects and Interaction Effect

Effects Null Hypotheses Decision Conclusion
Main effect of Hor: isc = B2 sc+cm  Reject P<.01 Higher completed
Treatment Condition weeks in treatment
(TOC) for SC+CM vs. SC.
Main effect of Hoo: pio-1 = po=2 Fail to reject Difference in
Treatment Status P>.01 completed weeks
(TS) was not found.
Interaction effect of Hoz: pite Xp2 1s =0 Reject P<.01 Difference in
TCand TS completed weeks
across levels of TC
and TS.

TABLE 9.16 Decisions and Conclusions Regarding Null Hypotheses
of Simple Effects

Effects Null Hypotheses Decision Conclusion

Treatment Condition at Hor: psc =psc+cm  Fail to reject  Difference in

O-1 prior treatment P>.01 completed weeks
attempts was not found.
Treatment Condition at Hoz: psc =psc+cm  Reject Higher completed
=2 prior treatment P<.01 weeks in treatment
attempts for SC+ CM at =2
prior treatment
attempts.
Treatment Status at SC Hoz: po-1=p=2 Fail to reject Difference in
P>.01 completed weeks
was not found.
Treatment Status at Hoa: po-1=p=2 Reject Higher completed
SC+CM P<.01 weeks in treatment

for =2 prior
treatment attempts
at SC + CM.

Magnitude of Treatment Effect—Post Hoc Effect Sizes

Please refer to the Tests of Between-Subject Effects table of the ANOVA results output
(see Table 9.12). First, find TreatmentCondition in the Source column and go across
the row until you find the partial eta-squared value of T]; = .198. Approximately
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19.80 percent of the change in the dependent variable (7reatmentRetention) can be
attributed to the first independent variable (77eatmentCondition). The T]z =.198

has a large strength effect according to Cohen’s convention for n* where approxi-
mately 1 percent to 6 percent is small, >6 percent to 14 percent is medium, and
>14 percent is large.

Following the same procedure to find the effect size for the second main effect
(TreatmentStatus), the n; = .033. Only 3.3 percent of the variability in 77reaz-

mentRetention can be explained by the effect of TreatmentStatus, which reflects a
small effect. Finally, the interaction effect produced a large magnitude of treat-
ment effect, n; = .169.

Post Hoc Power

Power is the probability of correctly rejecting a false null hypothesis. We con-
ducted a priori power analysis to help us determine if a combination of our
planned alpha level, estimated effect size, and sample size would be enough to
detect a significant difference if it existed. The actual or post hoc power values
obtained after the data were analyzed are found in the Tests of Between-Subjects
Effects table (Table 9.12). The post hoc power for the TreatmentCondition main
effect is .996, indicating that given a post hoc effect size of .198, a=.01,
and a sample size of 120, the probability was approximately 99.6 times in 100
that we would correctly reject a false null hypothesis in favor of the alternative
hypothesis.

The post hoc power for the TreatmentStatus main effect is power =.270,
indicating that the probability was approximately 27 times in 100 that we
would correctly reject a false null hypothesis given a post hoc effect size of .033,
o of .01, and a sample size of 120. Certainly, the lower than expected post
hoc effect size affects the low power value. The power =.986 of the interaction
effect represented a high probability of correctly rejecting a false null hypothesis
in this study.

Confidence Intervals of Mean Differences

A confidence interval (CI) provides information about the probability that a given
interval will encircle the true difference between the population means. The
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probability used for the confidence interval is .99 since av=.01 in this study.
Conduct the following SPSS analyses to obtain the Clogg for the 7reatmen-
tRetention mean differences of the main effects of TreatmentCondition and
TreatmentStatus.

IBM SPSS Commands to Obtain CI g9 of Mean Differences
1. Analyze > Compare Means > Independent-Samples T Test.

2. Click over Treatment Retention to Test Variable(s): and click over Treatment
Condition to Grouping Variable: > click on the Define Groups button;
type the number 1 next to Group 1, type the number 2 next to Group 2,
and click on Continue.

3. Click on the Options button and type in 99%; click on Continue and click
on OK. This produces the output for Treatment Condition. Keep the output
open.

4. Now, follow the same procedures and replace Treatment Condition with
Treatment Status. Add the resulting output to the output you have
already produced. Then, save the output as Confidence Interval Two-Way
ANOVA.

In Table 9.17, at the end of the row Equal variances assumed and under
the column 99% Confidence Interval of the Difference, the CI g9 lower limit is
—2.207 and the upper limit is —.660. The .99 CI interval for the means
difference in TreatmentRetention comparing the SC and SC + CM conditions is
(—2.207) — (—=.660). The probability is .99 that this interval will encircle the true
mean difference between the population means of 7reatmentRetention between
the SC and SC + CM conditions for adults with cocaine abuse disorders.

The confidence interval for the means difference in 7reatmentRetention
comparing the 0—1 prior treatment attempts and = 2 prior treatment attempts is
(—1.371) — (.304) (see Table 9.18). The probability is .99 that this interval will
encircle the true mean difference between the population means of Treatment
Retention between the levels of 0—1 prior treatment attempts and =2 prior
treatment attempts for adults with cocaine abuse disorders.
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TABLE 9.17 Cl o9 for Mean Difference of Treatment Retention by Treatment Condition

Independent Samples Test

Levene’s
Test for
Equality of
Variances t-Test for Equality of Means
99% Confidence
Interval of the
Difference
Sig. Mean Std. Error
F  Sig. t df (2-tailed) Difference Difference Lower Upper
TreatmentRetention Equal variances .828 .365 —4.850 118 .000 —1.43333 29553 —2.20706 —.65961
assumed
Equal variances —-4.850 115.740 .000 —1.43333 29553 —2.20731 —.65936

not assumed




TABLE 9.18 Cl o9 for Mean Difference of Treatment Retention by Treatment Status

Independent Samples Test

Levene’s
Test for
Equality of
Variances t-Test for Equality of Means
99% Confidence
Interval of the
Diff
Sig. Mean Std. Error frerence
F Sig. t df (2-tailed) Difference Difference Lower Upper
TreatmentRetention Equal variances 3.400 .068 —1.667 118 .098 —.53333 31990 —1.37087 .30421
assumed
Equal variances —-1.667 111.649 .098 —.53333 31990 —1.37165 .30499

not assumed




PROGRESS REVIEW

1. The omnibus TreatmentCondition main effect was significant,
whereas the TreatmentStatus main effect was not significant.
The interaction effect also was significant.

2. Two simple effects were found to be significant. There were
higher completed weeks in treatment for participants who
received the SC + CM treatment compared to the SC treat-
ment at =2 prior treatment attempts. Moreover, those who
received the SC + CM treatment and had =2 prior treatment
attempts showed more completed weeks in treatment than
participants who had O-1 prior treatment attempts.

3. The TreatmentCondition main effect and the interaction effect
were large, and the TreatmentStatus main effect was small.

4. The post hoc power values were larger than the criterion of
.80 for the TreatmentCondition main effect and the interac-
tion effect. However, the power value (.270) was considerably
lower than expected, primarily influenced by the low post hoc
effect size.

5. The upper and lower limit of the .99 confidence intervals for
the mean difference of the SC versus SC + CM were negative
values, suggesting that this interval encircling the true mean
difference between the population means of Treatmen-
tRetention would be higher for the SC+ CM condition. In
contrast, the Cl g9 for the mean difference between O-1 prior
treatment attempts and =2 prior treatment attempts was
inconclusive. The lower limit was a negative value and the
upper limit was a positive value, suggesting that either level
of TreatmentStatus could be higher in TreatmentRetention.
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TABLE 9.19 Two-Way ANOVA Summary Table Specifications

Sum of Mean
Source of Variation df Squares (SS) Square (MS) F
Treatment(Mmaineffect K71 — 1 Formula SS/dfn MSt/MSg
Treatment(2Qmaineffect K72 — 1 Formula SSto/dfrs MS+,/MSg
Treatment (Bintesrect  (Afr)(dfr2) Formula SStz/dfrz MSt3/MSg
Error (E) (dftor) — (dft) — Formula SSe/dfe —
(dfr2) — (dfrz)
Total (TOT) Nror —1 Add up the = =

preceding cells

dft1=Kt —11is the first main effect degrees of freedom, where K+ is the number of treatments,
groups, or means of the first main effect.

dfto=K7o—1is the second main effect degrees of freedom, where Ky, is the number of treat-
ments, groups, or means of the second main effect.

dfrz = (dft1)(dfy,) is the interaction effect degrees of freedom, where dfyy is multiplied by dft,.
dfe = (dftor) — (dft) — (dfy2) — (dfyz) is the error degrees of freedom, where the three treatment
dfs are substracted from the total degrees of freedom.

dftor=Ntor — 1is the total degrees of freedom based on N scores with one score unable to vary.

FORMULA CALCULATIONS OF THE STUDY RESULTS

The formula calculations for the two-way ANOVA, post hoc effect sizes, and
confidence intervals are presented next. Calculated values are a little different
from the computer values due to rounding differences.

Two-Way ANOVA Formula Calculations

The specifications for constructing a two-way ANOVA summary table are pre-
sented first (Table 9.19). The information in this table captures most of the
important data needed to conduct the two-way ANOVA. Additionally, the
information in Table 9.19 will be useful for calculating post hoc effect sizes and
confidence intervals. We will complete the two-way ANOVA summary table for
this study after we calculate the necessary formulas. The information in Table
9.20 will be useful in calculating the formulas.

Factorial ANOVA Formulas

We will be using treatment, error, and total sum of squares (SS) formulas to
calculate the F-tests for the main effects, interaction effects, and simple effects.
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TABLE 9.20 Study Data with Column and Row Means by Subject
and Condition

Standard
Care + Contingency
Standard Care Management

MeanRows
O-1 Prior Attempts

N OO0, WOTOOODURNRAJOODUTOWOOWMAMUUINNUUGAOO
ONOUITOUINOOONUITONOWNDRUUOOONOOUDAWDDOOUNO

5 5
Mean 5.567 [SC][0-1] 5.700 [SC + CM][0-1] 5.633 [Mo1]
n=30 n=30 n=60

(Continued)
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TABLE 9.20 Study Data with Column and Row Means by Subject
and Condition (Continued)

Standard
Care + Contingency
Standard Care Management

=2 Prior Attempts

4 8

6 10

2 8

4 7

5 6

7 7

5 8

3 9

4 n

5 8

6 7

3 9

7 7

6 6

4 7

4 8

5 6

3 5

2 8

6 8

6 7

5 8

7 9

4 6

6 7

5 5

7 7

4 8

5 9

4 7
Mean 4.800 [SC ][=2] 7.533 [SC + CM ][=2] 6.167 [M=>]
n=30 n=30 n=60
Meanc,s. 5.183[Msc] 6.617 [Msc+cml 5.900 [GM]
n=60 n=60 n=120
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Total (TOT)
SStow = » (X — GM ...)?

where )" =sum up the resultants of the operations that follow:
X;=individual score of the data set,
GM = grand mean (total mean weighted by group sample size)

= 57(6 —5.900)> + (9 — 5.900) ... (9 — 5.900)*(7 — 5.900)"
SS ot = 370.800

Treatment( 1 )MainEffect

SS TrearmentCondicion = (1) (M; — GM ... )?
= (60)[(5.183 — 5.900)* + (6.617 — 5.900)°]
= (60)[(=.717)* + (.717)%]
= (60)[(.514) + (.514)]
— (60)(1.028)
SST1eatmentCondition = 61.680

Treatment(z)MainEffcct

S8 TreatmentStatus = (”) Z (M i — GM . )2

= (60)[(5.633 — 5.900)* + (6.167 — 5.900)]
= (60)[(—.267)* + (.267)]

= (60)[(.071) + (.071)]

= (60)(.142)

= 8.520

SScaMeans = ()X (M — GM ... )?
= (30)[(5.567 — 5.900)* + (4.800 — 5.900)* + (5.700 — 5.900)*
+ (7.533 — 5.900)°]
= (30)[(—.333)* + (=1.100)* + (—.200)* + (1.633)’]
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= (30)[(-111) + (1.210) + (.040) + (2.667)]
= (30)(4.028)
= 120.840

Treatment (3)1,¢ Effece

8§ Int.Effect — 8§ Cell Means — SSTreatmemCondition - 88 TreatmentStatus
=120.840 — 61.680 — 8.520

=50.640

SSError = S8Tot. — SSTreatmentCondition — SSTreatmentStarus — SSTnt Effect
=370.830 — 61.680 — 8.520 — 50.640
=249.990

The observed F-values for testing the null hypotheses of the main effect of
Treatment Condition, the main effect of Treatment Status, and the interaction
effect of Treatment Condition X Treatment Status are in Table 9.21. Ciritical
values to compare the F-values to can be found using an online calculator.

1. Go to www.danielsoper.com > select Statistics Calculators > select
F-Distribution > select Critical F-value Calculator > type in 1 next to Degrees
of freedom 1:> type 116 next to Degrees of freedom 2:> type 0.01 beside
Probability level: > click on Calculate!

The F critical value is 6.85852061, rounded to 6.86. We place the F critical

value on the abscissa (base of the curve) of the F-distribution curve. Then, we place
the obtained omnibus ANOVA values of F=28.6 (Treatment Condition),

TABLE 9.21 Two-Way ANOVA Summary Table

Source of Variation df Sum of Squares (SS) Mean Square (MS) F
Treatment(Mmaineffect 1 61.680 61.680 28.6
Treatment(2)MainEffect 1 8.520 8.520 3.9
Treatment(3)nt effect 1 50.640 50.640 23.5
Error (E) 16 249.990 2.155 —
Total (TOT) 19 370.830 — —
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FIGURE 9.7 Hypothesis Testing Graph Factorial ANOVA

Area of Retention Area of Rejection

o1 2 314 5.,..20..|.25. .|.30.

Ferit, = 6.86 Fobt.(Tcy = 28.6

Fobt(tsy = 3.9 Fobt.(Ts x Ts) = 23.5

F=3.9 (Treatment Status), and /=23.5 (Treatment Condition X Treatment
Status) on the curve. The area of rejection begins on the abscissa at the CV, and any
obtained Fto the right of the CV informs us to reject the null hypothesis (see Figure
9.7). The main effect of Treatment Condition and interaction effect of Treatment
Condition X Treatment Status fall in the area of rejection.

Simple Effects Analysis

Since the interaction effect was significant, a simple effects analysis is conducted.
A simple effect is the effect of one factor (IV) on the DV at one level of the other
factor.

SSTreatmentCondition at O-1 Prior Treatment Attempts

(30)[(5.567 — 5.633) + (5.700 — 5.633)%]
(30)[(—.066)2 + (.067)%]

(30)[(.004) + (.004)]

(30)[(.008]

24

SSTreatmentCondition at =2 Prior Treatment Attempts

(30)[(4.800 — 6.167)2 + (7.533 — 6.167)]
(30)[(—1.367)% + (1.366)?]
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(30)[(1.869) + (1.866)]
(30)[(3.735]
112.05

SSTreatmentStatus at SC Condition

(30)[(5.567— 5.183)% + (4.800 — 5.183)?]
(30)[(.384)2 + (—.383)%]

(30)[(.147) + (147)]

(30)[(.294]

8.82

SSTreatmentStatus at SC+CM Condition

(30)[(5.700 — 6.617)% + (7.533 — 6.617)?]
(30)[(—.917)? + (.916)?]

(30)[(.841) + (.839)]

(30)[(1.680]

50.40

TABLE 9.22 Simple Effects Summary Table

Sum of Mean
Source of Variation df Squares (SS) Square (MS) F
TreatmentCondition
O-1 Prior treatment attempts 1 24 .24 m
=2 Prior treatment attempts 1 12.05 112.05 51.995
TreatmentStatus
SC condition 1 8.82 8.82 4.093
SC + CM condition 1 50.40 50.40 23.387
Error 116 249.990 2155

Post Hoc Effect Sizes

The magnitude of treatment effects are calculated next for the main effects and
interaction effect using both eta-squared (nj;) and omega squared (W?).

Partial Eta-Squared (1%)

Eta-squared is a measure of practical significance ranging from 0 (small) to 1.0
(large). The information needed to calculate the following formulas are found in

Table 9.21.
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2

Treatment (Effect) Sum of Squares (SS)

"lp Treatment SS + Error SS

61.680
61.680 + 249.990

_ 61.680
" 311.67

n? =.198

Treatment Condition Main Effect =

Treatment Status Main Effect
8520
8.520 + 249.990
8520
~258.510

> = .033

Interaction Effect

B 50.640
" 50.640 + 249.990

50.640
"~ 300.630

n? = .168

Omega-Squared (w?)

Omega-squared is a more conservative (lower) because it estimates effect size
between the IV and DV in the population (Tabachnick & Fidell, 2007) and also

ranges from 0 to 1.0.

»  Treatment SS — (K — 1)Error MS
~ Treatment SS + Error SS + Error MS

w
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where  Treatment SS = condition sum of squares
K= number of condition groups
Error MS = error mean square
Treatment SS = treatment sum of squares

Error 8§ = error sum of squares

Omega-squared is not reported in the Tests of Between-Subjects Effects
output, but it can be calculated using information from Table 9.12, Two-Way
Analysis of Variance Results.

Treatment Condition Main Effect

, 61633 —(2—1)2.155
we =
61.633 + 249.933 + 2.155

_ 61.633 —2.155
- 313.721
_59.478
T 313.721

w? =.190

Treatment Status Main Effect

,  8533—(2-1)2.155
"~ 8.533 4 249.933 + 2.155

8533 —2.155
260.621

6378
©260.621

w? = .024
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Interaction Effect
o 50700 - (2 - 1)2.155
" 50.700 + 249.933 + 2.155

50700 — 2.155
© 302.788
48545
" 302.788

w? =.160

Confidence Intervals (.99) for Mean Differences

The Clgg calculations for the mean differences of Treatment Retention by
Treatment Condition (SC vs. SC+ CM) and Treatment Status (0-1 prior
treatment attempts versus =2 prior treatment attempts) are presented next.
Cl g9 for Treatment Retention by Treatment Condition
1. MSE =S+ 537/2
where  MSE = mean square error
S§? =variance of the SC group

S = variance of the SC + CM group
MSE =2.254 + 2.986/2 =5.236/2 =2.618

2. SEmeandiff =V 2MSE/”

where 7= number of participants in a group

SEmeandiff = \/2(2.618)/60 = 1/5.236/60 = 1/.087 = .295
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3. t(.99)(s8df) = 2.663

4. Mysc) — Myscrom) = 5183 — 6.617 = —1.434

5. Clg9Lower Limit = —1.434 — (2.663)(.295)
= —1.434 — (.786)
= —2.220
Cl 99Upper Limit = —1.434 4 (2.663)(.295)
= —1.434 + (.786)
= —.648
Clog(—2.220)  Mpifierence (—-648)

Cl o9 for Treatment Retention by Treatment Status

1. MSE=S?+ §3/2
MSE = 2.338 + 3.802/2 = 6.140/2 = 3.070

2. SEmeandiff Y, 2MSE/”

where 7z =number of participants in a group

SEmeandit = 1/2(3.070) /60 = 1/6.140/60 = +/.102 = .319

3. #99)(58df) = 2.663

4. M (scy — Myscrem) = 5.633 — 6.167 = —.534

5. Clg9Lower Limit = —.534 — (2.663)(.319)
= —.534 — (.849)
= —1.383
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CIg9Upper Limit = —.534 + (2.663)(.319)
= —.534 + (.849)
= 315

CLog(—1.383)  Hpifierence (-315)

Study Results

The purpose of this study was to assess whether a contingency management
(CM) intervention when added to a standard care (SC) condition would increase
the retention of cocaine abusers in treatment. The researchers also focused on
whether the number of prior treatment attempts would produce an interaction
effect with the contingency management treatment on treatment retention. It was
expected that the addition of a contingency management treatment would
increase the length of stay in treatment of the cocaine abusers.

One independent variable in the study was treatment condition (SC vs.
SC + CM), and the second independent variable was treatment status (0—1 prior
treatment attempts vs. =2 prior treatment attempts). Treatment retention was
the dependent variable, and it is operationally defined as number of successful
weeks in treatment.

The study sample consisted of 120 cocaine abusers who sought treatment in
community programs. Fifty-four percent (7= 65) of the participants were males
while females comprised 46 percent (7=55) of the sample. The participants’
average age was 35 and their average time abusing cocaine was over 10 years
(M=10.50 years, SD=7.23).

The a priori power analyses were conducted to assess the probability of
correctly rejecting false null hypotheses in favor of alternative hypotheses. Using
an alpha of .01, a sample size of 120, and estimated effect sizes from previous
research, the power analyses demonstrated that the a priori power was adequate to
conduct the study. All of the a priori power values were higher than the threshold
guideline of .80, which provided support for conducting the study.

The data were screened prior to testing the null hypotheses. The data set was
checked for data entry accuracy and no missing data were identified. There were
no univariate outliers related the treatment retention scores for the four groups.
All measures of normality, homogeneity of variance, and independence were
assessed as meeting the underlying assumptions.
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There was a significant main effect of 7reatmentCondition on Treatmen-
tRetention, F(1, 116) = 28.605, p < .01. The mean number of completed weeks in
treatment was significantly higher for the participants in the SC + CM condition
(M=06.617, SD=1.728) compared to those in the SC condition (M =5.183,

SD =1.501). The magnitude of treatment effect was large, T]]% = .198. The mean
difference CI g9 was (—2.207) — (—.660).

There was not a significant main effect of 7reatmentStatus on TreatmentRetention,
F(1,116) =3.961, p > .01. The mean number of weeks completed in treatment was
not significantly different comparing the participants who had 0-1 prior treatment
attempts (M =5.633, SD=1.529) to those who had =2 prior treatment attempts
(M=6.167, SD=1.950). Consistent with this finding was a small effect size,
n; = .033. The ClI 99 of the mean difference was (—1.371) — (.304).

Combining T7reatmentCondition and TreatmentStatus, the interaction effect
on TreatmentRetention was significant, F(1,116) =23.531, p <.01. The inter-
action effect generated a large magnitude of treatment effect, T]; =.1069.

Since the significant interaction effect showed differences in TreatmentReten-
tion across the levels of TreatmentCondition and TreatmentStatus, a simple effect
analysis was conducted to pinpoint the differences. The participants who had =2
prior treatment attempts showed a significantly higher number of completed weeks
of treatment if they were in the SC + CM condition (M = 7.53) when compared to
those in the SC condition (M =4.80), (1, 116) =52.01, p <.01. A second sig-
nificant simple effect was for participants who received the SC + CM condition;
they had a higher number of completed weeks of treatment if they had =2 prior
treatment attempts level (M =7.533) compared to those who had 0-1 prior
treatment attempts (M = 5.70), F(1, 116) = 23.40, p <.01.

In conclusion, the standard care plus contingency management intervention
condition was more effective in increasing the number of weeks in treatment for
cocaine abusers when compared standard care. The length of prior treatment
attempts of the participants did not produce a significant effect on the number of
weeks in treatment. However, there were significant differences between the
levels of treatment condition and treatment status. Participants with =2 prior
treatment attempts demonstrated more completed days in treatment if they were
provided the standard care + contingency management condition. Overall, the
group of participants who showed the most success had =2 prior treatment
attempts and received the standard care plus contingency management treatment.
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SUMMARY

A 2 X2 ANOVA using a factorial research design was applied to a research
problem to assess whether a behavioral intervention known as contingency
management can improve treatment retention compared across prior treatment
attempts by cocaine abusers.

We conducted a priori power analyses and determined that study specifica-
tions supported the threshold probability of correctly rejecting the false null
hypotheses in favor of alternative hypotheses in our study. Data were screened
and met criteria for conducting the statistical analyses.

A 2 X 2 ANOVA was conducted assessing the significance of two main effects
and an interaction effect using data from Table 9.23. A simple effects analysis was
used to determine the effect of one factor (IV) on the DV at one level of the other
factor. The study results were presented.

PROBLEM ASSIGNMENT

Another 2 X2 ANOVA problem with data set is found on the companion
website. Use the worksheet that is provided along with the steps used in this
chapter to complete the assignment.

TABLE 9.23 Two-Way Analysis of Variance Data

ID# TreatmentRetention TreatmentCondition* TreatmentStatus**
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(Continued)
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TABLE 9.23 Two-Way Analysis of Variance Data (Continued)

ID# TreatmentRetention TreatmentCondition* TreatmentStatus**

12
13

14

15

16

17
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29
30
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50
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ID#

TreatmentRetention TreatmentCondition* TreatmentStatus**

51

52
53
54
55
56
57
58
59
60

62
63
64
65
66
67
68
69
70
71

72
73
74
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85
86
87
88
89
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(Continued)
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TABLE 9.23 Two-Way Analysis of Variance Data (Continued)

ID# TreatmentRetention TreatmentCondition* TreatmentStatus**

90
91
92 1
93
94
95
96
97
98
98
100
101
102
103
104
105
106
107
108
109
110
m
12
13
14
15
116
17
18
19
120
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*1=SC

*TreatmentCondition

1=SC

2=SC+CM

**TreatmentStatus**

1=0-1 Prior treatment attempts.
2==2 Prior treatment attempts.
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KEY TERMS

between-subjects ANOVA design mixed-subjects ANOVA design
factorial design orthogonal

factors simple effects analysis
independent 2 X 2 factorial design
interaction effects within-subjects ANOVA design

main effects

RANDOMIZED FACTORIAL EXPERIMENTAL DESIGN USING A FACTORIAL ANOVA e 295






Chapter 10

ANALYSIS OF COVARIANCE

LEARNING OBJECTIVES

o Demonstrate how to develop research questions and
hypotheses as they relate to a research problem incorpo-
rating an independent variable, a covariate, and a depen-
dent variable.

o Conduct data diagnostics to assess underlying assumptions.

o Execute conducting a one-way analysis of covariance

(ANCOVA) using IBM SPSS and by hand.

o Interpret post hoc effect size analyses using eta-squared
(m*) and confidence intervals.

o Understand the study findings combining the various
analyses.




s stated in Chapter 7, a one-way analysis of variance (ANOVA) was

used to evaluate the effects of treatment programs to reduce depression

among adolescents. The independent variable was the treatment pro-
gram. The dependent variable (DV) was the symptoms of depression and was
expected to change as a result of the impact of the IV. Researchers may come to
realize that extraneous variables at times interfere with the cause-and-effect rela-
tionship planned for a study. In order to discover the independent variable’s
effect on the dependent variable only, the effects of the extraneous variable(s)
must be accounted for and extracted from the results. Covariates represent one or
more other variables that are affecting the DV, but are not designated as IVs.
They usually cause unwanted variance.

An analysis of covariance (ANCOVA) is a statistical method that uses
both the analysis of variance and a regression analysis. An ANCOVA adjusts
the posttest means to what they would be if all groups started out equally on the
covariate.

The research problem presented in this chapter is similar to the problem in
Chapter 9. One condition is standard care (SC), and the other condition is
standard care with contingency management (SC + CM). The dependent vari-
able is longest duration of abstinence (LDA), operationally defined as the number
of weeks of the longest duration of objectively verified continuous abstinence
achieved. Age is considered an extraneous variable in this study and treated as a
covariate to be partialed out of the dependent variable. This example is simulated
based on a study by Rash, Alessi, and Petry (2008).

RESEARCH PROBLEM

The purpose of this research is to examine whether substance abuse treatment
condition controlling for age affects longest duration of abstinence from drugs.
Older participants are expected to have more weeks of objectively verified con-
tinuous abstinence achieved. Older participants also are hypothesized to have
more prior attempts at drug rehabilitation treatment programs and more coping
skills for relapse prevention. Participants in drug rehabilitation treatment are
randomly assigned to one of the two treatment conditions: (1) standard care and
(2) standard care plus contingency management. This resulted in 114 participants
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randomly distributed in the treatment condition groups, standard care (7; =57)
or standard care plus contingency management (7, = 57).

STUDY VARIABLES
Independent Variable

The independent variable (IV) is a drug treatment program that is intended to
influence the dependent variable (DV) (longest duration of abstinence) in this
study. The drug treatment program is operationally defined (OD) as having two
conditions in this study: (1) standard care and (2) standard care plus contingency
management. The IV is active since the conditions can be manipulated. The
scale of measurement of the IV is discrete-nominal (or categorical). Analysis of
covariance can be used with several independent and dependent variables.
Moreover, more than one covariate can be used at the same time. In this study,
one independent variable, one dependent variable, and one covariate are used.

Dependent Variable

The dependent variable (DV) is the longest duration of abstinence (LDA). The
DV in this study is operationally defined as the number of weeks of longest
duration of objectively verified continuous abstinence. Participants were assessed
on their longest duration of objectively verified continuous abstinence from zero
to 12 weeks; therefore it represents a continuous scale of measurement.

Covariate

The covariate is age of the participants and is continuously scaled. The covariate is
used to measure the extraneous variable of age that acts like an unwanted inde-
pendent variable affecting the dependent variable. For example, if the participants
in one of the groups (either SC or SC + CM) are older than the participants in
the other group, age may confound an understanding of the effects of Treatment
Condition (IV) on the DV (LDA). ANCOVA partials out the unwanted dif-
ferential effects of age so that we have a more accurate understanding of the effects

of the IV to the DV.
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RESEARCH DESIGN

The research design used for this example is a two-group posttest-only randomized
experimental design with covariate. We are comparing the dependent variable’s
results adjusted by the covariate age of the two groups of adults receiving different
substance abuse treatment conditions. This is an experimental group design
involving random assignment of participants to conditions, with a manipulated
independent variable. The research design can be diagrammed as follows:

R Xsc Oadj for.age
R XSC+CM Oadj.for.age

The R represents random assignment to the conditions. The conditions by
groups are represented by Xsc (standard care) or Xsc+cnm (standard care plus
contingency management). The observation (O,g; for.age) is the greatest number of
consecutive weeks of objectively verified continuous abstinence achieved adjusted
for the covariate age.

Statistical Analysis: Analysis of Covariance (ANCOVA)

Analysis of covariance (ANCOVA) is a statistical method that utilizes both analysis of
variance and regression analysis. The introduction of the covariate represents some
other variable that is affecting the DV. The researcher is interested in knowing what the
outcome of the posttest would be if the covariate was not there. Covariates are usually
measured unwanted, extraneous variables (EVs) that are correlated with the DV.

The following assumptions underlie the requirement to use the ANCOVA.
The ANCOVA has similar assumptions that were assessed in the ANOVA
research problem in Chapter 7, with a few exceptions. The underlying assump-
tions of the ANCOVA are normality, homogeneity of variance, independence,
and homogeneity of regression (slope).

PROGRESS REVIEW

1. The research problem relates to comparing the effects of
substance abuse treatment condition (independent variable)
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on the number of weeks of longest duration of objectively
verified continuous abstinence achieved (dependent vari-
able) when adjusted for the covariate age among adults. The
independent variable is operationally defined as standard
care, and standard care and contingency management.

2. The 114 adults with substance abuse problems are randomly
assigned to the two treatment conditions.

3. The research method is a two-group posttest-only random-
ized experimental design using a covariate, and the statistical
method is a one-way analysis of covariance.

STATING THE OMNIBUS (COMPREHENSIVE)
RESEARCH QUESTION

Will there be significant mean differences in longest duration of abstinence across
the substance abuse treatment conditions (standard care, and standard care plus
contingency management) when adjusted for the covariate of age?

HYPOTHESIS TESTING STEP 1: ESTABLISH THE
ALTERNATIVE (RESEARCH) HYPOTHESIS (H,)

Omnibus Narrative Alternative Hypothesis (H,)

H,: There will be a significantly lower number of reported weeks of
longest duration of abstinence when adjusted for the covariate of age for
the standard care treatment group when compared to the standard care
plus contingency management group.

Symbolic H,

Hy: piscagy < HSCHCMadj

where pisc is the population mean of the number of weeks of longest duration of
objectively verified continuous abstinence of participants in the standard care
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condition being estimated by the sample mean, and psc,cm is the population
mean of the number of weeks of longest duration of objectively verified con-
tinuous abstinence for participants in the standard care plus contingency man-
agement condition being estimated by the sample mean. The reference to “adj.”
refers to the posttest means of the number of weeks of longest duration being
adjusted using the covariate age.

This is a directional alternative hypothesis because it is expected that the
standard care plus contingency management treatment condition will signifi-
cantly increase the number of reported weeks of longest duration of abstinence
when compared to the standard care treatment condition.

HYPOTHESIS TESTING STEP 2: ESTABLISH
THE NULL HYPOTHESIS (Ho)

The omnibus null hypothesis is stated in both narrative and symbolic formats in
the second step of the hypothesis-testing process.

Omnibus Narrative Null Hypothesis (Hy)

Hy: There will be no significant mean differences in longest duration of
abstinence across the two substance abuse treatment conditions (standard
care and standard care plus contingency management) with a covariate
adjustment of age.

Symbolic H,

Ho: pigcag; = HsC+CMadi

HYPOTHESIS TESTING STEP 3: DECIDE ON A RISK
LEVEL (ALPHA) OF REJECTING THE TRUE Ho
CONSIDERING TYPE | AND Il ERRORS AND POWER

During this step of the hypothesis-testing process, we choose an alpha criterion
(o) that will take into consideration both Type I (alpha) and Type II (beta)

errors. The decision is made to select an alpha level of .01 for this example
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to provide more rigor in assessing the difference on LDA between the two
conditions.

A Priori Power Analysis

We use the chosen « level of .01 and combine it with anticipated sample size
and an estimated (a priori) effect size and determine if we have enough power to
conduct the study.

We will use alpha, sample size, and estimated effect size to conduct an a priori
power analysis. We can combine these three elements together mathematically
and determine if our planned alpha, sample size, and estimated effect size for our
proposed study converge into an acceptable probability (power) necessary to find
a significant difference in means if it exists.

We have decided to use an alpha of .01 and we are planning on using a sample
size of 114. We will use an average ° = .11 from four previous studies. Now we
can combine the three elements to identify the probability of correctly rejecting a
false null hypothesis in favor of the alternative hypothesis (power).

Power Analysis Using G*Power 3.1.2

Using a computer program such as G*Power 3.1 (Erdfelder, Faul, & Buchner,
2010), you can conduct the power analysis using G*Power 3.1 by following the
steps presented next. The steps of downloading free G*Power 3.1 are located in

Chapter 7.

1. Under Test family, click on F tests (see Figure 10.1A).

2. Under Statistical test, click on ANCOVA: Fixed effects, main effects and
interactions.

3. Under Type of power analysis, click on A priori: Compute required
sample size - given o, power, and effect size.

4. Click on the button called Determine to the left of Effect size f, and in the
new attached window to the right, click on the Direct circle and type 0.11
in the box next to Partial T]z; then click on the button that says Calculate
and transfer to main window and then click on the Close button.

5. For the next row, o err prob, type in our av=.01.
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6. For Power type in the criterion threshold we are using, which is 0.80.
7. The Numerator df in our study is 1.
8. There are two groups in our study, so type in 2.
9. There is one covariate in our study, so type in 1.
10. Click on Calculate and you will see that we need a total sample size = 98 to

reach an actual power of .8005192 (see Figure 10.1B). Our total sample of
114 exceeds a needed sample size. Considering the combined elements in
our study of total sample size of 114, n2 =.11, and ao=.01, a power greater
than .80 should be achieved. Therefore, we should be confident in correctly
rejecting a false Hj in our study and thus avoiding making a Type II error.

FIGURE 10.1A AND B G*Power Screen Shots for ANCOVA Problem

Test family Statistical test
F tests v ANCOVA: Fixed effects, main effects and interactions v

Type of power analysis
A priori: Compute required sample size - given o, power, and effect size v

Input Parameters .~ Output Parameters -
Eece izt 025 || [ — ;
o err prob 0.0s Critical F ?
Power (1 err prob) 095 Denominator df ? O  Fromvariances -
Numerator df 10 Total sample size ?
Number of groups S Actual power ?
Number of covariates 1 Ol
Partial nt on
Calculate Effect size ?

( Calculate and transfer to main window

Chck here to beg

a@®e @ 10-15-11-New Scree. .. Tl SR-Chapter10-ANCO... 1L, G*Power 3.1.2
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FIGURE 10.1A AND B (Continued)

i, G*Power 3.1.2
File Edit Yiew Tests Calculator Help

: Central and noncentral distributions [ Protocol of power analvsesJ
critical F =6.90941

0.5+

0.4+

0.3 4

0.2 4

0.14

[3 __-._—-(X--._________
Iy - : : e e
0 5 10 15 20 25
Test family Statistical test
[F tests v] IANCOVA: Fixed effects, main effects and interactions Vl

Type of power analysis

[A priori: Compute required sample size - given o, power, and effect size v]
Input Parameters Output Parameters
Effect size f 0.3515615 Noncentrality parameter A 12.1123579
& err prob 0.01 Critical F 6.9094101
Power (1-p err prob) 0.80 Denominator df 95
Numerator df 1 Total sample size 98
Number of groups 2 Actual power 0.8005192

Number of covariates :}

| X-Y plotfor arange of values i Calculate I
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PROGRESS REVIEW

1. We stated the research question for the problem.

2. We completed the first two steps of the hypothesis-testing
process by stating the alternative and null hypotheses in
narrative and symbolic formats.

3. Next, we decided on the risk we are willing to take when
rejecting a true null hypothesis by choosing alpha (o). We
chose a=.01.

4. We conducted a power analysis using G*Power to make
sure that our probability of correctly rejecting a false null
hypothesis was adequate (power =.80) before moving ahead
with the study. This provided information necessary to con-
tinue on with the study.

HYPOTHESIS TESTING STEP 4: CHOOSE APPROPRIATE
STATISTIC AND ITS SAMPLING DISTRIBUTION TO TEST
THE Ho ASSUMING Hy, IS TRUE

We will be using an ANCOVA to test the null hypothesis: Hy: f11,4j = 2045 We
are going to compare the means of weeks of longest duration of abstinence across
the conditions (standard care and standard care plus contingency management)
for significant mean differences. The purpose of the ANCOVA is to increase the
sensitivity of the test of main effects and interactions by reducing the error term;
the error term is adjusted for, and it is hoped reduced by, the relationship
between the DV and the covariate. Another purpose of the ANCOVA is to adjust
the means of the DVs themselves to what they would be if all participants scored
equally on the covariate.
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HYPOTHESIS TESTING STEP 5: SELECT SAMPLE, COLLECT
DATA, SCREEN DATA, COMPUTE STATISTIC, AND
DETERMINE PROBABILITY ESTIMATES

The study sample participants are selected and data are collected from them. The
data are assessed for data accuracy, missing values, and univariate outliers, and to
determine if the underlying assumptions of the ANCOVA have been satisfied.

Sample Selection and Assignment

A sample for this study was selected using purposive sampling that involved the
application of inclusion and exclusion criteria. The sample consisted of 114
treatment-seeking substance abusers who were randomly assigned to one of two
treatment conditions. This resulted in the following number of participants in
each treatment condition group: standard care (7; =57) and standard care with
contingency management (73 = 57).

Exploratory Data Analysis

The purposes of exploratory data analysis (data screening) are to ensure the data has
been properly entered, extracted, or imported into the statistical spreadsheet; locate
and address any missing data; handle potential outliers; and assess for univariate
underlying assumptions. This process is essential to maintain data integrity.

The following IBM SPSS commands are used to gather descriptive statistics.
To start, we assess the dependent variable of longest duration of abstinence
(DVLDA) and the covariate (COVAge) for univariate outliers. Then, we evaluate
COVAge and LDA by group for normality and homogeneity of variance
by examining histograms, skewness, kurtosis, the Shapiro-Wilk statistic, normal
Q-Q plots, and Levene statistics.

Data Screening IBM SPSS Commands
1. Analyze > Descriptive Statistics > Descriptives.
2. Click over COVAge and DVLDA to under Variable(s): and check the box

called Save standardized values as variables and click OK. This command
produces z-scores on the Data View.
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10.

Analyze > Descriptive Statistics > Explore. This command results in
information used for assessing underlying assumptions.

Click over the covariate (COVAge) and the dependent variable (DVLDA) to
Dependent List.

Click over independent variable /V7reatment Condition to Factor List.
Do not change Display choices—leave on Both.

Click on the Plots button in the upper right corner. Then, select Normality
plots with tests.

Under Spread vs. Level with Levene Test, click on Untransformed.
Click on Continue.

Click on OK.

The highest and lowest postive z-scores for the covariate age and the

dependent variable longest duration of abstinence are identified in Table 10.1.

The z-scores were produced on the Data View spreadsheet as new columns. The

z-scores are transformed scores of participants on COVAge and DVLDA.
None of the z-scores are greater than a =3.29 (P=.001, two-tailed). As such, we
conclude that there are no participant scores that represent univariate outliers

on either the covariate or dependent variable.

The output of skewness, kurtosis, and standard errors for CovAge and

DVLDA by group are presented in Table 10.2.

TABLE 10.1 Highest +z-Scores for the Covariate
Age and the Dependent Variable Longest Duration
of Abstinence

Highest Outlier? Highest Outlier?
+z ==+3.29 =7 =+3.29
CovAge

2.858* No —1.588 No
DVLDA

2.664 No —-2.119 No

*This number is rounded to three decimals.
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TABLE 10.2 Skewness, Kurtosis, and Standard Error Values by Group

Descriptives

IVTreatmentCondition

Statistic Std. Error

CovAge

DVLDA

SC

SC+CM

SC

Mean

95% Confidence Interval
for Mean

5% Trimmed Mean
Median

Variance

Std. Deviation
Minimum
Maximum

Range
Interquartile Range
Skewness

Kurtosis

Lower Bound
Upper Bound

Mean

95% Confidence Interval
for Mean

5% Trimmed Mean
Median

Variance

Std. Deviation
Minimum
Maximum

Range
Interquartile Range
Skewness

Kurtosis

Lower Bound
Upper Bound

Mean

95% Confidence Interval
for Mean

5% Trimmed Mean
Median

Variance

Std. Deviation
Minimum
Maximum

Range
Interquartile Range

Lower Bound
Upper Bound

31.82
29.48
34.17

31.31

31.00
78147

8.840

19
57
38

15

.681
.039

1171

316
.623

34.75

32.37

37.14

34.37

34.00

80.796
8.989

20

59

9

1.191

461
=315

316
.623

4.79
4.30
5.28
4.80
5.00
3.419
1.849

245

W 00 O

(Continued)
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TABLE 10.2 Skewness, Kurtosis, and Standard Error Values by Group
(Continued)

Descriptives

IVTreatmentCondition Statistic Std. Error
Skewness —.189 .316
Kurtosis —.385 623

SC+CM Mean 6.07 .283
95% Confidence Interval Lower Bound 5.50
for Mean Upper Bound 6.64
5% Trimmed Mean 6.06
Median 6.00
Variance 4.566
Std. Deviation 2137
Minimum 2
Maximum 1
Range 9
Interquartile Range 4
Skewness .042 .316
Kurtosis —.649 623

We divide the skewness statistics by the standard errors and examine if there
is significant skewness by comparing the skewness z-scores to the critical value
of £3.29. Since the skewness z-score values are less than *=3.29, we conclude that
the distributions are not significantly skewed (see Table 10.3).

We follow the same procedures to examine the kurtosis of the distributions of
the groups. (See Table 10.4.) The researcher will divide the kurtosis statistic by
its standard error and compare the z-score to the critical value of £3.29 to see if a
group distribution significantly departs from normality.

The kurtosis z-scores are all within acceptable standards of being normally
distributed (< *+3.29).

The Shapiro-Wilk (S-W) statistic is the next statistic we will use to establish
whether the distribution of the group conditions are normally distributed. (See
Table 10.5.) Remember, we want to retain the null hypothesis, which indicates
that the sample distribution that we are looking at is not deviating significantly
from normal.
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TABLE 10.3 Skewness z-Scores by Treatment Condition Group

Skewness z Skewness Sig. Departure?
Variable/Condition (Stat./Std. Error =2) Direction ( +3.29)
CovAge
Standard Care .681/.316 =2.155 Positive No
Standard Care + .461/.316 =1.459 Positive No
Contingency Management
DVLDA
Standard Care —.189/.316 =—.598 Negative No
Standard Care + .042/.316 = 133 Positive No

Contingency Management

TABLE 10.4 Kurtosis z-Scores by Substance Treatment Group

Kurtosis z Kurtosis Sig. Departure?
Variable/Condition (Stat./Std. Error=2) Direction  *£3.29)
CovAge
Standard Care .039/.623=.063 Leptokurtic No
Standard Care + —.315/.623 =— .506 Platykurtic No
Contingency
Management
DVLDA
Standard Care —.385/.623=—-.618 Platykurtic No
Standard Care + —.649/.623=-1.042 Platykurtic No
Contingency
Management

TABLE 10.5 Shapiro-Wilk Statistics by Substance Treatment Condition

Tests of Normality

Kolmogorov-Smirnov® Shapiro-Wilk

IVTreatment
Condition Statistic df Sig. Statistic df Sig.

CovAge SC M 57 .078 .947 57 .04
SC+CM 104 57 192 .964 57 .084

DVLDA 5@ 147 57 .004 .963 57 .079
SC+CM 107 57 161 .968 57 131

2Lilliefors significance correction
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Since the significant probability levels of the Shapiro-Wilk statistic are all
larger than the set alpha level of .01, we conclude these group distributions on
both CovAge and DVLDA are not deviating significantly from being normal.

Last, we will observe the Q-Q plot for each distribution (see Figure 10.2A
and B). While the Q-Q plots look better for the DVLDA (see Figure 10.3A and B),
the majority of points of all distributions for both variables fall on or near the line.
Thus, the Q-Q plots support the normality of the distributions.

The integrated results of the analyses of univariate outliers, skewness z-scores,
kurtosis z-scores, Shapiro-Wilk statistics, and the Q-Q plots support the normality
of the distributions.

Homogeneity of Variance

In this study we are expecting that the independent variable (drug rehabilitation
treatment conditions) will affect the means of the covariate age and the dependent

FIGURE 10.2A AND B Normal Q-Q Plots of CovAge by Groups

Normal Q-Q Plot of CovAge
for IVTreatmentCondition = SC
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FIGURE 10.2A AND B (Continued)

Normal Q-Q Plot of CovAge
for IVTreatmentCondition = SC + CM

Expected Normal
o
1
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variable (longest duration of abstinence) but not the variances of the groups.
We want the variances of the two groups (standard care and standard care plus
contingency management) on the covariate and the dependent variable to be
relatively constant. We are going to use the variance ratio (F,,,), which is the ratio
of the largest group variance to the smallest group variance between the two
condition groups providing simple descriptive statistics for initial screening.

The two groups have the same number of participants, so the group size ratio
is 57/57 = 1.00; since this is well below a group size ratio of 4, we can apply the
Finax = 10 guideline (Tabachnick & Fidell, 2007).

The SC + CM group had the highest variance on CovAge and the SC group
variance had the lowest (see Table 10.2). The F, .= 80.796/78.147 = 1.034,
and the ratio is well below 10.

Again for the DVLDA variable, the SC + CM group had the highest variance
of 4.566 and the standard care group showed the lowest variance of 3.419. The
Frax =4.566/3.419=1.335 and is <10. The low variance ratios support

ANALYSIS OF COVARIANCE o 313



homogeneity of variance across the two groups on both variables. We next confirm
this finding with the results of the Levene’s test.

We test the following null hypothesis of equality of the error variances
between the two groups when using Levene’s test of homogeneity of variance. We
want to retain the null hypothesis concluding that the variances across the two
groups on both variables are equal enough using an alpha criterion of .01.

Hy: O'g standard care — Oe standard care plus contingency management

The Levene’s statistic is found in the “assumptionscreen” output under the
heading Test of Homogeneity of Variance (see Table 10.6) on the line called “Based
on mean.”

We fail to reject the H, that the error variances are equal since the probabi-
lity values (Sig.) based on the mean (CovAge =.772 and DVLDA = .3006) are

FIGURE 10.3A AND B Normal @-Q Plots of DVLDA by Groups
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FIGURE 10.3A AND B (Continued)

Normal Q-Q Plot of DVLDA

for IVTreatmentCondition = SC + CM

Expected Normal
o
1

Observed Value

TABLE 10.6 Levene’s Test of Homogeneity of Variance for CovAge and

DVLDA
Test of Homogeneity of Variance

Levene’s Statistic dfl df2 Sig.
CovAge Based on mean .084 1 n2 772
Based on median .066 1 n2 797
Based on median and .066 1 111.948 .797

with adjusted df
Based on trimmed mean .076 1 n2 .783
DVLDA Based on mean 1.056 1 n2 .306
Based on median 1.221 1 12 272
Based on median and 1.221 1 110.669 .272

with adjusted df
Based on trimmed mean 1.057 1 n2 .306

ANALYSIS OF COVARIANCE e 315



greater than o =.01. The evidence from the variance ratios and the Levene’s
statistic suggests that the underlying assumption of homogeneity of variance has
been met.

Independence

We are going to assess the independence of observations by graphing the
responses of participants on the dependent variable by treatment condition based
on the same order in which measurements (observations) were obtained. The data
in the IBM SPSS Data View spreadsheet are in a similar order by group based on
when the data were collected. We will need to create two columns of data to
complete the matrix scatter plot analysis to assess independence.

Matrix Scatter Plot IBM SPSS Commands

1. Under the column labeled DVLDA on the IBM SPSS Data View spread-
sheet, left click and hold on the first cell, which is score 3, and drag down
until you reach row 57, which is score 6 and is the last participant score in the
standard care group (treatment condition).

2. At the top of the screen, click on Edit and then Copy.
3. Go to the first empty column, click on the first cell, and it will be bolded.

4. At the top of the screen, click on Edit and then click on Paste and the data
from the standard care group will be copied to the new column.

5. At the bottom left of the spreadsheet, click on Variable View; name the new
column on the fifth row as LDASC and change the decimals to 0.

6. Click on Data View button and create a new column for the 57 standard care
plus contingency management scores (treatment condition 2) in rows 58

through 114 in the same way. Name the new column as LDASCCM. Once
you have completed the two new columns, click File > Save.

7. At the top of the screen, click on Graphs > Legacy Dialogs > Scatter/
Dot > Matrix Scatter > Define.

8. Click over the two new columns (SCLDA, LDASCCM) to the space under
Matrix Variables > OK.
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FIGURE 10.4 Matrix Scatter Plot to Assess Independence
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The matrix scatter plot (Figure 10.4) shows the scores of each group com-
pared to the other groups. The scores are in the order they were obtained and are
paired as circles in each graph. Since the points scatter in many directions, we
conclude that we have met the assumption of independence.

Homogeneity of Regression (Slope) Assumption

In addition to testing the assumption of independence and the assumption of
normality, we need to conduct a test of homogeneity of regression (slope)
assumption. This test examines the interaction between the covariate (age) and
the independent variable (treatment condition) in the prediction of the depen-
dent variable (longest duration of abstinence). We do not want the interaction
between the dependent variable and the covariate to be significant. A significant
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interaction indicates that the difference on the dependent variable (LDA)

between the treatment conditions is different because of the covariate (age).

Homogeneity of Regression (Slope) IBM SPSS Commands

1.
2.

® N s

10.
11.

Click Analyze, click General Linear Model, and then click Univariate.

Click the dependent variable (DVLDA), click the arrow to move it to the
Dependent variable: box.

Click the independent variable (/V7TreatmentCondition), click the arrow to
move it to the Fixed Factor(s) box.

Click the covariate (COVAge), click the arrow to move it the Covariate(s): box.
Click on the Model button.

Click the Custom circle under Specify Model.

Click over /VTrearCond and COVAge to the space under Model.

Next, holding down the Curl key, click both the /VTreatmentCondition and
COVAge together in the Factors & Covariates box. Check to see that the
default option Interaction is specified in the drop-down menu in the Build
Term(s) box. If it is not, select it.

Click the arrow going right and COVAge * IV1reatmentCondition should
now appear in the Model box along with [VTreatCond and CovAge.

Click Continue. This will bring you back to the Univariate screen.

Click OK.

In Table 10.7, find the interaction effect called /V7reatCond*COVAge under

the column Source. The significance value (Sig.) is 2=.022. The interaction is

not significant (P> .01). We conclude that the assumption of homogeneity of
regression is tenable and proceed with the ANCOVA.

Summary of Underlying Assumptions Findings

The evidence obtained demonstrates that the distributions of scores on the

dependent variable for both condition groups did not deviate from normality.

Both measures of homogeneity of variance supported the assumption of equality.

318 ¢« CHAPTER 10



TABLE 10.7 Homogeneity of Regression (Slope)

Tests of Between-Subjects Effects

Dependent Variable: DVLDA

Source Type Il Sum of Squares df Mean Square F Sig.
Corrected model 169.178° 3 56.393 19.101 .000
Intercept 22.937 1 22.937 7.769 .006
IVTreatCond 6.416 1 6.416 2173 143
CovAge 105.161 1 105.161 35.619 .000
IVTreatCond*CovAge 15.876 1 15.876 5.377 .022
Error 324.761 110 2.952

Total 3,855.000 14

Corrected total 493.939 n3

?R-squared =.343 (adjusted R-squared =.325)

The scatter plots suggested that independence was met. The homogeneity of
regression (slope) was not significant. This information provides support to
conduct the ANCOVA statistic to test the omnibus null hypothesis in this study.

PROGRESS REVIEW

1. We collected the data on the dependent variable longest
duration of abstinence from the 114 participants who were
randomly assigned to one of two condition groups (standard
care and standard care plus contingency management).

2. Problems with data accuracy and missing data were ruled out
in the early steps of the data screening process.

3. The distributions of the covariate age and the dependent
variable longest duration of abstinence (LDA) scores of two
condition groups were assessed for compliance to meeting
the underlying assumptions of using the ANCOVA. The pos-
itive results of this screening assessment allow us to conduct

(continued)
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the ANCOVA to determine the effects of the substance abuse
treatment conditions (standard care and standard care plus
contingency management) on longest duration of abstinence
with age as a covariate.

Analysis of Covariance of the Omnibus Ho

ANCOVA IBM SPSS Commands

1.

Click Analyze > click General Linear Model > click Univariate > click
over LDA under Dependent Variable, 7reatmentCondition under Fixed
Factor(s), and Age over to Covariate(s).

Click on the Plots button > click TreatmentCondition to Horizontal Axis >
click the Add button > click Continue.

Click on the Options button > click (Overall) and TreatmentCondition to
Display Means for. Select Compare Main Effects. Select LSD(none).

Click on the boxes for Descriptive statistics, Estimates of effect size,
Observed power, and Homogeneity tests > the Significance level should
be .01 > click on Continue > click OK.

Save generated output as ANCOVA with Age Results.

The results of this analysis provide us with information to test the omnibus

null hypothesis of the study:

Hy: There will be no significant mean differences in longest duration of
abstinence across the two substance abuse treatment conditions (standard
care and standard care plus contingency management) with a covariate
adjustment for age.

Hy: pigcadg = PscrOMadi

The results of the ANCOVA are presented next. Additionally, interpretations

are provided for the magnitude of treatment effects (effect sizes), post hoc power,

320 ¢« CHAPTER 10



post hoc multiple comparisons of means, and confidence intervals for the mean
differences.

ANCOVA Results

Previously, homogeneity of variance was assessed across groups for the dependent
variable and covariate separately (see Table 10.6) and the assumption was met.
Table 10.8 shows the test of homogeneity of variance of the dependent vari-
able when the independent variable and covariate are combined. The significance
value of .506 is greater than the o= .01, so we retain the null hypothesis that the
variances are equal and the assumption is met.

In the ANCOVA output labeled Tests of Between-Subjects Effects you will
see the name of the independent variable (/V7reatmentCondition) under the
heading Source that we created when the data were entered (see Table 10.9).
We will be using the information in this row to make a decision about rejecting
the null hypothesis.

The ANCOVA statistic is in the F column (F=8.332) and the F-statistic is
significant at the p = .005 probability level from the Sig. column (see Table 10.9).
The criterion that we selected to make a decision about rejecting the null hypothesis
was o =.01. The significant statistic probability of .005 is less than =01, so the
decision is to reject the null hypothesis (» <.01). Hence, there is a significant dif-
ference among the two group (standard care and standard care plus contingency
management) means on longest duration of abstinence when age is adjusted as the
covariate. We can write this finding of the omnibus hypothesis as (1, 111) = 8.332,
p<<.01.

TABLE 10.8 Test of Homogeneity of Variance of DVLDA Including
CovAge and IVTreatmentCondition

Levene’s Test of Equality of Error Variances®

Dependent Variable: DVLDA

F dfl dar2 Sig.

445 1 12 .506

Tests the null hypothesis that the error variance of the dependent variable is equal across
groups.
2Design: Intercept + CovAge + IVTreatmentCondition
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TABLE 10.9 ANCOVA Results

Tests of Between-Subjects Effects

Dependent Variable: DVLDA

Partial

Type Il Sum Mean Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power?
Corrected model 153.302° 2 76.651 24.978 .000 .310 49.955 1.000
Intercept 23.973 1 23.973 7.812 .006 .066 7.812 .570
CovAge 106.556 1 106.556 34.722 .000 .238 34.722 .999
IVTreatmentCondition 25.570 1 25.570 8.332 .005 .070 8.332 .605
Error 340.637 m 3.069
Total 3,855.000 N4
Corrected total 493.939 13

Computed using alpha=.01
PR-squared =.310 (adjusted R-squared =.298)



You can see in Table 10.8 that the covarate age was significant (p =.000),
indicating the two groups did differ in the average age. Thus, it was a good
decision to use age as a covariate.

Estimated Marginal Means

The purpose of the ANCOVA was to control the effects of an extraneous vari-
able, age, interacting differentially with the IV (Treatment Condition) on the DV
(Longest Duration of Abstinence). In other words, what would the values of
means of the DV be if the participants in the two condition groups (SC and
SC + CM) had not differed on the covariate (age)? ANCOVA partials out the
effects of the covariate (age) on the DV (Longest Duration of Abstinence) on
the means produced by the SC and the SC + CM conditions. These adjusted
means are then tested for significant differences. These adjusted (estimated) means
are presented in the output (see Table 10.10). The estimated (adjusted) mean of the
DV for the SC condition group is M =4.95, and before the mean was adjusted
for the covariate (age) it was M = 4.79 (see Table 10.2 earlier in the chapter). The
estimated mean of the DV for the SC + CM condition group is M=5.91, com-
pared to the unadjusted mean of M= 6.07.

The plot of the two estimated marginal means is depicted in Figure 10.5. You
can visually see the higher adjusted mean representing longer duration in treat-
ment for the participants who received the SC+ CM compared to the CM
condition. We discovered previously that this difference is significant.

The mean comparisons support the directional alternative hypothesis that
standard care plus contingency management treatment condition significantly
increase the number of weeks of abstinence.

TABLE 10.10 Estimated Marginal Means

Estimates

Dependent Variable: DVLDA

99% Confidence Interval

IVTreatmentCondition Mean Std. Error Lower Bound Upper Bound
SC 4.950° 234 4.337 5.562
SC+CM 5.910° 234 5.298 6.522

2Covariates appearing in the model are evaluated at the following values: COVAge = 33.29.
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FIGURE 10.5 Profile Plot

Estimated Marginal Means of DVLDA
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Covariates appearing in the model are evaluated at the following values: COVAge = 33.29.

HYPOTHESIS TESTING STEP 6: MAKE DECISION
REGARDING THE Ho AND INTERPRET POST HOC EFFECT
SIZES AND CONFIDENCE INTERVALS

We conclude there are mean differences in longest duration of abstinence across
the two condition groups with age as a covariate. We next assess the magnitude of
treatment effect, post hoc power, and the .99 confidence interval of the mean
difference.

Magnitude of Treatment Effect—Post Hoc Effect Size

In the 7ests of Between-Subject Effects table of the ANCOVA results output (see Table
10.9), the partial eta-squared value (nz =.070) is located on the Condition line next
to the Sig. value. We will interpret the 1> =.070 by converting the fraction to a
percentage and reporting that approximately 7 percent of the change in the
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dependent variable (longest duration of abstinence) can be attributed to the inde-
pendent variable (substance abuse treatment program) when age scores are used as
the covariate. The n°=.070 has a medium strength effect according to Cohen’s
convention where approximately 1 percent to 6 percent is small, >6 percent to 14
percent is medium, and >14 percent is large. The substance abuse treatment pro-
gram has a significant magnitude of treatment effect on the duration of abstinence.

Post Hoc Power

You remember that we estimated the probability of correctly rejecting a false null
hypothesis prior to conducting the study resulting in an a priori power = .80. The
actual power after the study was conducted is reported in the Between-Subjects
Effects output under Observed Power for Condition (see Table 10.9). The post-hoc
power is .605, indicating that given a post hoc effect size of .070, o .01, and a
sample size of 114, the probability was approximately 60.5 times in 100 that we
would correctly reject a false null hypothesis. The lower than desired post hoc
power of .605 was likely due to overestimating the a priori effect size at n° =.11.
The post hoc effect size was 1> = .070. Fortunately, we were still able to identify a
significant difference in longest duration of abstinence resulting from comparing
the treatment effects of standard care to the treatment effects of standard care plus
contingency management.

Confidence Intervals of Mean Differences

The probability used for the confidence interval is .99 since av=.01 in this
study. The CI 99 was found by using the least significant difference (LSD) pairwise
comparisons output (see Table 10.11). The pairwise mean comparisons do not
need to be interpreted since there are only two groups (SC and SC + CM) and we
already know that the two means are different from the ANCOVA analysis.

The .99 Cl interval for the means difference in longest duration of abstinence
for comparing the standard care and standard care plus contingency management
conditions is (.088) — (1.832). The probability is .99 that this interval will
include the true mean difference between the population means of longest
duration of abstinence between the standard care and standard care plus con-
tingency management conditions. It is important to note that the upper and
lower limits of the .99 interval are going in the same direction, indicating an
interval that reflects a gain in duration of abstinence.
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TABLE 10.11 Confidence Interval (.99) for the Mean Difference between SC and SC + CM

Pairwise Comparisons

Dependent Variable: DVLDA

99% Confidence

Interval for Difference®

Mean Difference Std. Lower Upper
(D) IVTreatmentCondition (J) IVTreatmentCondition (-J) Error Sig.? Bound Bound
SC SC+CM —.960* .333 .005 —-1.832 —.088
SC+CM SC .960* S5 .005 .088 1.832

*Based on estimated marginal means.
The mean difference is significant at the .01 level.
Adjustment for multiple comparisons: least significant difference (equivalent to no adjustments).



PROGRESS REVIEW

1. The omnibus Ho: piscadj= ftsc+cmagj Was rejected (p <.00),
indicating the existence of significant mean differences on
the dependent variable (LDA).

2. The overall magnitude of treatment effect of the independent
variable (substance abuse treatment condition) on the
dependent variable (longest duration of abstinence) was a
medium effect, n°=.070.

3. The post hoc power of .605 was smaller than the criterion of
.80, but we still found a significant effect.

4. The probability is .99 that this interval (.088) — (1.832) will
include the true mean difference between the population
means of longest duration of abstinence between the stan-
dard care and standard care plus contingency management
conditions adjusted for age.

FORMULA ANCOVA CALCULATIONS OF THE
STUDY RESULTS

The calculation of the ANCOVA problem data are presented in steps following
the format of Lowry (2011).

Step 1: Calculations for the Dependent Variable LDA (Y)
The data for LDA (DV, Y) are presented by the groups SC and SC + CM. At the

end of the Table 10.12, the &V, sums of scores, sums of scores squared, sums of
squares and means are provided by group and as totals. The summary statistics
will be used in calculating SSt1, SSpetween, a0d SSwithin- These SS values will be
used in later analyses.
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TABLE 10.12 Data and Summary Statistics
for LDALDA DV (Y)
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SC SC+CM
6 9
5 5
4 4
5 5
4 9
9 8
6 10
4 4
6 g
4 7
7 6
4 7
6 9
3 9
6 n
4 6
6 7
Totals
N 57 57 n4
XY 273 346 619
2Yi2 1,499 2,356 3,855
SS 215 279 494
M 4.79 6.07 5.43

SStow = 3 (Xj — Mrer.)’
= (3 —5.43)> + (2 — 5.43)*--- (6 — 5.43)> + (7 — 5.43)°
— 493.94
SSperween = 11 (My — Mo ) + ma(My — Mo, )?
= 57(4.79 — 5.43)* 4 57(6.07 — 5.43)"
= 57(—.64)" + 57(.64)°
= 57(.410) + 57(.410)
= 23.37 +23.37
— 46.74
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SS\X/ithin - SSTotal - SSBetween
= 493.94 — 46.74
= 447.20

Step 2: Calculations for the Covariate Age (X)

The data for Age (covariate, X) are presented in table 10.13 by groups SC and
SC + CM. At the end of the table the 2V, sums of scores, sums of scores squared,
sums of squares, and means are provided by group and as totals. The summary
statistics are used in calculating SStqc1, SSBerween, aAnd SSwithin, in later analyses.

TABLE 10.13 Data and Summary Statistics for Age

Age COV (X)

SC SC+CM
19 36
20 33
20 23
21 53
21 41
21 32
22 37
22 29
22 40
23 31
24 25
24 26
24 42
24 33
24 23
24 26
25 26
25 22
26 43
27 41
27 25
27 45
27 35
28 24
29 53
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SStoal =Y (Xj — Mror.)’

= (19 — 33.29)* 4 (20 — 33.29)*(27 — 33.29)" + (43 — 33.29)°
=9,145.45

SSbecween = 11 (My — Mo ) + 1o (M — M)
=57(31.825 — 33.289) + 57(34.754 — 33.289)"
— 57(—1.464)" 4+ 57(1.465)
—57(2.143) 4 57(2.146)
=122.151+122.322
— 244.473

SSWithin - = SSTotal — SSBetween
= 9,145.45 — 244.47
=8,900.98

Step 3: Calculations of Covariance of Age X LDA

Next, the covariance calculations of the covariate (Age) times the dependent
variable (LDA) are conducted. These analyses result in sums of the cross product
of Age and LDA for SC and SC + CM groups and a total. Then, the sums of

squares total and within of the covariance are calculated.

SC SC+CM
Age LDA Age LDA
19 3 36 7
20 2 33 2
20 5 23 4
21 2 53 6
21 3 41 6
21 6 32 5
22 1 37 4
22 4 29 8
22 1 40 7
23 3 31 4
24 1 25 6
24 4 26 3
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SC+CM

SC

LDA

Age

LDA

Age

5936437_/58859764576733267638954598@4976

42
33
23
26
26
22
43
41

25
45
35
24
53
43
44
23
41

34
37
40
39
22
25
34
32
31

27
37
35
31

29
30
41

47
42
20
33
27
27
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24
24
24
24
25
26
27
27
28
29
30
30
32
33
34
34
34
38
38
39
39
40
40
40
40

25
27
27
31

31

32
55
55
&Y
&Y
55
41

41

43

(Continued)
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SC SC+CM

Age LDA Age LDA
43 4 45 7
44 6 42 9
45 3 50 9
49 6 59 1
53 4 27 6
57 6 43 7
SC SC+CM Total
> (XigeYina) =8,979 D (Xige¥ipa) = 12,708 > (Xyp VivaTor) = 21,687
S X = 1,814 S Xge = 1,981 ™ XogeTor = 3,795
> Yipa =273 > Yipa =346 > YipaTor = 619
)(a €l ot Y ot
SSCOVre = 3 (Xige YiDATor) — (2 Xoger ])\EZ folic)
tot
(3,795)(619)
=21,68 - —FF——~
7 114
= 21,687 — 2,349,105/114
= 21,687 — 20,606
= 1,081
Xage )6l
SSCOVWithin(group) = Z()(age YLDA) - (Z a )f’lz LDA)

SCGroup = 8,979 — (1,814)(273)/57
— 8,979 — 495,222/57
— 8,979 — 8,688
=291
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SC+ CM Group = 12,708 — (1,981)(346)/57
— 12,708 — 685,426/57
= 12,708 — 12,025
= 683
SSCOVithin = SSCOVithin(sc) + SSCOVithin(sc + cm)
=291 + 683
=974

Step 4: Adjustment of LDA (DV, Y) Based on the Covariate
of Age (X)

We are conducting calculations to remove (or adjust) the effects of the covariate
(Age) on the dependent variable (LDA). We will use previous calculations to
conduct the adjustments so they are summarized in Table 10.14 for easy access.

Adjustment of SStcai(y)

Adjusted SS,.1y) = SSToul(y) — (SSCOVror)* /SStomi(x)

= 493.94 — (1,081)*/9,145.45)
— 493.94 — 1,168,561/9,145.45
= 493.94 — 127.78
= 366.16

Adjusted SSyy,iiny) = SSWithin(y) — (SSCOVwidhin)? /SSwichin(x)
= 447.20 — (974)*/8,900.98
= 447.20 — 948,676/8,900.98
— 447.20 — 106.58
= 340.62

TABLE 10.14 Summary of Previous Calculations

Age (X) LDA (Y) Covariance
SStotal 9,145.45 493.94 1,081
SSwithin 8,900.98 447.20 974
SsBetween 46.74

ANALYSIS OF COVARIANCE e 335



Adjustment of SSpeqyeen(y) = adj (SSTml(Y)) — adj (SSWithin(g)(Y))
= 366.16 — 340.62
= 25.54

The summary table of the ANCOVA results is presented in Table 10.15.
Figure 10.6 shows a visual representation of the findings. A critical value
(CV) is obtained using an online calculator.

Go to www.danielsoper.com > select Statistics Calculators > select F-Dis-
tribution > select Critical F-value Calculator > type in 1 next to
Degrees of freedom 1: > type 111 next to Degrees of freedom 2:>
type 0.01 beside Probability level: > click on Calculate!

The F critical value is 6.86884699, rounded to 6.87. We place the F critical
value on the abscissa (base of the curve) of the F-distribution curve. Then, we
place the obtained omnibus ANOVA value of #=8.3 on the curve. The area of
rejection begins on the abscissa at the CV, and any obtained F to the right of the

TABLE 10.15 Summary of ANCOVA Results

Source SS df MS F P
Adjusted means (Between) 25.54 1 25.54 8.3 P<.01
Adjusted error (Within) 340.62 m 3.07

Adjusted total 366.16

FIGURE 10.6 Hypothesis Testing Graph ANCOVA

Area of Retention Area of Rejection
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Ferit, = 6.87  Fopy, = 8.3
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CV informs us to reject the null hypothesis. Our Fpined = 8.3 falls in the area of
rejection to the right of the CV = 6.87, so we reject the Hy, concluding that if the
null hypothesis is true we would have obtained results like these less than 1
percent of the time.

Step 5: Calculation of Adjusted Means

Byithin = SSCOV Within / SSWithin(Age)
— 974/8,900.98
=.11
Mipasc Adjusted = Mipasc + (Bwithin) (Magesc — MageTor)
— 479 + (.11)(31.82 — 33.29)
— 479 + (.11)(1.47 absolute value)
= 479 + (.16)
=4.95
Mipascrem Adjusted = Mipascrem — (Bwichin) (Magesc+cm — MageTor)
— 6.07 — (.11)(34.75 — 33.29)
— 6.07 — (.11)(1.46)

= 6.07 — (.16)

=591

Mage M pa M pa Adjusted
SC 31.82 4,79 4.95
SC+CM 34.75 6.07 5.91
Total 33.29 5.43
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Adjustment of SSt,a(y) Correlation 7

SSCOV 14,

sqre([SStor(age) [SSTor(LDA)])

1,081
sqre([9,145][494])

= 1,081/sqrt(4,517,630)

—1,081/2,125

=.509
(rrer)” = (:509)° = .259

TTot. —

Adjustment of SSy;ihin(y)y Correlation (r)

SSCOV Wichin(LDA)

"Within(LDA) =
sqrt ( [SSwithin(Age) | [SSwithin(LDA) ] )

974
sqrt([8,900.98][447.20])

= 974/sqrt(3,980,518.26)
=974/1,995.12
= .488

(7Within)2 = (-488)2 = .238

Post Hoc Effect Size

,  Treatment (Condition) sum of squares (SS)

e = Treatment SS + Error SS

B 25.570
©25.570 + 340.637

~25.570
T 366.207

n =.07
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ANCOVA STUDY RESULTS

The purpose of this study was to determine if abstinence from using drugs is
increased when a contingency management program is added to standard care with
age as a covariate. The independent variable is a drug treatment program having
two conditions: standard care, and standard care plus contingency management.
The dependent variable is the longest duration of abstinence (LDA), operationally
defined as the number of weeks of longest duration of objectively verified con-
tinuous abstinence. The legally documented age of the participants is used as the
covariate in the study.

Data were collected from a sample of 114 substance abusers who were ran-
domly assigned to receive the standard care condition (7= 57) or the standard
condition plus contingency management condition (z=57). The data were
assessed for data accuracy and missing data. Also, the data were screened for
underlying assumptions and were found to meet normality, homogeneity of var-
iance, independence, and homogeneity of regression requirements.

The a priori power analysis was conducted using an average estimated effect
size (T]2 =.11) from previous studies, a« =.01, V=114, and a power criterion of
.80. The analysis showed that we should be confident in correctly rejecting a false
Hj in favor of the alternative hypothesis in our study.

The omnibus null hypothesis was tested, and there was a significant differ-
ence in LDA among participants in the SC condition compared to those in the
SC + CM condition with age used as a covariate, F(1, 111) =8.332, p <.01.
The participants in the SC + CM condition showed a higher number of days of
abstinence (M,q;. = 5.91, SE =.234) than did participants in the standard con-
dition (M,g;. =4.95, SE = .234).

The post hoc effect size was 1> = .07. The CI o9 of the mean difference was
(.088) — (1.832), indicating that the probability is .99 that this interval will
include the true mean difference between the population means of longest
duration of abstinence between the standard care and standard care plus con-
tingency management conditions adjusted for age.

In conclusion, a longer duration in abstinence from drugs was found when
contingency management treatment was added to the standard care compared to
the results of standard care only. Moreover, this finding is contingent on age
being used as a covariate.
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SUMMARY
An ANCOVA was conducted for this research problem. The independent variable

(substance abuse treatment condition) included two levels: standard care and
standard care plus contingency management. The dependent variable was the
longest duration of abstinence and the covariate was the age of participants.
Research questions and hypotheses were developed that incorporated independent,
dependent, and covariate variables. We established a criterion alpha level consid-
ering Type I and Type II errors. An a priori power analysis was conducted to assess
the dependability of the study.

Data were entered for computer analyses using the IBM SPSS statistical
program (see Table 10.16). Data diagnostics were conducted to ensure we met
univariate underlying assumptions of normality, homogeneity of variance,
independence of scores, and homogeneity of regression (slope).

TABLE 10.16 Analysis of Covariance Data

ID# IVTreatCond COVAge DVLDA
1 1 19 g
2 1 20 2
3 1 20 5
4 1 21 2
5 1 21 3
6 1 21 6
7 1 22 1
8 1 22 4
) 1 22 1
10 1 23 3
1l 1 24 1
12 1 24 4
13 1 24 2
14 1 24 5
15 1 24 6
16 1 24 8
17 1 25 &
18 1 25 5
19 1 26 2
20 1 27 8
21 1 27 3
22 1 27 6
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IVTreatCond COVAge DVLDA

ID#

NOOLONMNOLTONOTOLNNDOMOULSTOHITOOTOIITNHENTOMOTONNTT OO

27
28
29
30
30

31

31
32
32
33
33
33
33
33
34
34
34
35
38
38
39
39
40
40
40
40
41
41
43
43
44
45
49
53
57
36
33
23
53

41

— o — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — N N N

23
24
25
26
27
28
29
30
3

32
33
34
35
36
37
38
39
40
41

42
43
44
45
46
47
48
49
50
51

52
53
54
55
56
57
58
59
60
61

62

(Continued)
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TABLE 10.16 Analysis of Covariance Data (Continued)

DVLDA

IVTreatCond COVAge

ID#

N < ONS OMIODOMOSMINNIDOOOLOMNOSOLNONMMANONOMOOLLST N O O

32
37
29
40

31
25
26
42
33
23
26
26
22
43

41
25
45
35
24
53
43
44
23

41
34
37
40
39
22
25
34
32

31
27
37
35

31
29
30

41
47

AN AN ANANANANANANNNANANNANANNNANANNANANANANANANANANANANANANNANANNNNNANAN

MYTODONDRDO —AMIWONDDIO - AMIWONDNO —ANNMTOLONDDS SIS
COOOOOORRNRANNRNNRNRDODODOODBDDDDO OO ODOS O O 22822
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ID# IVTreatCond COVAge DVLDA

104 2 42 10
105 2 20 4
106 2 3 ©
107 2 27 7
108 2 27 6
109 2 45 7
110 2 42 9
m 2 50 ©
12 2 59 1
13 2 27 6
14 2 43 7

Treatment conditions:
1= Standard care
2 =Standard care plus contingency management

An ANCOVA analysis was conducted by hand and using IBM SPSS com-
puter analysis. Post hoc effect size, power, and .99 confidence interval were
calculated. Finally, a summary of the results was presented.

PROBLEM ASSIGNMENT

The steps involved in conducting an ANCOVA using IBM SPSS have been
presented in this chapter. Now it is your turn to work independently through the
steps of the hypothesis-testing process related to an ANCOVA using IBM SPSS.
Go to the companion website and you will find a new ANCOVA research
problem and data set along with a worksheet to complete. Use the problem
presented in this chapter as a guide so you can complete the assignment. Your
instructor will evaluate your completed worksheet when it is finished.

KEY TERMS
ANCOVA discrete-nominal
continuous scale error term
covariates exploratory data analysis
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extraneous variable

homogeneity of regression (slope)
G*Power 3.1

nominal-scaled

population mean

regression analysis
sample mean

two-group posttest-only randomized
experimental design with covariate

variance

344 ¢« CHAPTER 10



Chapter 11

RANDOMIZED CONTROL
GROUP AND REPEATED-
TREATMENT DESIGNS AND
NONPARAMETICS

LEARNING OBJECTIVES

Demonstrate how to develop research questions and hypoth-
eses as they relate to a research problem incorporating inde-
pendent and dependent variables studies using nonparametric
statistics.

Conduct data diagnostics to assess for parametric under-
lying assumptions and show how, when they are not met,
nonparametric statistics provide alternatives.

Execute a Kruskal-Wallis test for independent samples, Mann-
Whitney U test of two independent samples, Friedman’s test
for correlated samples, and Wilcoxon’s test for two correlated
samples.

Interpret post hoc analyses and understand the study
findings combining the various analyses.




he use of four commonly used nonparametric statistics as alternatives to

‘ their parametric counterparts is covered in this chapter. Two research
problem data sets are used to understand the application of nonparametric
statistics. Kruskal-Wallis and Mann-Whitney U statistics will be used in the first
data set and another data set will be used to illustrate the analyses of the

Friedman and Wilcoxon tests.

RESEARCH PROBLEM

Multiple sclerosis (MS) is a central nervous system disease that affects the brain,
spinal cord, and optic nerves (National Multiple Sclerosis Society, 2012). Chronic
low back pain is one of the symptoms that individuals with MS can experience. In
addition to medications to control pain, there are nonpharmacological methods
used to manage pain. One method being tested by researchers is called transcuta-
neous electrical nerve stimulation (TENS) (Warke, Al-Smadi, Baxter, Walsh, &
Lowe-Strong, 2006). TENS is administered as an electrical current applied to the
participant’s lumbar spine using a lumbar belt with self-adhering electrodes. Par-
ticipants are trained on how and when to self-administer the TENS. This simulated
study problem is designed to assess the effects of TENS on chronic low-back pain of
persons with multiple sclerosis using the study by Warke et al. (20006) as a guide.

Persons with multiple sclerosis were recruited from an MS support group
organization in a large city in the United States. Sixty persons who have multiple
sclerosis comprise the sample. The average age of participants is 42.30 (SD =
4.20). There are 48 females (80 percent) and 12 males (20 percent). The par-
ticipants have experienced low back pain over 11 years.

The 60 participants are randomly assigned to three condition groups.
The participants in the first condition receive a low electric stimulation while the
second group receives a placebo and the third group receives a high electric
stimulation. The outcome variable is pain improvement as measured by the

McGill Pain Questionnaire (MPQ).

STUDY VARIABLES

The independent variable is electric stimulation condition and has three condi-
tions: (1) low electric stimulation, (2) placebo, and (3) high electric stimulation.
The participants used a lumbar belt with neurostimulation electrodes positioned
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to emit a current to their lumbar spine region. The participants were trained in
the use of the lumbar belt and how to self-administer their allotted electric
stimulation level six days a week for 45 minutes at home over 24 weeks. The
placebo condition participants received everything that the stimulation condition
participants received except for the real electric stimulation.

The dependent variable is pain improvement, and it is operationally defined as
scores on the McGill Pain Questionnaire (MPQ). An MPQ score is derived from
patients rating their pain based on its location, what it feels like, pain change over time,
and strength of pain from mild to excruciating. MPQ scores were obtained before
treatment began. Improvement scores were recorded following treatment. In this
study example, higher improvement scores translate to greater pain improvement.

RESEARCH DESIGN

The research design used for this research example is a randomized pretest-posttest
control group design (Shadish, Cook, & Campbell, 2002) (see Figure 11.1). Each
line in the diagram represents a group (three groups), and the R symbolizes
random assignment to each group condition. The observations (O) before the
treatment conditions represent a pretest on pain improvement using MPQ scores.
The conditions by groups are represented by X; (low stimulation condition), C
(placebo), and X, (high stimulation condition). The observations (O) following
the treatment conditions represent the posttest pain level scores on the MPQ.
This design has utility for several statistical analyses. The pretest scores can be
analyzed for differences (between-design) in pain improvement across the treatment
conditions before the study is implemented. If there are differences in pain
improvement across the groups, the pretest pain level scores can be used as a covariate
to cancel out differences when comparing the posttest scores on pain improvement.
Pretest and posttest scores can be analyzed for gains using a repeated-measures
(within-design) statistic. Posttest scores can be analyzed for differences in pain
improvement across the treatment conditions following treatment (between-design).

FIGURE 11.1 Randomized Pretest-
Posttest Control Group Design

R (@) X;LowElectStim O
R (@) CsPlacebo (@)
R (@) X5HighElecStim (@)
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Statistical Analyses

We begin with an analysis of the posttest pain improvement as measured by the
MPQ scores to see if there were any differential treatment effects across the three
conditions. The pain improvement scores were analyzed at the pretest and no
significant differences were found. So the condition groups are starting out rel-
atively equal on pain improvement before the treatment begins. We will find that
the dependent variable does not meet the underlying assumptions of normality,
so our choice will be to use a nonparametric Kruskal-Wallis ANOVA with a post
hoc analysis using a Mann-Whitney U (MWU) statistic.

Parametric statistics use sample statistics to estimate population parameters
requiring underlying assumptions that include normality and homogeneity of
variance of the dependent variable from which the sample was drawn. Nonpara-
metric statistics do not have the same stringent assumptions (Siegel, 1956). Salsburg
(2001) says that a nonparametric statistic compares “the observed scatter of data
with what might have been expected from purely random scatter” (p. 163).

Siegel (1956) identified several advantages of using nonparametric statistics.
Nonparametrics use either exact probability or excellent approximations for
large samples. Thus, the accuracy of probability statements does not rely on
the shape of the population. When the sample size is quite small, say V= 6,
nonparametrics are most effective. Nonparametric statistics can be used for
dependent variable scores that are inherently in the form of ranks (ordinal) or
categories (nominal).

PROGRESS REVIEW

1. Theresearch problem that is focused on in this chapter relates
to comparing the effects of electric stimulation (independent
variable), operationally defined as a low electric stimulation
condition, a placebo condition, and a high electric stimulation
condition on pain improvement (dependent variable) among
persons with multiple sclerosis who have chronic back pain.
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2. Sixty participants were randomly assigned to the three
treatment conditions using a randomized pretest-posttest
control group design.

3. MPQ scores were obtained before treatment began. Improve-
ment scores were recorded following treatment. Higher
improvement scores indicate greater pain improvement.

4. A Kruskal-Wallis analysis of variance will be used to assess
differences in the pain improvement scores across the three
condition groups following treatment (posttest).

5. Next, the research question is stated and we begin complet-
ing the steps of the hypothesis-testing process.

STATING THE OMNIBUS (COMPREHENSIVE) RESEARCH
QUESTION

The research question is stated first and then the steps of the hypothesis-testing
process related to this research problem are presented.

Omnibus Research Question (RQ)

Will electric stimulation improve lower back pain when compared to a placebo
condition among persons who have multiple sclerosis?

HYPOTHESIS TESTING STEP 1: ESTABLISH THE
ALTERNATIVE (RESEARCH) HYPOTHESIS (H,)

The omnibus (comprehensive) alternative hypothesis for the research problem is
stated next in both narrative and symbolic formats.

Omnibus Narrative Alternative Hypothesis (H,)

H,: The low and high electric stimulation conditions will produce
significantly more pain improvement when compared to the placebo
condition among persons who have multiple sclerosis.
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Symbolic H,
Hy: HrankLowElectStim > HrankPlacebo < MrankHighElectStim

This is a directional alternative hypothesis since it is expected that either low
or high electric stimulation will improve low back pain when compare to the
placebo condition.

Jones and Tukey Method of Possible Conclusions

Once the results are obtained, we will make one of the following decisions: (1)
(1 = p2) >0, (u — p3) >0, (u2 — pa) > 05 (2) (1 — p2) <0, (y —

H3) < 0, (p2 — pa) < 0; or (3) the sign (< 0 or > 0) of (1 — p2), (11 — p3),
(Lp — p3) is indefinite. In this study, we are expecting that (fanklowElectSim —

MrankPlaCCbo) >0 and that (MrankHighEleCtStim - MrankPlacebo) > 0’ and that
(urankLowElectStim - MrankHighElectStim) is indeﬁnite-

HYPOTHESIS TESTING STEP 2: ESTABLISH THE NULL
HYPOTHESIS (Ho)

The omnibus null hypothesis is stated in narrative and symbolic formats in the
second step of the hypothesis-testing process.

Omnibus Narrative Null Hypothesis (H,)

Hpy: There will be no significant mean rank differences in pain
improvement (MPQ scores) across the electric stimulation conditions
(low electric stimulation, placebo, high electric stimulation) following
treatment implementation.

Symbolic H,

HO: MrankLowElectStim — MrankPlacebo — MrankHighEleCtStim

HYPOTHESIS TESTING STEP 3: DECIDE ON A RISK LEVEL
(ALPHA) OF REJECTING THE TRUE Ho CONSIDERING TYPE
| AND Il ERRORS AND POWER

We will use our chosen o level and combine it with anticipated sample size
and an estimated (a priori) effect size, and determine if we have enough power
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(a priori) to conduct the study. Two power analyses for this problem will be
conducted. The first will be for the comparison of the low electric stimulation
condition to the placebo and the second will be comparing the high electric
stimulation condition to the placebo.

Selecting Alpha (o) Considering Type | and Type Il Errors

Since there have been previous studies and we are repeating their procedures, we
will use a more strict alpha level of .01 to increase the probability of not making a
Type I error, which is rejecting a true null. We will have more confidence that the
low and high electric stimulation conditions are more effective in improving pain
when compared to a placebo condition.

A Priori Power Analysis

We are going to conduct two a priori power analyses to make sure that our planned
alpha, sample size, and estimated effect size will produce acceptable power prob-
abilities necessary to find significant differences in pairs of mean ranks if they exist.
The first power analysis will be conducted for the low electric stimulation compared
to the placebo condition. A similar previous study resulted in a posteffect size
of d = .90, where .20 = small, .50 = medium, and .80 = large (Cohen, 1988).
We are going to use G*Power 3.1 using our values of NV = 60, o = .01, and the
estimated effect size of 4 = 1.10. We are assessing whether we meet or exceed
our criterion of a power probability = .80 for the low electric stimulation versus
placebo on pain improvement.

A Priori Power Analysis Using G*Power 3.1.2 for Low Electric Stimulation
versus Placebo

1. Open up the G*Power 3.1.2 program.

2. Select t tests under Test family > under Statistical test, select Means:
Wilcoxon-Mann-Whitney test (two groups) > under Type of power analysis,
select A priori: Compute required sample size - given o, power, and effect size.

3. Select One beside Tail(s) > select Normal next to Parent distribution
> type in 1.10 next to Effect size d > beside o err prob, type 0.01 >
beside Power (1-3 err prob), type 0.80 > type 1 next to Allocation ratio
N2/N1 > click on Calculate. The results are in Figure 11.2.
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FIGURE 11.2 A Priori Power Analysis Results for Low Electric Stimulation
Versus Placebo

ii# G*Power 3.1.2

File Edit View Tests Calculator Help
Central and noncentral distributions | protocol of power analvsesj
critical t =2.44014
l/ o N
p \
0.3 ’ A
4 )
/ \
4 / \
0.2 / \
/ \
/ \
- N\
0.1 4 B N
pr (04 NI
~
0 il el 1
-3 -2 -1 o 1 2 3 - 6
Test family Statistical test
|ttests v ‘ IMeans: Wilcoxon-Mann-Whitney test (two groups) v ‘
Type of power analysis
|A priori: Compute required sample size - given o, power, and effect size v‘
Input Parameters Output Parameters
Tail{s) One v Noncentrality parameter & 3.3131430
Parent distribution | Normal v Critical t 2.4401435
Effect size d | 1.10 Df 34.2873270
o err prob | 0.01 Sample size group 1 19
Power (1-p err prob) | 0.80 Sample size group 2 19
Allocation ratio N2/N1 | 1 Total sample size 38
Actual power 0.8036630
Options X-Y plotfor arange of values Calculate

The power analysis results show that we would need a total sample size = 38
participants to reach a power =.80. Considering the combined elements in our
study of total sample size of both groups, 7; + 7, = 40,4 = 1.10,and o = .01,a
power of .80 should be achieved. We are therefore confident that we will correctly
reject a false Hjy and avoid making a Type II error for the low electric stimulation
condition compared to the placebo condition related to pain improvement. Next,
we will do a similar power analysis for the high electric stimulation condition
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compared to the placebo condition. The only thing that will change will be the
estimated effect size, which will be 4 = 1.25 from a previous study. We already
know that the power value will be acceptable since we are increasing the estimated
effect size, but let’s run it anyway to see how sample size changes.

A Priori Power Analysis Using G*Power 3.1 for High Electric Stimulation
versus Placebo

1. Open up the G*Power 3.1 program.

2. Select t tests under Test family > under Statistical test, select Means:
Wilcoxon-Mann-Whitney test (two groups) > under Type of power analysis,
select A priori: Compute required sample size - given o, power, and effect size.

3. Select One beside Tail(s) > select Normal next to Parent distribution
> type in 1.25 next to Effect size d > beside o err prob, type 0.01 >
beside Power (1-3 err prob), type 0.80 > type 1 next to Allocation ratio
N2/N1 > click on Calculate. The results are in Figure 11.3.

The results show that we would need a total sample size = 30 participants to
reach a power = .801. The higher estimated effect size reduced the total parti-
cipants needed by eight participants compared to the previous analysis.

PROGRESS REVIEW

1. The research question and hypotheses were identified for the
study problem.

2. An o = .01 was selected as the risk we are willing to take when
rejecting a true null hypothesis. We believe this alpha to be a
reasonable balancing point between the avoidance of making
eithera Typelor Typell error forthe goal of this particular studly.

3. We conducted two power analyses to assess the probability
of correctly rejecting a false null hypothesis. Both power
analyses, comparing the placebo condition to low electric
stimulation condition and then to the high electric stimulation
condition, resulted in power probabilities =.80.
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FIGURE 11.3 A Priori Power Analysis Results for High Electric Stimulation

Versus Placebo

ii#, G*Power 3.1.2
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o err prob 0.01 Sample size group 1 15
Power (1-p err prob) | 0.80 Sample size group 2 15
[
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Actual power 0.8014902
[ Options ] [ X=Y plotfor arange of values ] I Calculate I

HYPOTHESIS TESTING STEP 4: CHOOSE APPROPRIATE
STATISTIC AND ITS SAMPLING DISTRIBUTION TO TEST THE
Ho ASSUMING Hy IS TRUE

We are using a Kruskal-Wallis (K-W) statistic to evaluate the omnibus null
hypothesis and will follow up using the Mann-Whitney U statistics to compare
paired-means rank differences.
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We will discover during the data diagnostic process that the dependent
variable does not meet the normality assumption across conditions. The non-
parametric K-W one-way analysis of variance is appropriate to use as a
good alternative to a parametric one-way ANOVA statistic when the assumption
of normality is not met. Also, the K-W statistic is used when there are more than
two groups being compared and the groups are independent from each other.

HYPOTHESIS TESTING STEP 5: SELECT SAMPLE, COLLECT
DATA, SCREEN DATA, COMPUTE STATISTIC, AND
DETERMINE PROBABILITY ESTIMATES

The sample consisted of 60 persons with multiple sclerosis who experienced
chronic back pain. They were recruited from an MS support group organization
in a large metropolitan area. The sample was selected using purposive sampling of
typical instances (Shadish, Cook, & Campbell, 2002). The 60 participants were
randomly assigned equally to the three conditions of the independent variable:
(1) low electric stimulation, (2) placebo, and (3) high electric stimulation.

Study Data Diagnostics

Diagnostic assessments are conducted on the sample data after it has been col-
lected but before the primary study hypothesis is tested to check for data accu-
racy, missing data, univariate outliers, and underlying assumptions.

Accuracy of Data Entry

The original data were compared to the entered data by two members of the
research team. The accuracy of the data was corroborated by the two researchers.
Moreover, the variable scores were in the expected range and the means and
standard deviations appeared plausible.

Missing Data Analysis

There were no missing data in the original data set.
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Means, Standard Deviations, Variances, and Assessing for Univariate
Outliers IBM SPSS Commands

Enter the data from Table 11.1, K-W—-MWU Data, into SPSS. Enter the data

into three columns just as it appears in the table.

1. Click on Data > Split File > click on circle beside Compare groups
> click on ElectricStimulation and click the arrow so that Electric-
Stimulation is under Groups Based on > click on OK and don’t save
command output. You have told the program to provide output by the
three groups (ElectricStimulation). You will need to change this command
back later.

2. Click on Analyze > Descriptive Statistics > Descriptives > click over
Painlmprovement to Variable(s) > click on Save standardized values as
variables > click on Options and check Mean, Std. deviation, and Vari-
ance > click on OK > save the output as KW Descriptives.

The descriptive statistics table (Table 11.2) lists the sample size of each group
followed by the lowest (minimum) and highest (maximum) scores in each group.
Valid Vis the number of participant scores that do not having missing data. The
average score (mean) of pain improvement for each group following electric
stimulation condition is provided. Measures of variability (standard deviation and
variance) designate how the scores in each condition distribution deviate from
their group mean. Looking at the descriptive statistics, it is evident that high-
frequency electric stimulation produced the most pain improvement
(M = 28.900) followed by the low-frequency condition (A = 28.700) and then
the placebo condition (M = 26.750).

The standard values (z-scores) requested for the analysis to assess for uni-
variate outliers are produced in a new column on the Data View spreadsheet and
named ZPainlmprovement. These values represent the z-scores corresponding
to the raw scores in each group. Since we used the “Split File” command, the
z-scores are produced separately for each of the three electric stimulation con-
ditions. The three highest positive and negative z-scores for each group are

reported in Table 11.3.

356 ¢« CHAPTER 11



TABLE 11.1 K-W-MWU Data

ID# Painlmprovement ElectricStimulation*
1 28 1
2 38 1
3 26 1
4 29 1
5 26 1
6 27 1
7 29 1
8 29 1
S 28 1
10 27 1
n 30 1
12 31 1
13 27 1
14 28 1
15 32 1
16 26 1
17 25 1
18 29 1
19 30 1
20 29 1
21 26 2
22 19 2
23 30 2
24 25 2
25 27 2
26 26 2
27 29 2
28 28 2
29 26 2
30 27 2
31 28 2
32 27 2
33 27 2
34 28 2
35 26 2
36 29 2
37 26 2
38 25 2
39 29 2
40 27 2

(Continued)

RANDOMIZED CONTROL GRO